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Introduction

This is the User Guide for EPiServer Commerce, a state-of-the-art solution for building e-commerce
websites. With EPiServer Commerce you can quickly create and deploy a flexible e-commerce website,
combining powerful content display with advanced back-end online store management.

This is a demo store. Any orders placed through this store will not be honored or fulfiled.
Welcome, admin  Log Out My Profile

Your Local Store

' 1 Park Road

Rickmanswoth

Hertfordshire

WD3 1RE W Your Basket

enoteca +44 (0)1823 432608 Oitem(s)  Total $0.00

Mixed Cases

. 1 3’._
Discover our new Spring'collection

View our new arrivals ©

Recent Reviews

No Recent Reviews

3 for the price of 2
on all mixed cases

See our most popular mixed cases ©

) Get RSS Feed ©

LEELLEE I LR D 20% off select Reds Our newest arrivals ~ Bring out the bubbly

Multiple Deliveries Our Favorites

Our delivery services are

managed locally Pulenta, La Flor, T Tokaji Betsek, 6
Sauvignon Blanc, Puttonyos, The Royal
Find Qut More © Mendoza (Stelvin) 2010 J Tokaji Wine Company

2005

fn-gray:17002

This user guide provides guidance to the usage of the various functions of EPiServer Commerce, both
within web store administration as well as content management for your e-commerce website. The pur-
pose of the EPiServer Commerce, sample site, which is described here, is to provide an example of how
you can work with EPiServer Commerce,, in order to get your web store up and running in as little time as
possible.

To find out more about how to integrate and extend the functionality of EPiServer Commerce,, please
refer to the technical documentation for EPiServer Commerce.

About This Documentation

Target Groups
The EPiServer Commerce User Guide is intended for the target groups as described below.
o Marketers and merchandisers creating website content and campaigns.
e Content editors and system administrators, creating content and administering the website.

e Administrators working with online store procedures such as customer and order management..

References

This documentation describes features in EPiServer Commerce. Features in other EPiServer products
will not be covered here. Therefore, the following documentation available from world.episerver.com, may
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be useful for reference purposes:
o User documentation for editors of EPiServer CMS.
e User documentation for administrators of EPiServer CMS.

e SDK for EPiServer CMS and the EPiServer Framework (for developers).

Accessing EPiServer Help System

You can access the web help from the Global Menu. Click the ? icon and select the system for which you
want to view the help. Browse or search for the topic where you need guidance.

You can also access the web help by browsing to EPiServer Web Help.

Online Community on EPiServer World

EPiServer World is an online community where you can find the latest product information. It is open to
the public, for partners, customers, and everyone working with EPiServer products, such as editors, web-
masters, site owners and developers. Here you can download material, participate in discussions, read
articles, receive support and much more. Feel free to sign up as a member.

Copyright Notice

Copyright © 1996 — 2012 EPiServer AB. All rights reserved.

Changes to the contents, or partial copying of the contents, may not be done without permission. The doc-
ument may be freely distributed in its entirety, either digitally or in printed format, to all users of EPiServer
Software. We assume no liability or responsibility for any errors or omissions in the content of this doc-
ument. We reserve the right to alter functionality and technical system requirements. EPiServer is a reg-
istered trademark of EPiServer AB.

© EPiServer AB
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About EPiServer Commerce

Introduction

The foundation of EPiServer Commerce is an e-commerce core for web store management, and EPiS-
erver CMS for content presentation.

The EPiServer platform contains common functionality shared by all EPiServer products:
e Add-ons - access to both EPiServer add-on modules, as well as third-party add-ons.

e OnlineCenter - "entrance" to the website dashboard and integrated systems, with gadgets and
access to website edit/admin interfaces.

o Framework - with data storage, localization services and global search.

EPiServer Commerce

Add-Ons Website
EPiServer CMS
Friendly URL Personalization Globalization
m |
= Business API
@
5
s Catalog Management Markets
=4
=1 e
2 Asset Management Reports 9]
® A
- . =1
=~ Marketing & Q
[0}
L Order Management Promotions =
Commerce

Customer Management Administration

EPiServer Framework

EPiServer Commerce contains the following parts:
e Complete e-commerce management features:

~ Business API for integration

~ Workflows based on Windows Workflow Foundation (WWF)
~ Order, Catalog, Customer and Asset Management

~ Multi-market management

~ Marketing & Promotion

~ Reporting functionality

~ Administration interface
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e EPiServer CMS providing content management functions such as globalization, personalization
and content providers for product display.

e A sample site with a set of page templates and blocks with examples of how to work with and dis-
play content and illustrate e-commerce procedures for both B2B and B2C businesses.

The EPiServer Commerce Sample Site

EPiServer Commerce comes with a sample site including a complete set of page templates containing all
the necessary functions for setting up a website with an online store. The purpose with the sample site is
to exemplify and illustrate the code behind the templates, and to provide inspiration when building your
own e-commerce solution. Refer to the Sample Site section for more information.

Function Overview

Introduction

This section provides an overview of the functionality of EPiServer Commerce. This contains features for
both back-end administration of the online store as well as for managing and displaying specific content
for e-commerce, such as presentation of catalogs and product items.

O The documentation describes a sample installation based on the sample template package
of EPiServer Commerce. Please be aware that your specific system may differ from what is
described here, since your website is most likely customized and may be integrated with addi-
tional systems.

Store Management
Administering and Configuring the Store

Settings includes various administrative and configuration tasks such as setting up shipping and payment
gateways, your default language, currency, units, tax configuration, licensing, and search settings.

Administrating Users and Customers

Users and customers are managed by the Customers system. Users are internal to your organization and
should not be confused with customers, partners and organizations. Generally, only your team of internal
users will have access to the administrative parts, and depending on their permissions will have varying
access to the systems and menu items within each system.

Catalogs and Product Entries

The Catalogs system provides users with the ability to manage catalogs, product categories and prod-
ucts. Products are arranged into a particular catalog. Catalogs are independent from one another and
you may create as many catalogs as you need. Catalogs can be structured in a number of ways and
organized into Categories, Products, SKUs, Bundles, Packages and Dynamic Packages. The Enoteca
sample site includes a sample catalog with products, SKUs, and packages.

Purchase Orders, Shopping Carts, Shipping, and Returns/Exchanges

The Orders system is where you can monitor, track, change or create new orders, ship out items, and
create returns/exchanges. Orders are highly flexible, giving internal users the ability to create purchase
orders with various options including split payments, split shipping, and split shipping addresses.

Customer Campaigns, Promotions, and Discounts

The Marketing system handles for instance promotions. A promotion is a marketing tool used to increase
sales of certain products or product lines. Various incentives such as lowered pricing and other discounts

© EPiServer AB
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can be employed as part of a promotion.Either you can create a promotion that s visible prior to checkout
or you can configure the promotion to be displayed during the checkout process.

The most powerful aspect of the Marketing system is the workflow engine which allows variable con-
ditions to be applied when creating a promotion. These conditions vary from the number of items, the per-
centage discount, shipping rates and many others. Marketing teams also have the ability to target specific
customer segments by region, individual customers or customer groups.

Assets Management

The Assets system allows for assets such as images, MP3s, PDFs, software packages and other down-
loadable files to be centrally stored and available from either the public site or from inside EPiServer Com-
merce.

Content Management
Working With Content

Marketers, merchandisers and editors will work from the EPiServer CMS editorial interface to create and
update content. Perhaps you want to create a campaign or a landing page and display products from the
product catalog. Or maybe create news or an article with content related to the products in your online
store. EPiServer CMS has functionality allowing editors to drag-and-drop content blocks or pages into the
content area of another web page, making it easy to create dynamic websites putting important contentin
focus.

Administering the Website

The EPiServer CMS administration interface is where you will manage the administrative tasks for the
website. These may involve setting access rights for EPiServer CMS web pages in the page tree and
block folder structure, configuration of page types, management of scheduled jobs, and globalization set-
tings.

Fore more information on the functionality and how to use EPiServer CMS, refer to the user doc-
umentation for EPiServer CMS.

Roles

Introduction

E-commerce solutions with online stores can be set up in many different ways, depending on the purpose
they serve. An EPiServer Commerce sample installation is based on a setup of certain roles with specific
tasks and access rights. The description in this documentation reflects these roles in order to make it eas-
ier to understand the underlying work procedures.

Visitor

A visitor in this context is a customer using a web browser to visit the website with purchasing intentions
("shopper"). In a standard installation of EPiServer Commerce (B2C), purchasing can be done either
anonymously or by registering an account. Registered visitors can also contribute to the website content
by rating and commenting on products.

Merchandiser

The merchandiser typically works with all stock on the website to ensure that the strongest products are
putin focus, This role also creates landing pages, sets product pricing and coordinates cross-product sell-
ing. Furthermore, this role may also oversee delivery and distribution of stock and deal with suppliers.

© EPiServer AB
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Marketer

The marketer creates content and campaigns with targeted banner adverts to ensure customers have con-
sistent onsite experience of the various marketing channels. Furthermore, the marketer monitors cam-
paign KPlIs to optimize page conversion.

Store Administrator

The store administrator works with information related to customers, orders and products. Store admin-
istrators may also work with configuration and system settings. Depending on how the organization is set
up, the store administrator role may be sub-divided into sub-roles with specific access rights and tasks:

e Order Supervisor - full permission for the entire order management.

e Order Manager - creates returns and exchanges, edits orders, sends notifications, processes pay-
ments and split shipments.

e Shipping Manager - handles packing and completion of shipments.

e Receiving Manager - handles shipments and returns.

System Administrator

In the EPiServer Commerce back-end system, this administrator role has extensive administration rights
in areas such as assets, catalogs, core functions, marketing and customer and order management.

Website Administrator

The website administrator is someone responsible for administrative tasks for the website, including the
setting of access rights for editors on the website. Can also define visitor groups used by editors when cre-
ating personalized web content for target groups. Usually has full access to both the editorial and admin-
istrative interfaces in EPiServer CMS.

Website Editor

Someone creating and editing content on the website with access to the editorial interface. Editors can
be either frequent editors or occasional editors, and they may or may not have publishing rights.

Website Owner

The website owner is someone with an overall responsibility for one or more websites. Creates content
occasionally, approves and publishes content created by others, and uses OnlineCenter and gadgets to
monitor website activities. May also be an e-commerce manager.

Refer to Access Rights for more information on access rights for different roles in EPiServer Commerce.

Shopping Workflow

Introduction
There are many different types of e-commerce websites, however the two most common ones are:
e Business-to-Consumer (B2C) - typically designed for selling goods and services to consumers.

e Business-to-Business (B2B) - used to build strategic relationships with other businesses, and to
ease the supply and procurement processes that characterize trade among those organizations.

Sites can also have multiple roles, and a single site can provide several functions. EPiServer Commerce
is a flexible platform allowing for seamless integration with external systems such as financial, CRM,
inventory, warehouse and customer service systems.

© EPiServer AB
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Depending on how you choose to work with editorial content and your online store administration, you
will define your user roles and groups, and give them access rights to the different parts. Example of user
roles in EPiServer Commerce are content editors, marketers, business owners, and store and system
administrators.

Step-by-Step Process

A typical "shopping workflow" involves a number of interactions between a "shopper" on the website,
EPiServer Commerce, and any integrated external system.. Depending on how the system is set up, the
shopping workflow can be fully automated so that it requires little manual attention. However, a purchase
order can always be monitored, accessed and handled manually from the Orders system if needed.

In the following we will describe an example of a shopping workflow and the actions and tasks involved.
This example is mainly based on a standard installation of EPiServer Commerce, which is a B2C type of
e-commerce site.

Shopping Process

1. Welcome 2. Address 3. Payment 4. Confirmation

| 2. Start 3.Add 4.Add 5. Order !
checkout address payment created 1

created 1 .
1 - 2 P = ot
| Financial CRM Payment 1
1 system system gateway(s) : f
: /_\7_\ ) T 6. Order
—_— — 1 n
! Shipping Inventory/ Customer | p:ocessmg
! warehouse ; & ISR
H gateway(s) . services 1 B
\ J
: system : + Shipment split
L ! S
Manual
Order

Packing
Tracking # . slip

Picklist

¥

10. Retums/ Baoncy 8.Add to 7. Shipment
Exchanges CELEE icklist released
L 9 . shipped | P

1. Cartcreated
In this example, a shopper does not need to register on the site in order to buy. The order process
actually starts as soon as the shopper selects a product and adds it to a shopping cart. A cart (bas-
ket) will be created and saved in the system, and can be viewed in Orders under "Carts". If the
shopper doesn't complete the checkout procedure, the cart will remain in the system for a spec-
ified time.

When the shopper returns to the website, the cart will be "remembered" and made available for
continued shopping. Already in this early step the system will perform an inventory and pricing
check, to look for availability in the warehouse, as well as discounts for selected products in the
cart. This will be updated if and when the shopper returns to the cart at a later stage.
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10.

Start checkout
When the shopper decides to complete the purchase and chose to "proceed to checkout", the first
step of the checkout procedure is initiated.

Add address

In the second step of the checkout procedure, the shipping and billing address information is
added together with the preferred type of delivery (First class/Express etc). The address infor-
mation can be entered manually by an "anonymous" shopper, or automatically if the shopper is
logged in and has a registered user profile with address information. The system can also be set
up so thatitis possible to split shipments in different parts and to different addresses here.

Add payment

In step three of the checkout procedure, the payment is added to the "purchase order to be". The
system will calculate the total sum including the purchase amount and the shipping fee. In this
step the shopper selects a payment method, for instance by credit card or PayPal. The payment
will be registered and verified. This may happen instantly or after a certain specified time, depend-
ing on how the payment process is set up and the type of e-commerce solution (B2C or B2B). In
this step itis also possible to split payments, if the system is configured for this.

Order created

Usually the actual purchase order is created in the system when the payment is settled. In the last
checkout step, a purchase order number is created, the shopper confirms the purchase, and an
order confirmation is sent to the shopper. The shopping cartis now converted to a purchase order
which is visible with status "In Progress" under "Purchase Orders" in Orders.

Order processing

When the order is created the order processing starts. This consists of steps to check the ware-
house and inventory status for the products in the order, and for creating the actual shipment.
Depending on the inventory status for the products, the order may be splitinto more than one ship-
ment.

Shipment released - when the shipment is verified, it will be released. The purchase order will
now appear in Orders, under "Shipping/Receiving" and "Released for Shipping".

Add to picklist

This steps involves the addition of the shipping items to a picklist. The picklistis the list that the
warehouse will use to create the physical shipping of the products in the order. This step will also
produce a packing slip, which is the paper slip that will be attached to the physical package to be
shipped.

Order completed/shipped

When the picklists with the different orders and their respective packing slips have been created,
the order will be set to completed. In the system this involves the creation of a shipment validation
number which is associated with tracking number. The tracking number can be entered manually
or automatically, if such an integration exists. The tracking number connects the physical package
with the shipping provider for the delivery, and is used for tracking the package on its way to the
delivery address. The purchase order will now appear in Orders under "Purchase Orders" again,
with status "Completed".

Return/Exchanges

Only completed orders can be subject to returns/exchanges. Depending on how the system is
set up, returns can be created automatically or manually. Creating a return usually involves replac-
ing a delivered product with another one in exchange, and/or a payment refund. When the return
is created it will appear in Orders under "Shipping/Receiving" and "Returns". Order status can be
for instance "Awaiting Exchange".

If the return involves replacement of a new product, the shipping procedure will be initiated again.
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The return may also involve receiving a faulty product, in which case a receiving procedure is ini-
tiated involving the acknowledgement of a receiving receipt for the returned product.

Integration with External Systems

EPiServer Commerce is a flexible platform built for integration with other business systems needed in an
e-commerce environment. These systems are typically integrated with various parts of the shopping work-
flow, for exchange of data with EPiServer Commerce.

Examples of such external systems:
e Financial system - for instance invoice management, payment refunds,and sales reporting.
e CRM system - for management of customer profiles and address information.

o Payment gateways - the setup of different payment solutions for instance credit cards and Pay-
Pal.

o Shipping gateways - the management of shipping providers and exchange of tracking infor-
mation.

¢ Inventory/Warehouse system - exchange of inventory information in connected warehouses.
e Customer Services - exchange of for instance order status information.

Through the EPiServer Add-on Store you also have the possibility to extend your EPiServer Commerce
solution with additional modules from EPiServer and third-party providers. The Add-on Store is available
from the Add-on option in the EPiServer global menu.

© EPiServer AB
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Getting Started

Introduction

This section describes how you can log in to an EPiServer Commerce website, and access and navigate
the different modes. Note that the login procedures may be different from what is described here, depend-
ing on how your website and infrastructure is set up. The examples described here are based on a stand-
ard sample installation of EPiServer Commerce.

Logging In
As an editor or administrator, you usually log in to your website using a specified URL or a log in button.

On the EPiServer Commerce sample site, clicking Log In in the top menu will take you to the login page of
the website. Enter your user name and password, and click Log In.

Note that this login page is the same for both customers logging in to their account, as well as for web
editors and store administrators logging in to work with content or administer the online store parts. What
you are allowed to do after you have logged in, depends on your access rights.

Register  Logln My Profile
Your Local Store

' 1 Park Road

Rickmanswoth

Hertfordshire
WD3 1RE @ Your Basket

enoteca Diens) o s000

Mixed Cases Popular searches |+ |

Log in or create an account

Registered Customer " Required Fields
If you have an account with us, log in using your username.
Username *  admin
Password ®  sreer
e —
Use your Facebook account to log in.

New Customers
Register on our site and create your personal profile.

New to Enoteca?
Take advantage of Enoteca’s fine wine collections, education resources and special events by

registering Register ©

Access Options

When logged in to your EPiServer Commerce website, you will have some different options to chose
between, depending on your access rights. In the examples in this documentation we assume that you
have full permission to the different parts of the EPiServer Commerce website.

You access EPiServer Commerce through the Edit View. Select Go to Edit View and proceed to the edit-
ing view.

EPISERVER v

admi Go to Edit View

Go to my Dashboard

You can also go directly to your personal dashboard by selecting the Go to my Dashboard option.
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Navigation

When logged in, use the global menu available at the very top to navigate your way around. In the menu
you will find the different systems integrated with your e-commerce website. From here you can select
Commerce for store administration, or CMS for managing website content.

Dashboard Add-ons

Commerce Manager Setlings

Selecting Commerce in the global menu will expand a submenu where you can select Commerce Man-
ager fo work with e-commerce management. The Settings option, will take you to a settings screen
where you define specific site settings.

O The options you see may vary depending on your access rights. In the examples in this doc-
umentation we have assumed that the user has full permissions to all functions in EPiServer

Commerce.
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Commerce Manager

This section explains how end users can administer e-commerce tasks through the EPiServer Commerce
back-end Commerce Manager system. Commerce Manager includes a number of sub-systems for man-
aging the different parts of the online store system. The sub-systems are configurable, the setup
described here is that of the EPiServer Commerce sample site.

Dashboard

Customer Management

Catalog Management

(o}
Qs
=
nﬁ Order Management
.
=
2l
i

Marketing

Asset Management

Reporting

Administration

Dashboard

Introduction

The dashboard is the area within Commerce Manager where you will find general status information
about your EPiServer Commerce application. The purpose of this area is to give administrators an "at a
glance" view of updates and status of the site or sites that are running on that particular instance of EPiS-
erver Commerce.

Dashboard View

The dashboard is an aggregated view of a site's status. Typically, the dashboard is the first screen seen
that a user sees when he/she logs into Commerce Manager. This is the area where a user can geta
quick overall snapshot of e-commerce site, including notifications and alerts, an overall summary of prod-
ucts, categories, orders, customers, and promotions, sales performance graphs, customizable news and
announcements, and a search field for help.

Customizing the Dashboard

You can customize the dashboard by re-arranging the layout of the controls ("widgets" or components) on
the page. You can arrange the controls and adjust the page template that is used for the dashboard. The
following controls are available: Help, Summary, News & Announcements, Alerts, and Performance.

Control Description

Help Allows users to search for help topics that links directly to the EPiServer
Commerce webhelp site. Enter key terms into the Search field and then
click on Search Help. Other frequently asked questions (FAQs) are listed
underneath the Search field.

Summary Displays the total number of Products, Categories, Orders, Customers,
and Promotions .
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Control Description

News & Announcements Displays a feed of the latest blogs from EPiServer World.

Alerts Displays warnings about each site that may hinder performance and
sales, such as the lack of site analytics installed on the site .

Performance Displays a Sales Graph and a graph for the Total Sales of the year.

Adding Controls and Adjusting the Page Template
Click on Add on the Dashboard page. The Information form pops up above the Dashboard page.

Information

Controls Set Page Template

Help

News & Announcements
D Performance

Summary

]

| gsato default || E]Add and cI%H X Cancel |

The Controls Set tab allows you to select which Controls you want to add to the Dashboard. Check the
boxes and then click on Add and Close. The Controls you selected will appear on the Dashboard.

To reset the Dashboard back to the default state before any customizations were made, click on Set to

Default.

On the Page Template tab, you can adjust the Dashboard page layout to a One column template, Two
columns template (first twice bigger than the second), Two columns template (2nd twice bigger than
the 1st), and Two equal columns template. Click on the layout you want and then click on Add and

close.

Information

Controls Set Page Template

One column template

Two columns template (first twice bigger than the secand)

Two columns template (2nd twice bigger than the 1st)

Two equal columns template

]

| gsato default || E]Add and closeh” A Cancel |

The screen below is an example of how a One column template looks.
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‘ News & Announcements v X

Summary

& Products- 1320 (O categories: 64 [ Orders:17 &1 customers: 10 = promotions: 1

Help - x

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms
Examples: Campaigns and Promations

a. Howdo | Create a Discount Promotion?

b. How do | Create a New Product?

¢. Whereis the release history?

Wadd

Rearranging, Collapsing, and Removing Controls

To rearrange Controls, hover the mouse cursor over the title bar and drag the Control to another space in
the Dashboard.

1ERCE Dashboard Home

1@ Cet Help For This Page

News & Announcements - x ‘

Help - X

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms..
earch Help

Examples: Campaigns and Promotions

a. Howdo | Create a Discount Promotion?

b. How do | Create a New Product?

<. Where is the release history?

¥ Summary

& products: 1320 3 Categories: 64  [E] Orders: 17 &1

%3 promotions: 1

To collapse Controls, click on the Up-arrow icon. To expand a collapsed Control, click on the Down-
arrow.

Summary - X

4 Products: 1320 © categories- 64 (2] Orders: 17 &1 custamers: 10
%3 promotions: 1

News & Announcements - X |

Help J\ebx_

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms...
earch Help

Examples: Campaigns and Promotions

a. How dol Create a Discount Promotion?

b. How do | Create a New Product?

<. Where is the release history?

v
s dd

To remove a Control, click on the Xicon.

Customer Management

Introduction

The Customer Management system is the Customer Relationship Management System (CRM) within
EPiServer Commerce. Customer Management is comprised of Organizations, Contacts, and Roles. Cus-
tomer Management can be used to organize both internal business users and customer groups. Fur-
thermore you can control both end-users and employees within your company that use the system.
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Utilizing the hierarchy you can create with organizations, sub-organizations, contacts, and roles you can
segment all users of the system into the desired groups.

e Organizations - organizations are structures that allow you to divide, separate and manage all of
the users that are in your system. Organizations can also have suborganizations to further classify
your users.

e Contacts - contacts are individual persons that are added to your Customer Management system.
They also contain all the information for a person's account, which allows them to interact with the
system based on their account and role.

e Roles -roles in the Commerce Manager back-end system, are classes that you setup in order to
give specified users certain accessibility and permissions. Certain roles come out of the box and
roles can be created, edited and deleted to fit your needs. Itis useful to set up roles to coincide
with organizations within your Customer Management system, since that will allow you to more
easily manage your users and organizations. Roles are completely separate from users and
organizations, so how you choose to divide your roles will be up to you.

e Gift cards - on the EPiServer Commerce sample site, gift cards are administered from Customer
Management. Gift Cards are described in more detail under Payment Methods.

Customer groups can be leveraged by Marketing for special promotions, pricing, etc. As with any part of
the EPiServer Commerce, you can always choose to integrate with a third party CRM.

Working With Customer Management
Planning Organization Hierarchy

One of the first things you will want to do is to plan your organization hierarchy so that your organizations,
contacts and roles ready for input. You can create Organization Hierarchies by creating parent-child rela-
tionships between organizations. For example, creating your Organization Hierarchy for your internal
Administration you can create a the hierarchy of organizations being Administration > EU Headquarters >
EU Management.

You may then associate Contacts with the appropriate level of the Organization Hierarchy. Permissions
can be set to determine which users can view certain Organizations in the hierarchy as well. The same
principle applies for creating hierarchies for customer groups. For example, you could have a customers
organization with sub-organizations of Gold, Silver, and Bronze level customer groups. You could then
leverage those customer groups to display different prices for each of your valued customer groups.

Creating Organizations and Contacts

Organizations are structures that allow you to divide, separate and manage all of the users that are in
your system. Contacts are individual persons that are added to your Customer Management system. They
also contain all the information for a person's account, which allows them to interact with the system.
When users register on the front-end of the site (for example to make a purchase) they automatically geta
Contact made for them and an account created that they setup. For more information see Organizations
and Contacts.

Using Roles and Permissions

Roles allow you to give users access to different parts of the system with varying levels of permissions.
For example, a marketing person within your organization may be able to draft new pages, and their mar-
keting director must be the person to approve it. Users are able to have multiple roles within the system.
For more information see the Roles section.
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Organizations
Introduction

Under Organizations, Commerce Manager users can create new organizations. Organizations can be
categorized into different types such as organization or organization units (for example regional
branches, departments) and also business categories such as "Computer and Electronics" or "Clothing
and Accessories".

Organizations can be structured into a tree structure with subunits with different levels of permissions
assigned to each. For example, you can set up your company as a parent level organization while your
departments such as Sales & Marketing, IT/Development, and operations as organization units. With this
scenario, you can allow users in each departments to have access to only relevant systems, screens and
functionality within Commerce Manager.

Working With Organizations
The work with organizations includes the following tasks:
e Creating organizations and organization hierarchies
e Browsing and viewing existing organizations
e Managing company accounts for a B2B scenario
e Editing and deleting existing organizations

e Defining dictionary values for organization types and business categories

Browsing and Viewing Organizations

Browsing Organizations

Organizations are one of the major function areas of the Customer Management system. You can browse
and view existing organizations and suborganizations.

To browse organizations, go to Customer Management and select Organization in the left menu.

Customer Management .ff}‘

:lm Customer Management

| :ﬂ Organizations

: [
g Contacts AW,
'é,‘:l Roles

B Cift Cards

This will open the Organization List page.

,J View: Primary contact - ‘X

;1:3 New Organization £ Printer Version | ¥ Delete

D Name Description Type Business Category Primary Contact
D Knudsen inc temp Organization Automaotive Mr Mike Smith
|:| Company X West Company X West Organization Unit Food & Dining Mr Mike Smith
|:| Big Bank A large bank with lots of VIP customers Organization Legal & Financial Mr Mike Smith
[ CompanyX Company X Organization Food & Dining Jane Seymour
|:| The Wine Cellar The Wine Cellar Organization Industry & Agriculture Mary Edwards

In this view, the organization details displays the following information:

Description

Name Name of the organization
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Field Description

Description Additional details of the organization

Type The kind of organization itis

Business Category Under which category the organization falls
Primary Contact The main contact person for the organization

Viewing Organization Details

Selecting an organization in the list will display more detailed information about the type of organization
and related contacts, organizations (parent/sub), addresses and credit cards.

Edit Organizations

Name: Company X West Parent: Company X
Infor i Information
Information or
Contacts N c w T o ion Uni
ame:- ompan est e rganization Unit
Organizations pany e g
Addresses Description: Company X West Business Category:-Food & Dining

Credit Card
redit Lards Primary Contact: Mr Mike Smith

Amount:

Limit Debt
Amount:

Searching for Organizations

You can also use the search field on top of the Organization List to find specific organizations by name.
To conduct a search, enter your search terms and click on the Search button. To conduct a new search,
click on the Reset button to reset the form and enter new search terms.

Customizing Views for Browsing Organizations

As an Organization List gets longer, you can create and customize views to filter the list. You define the
columns you want to be displayed for the view, and the filters to be applied when selecting what to
include in the view.

Do the following to create a new organization view:

1. Click on the View drop-down menu and select "New View."

ERCE Organization List

| |,.) View: All organizations E‘
” N I[ System Views |

“= New Organization | (5) Printer Version | ¥ Delete All organizations

|:| Marre Description Type

|:| = Company X East Online software application Organization Computers & Electronics

|:| =¥ CompanyXWest Online software applications Organization Computers & Electronics

|:| =¥ CompanyX Online software applications Crganization Computers & Electronics
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2. The New View dialog is displayed.

New View *

GCeneral || Fields || Filters

Enter Title

Everything is ready
tO Create a new view
for entities list.

Please, type view
name.

D Show this view for all users

| Save | | Clase |

3. The defaulttab is General. Enter a Title for the custom view. Click the check-box Show this view
for all users, if you want other users to see this custom view.

New View *

General || Fields || Filters

Enter Title

Professional Services Companies Ewverything is ready
to create a new view
[¥] Show this view for all users for entities list.

Please, type view
name.

| Save | | Close

4. Click on the Fields tab to select which columns you want to appear in the custom view. Under
Available columns, select the columns you want to appear by clicking and highlighting the col-
umn name and moving it over to the Visible columns list by clicking on the Right Arrow icon.
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Ceneral

|| Fields || Filters

Available columns:

Description

Id

Modified
Modifier

MName

Parent (ref)
Primary Contact
Primary Contact (ref)

Type

Wisible columns:

Business Category

m

&1

To deselect a column, click and highlight a column name from the Visible columns list and then
click on the Left Arrow icon. To change the ordering of the Visible columns list, click and high-
light a column name and click on the Up and Down Arrow icons on the right of the list to repo-
sition the column.

5. Click on the Filters tab to set the view filters. Clicking the + icon allows you add an additional filter.

New View

Ceneral

|| Fields || Filters

And

Or

Business Category Equals

Please choose

Arts & Entertainment

Please choose
And

Or

Business Category
Created
Description

Id

Madified

Parent

Parent (Reference)

Primary Contact

Primary Contact (Reference)
Type

Save

6. Click Save to save the settings and return to the Organization List screen.
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Applying a View

Once a View is created and saved, it appears in the View drop-down box.

View: | Professional Services Companies - }(

[ System Views ]
All organizations

Mall Yser views ]
Professional Services Companies *
[ New Wiew |

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the cus-

tom View, your organization list will reflect those options.
Editing and Deleting Views

To edit an existing view, select the view from the drop-down menu and click on the Edit icon next to it. The
View Editing dialog is displayed and you can edit all properties.

FRCE Organization List

| |,) Wiew: | Professional Services Companies |Z| %‘X
)FEI MNew Organization ﬁ Printer Version X Delete Edit h
|:| Creator Business Category Marme

]

To delete a custom View, click on the X icon next to the Edit icon.

There are a multitude of options available for customization, but here are some examples to get you
started.

Customized View Example

In this example we will create a view that only shows organizations matching a business category and
organization name. We will create a filter condition that display organizations with a Business Category
that equals "Business & Professional Services" and an Organization Name that equals "Company X."

ERCE Organization List

| |,J View: | All organizations lz‘

= New Organization | & Printer Version | ¥ Delete

|:| Marne Description Type EBusiness Cateqory

|:| =¥ Company X East Online software application Organization Unit Computers & Electronics h
|:| = Company X West Online software applications Organization Unit Computers & Electronics

|:| =¥ Company X ITW... Online software application IT s... Divisional Unit Computers & Electronics

|:| =¥ Company X Online software applications Organization Computers & Electronics

1. Click on the + icon and from the drop-down select "Business Category." Two fields, which default
to "Equals" and "Arts & Entertainment," automatically appear. Click on "Equals" and a drop-down
appears. Keep the field as "Equals." Click the field to the right of it and select a "Business Cat-
egory" name (such as "Business and Professional Services").
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2. Since we want to add another filter so that the Organization not only matches this "Business Cat-
egory," but also a specified name, click on the following + icon and then on the drop-down select
"Name."

3. Inthe nextfield, select "Equals" and then on the field that says "Text" enter in the name of the
Organization.

4. Once done, click Save to save the View.

New View *

Ceneral || Fields || I-'ilter5|

. And

Business Category Equals Business & Professional Services

Mame Equals Cu:’n:a’rg' X

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the cus-
tom view, your organization list will reflect those options.

ERCE A Organization List

| |,J View:| Professional Services Companies IZI = X
;[:ElNew Organization ﬁPrinter\-’ersion X Delete

|:| EBusiness Category Marne Description Type

|:| Computers & Electronics Company X Online software applications Organization

Printing a List of Organizations

If you want to generate a printer-friendly list of Organizations, click on Printer Version. A new window will
pop-up and render a simple table suitable for printing. Click on the Print button on the upper right corner
of the page.

Creating Organizations
Introduction

In the following we will describe how to create an organization hierarchy with a "parent" and "child" organ-
izations for your EPiServer Commerce site. The parent organization is of the type "Organization", and the
suborganization will be of the type "Organization Unit" in the system.

Creating an Organization or Organization Unit

These steps apply to both organizations and organization units.

1. Go to Customer Management and Organizations. You will be brought to the Organizations page
which lists any existing organizations.

2. Click New Organization. This will lead you to a new screen to input data for your new Organ-
ization.
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Organization List

| |,.) View: | All organizations

*(= New Organization | 3 Printer Version | 3 Delete

|:| Marme U Description Type Business Category

]

3. Enter data for the new organization, see below for available options.

MMERCE New

Name:

| Company X West
Description: Western subsidiary i
Type: Organization Unit ¥ ﬁ
Business Category: Food & Dining hd ﬁ
Parent: Company X hd
Farent Qrganization

{Custarmer:Organization_mi_FrimaryContacild_Description}

Available Balance: 0.00

Owverdraft Lirnit: 0.00

| K || Cancel ‘
Field Description
Name Enter in the organization name (this is the only required field).
Description For additional details about the organization.
Type Select from the drop-down menu to assign a type to the organization. If the

organization is a parent organization, select "Organization", if the organ-
ization is a suborganization, select "Organization Unit". More types can be
added to the drop-down by clicking on the icon.

Business Cat- Select from the drop-down menu to assign a category to the organization.
egory You can add more categories by clicking on the icon.
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Field Description

Parent You can assign a parent organization to an organization. If the organ-
ization you are creating is a subunit (child) of a larger organization, then
select the parentin the drop-down menu. If you do not see the Organ-
ization listed on the drop-down menu, click More...

Primary Contact  Name of main contact for the organization.

Available Balance | Account settings related to a company account. For more information, refer
and Overdraft to Managing Company Accounts.
Limit

4. Save the organization by clicking OK. The Organization Info window of the organization appears.
From here, you can view Information about the Organization you just created. Out of the box, you
can also see associated Contracts, Organizations, Addresses, and Credit Cards. You can fur-
ther edit the Organization by clicking the Edit button. To go back to the Organization List, click on
Organizations on the menu bar next to Edit.

ﬂ Organizations

Name: Company X Parent:
Infor i Information
Information or
Contacts N c % - o o
ame: ampan e: rganization
Organizations pany e a
Addresses Description: Company X Business Category-Food & Dining

Credit Cards Primary Contact: Jane Seymour

Amount:

Limit Debt
Amount:

Creating an Organizational Hierarchy

You can create organization hierarchies by assigning a "parent organization" to a "child organization"
and then another organization to the child. Permissions can be set to determine which users can view cer-
tain organizations in the hierarchy. In this example, "Company X" is the Parent Organization and "Com-
pany X West" is the Organization Unit.

1. Go to Organizations and click New Organization. Enter data for the organization (see previous
section).

2. Under the Parent option, assign the desired parent organization ("Company X"). If you do not see
the organization listed on the drop-down menu, click More...
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ERCE

Organization Edit

Overview
Name: Company X West
Description: Online software applications
Type: Organization Unit

Business Category: Computers & Electronics

Parent: ||:|:|rr1par11.rx |Y|
F N.Dz Set .
oK C I Company X

|| ance | More. h‘

3. Click OK to save the organization.

4. In the Organization Info page, the Organization Unit ("Company X West") becomes the child to the

Organization ("Company X") you selected.

Edit Organizations

Organizations
Addresses
Credit Cards

Description: Company X West
Primary Contact: Mr Mike Smith
Amount:

Limit Debt
Amount:

Name: Company X West Parent: Company X
Infor i Informartion
Information or
Contacts . .
Name: Company X West Type: Organization Unit

Business Category-Food & Dining

5. Repeatthe steps above to create further organization units for the parent organization

Managing Company Accounts

Introduction

A company account is part of the B2B features on the EPiServer Commerce sample site, where busi-
nesses can manage their purchasing and deliveries from the e-commerce website. Companies can add
their employees to the company account, and orders can be delivered to multiple addresses.

Adding a Company Account

Do the following to add a company account:

1. In Commerce Manager, go to Customer Management and Organizations. Select New Organ-

ization, and add the company information.
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2. Under Primary Contact, select the user that will be the administrator of the company account.
The admininstrator must be registered on the website with an account.

EPISERVER COMMERCE Edit

Welcome = Change Language About -

Customer Management 3% || _]
:lm Customer Management Name- Company XYZ
;ﬂ Organizations
Cg Contacts Description: A company in the wine business
-
&~ Roles
@ Gift Cards Type: [ No value ] =] |
Business Category: [ No value | IE‘ ﬁ?l
Parent: Mot Set -
FParent Organization
Dashboard g -
ﬁ | Primary | yaee smith v
Contact: .
m Customer Management Mot Set onf
= Availabli pary smith
'_E Catalog Management ISl L\’.-
Carlos Santana
Overdra
Order Management John Browne
. More._..
% T 0K || Cancel |
_?ﬂ

3. Under Contacts for the organization, select Add to add memebrs to the company account. You
must at least add the administrator as a member of the account. Thisis needed to provide the
account administrator access to the company account management features. Click OK to save the
changes.

Edit Organizations

MName: Company XYZ Parent:
Information Contacts
Information A |
Contacts |
Organizations I
Addresses Mary Smith
Credit Cards Carlos Santana
i Page Size: 20 IE‘ (2 items) | Page4 1
4
Edit || Cancel

Administering Company Accounts

When the administrator goes to the My Profile Page, it will be a Company Profile page instead, from
where the administrator can manage do the following tasks:

o Edit the settings of the company account.
e Manage members of the company (create/edit/delete).
e View comments posted by members of the company.

e View orders purchased by members of the company.
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Company Profile

Members
EPiServer
admin Business Categary: Computers & Electronics

Member Since: 01 Mar 2012 Members: 2

quma quma

Uember Since: 01 Mar 2012
Edit Settings @

Members Latest Comments

No Orders Yl

O The personal My Profile page of the company account administrator can be accessed by typ-
ing in the URL in the address bar, for example: http://<domain>/en-US/My-Profile/My-Orders/

Delivering to Multiple Addresses

Multi-address delivery is a feature allowing for company users to dispatch deliveries to multiple
addresses. The dispatch to multiple addresses option will be available for company account users during
the checkout procedure. You can specify different quantities, delivery addresses and shipping methods
for each delivery.

e | would like to dispatch to Multiple Addresses

Product Quantity Address Shipping Method
Pulenta, La Flor, Sauvigr E 2 1 EI Express delivery (1 day’ EI
Pulenta Estate, Pinot Grit[v] 1 123 [v] Fistoassceivery(12 [v] @

Do you want to change the quantity of your orders? Go back to the shopping basket

Each delivery can have its own shipping method but there will only be one billing address option.
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Split Shipment - Part 1

Name

Pulenta, La Flor, Sauvignon Blanc, Mendoza (Stelvin)

Shipping Address Shipping Method(s)

11
1
1

United States

1 package via:
Express delvery (1 day)

Split Shipment - Part 2

Name

Pulenta Estate, Pinot Gris Mendoza

Shipping Address Shipping Method(s)
123123 1 package via:

123 First class delfvery (1-2
123 days)

United States

Quantity Price
2 945
Subtotal

Shipping & Handling

Taxes
Quantity Price
£9.35
Subtotal

Shipping & Handiing

Taxes

Order Discount

Total Order

Commerce Manager | 31

Total
Discount Total
£0.00 £18.90

E18.90 (exc Tax)

£20.00 (exc. Tax)

£0.00
Total
Discount Total
E0.00 E93S
£9.35 (exc. Tax)

E10.00 (exc. Tax)

£0.00

-£0.00 (exc. Tax)

£58.25 (exc. Tax)

The functionality of the company account related page templates are described in more detail in the Com-

pany Profile section under Page Templates.

Editing and Deleting Organizations

Editing Organizations

Do the following to edit an existing organization (parent) or organization unit (child):

2. Open an organization by clicking on itin the list.

'J Wiew:

Go to Customer Management and Organizations. The Organization List page will be displayed.

3. Selectany of the Edit options at the top or the bottom.
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Primary contact - x

;EI MNew Organization Eﬁ Printer Version X Delete

D MName Description Type Business Category Primary Contact
|:| Knudsen inc temp Organization Automaotive Mr Mike Smith
[[] Company X West Company X West Organization Unit Food & Dining Mr Mike Smith
|:| Big Bank A large bank with lots of VIP customers Organization Legal & Financial Mr Mike Smith
|:| Company X Company X Organization Food & Dining Jane Seymour
D The Wine Cellar The Wine Cellar Organization Industry & Agriculture Mary Edwards
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Edit Organizations

Name: Company X West Parent: Company X
Information Information
Information Oor
Contacts
Name: Company X West Type: Organization Unit

Organizations
Addresses Description: Company X West Business Category:-Food & Dining

Credit Card
reditLards Primary Contact: Mr Mike Smith
Amount:

Limit Debt
Amount:

[ o [ cancer ]

4. Editthe available information, see Creating an Organization for explanation of the fields.

MMERCE Edit

ut’™
MName: Company X East
Description: Company X East it
Type: Organization Unit - ;@?
Business Category: Food & Dining b ﬁf'
Parent: Company X 7
Farent Organization
Primary Not Set h

Contact:
{Customer Qrganization_mi_ PrimaryContactiad_Description}

Available Balance: 0.00

Owerdraft Limit: 0.00

Ok || Cancel

5. When you are done, click OK to save your changes.
Deleting Organizations
Do the following to delete an existing organization (parent) or organization unit (child):

1. Go to Customer Management and Organizations. You will be brought to the Organizations page
which lists any existing organizations.

2. Inthe list of organizations, select the checkbox next to the organization you want to delete and
click Delete.
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;J[:E Mew Organization ﬁ Printer Wersion x Delete

D Mame Description Type

|:| Enudsen inc temp Organization
Company X West Company X West Organization Unit
|:| Big Bank A large bank with lots of VIP customers Organization

|:| Company X East Company X East Organization Unit
|:| Company X Company X Organization

[] TheWine Cellar The Wine Cellar Organization

3. Aconfirmation message will be displayed. You can delete organizations with children without
deleting the child organizations and contacts with no repercussions. This only leaves the contacts
and child organizations as orphans that you can later reassign using the same methods described
in Creating an Organization.

Deleting b A

Selected organizations can have related contacts and child
arganiztions. What do you want to delete?

@ Delete Organizations Only.

") Delete Organizations, Child Organizations and
Contacts.

I o] 4 I | Cancel

Select either Delete Organizations Only or Delete Organizations, Child Organizations and Con-
tacts and click OK to complete the deletion.
Defining Organization Types and Business Categories
Introduction
This section describes how to update dictionaries to create your own organization type definitions and
business categories that can be applied when building an organization structure. By default, organ-
izations can be of type "organization (parent)" or "organization unit" (child). A business category can be

for instance an industry branch such as "Automotive" or "Food & Dining". This type of data is managed in
so called dictionaries.

Creating, Editing and Deleting Organization Types

1. Open the Organization Edit page by creating a new organization or editing an existing one. Click
on the Edit Dictionary icon next to the Type drop-down menu.
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MERCE Edit

(19

I

Name:

Awvailable Balance: 0.00

Owverdraft Limit: 0.00

I oK || Cancel |

Company X
Description: Company X -
Type: Organization - *
Business Category: Food & Dining - _EditDictionar}r
Parent: Mot Set v
Parent Organization
Primary Not Set v
Contact:

{Custamer:CQrganization_mi_FrimaryContactld_ Description}

2. Adialog is displayed appears allowing you to edit the existing organization type dictionary by
clicking the editicon. To add a new item to the dictionary, click on New ltem.

Manage List

5 New Iteﬂﬂ B Close

Systemn Name: OrganizationType

Friendly Name: OrganizationType

N
Type: Single Value

N Item Value Display Value
1 Organization Organization )(
2 Organization Unit Organization Unit ™

3. Selectthe order of the item from the drop-down on the left and enter a name for the item on the

field next to the drop-down.

Manage List 3 New Item m Close
System Name: OrganizationType Friendly Name: OrganizationType Type: Single Value

M2 Item Value Display Value

1 COrganization Organization )(

2 Crganization Unit Organization Unit }(

3 = |Division =

1

2

4. Click the Save icon to save the dictionary item. Click Close to close the dialog.

5. The dictionary item is now available for selection in the Type drop-down.

To edit an existing dictionary item, click the Edit icon next to the item. To delete a dictionary item, open
the dictionary list and click the Delete icon next to the item.
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O If you change the number to a position higher in the list, the list will NOT be automatically reor-
dered. You must therefore manually edit the entire list. However, having multiple copies of the
same numerical value does not affect the system. Therefore, you can feel free to use the
numbers as a ranking system, or you can devise your own internal method to numbering.

Creating, Editing and Deleting Business Categories

Out of the box, there is a list of categories you can assign to an organization. You can add more cat-
egories the same way you add organization types.
1. Click on the Edit Dictionary icon next to the Business Category drop-down menu.

2. Adialog is displayed appears allowing you to edit the existing business categories by clicking the
editicon. To add a new item to the dictionary, click on New ltem. To delete an item in the list, click
the Delete icon next to the item.

3. Select the order of the item from the drop-down on the left and enter a name for the item on the
field next to the drop-down.

4. Click the Save icon to save the dictionary item.
5. The new business category is now available for selection in the Business Category drop-down

menu.

To edit an existing dictionary item, click the Edit icon next to the item. To delete a dictionary item, open
the dictionary list and click the Delete icon next to the item.

Contacts
Introduction

Contacts and their related accounts are created automatically when users create them on the front-end,
for example if they register to make a purchase, or you can create them from the back-end.

Contacts are individuals with a certain set of personalized information (name, address, email, etc.).

e Contacts with Accounts - a customer who registers on the public site. If this customer chooses,
he/she can login to his/her Account from the public site and access his/her order history and other
personalized information. He/she cannot access the Commerce Manager.

e Contacts with User Permissions - someone internal to your team who has varying levels of
access to the systems within Commerce Manager.

Contacts that are users who will be accessing Commerce Manager, can be assigned roles based on var-
ying permissions. Refer to Roles and Permissions for more information.

Working With Contacts

The work with contacts and accounts includes the following tasks:
e Creating contacts and related accounts
e Browsing and viewing existing contacts
e Editing and deleting existing contacts and related accounts

e Defining dictionary values for customer (contact) groups

Browsing and Viewing Contacts

Browsing Contacts

To browse Contacts, go to Customer Management > Contacts.
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Customer Management

= m Customer Management

@ Organizations

C@ contacts

; U
&7 Roles

B Gift Cards

Viewing Detailed Contact Information

The Contact List page shows a list of existing Contacts.

ERCE List

-

You can click through the name an existing Contact to view more information.

ne, admin

©cet Help For This Page

| |,.) View: | All contacts Iz‘
@] Mew Contact | ) Printer Version | P4 Delete Selected

|:| FullName2 FirstName2 Last Name Middle Name
|:| Receiving Manager Receiving Manager

|:| Order Manager Order Manager

|:| ennifer Browne Jennifer Browne

= Mary Smith Mary Smith

|:| =¥ Shipping Manager Shipping Manager

|:| =¥ admin admin

|:| Y Order Supervisor Order Supervisor

|:| =¥ Carlos Mevada Carlos Mevada

|:| =¥ Lisa Prescott Lisa Prescott

Ay 1

wour 7
= Edit ¥ Delete Contact Contacts D New Order
Full Name: admin Parent Organization:
Information Infor: i |
Information — Contact
Addresses Full N S c c
Credit Cards ull Name: admin ustomer Group:
Security First Name: admin Preferred Currency:
Rol
oles Middle Name: Preferred Language:
Orders

Order History
Shopping Lists

Wish Lists

Shopping Carts

Last Name:
Parent Organization:

Preferred Shipping
Address:

Preferred Billing
Address:

Registration Source:

Last Order Date:

«— Account

User Name:
Description:

Email-

admin

admin@yourcompany.com

Is Locked Out:
Last Activity:
Last Login:

Last Password
Changed:

Edit Account | Change Password | Remove Account —

none
Today, 2:49 PM

Today, 2:48 PM

/772011 9:34:48 AM

e[ conee |

From within the Contact Info form, you can view other recorded information about the Contact. For exam-
ple, you can view Addresses and Order History related to this Contact.
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O More objects or metadata can be added to the default View Form via Business Foundation.

Searching for Contacts

On the Contact Info page, you can use the search form above to search for a particular Contact using key
terms. Conduct the search by clicking on the Search icon (magnifying glass). Contacts that match the
search terms will appear on the list.

|vi5itur | =y
[@=|New Contact | S Printer Version | 2% Delete Selected

] Full Mame First Mame

|:| ¢ EPiServer Commerce Visitor Visitor

To clear the search and revert back to show all Contacts, click on the Reset icon (eraser) next to the
Search icon.

Customizing Views for Browsing Contacts
Llke Organizations, users can create or customize Views when browsing objects.
Creating a New View

On the Contact List page, click on the View drop-down menu and select New View.

ERCE Contact List

| |I) View: | All contacts E‘
N I[ System Views |

{85 New Contact | 5 Printer Version | ¥ Delete Selected All contacts

= Full Marne First Marme

] Mats Hellstrém Mats Hellstrém

] admin admin

A pop-up appears, very similar to the one found in Organizations. This form gives users the ability to cus-
tomize which columns appear and apply a variety of filters.

New View *
x

Ceneral || Fields || Filters

Enter Title

Everything is ready
to create a new view
faor entities list.

Please, type view
name.

DShnw this view for all users

The default tab is General. Enter in a Title for the custom View. Check the box Show this view for all
users if you want other users to see this custom View.
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New View

Ceneral || Fields || Filters

Enter Title

Only in Company X

Show this view for all users

Ve

Everything is ready
to Ccreate a new view
for entities list.
Please, type view
name.

Click on the Fields tab to select which columns you want to appear in the custom View. Select the col-
umns you want to have appear by clicking and highlighting the column name and moving it over to the

Visible columns list by clicking on the Right Arrow icon.

New View

Ceneral || Fields || Filters

Available columns:
Code
Created
Creator
Customer Group
Date OF Birth

Last Name

Last Order Date
Middle Name
Modified

*

m

First Name
Full Name
Email

Egs0

Visible columns:

Save

| | Close

To deselect a column, click and highlight a column name from the Visible columns list and then click on

the Left Arrowicon.

To change the ordering of the Visible column list, click and highlight a column name and click on the Up
and Down Arrows on the right of the list to reposition the column.

Click on the Filters tab to set the view filters. Users are given precise controls over filters for setting up
rules for their custom View. Clicking on the + icon allows you add an additional filter.
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New View *

Ceneral || Fields || Filters

+- And

Parent Organization Equals Company X

Please choose H
Please choose

And k‘
Or

Code

Created

Customer Croup

Date Of Birth

Email

First Name

Full Name

Id

Last Mame

Last Order Date

Middle Name

Modified

Parent Organization

Parent Organization (Reference) ]
Preferred Billing Address

Preferred Billing Address (Reference)
Preferred Currency

Preferred Language

Preferred Shipping Address

Preferred Shipping Address (Reference)
Registration Source

There are a multitude of options available for customization.
Applying and Editing a View

Once a View is created and saved, it appears in the View drop-down box.

ERCE Contact List

| |,.) View: | Only in Company X x| & X
— [ System Views |
[ New Contact | ) Printer Version | ¥ Delete Selected All contacts
=] Ernail Full Marne FirjLUser views ]
Only in Company X *
|:| mats&episerver.com Mats Hellstrém Mal[ New View |
= mary.smtih@comopanyx.... Mary Smith Mary
D = peter.sunna@episerver.com Peter Sunna Peter

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the cus-
tom View, your Contact List will reflect those options.

To edit an existing View or a View you just created, select the View from the drop-down menu and click
on the Edit icon next to it. The View Editing form pops up and you are able to edit all properties.

View:| Only in Company X E ﬁ >

Edit i

First Marne
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Printing a List of Contacts

To generate a printer friendly layout of the Contact List, click on Printer Version from the menu bar on
the Contact List page.

MERCE List

-
| |,.) WView: | All contacts
|G New Contact 5 Printer Vergion }( Delete Selected
|:| FullMame2 o FirstName2 Last Mame
[ Receiving Manager Receiving Manager
|:| ¢ Order Manager Order Manager
|:| =¥ |ennifer Browne Jennifer Browne
[ Mary Smith Mary Smith
|:| B¢ Shipping Manager Shipping Manager
|:| =¥ admin admin
[ Order Supervisor Order Supervisor
|:| B¢ Carlos Nevada Carlos Nevada
[l Lisa Prescott Lisa Prescott

A new browser window opens showing a printer-friendly version of the Contact List. Click on Print on the

far right corner of the browser window.

Contact

Full Name First Name Last Name Middle Name Last Order Date|/Customer Group
Receiving Manager|Receiving |Manager
Crder Manager Order Manager
Jennifer Browne [Jennifer Browne
Mary Smith Mary =mith
Shipping Manager |[Shipping Manager
admin admin

Order Supervisor |QOrder Supervisor
Carlos Mevada Carlos Nevada
Liza Prescott Liza Prescott

Creating Contacts and Accounts

Creating Contacts

To create a new Contact, from the Contact List page, click on New Contact.

ERCE Contact List

»

8] New Contacg é Printer Wersion X Delete Selected

&l Fulls_ e

First Mame
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The Contact Edit page appears where you can enter all relevant information about the contact. The only
required fields to complete are Full Name, First Name, Last Name, and Email. The rest of the fields are
optional but are recommended.

1.

@

Select a Parent Organization from the drop-down menu to associate the contact with a single par-
ent organization.

Assign the contact to a Customer Group. More Customer Groups can be added by editing the
Customer Group Dictionaries. Customer Groups become useful when setting specific permissions
and targeted Marketing Campaigns. (For more information, see "How to Assign a Customer Group
Sales Price for a Particular Item" section below.)

Select a Preferred Currency for the contact. If the contactis in France, you may want to associate
the Euro currency. Available currency options are based on settings in Administration > System
Settings > Dictionaries > Currencies.

Select a Preferred Language to associate with the contact. Languages are populated based on
the languages set under Administration > System Settings > Dictionaries > Languages.

Preferred Shipping and Billing addresses are related to company accounts, refer to Manage
Company Accounts for more information.

The Registration Source field is a text field for entering in notes about the contact. For instance,
you may want to reference which website the contact is currently registered under.

The Registration Source field is automatically filled when a user creates a new account from
the public website.

ERCE New

—

Full Name:

Email:

Parent Organization:

Mary Smith
First Name: Mary
Middle Name:
Last Name: Smith

mary.smith@&companyx.com

Contact Email Description

Company X W
Contact Organizarion
Customer Croup: Customer - ﬁ)
1 Preferred Currency: US dollar -
Preferred Language: English (United States) -

Preferred Shipping
Address:

Preferred Billing
Address:

Registration Source:

Ok || Cancel
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Click OK to save the contact. The Contact Info View Form, where you can enter in additional information
about the contact as well as go back and edit the contact again.

O The screenshot below shows the default layout of the Contact Info form. This can be cus-
tomized using Business Foundation.

Contact Info

@) Get Help For This Page &

&=/ Edit | ¥ Delete | [ Contacts
Full Name- Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Orders First Name: Mary Preferred Currency: usp
Order History Middle Name: Preferred Language: en-Us
Shopping Lists Last Mame: Smith Registration Source:  companyx
Wish Lists
Shoppin[}cms Parent Organization- Company X Last Order Date:
Account Create account
Account not found:

To go back to the Contact List, click Cancel or the Contacts button next to the Right Arrow icon.

Creating Accounts

An Account can be created with a contact. Once an account has been created, the contact can be
assigned permissions using Roles and access the Commerce Manager.

O A customer account is automatically created for a customer who registers from the front-end
public website, allowing them to login and view personalized information.

To create an account for an existing contact, click on a contact name from the Contact List. On the Con-
tact Info page, click on Create Account.

Contact Info

@ Get Help For This Page &

EFEdit | ¥ Delete | [EJ Contacts
Full Name: Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Orders First Name: Mary Preferred Currency-  USD
Order History Middle Name: Preferred Language: en-US
Shopping Lists Last Name: Smith Registration Source: companyx
Wish Lists
Shopping Carts Parent Organization: Company X Last Order Date:
Account Create acco{%(
Account not found:

A pop-up appears to enter in their user account credentials. A User Name and Password are required to
create the account.

1. Enterin a User Name, which can include spaces and special characters.
Enter in a Password, which must be four or more characters.

Enter in a Description and Email Address, which are both optional.

B w Dd

To enable the account, select "Yes" under Approved. Otherwise, select "No" to keep the account
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inactive and inaccessible by the user.

5. Click OK to save the account.

Create account

User Name:
Password:
Description:
Email:

Approved:

Mary
[TTTITTYY
mary.smith&companyx.com

mary.smtih&companyx.com

@Yes

(INo

[ Hox

| | E_] Cancel
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User account information appears under the Account section of the Contact Information form.

Fields Explained:

e Last Activity - last time the user logged in or made any changes to the site.

e Last Lockout - last time a user was locked out due to too many failed login attempts.

e Last Login - last time the user logged into his or her account.

e Last Password Changed - Iast time the user account password changed.

ERCE

Contact Info

Welcome, admin

1@ Get Help For This Page %

= Edit | ¥ Delete | £ contacts
Full Name: Mary Smith Parent Organization- Company X
Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Security First Name: Mary Preferred Currency: usop
Roles Middle Name: Preferred Language: en-Us
Orders Last Name: Smith Registration Source:  companyx
Order Histary o
Shopping Lists Parent Organization: Company X Last Order Date:
Wish Lists
Shopping Carts Account EmtAccan; | Change Password | Remove Account
User Name: Mary Last Activity: 6/1/2010 9:17:44 AM
Description: mary.smith@companyx.com Last Lockout: none
Email: mary.smtih@companyx.com Last Login: 6/1/2010 9:17:44 AM
Last Password L |
Changed: 6/1/2010 91744 AM

Editing and Deleting Contacts and Accounts

Editing Contacts and Accounts

To edit a Contact, select the contact in the contact list and click Edit. Edit the information and click OK
when done.

To editan Account, select the related contact in the contact list and select the Edit Account option in the
lower part of the dialog. Edit the information and click OK when done.

@
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Deleting Contacts and Accounts

To delete a contact, select the contact in the list of contacts, select the checkbox next to the contact you
want to delete and click Delete. Click OK to confirm the deletion.

To delete an account, select the related contact in the contact list and click the Remove Account option
in the lower part of the dialog.

Defining Customer Groups

Introduction

This section describes how to update dictionaries to create your own customer (contact) groups that
can be applied when adding contacts to your organization. By default, customer groups can be of type

"customer”, "partner"” or "distributor". This type of data is managed in so called dictionaries.

Creating, Editing and Deleting Customer Groups

1. Open the Contacts Edit page by creating a new contact or editing an existing one. Click on the
Edit Dictionary icon next to the Customer Group drop-down menu.

RCE Edit

Overview

Full Name: Mary Smith

First Name: Mary

Middle Name:

Last Name: Smith

Email:

Parent Organization:

Customer Group:

Preferred Currency:

Preferred Language:

Preferred Shipping
Address:

Preferred Billing
Address:

Registration Source:

| OK || Cancel |

mary.smith&companyx.com

Cantact Email Description

Caompany X R
Cantact Qrganization

Customer -

Us daollar

English (United States) -
[ Mo wvalue ] -
[ Nowvalue ] hd

2. Adialog is displayed appears allowing you to edit the existing customer group dictionary by click-
ing the editicon. To add a new item to the dictionary, click on New Item.

Manage List

yFI_EINer.' ermn aCIose

Systern Name: ContactGroup

Friendly Name: ContactGroup

Nt
Type: Single Value

N2 Item Value Display Value

1 Customer Customer >(
2 Partner Partner by
3 Distributor Distributor by
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Select the order of the item from the drop-down on the left and enter a name for the item on the
field next to the drop-down.

Manage List )EI Mew [tern \3 Close
System NMame: ContactGroup Friendly Name: ContactGroup Type: Single Value
Item Value Cisplay Value
1 Customer Customer =i
2 Partner Partner x
3 Distributar Distributar -
4 | Subvendor @ E ﬂ

1
2
3

Click the Save icon to save the dictionary item. Click Close to close the dialog.

The dictionary item is now available for selection in the Customer Group drop-down.

To edit an existing dictionary item, click the Edit icon next to the item. To delete a dictionary item, open
the dictionary list and click the Delete icon next to the item.

@

If you change the number to a position higher in the list, the list will NOT be automatically reor-
dered. You must therefore manually edit the entire list. However, having multiple copies of the
same numerical value does not affect the system. Therefore, you can feel free to use the
numbers as a ranking system, or you can devise your own internal method to numbering.

Roles

Introduction

Roles are used for managing permissions for different groups of users. Out-of-the-box, EPiServer Com-
merce includes a list of predefined roles that can be assigned to user accounts.

Order Managers - allows users to manage (View/Create/Edit/Delete/Others) elements within the
Order Management system.

Order Supervisor - allows users to fully administer the Order Management system.
Shipping Manager - has the ability to view, pack, and complete shipments.
Receiving Manager - has the ability to view shipments and receive returns.

Everyone - one of the default roles which is assigned when a customer registers an account from
the front-end public site.

Registered - one of the default roles which is assigned when you register from an account from
the front-end public site.

Management Users - allows users access to Commerce Manager.

Administrators - allows users to fully administer most areas of Commerce Manager.
WebkEditors - allows users to access the edit interface for working with website content.
WebAdmins - allows users to access the admin interface for administering the website.

Expert - on the EPiServer Commerce sample site, you can assign experts to be involved in rat-
ing and reviewing of products. Refer to the Social Features section for more information.

Users can also create their own roles based on a set of permissions. Roles allow administrators to restrict

users from accessing different systems or folders depending on their needs. There is a wealth of
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permissions options administrators can set for a role, and each role area has specific areas that may not
be applicable to other areas. Generally, permissions such as View and Edit are commonplace.

Exploring Roles and Permissions

When you first select Roles, you will see a list of the roles that are currently available in the system.

PiISERVER COMMERCE ole List

Welcome ¥ Change Language About™

Customer Management e D New | [ More Actions ™
= Customer Management [l Role Name
cﬂ Organizations 0 Admins
| :,i E:lr::crs [l % Order Mansgers
m Gift Cards 0 X Order Supervisor
(&l >( Shipping Manager
O & X Receiving Manager
0 ¥ Everyons
O & X Registered
[ @' % Managsment Users
O g X Administrators
[l ¥ WebaAdmins
[ g X webEditors
[ & % Expert

Each role has a series of defined permissions that can be set on a very detailed level. For instance, the
Order Managers role can create returns and exchanges, and view. edit, send notifications, process pay-
ments and split shipments for orders.

Overview

Rale Name: Order Managers

Permissions: 2 . .
3 [ administration

= [@ Order

= 3 [[]Manage

2 3 [Returns

Create
Create Exchange
DRecei\ring
[l shipment
View
[ create
[¥] Edit
DDeIete

*

PLPLPPPLLLL A

P

m

Send Motifications
Process Payments

[¥] split Shipment
DCredit Payment
DDiscount

|:| Change Line ltem Price
M [ administration

= [*@ Customer

'g [ roles ¥

OK || Cancel |
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O For a role to be able to successfully view Commerce Manager, it must have the following attrib-
ute. Go to Core > Management > Login and check the Login button. Without this checked, the
user with that role will be unable to login into Commerce Manager unless that user has
another role that includes that ability since all roles are cumulative in their effect.

Definitions of roles can be even more in-depth. A role can have certain detailed permissions in parts of
the system, but not full control. In the example below, this role has full control over the Management part
of the Core system, but only partial control over the Administration system.

Overview

Role Name:

Permissions: H '3 Administration -

= [*g Core
=5 3 [¥]Management
% | Login

V| Licensing

B

F PP

m

| Search Index
| Settings
| Business Foundation
=2 '3 Administration
= 3 [¥]system Log
= @ ¥ Manage
ig, | View
3{1:.1, V| Delete
H '3 Application Log
= [*3 Reporting
= _"_] Manage
%1&_ | View
Eg_ Create
T

L, [ Delete

= [*g Content -

QK || Cancel |

Notice how the tree system works. Clicking on the system above it gives full control of all the branches
beneath it, but clicking farther down the tree only gives access to those systems.

Working With Roles

The work with roles and permissions includes the following tasks:
e Creating, editing and deleting roles
e Assigning roles to individual accounts

Creating, Editing, and Deleting Roles

Introduction

Out of the box, Commerce Manager includes a list of pre-existing Roles that can be assigned to
Accounts. Users can also create their own Roles based on a set of Permissions. Roles allow Admin-
istrators to restrict users from accessing different systems or folders depending on their needs.

Creating a Role

To create a new Role, go to Customer Management > Roles to see the Role List.
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EPISERVER COMMERCE Role List

Welcome ¥ Change Language About ™

Shipping Manager

Customer Management = I3 New ¥ More Actions ™
)
:Im Customer Management [ Role Name
@ Organizations | admins
& Contacts
l-_:i O Order Managers
&7 Roles
B Cift Cards [ Order Supervisor
(&l
(&

Receiving Manager

il

1L
MM M X

Click on New to open up the Role Edit page.

ERCE Role Edit

Overview

Role Name:

Permissions: »
2 g Asset i

h [[Manage

[z [[lAdministration
= [*g catalog

h [|catalogs

g [C]Administration
=l m Content

g [C]Sites

'z [[lAdministration
= m Core

h [[Management

g [ClAdministration
= [*g Customer

‘g [C|Roles
= [*3 Marketing

h [[|€ampaigns

[*z [[]Promations

h [[|Customer Segments

m

There is a wealth of Permissions options Administrators can set for a Role.
Enter a Role Name.

Checkmark the boxes to give Permissions to the Account for this particular function or action. For exam-
ple, if you want an Account to only View and Edit Assets, you will need to expand Assets > Manage and
checkmark View and Edit.
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ERCE Role Edit

Owverview

Role Name: | accet view/Edit

Permissions: ;
= b Asset

= [*g [[|Manage
[ View
[|Create
U

Once done defining the Role, click on OK. The new Role will appear on the Role List.

O ¥ Customer Managers

[l ¥ Everyone

O % Registered

] ¥ Asset View/Edit

Page Size: | 100 IE‘

elete

Editing Existing Roles

All existing Roles, including the ones included out of the box with Commerce Manager, can edited and
customized. ltis also a recommended reference to how each pre-existing Role works.

To edit a Role, click on the Edit icon.

[l @& X catalog Managers

|:| Ty >( Catalog Schema Managers
[ ;! ¥ Order Admins

] &' % oOrder Managers

] & X Marketing Viewers

[ & ¥ customer Viewsrs

The Role Edit page appears. You can customize the Permissions settings for the Role. Once done, click
OK.

Deleting Roles

To delete any Role on the list, there are two ways:

Click on the X button next to the name of the Role to delete one at a time.

>( Cms Viewers

Cms Editors
gement Users

>( Markeating Admins

T i A i R
El
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To delete multiple Roles, checkmark each box and on the menu bar, click on More Actions > Delete
Selected. Click OK when the pop-up appears.

ERCE Role List

Maore Actions~

Delete Selected ’?_"ﬂ

Asset Admins

L
®
2

fl

Asset Managers

il

Catalog Viewers

Cms Admins

il

Cms Managers

Cms Viewers

Al

Cms Editors

fl

4
b A b b 8b ab g G (Ve Y

Management Users

Al

DEEEEEEC
Bl

Assigning Roles to Individual Accounts

Introduction

Roles are designed to allow and disallow certain functionality and folders to individual accounts. When a
contact logs into his or her account, that account is bound by the roles it was assigned.

Assigning a Role

To assign one or more Roles to an account, go to Customer Management > Contacts and click on an
existing Contact with an Account.

ERCE Contact Info

& Get Help For This Page %

&=/ Edit | ¥ Delete Contacts

Full Name: Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Security First Name:- Mary Preferred Currency:  USD
Rm% Middle Name: Preferred Language:  en-US
Orde Last Name: Smith Registration Source: Companyx
Order History o
Shopping Lists Parent Organization: Company X Last Order Date:
Wish Lists .
Shopping Carts Account Edit Account | Change Password | Remove Account
User Name: Mary Last Activity: 6/1/2010 2:17:44 AM
Description: mary.smith@companyx.com Last Lockout: none
Email- mary.smtih@companyx.com Last Login: 6/1/2010 91744 AM

Last Password

Changed: B/1/20109:17.44 AM

Under Security, click on Roles. The Security section only appears after an Account was created for the
Contact.

The Roles form appear, allowing you to assign Roles to the Account. By default, an Accountis already
assigned to the "Registered" and "Everyone" roles.

© EPiServer AB



Commerce Manager | 51

Contact Info

i@ Get Help For This Page &

= Edit | X Delete Contacts

Full Name: Mary Smith Parent Organization: Company X

Information Roles

Information e
5 Assign Role | ¥ Remove Roles
Addresses

Credit Cards ] Eole Name Organization Inheritance

Security 0 Registered none [ Undefined ]

Roles [ () Everyone none [ Undefined ]

Orders

Order History Page Size:| 20 E‘ (Ziterns) | Page 4 1»
Shopping Lists

Wish Lists
Shopping Carts

Click on Assign Role to assign a new Role to the Account. A pop-up appears allowing you to assign a
specific Role from the drop-down menu.

Assign Role b o
Security Role: Cms Admins -
Organization: Company X |V|
Inheritance: Inherit From Parent IE'
Save | Cancel

Select a Security Role from the drop-down to assign to the Account.

Optionally, you can assign an Organization to the Account, which enables the Inheritance drop-down
menu below. If specific permissions are set for an Organization, you can set to "Inherit from Parent"
(inherit permissions from the Parent organization) or "Overwrite parent."

Click Save to assign the role. Repeat these steps to assign more roles to the Account.

ERCE Contact Info

@ Cet Help For This Page &

EF Edit | % Delete Contacts

Full Name: Mary Smith Parent Organization: Company X

Information Roles L
Informati =
nformation "= Assign Role | 3 Remove Roles
Addresses
Credit Cards F Role Narne Qrganizatian Inheritance

Security | Registered none [ Undefined ]
Roles \ ) Everyone none [ Undefined ]

Orders ] a_f Cms Admins Company X Overwrite parent
Order History

Shopping Lists Page Size:| 20 (3 iterns) | Paged 1 b
Wish Lists
Shopping Carts
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Gift Card Administration

Introduction

The EPiServer Commerce sample site has functionality for creating gift cards that are used during the
checkout procedure. You can create gift cards for different amounts and define the validity period for the
card. A gift card payment can be combined with other payment methods.

The sample site has a page template which enables the customer to enter gift card information to be used

during purchasing. The gift card sample page template is described in more detail under the Gift Card sec-
tion under Payment Methods.

Gift cards are administered from the Customer Management sub-system.

EPISERVER COMMERCE List

Welcome ¥ Change Language About™

Customer Management @ 'J

= Customer Management % .
m J = New | =3 Printer Version | #% Delete

|:| Cift Card Number

:ﬂ Organizatians

Cg Contacts
:ﬁ' Roles [ 123-436
B GCift Cards D card123

Creating a Gift Card

Do the following to create a new gift card:

1. Under Customer Management, select Gift Cards and then the New menu option.
Enter the Gift Card Number.

Enter the Gift Card Security Code.

In the Expiration Date field, enter the end date for the validity of the gift card.

Enter the value for the gift card in the Amount field.

I

Click OK to save the gift card.

Welcome, admin

Create

o Cet Help For This Page :

=

— Gift Card S
Cift Card Number: 987-554
Cift Card Security 12345678
Code: - - - -
Cift card security code information
Expiration Date: 3720/2012 411PM
i Amount: 500
Ok ” Cancel
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Editing a Gift Card

Do the following to edit an existing gift card:

1. Click on the link for the desired gift card in the gift card list.

2. Click the Edit button, or select the Edit menu option.

3. Update the gift card information and click OK to save the changes.
4

Click Back to list to return to the list view.

Deleting a Gift Card

Do the following to delete an existing gift card:

1. In the gift card list view, select the gift card(s) to be deleted by checking the select box in front.

2. Click the Delete menu option, and click OK to confirm the deletion.

Catalog Management

Introduction

The Catalog Management system provides full complement of tools and capabilities to create and man-
age a diverse range of products, variations, pricing strategies, languages, and related website functions.

To manage products, you can go to the back-end Commerce Manager and you will notice that products
are arranged into one or more catalog(s). Catalogs are independent from one another and you may
create as many catalogs as you need. Catalogs can be structured in a number of ways. For example,
you may have various brands or product lines. Each brand or product line can have its own catalog. Or,
a retailer may have multiple suppliers, in which case, you can segment each supplier into its own catalog.

A default B2C Sample Site along with a default electronics catalog (consisting of a Brands catalog + an
Everything catalog) is included giving you a running demo site after you run the installer.

EPiServer Commerce allows you to easily and flexibly organize and categorize your products. All prod-
ucts referenced on a front-end site reside in a catalog created in Commerce Manager. Multiple catalogs
can be created and assigned to one or more sites. The dates that each catalog will be available to the cus-
tomer can also be defined. In this way, future revisions to items and pricing can be prepared easily and
reviewed in advance of the release date to the site.

Organizing Catalogs and Catalog Entries
A catalog is a top-level container for all types of catalog entries such as:
e Categories - a grouping of purchasable products.

e Products - represents various forms of merchandise that you can display and purchase from the
front-end site. Products can be organized into the following:

e Variations/SKUs
A variation or SKU (Store Keeping Unit) corresponds to a specific type of product with specific
characteristics. For example, a product of Shirts will have an individual variation/SKU which
includes size, color and sleeve length.

e Bundles
a bundle is a collection of Variations and SKUs allowing customers to purchase two or more items
atonce. All pricing is SKU specific and separate, unlike for a package which is multiple SKUs put
together in a single unified price.
Refer to "Mixed Cases" on the EPiServer Commerce sample site, for an example of a product bun-
dle.
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e Packages
A package is comparable to an individual SKU because the package item must be purchased as
a whole (for instance computer system). Multiple SKUs make up the package, but it has its own sin-
gle unique pricing and SKU.

e Dynamic Packages
A dynamic package is similar to the package definition above with the added ability to configure
the package during checkout.

e Associations
One or more products can be associated to a product so that they can be displayed advertised on
the public site as product accessories, or outselling/cross-selling item. Associations can be made
from any of the individual products.

Meta Classes and Fields for Products

You can define your own meta classes and meta fields for both products and orders in Commerce
Manager. For instance, if you create a meta class called "Wine" you will want to add meta fields that are
characteristic for wine, for instance "color", "taste", "vintage" and "maturity".

When meta fields and classes have been created, they will be available for usage when working with the
product catalog. Meta classes and fields for catalogs are defined in the Catalog System part of System

Administration. For more information, refer to Setting up Meta Classes and Fields.

Working With Catalog Management
The Catalog Management system provides a full complement of tools and capabilities for managing com-
mon catalog tasks such as:

e Importing and exporting product catalogs between websites.

e Create multiple independent catalogs which can be associated to one or more sites.

e Categorization and organization of catalog entries.

e Merchandise products through the creation of bundles, packages, and dynamic packages.

e Managing catalog and product availability, structuring, pricing, and taxation.

e Reviewing and editing catalogs before launching live on your site.
We recommend that you start with the catalog that came with the EPiServer Commerce sample site,
which contains the Wine sample catalog. You can also use the export/import functionality to get catalogs

into a different environment. Also, you are given the flexibility to use a .csv file to rapidly create a new cat-
alog from scratch

Importing and Exporting Catalogs

Managing product catalogs is a central feature in e-commerce, and getting the products into the system is
a primary task when setting up a site the first time. The scenario could also be that you want to move or
copy existing product catalogs between sites. Creating catalogs and adding catalog entries manually can
be done butis most often not an option when dealing with large product catalogs.

Existing product catalogs can be exported and imported into EPiServer Commerce as a .zip file, using the
standard export/import feature . You can also manage the product catalog in bulk using the CVS catalog
import feature. Here you use an Excel sheet and save the file in the .csv file. Before the export/import, the
various types of product data is mapped to the desired catalog structure and format. The CSV catalog
import feature can be used for your entire catalog data, or just portions of them.

The various import and export functions are described in detail in the following.
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Importing and Exporting Existing Catalogs

Introduction

Existing catalog data can be imported or exported quickly to and from Commerce Manager using the
standard catalog Import/Export feature. The standard catalog importer imports .zip files exported from

Commerce Manager. Itis a quick way to import catalogs from other EPiServer Commerce sites and start
off with a base to expand your catalog.

Accessing Import/Export
1. Access the Catalog List page in the Catalog Management subsystem. The Import/Export menu is
located in the upper left corner of the main window.
2. For exporting catalogs, click on the check box for the appropriate catalog nodes.

3. Click on the Import/Export pull-down menu to choose either import or export. The corresponding
page will appear in the main window.

MERCE Catalog List

= = §
4 New Catalog :ﬂ Import/Export™ ﬁ Maore Actions ™

D N ﬂE CSV Import Catalog '\I'__")J
D ﬂﬁ W ﬂE Import Catalog

ﬂﬁ Export Catalog

Importing Catalogs
1. Click Add New File and browse and select the file to upload.
Click on the Upload file button. The files uploaded will appear in the list below.

2
3. Click on the Start Import button. The progress window will show that the import is taking place.
4

When the importis 100% complete, close the progress window.

It is strongly recommmended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one. Then click the button "Start Import' to start importing.

Add Mew File

Files Available For Import:

Actions File Name Size Created Last Updated
Download | Delete CatalogExport_Catalog_Wine_Sample.zip 74290 KB Today, 2:35 PM Today, 2:34 PM
1 Page 1 of 1 {1 items)

Exporting Catalogs

There are two ways to export catalogs in the Export Catalogs page.

1. Export everything included in the catalog node that you've selected.
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e To do this, click on the Start Export button. The progress window appears and shows the status of
the export.

e When the exportis 100% complete, click on Close to close the progress window
2. Export only the desired files.
e To do this, click on the Download links highlighted in blue.

Welcome, admin
ERCE Export Catalog

@ Get Help For This Page
Export

You're about to export a catalog. Click the button to start.

Start Export

Exported Files List
Actions File Name Size Created Last Updated

Download | Delete CatalogExport_Catalog_Wine_Sample.zip 74290 KB Today, 10:31 AM Today, 10:31 AM

1 Page 1 of 1 (1 items)

Importing Catalogs Using CSV Files

Introduction

The CSV catalog importis a feature in the Catalog Management system that enables you to import and
manage catalog entries (such as Products, Variations/SKUs, Packages) in bulk using an excel spread-

sheet (.csv format). It is an alternative to manually creating catalog entries directly in Commerce Manager,
which can be tedious when dealing with a large amount of catalog data.

This feature enables you to accomplish these key tasks:
e Import your .csv spreadsheets and create new catalog entries in Commerce Manager.
e Setyour catalog items into a desired category structure of your choosing

e Create entry relations to associate one entry with others (e.g., variation/SKUs will appear within a
product or a package)

o Editor delete existing catalog items..
The CSV catalog import feature can be used for your entire catalog data, or just portions of them.
Import Overview
Here are the basic steps you can take to import and set up a new catalog using the CSV import feature.

Before you start, choose an existing catalog folder or create a new one (in the Catalog Management sys-
tem) to import the CSV files to.

1. Create CSV data files (using Excel Spreadsheet, Notepad, etc.) with information about your cat-
egories, entries, and entry relations.

2. Create necessary meta fields for the new catalog entries (in the Administration system).

3. Upload the CSV data files to the CSV Import page.

4. Create a mapping file for each CSV file. A mapping file is needed to link each column of data in a
CSYV file to the correct attributes in Commerce Manager.

5. Importthe CSV files and their corresponding mapping files into a specific catalog.

6. Create entry relations to associate one entry with another (e.g., a Package and a Product, a Prod-
uct and a Variation/SKU, efc.).
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Format for CSV Files

CSV files you create and import into Commerce Manager need to have a particular format.

e The firstrow should have headers that correspond to different attributes of the data you want to
import (e.g., product name, price, description, image file location, etc.).

e There are a few attributes that are in your CSV file to correctly structure your catalog:
e Code: A unique code to identify each category or entry
e Name: A unique name for each row of data

e Entry Type (for entries only): Each row must contain one of the following five words in order for
the Commerce Manager to correctly recognize its entry type --"Variation", "Product", "Package",
"Bundle" or "Dynamic Package"

e Parent & Child Entry Code (for entry relations only): A CSV file containing these codes can spec-
ify relationships between entries (e.g., display different Variations within a Product).
Although , the following attribute is useful in creating a hierarchy in your catalog:

e Action: A command to specify the action that will be taken during the import. Choose one of the
three options: Insert/Update/Delete or I/U/D.

Note: Please make sure to specify an appropriate command for each line of the CSV files. Enter-
ing "Insert" when that data already exist, or "Update" when no data exist will give an error during
import and those line of data will not get successfully imported.

e Category Code (by comma): By assigning a category code to an entry, you can specify the cat-
egory that you want to place your entry in.
Also please note this rule:

e SEO URL: By design, this attribute that is presentin both categories and entries must be unique
for each item in your catalog. Importing files that contain more than one identical url will resultin
an error.

Mapping Types
Different mapping types are used to create the mapping files mentioned in step 4 above.

e Category w/ Meta Data — select this type to create a mapping file for your category files.

o Entry w/ Meta Data — select this type to create a mapping file for all the entry files (i.e., Packages,
Products, Variation/SKUs, Bundles, and Dynamic Packages).

e Entry Relation — select this type to create a mapping file for your entry relation file that specifies
the relationships between entries such as many SKUs to one Product, or SKUs and Products to a
Package.

e Entry Association — select this type when creating a mapping file for entry associations (Adver-
tizing other items under titles such as "You may also be interested in...

e Variation w/ Inventory — select this type to create a mapping file to import your Pricing/Inventory
data located in your Variation/SKU Edit screen.

e Sale Price — Select this type to create a mapping file for Sale Price file, which specifies different
currencies for each item.

By selecting these options, the Commerce Manager will display different sets of Fields and Attributes for
you to manually assign to each data column of your CSV file. Figure 8 and 9 below shows the display of
the mapping files with the Category w/ Meta and Entry Relations Data type respectively. The items under
Fields and Attributes with superscripts 1 and/or 2 are headers that are required attributes that must exist
in the CSV files you are importing (1- required field for Insert, 2 — required field for Update).
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Example: Importing and Setting up a New Catalog

The example below demonstrates how to use CSV import using the guidelines provided above.

Let's say you want to set up a "Baby Stuff' catalog with categories and entries as shown here in Figure 1.

(Example Catalog)
Catalog Categories & Subcategories Products Variation/SKiLls Packages
Baby Stuff Infants — Diapering Supplies - Diapers ————  Newborn size Package NB
Size 1 Package 3w 6
——  Sizel
Size 3
_Wipes— Portable
— — 100 sheets =
300 sheets

Toddlers Potty Training Pants Blue Pants
Pink Pants
Yellow Pants

Figure 1
Prerequisite: Create a new catalog
First, create a new catalog called "Baby Stuff" in the Catalog Management system.

Step 1: Create CSV files containing data for your new entries

The example below is based on an a set of sample .csv files.
These files provide the base for the discussion in the following section.

The sample files contain the following:
e BabyStuffCategories.csv
e BabyProducts.csv
e BabyPackages.csv
e BabyVariations.csv
e BabyVariationInventoryPricing.csv
e BabyEntryRelations.csv
e BabyAssociations.csv
e BabySalePrice.csv
CSV File Type 1 - Category File
This file specifies data for categories and/or subcategories within a Catalog.

The top line has column headers that will be matched with the Meta fields in the later steps. The headers
can also have different names. As you will see in later steps, Category Code in column 1 is important

since it specifies where the entry data will be stored. The code entered in under Parent Code in column 2
can be used to create subcategories. If the Parent Code is set to "null" or "root," then that category will be
created in the root level of a catalog. In this example, the "Infants" and "Toddlers" category will be created
at the root level, while the "Diapering Supplies" category will be located under "Infants" as a subcategory.
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A B C D E F G
1 Action Category Code Parent Code Category Mame Available from Expires on Available (True/False
2 |Insert Catl rull Infants 1/1/2009 6/1/2009 TRIUE
3 Insert Cat2 rull Taoddlers 1/1/2009 6/1/2009 TRIUE
4 |Insert Catl0 Catl Diapering Supplies 1/1/2009 5/1/2009 TRIUE
3
Figure 2

CSV File Type 2 — Entry Files

These files specifies data for Catalog Entries. The Products, Variation/SKUS, and Packages CSV files for
this example are shown in Figure 3, 4, and 5 respectively.

A B C D E F G
1 |Action Product Code Product Mame Entry Type Category Code Available from Expires on Avail:
2 |Insert Orodl Diapers Product Catl0 1/1/20009 6/1/2009
3 |Insert Drod2 Wipes Product Catl0 1/1/2009 5/1/2009
4 |Insert Drod3 Potty Training Pants Product Cat2 1/1/2009 6/1/2009
5
Figure 3
yil B C D E F G
Variation Category
1 |Action Code Variation Mame Entry Type  Code Available from  Expireson |
2 |Insert WVarl Diapers - Newbaorn size Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
3 |Insert Var2 Diapers - size 1 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
4 |Insert Var3 Diapers - size 2 Variation Catlo 1/1/2009 6:00 10/1/2012 18:00
5 Insert Vard Diapers - size 3 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
& Insert ‘ars Diapers - size 4 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
7 Insert ‘arG Training Pants - Blue Variation Cat2 1/2/2009 11:00 10/1/2012 18:00
8 Insert Var7 Training Pants - Pink Variation Cat2 1/2/2009 11:00 10/1/2012 18:00
9 Insert arg Training Pants - Yellow Variation Cat2 1/2/2009 11:00 10/1,/2012 18:00
10 | Insert War9 Baby Wipes - Portable 80 ct Variation Catll 1/2/2009 11:00 10/1/2012 18:00
11 |Insert Warlo Baby Wipes - 300 ct Variation Catl0 1/2/2009 11:00 10/1/2012 18:00
12 Insert Warll Baby Wipes - 700 ct Variation Catl0 1/2/2009 11:00 10,/1/2012 18:00
13
14
Figure 4
B B C D E F €]
1 |Action Package Code Package Mame Entry Type Category Code Available from Expires on  Availa
2 |Insert Package NB  Mewborn Package Package  Catll 1/1/2009 12/31/2010
3 |Insert Package3tof 3 to6mo Package Package  Catll 1/1/2009 12/31/2010
4
Figure 5

CSV File Type 3 — Entry Relations File
This file is used to link one entry to others. In this example, Var1 ~ Var5 (different diaper sizes) are asso-
ciated to Prod1 "Diapers," Var9 ~ Var11 (different quantity for wipes) are associated with Prod2 "Wipes"
and so forth. Also some variations are assigned to packages. Please note that the Prod, Var and Package
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codes MUST BE the codes from the entry CSV files (Figure 3, 4, and 5). If you include codes that are not
defined in the entry CSV files, you will get an error while importing them into Commerce Manager in Step

4.
A B C D
1 |Action Parent Entry Code Child Entry Code
2 |Insert Prodl Varl
3 |Insert Prodl Var2
4 |Insert Prodl Var3
5 |Insert Prodl Vard
6 |Insert Prodl Var3
7 |Insert Prod2 Warg
8 |Insert Prod2 Varld
9 |Insert Prod2 Varll
10 |Insert Prod3 Varg
11 |Insert Prod3 Var7
12 |Insert Prod3 Vard
13 |Insert Package MNB Warl
14 |Insert Package MB Varlo
15 |Insert Package3tos Var2
16 |[Insert Package3ton Varlo
17
Figure 6

CSV file type 4 - Associations file

This file is used to create associations between different entries. In this example, Var 10 is associated to
Var 1 as an Accessory, and Var 2 to Var 1 as a cross-sell item.

A B C D E
1 |Action Baby Catalog Association Name Parent Entry Code Child Entry Code Sort Crder £
2 |Insert Accessories Varl Warld 1 i
3 |Insert Customers Who Bought This Item Also Bought Varl Var2 2 C
4
Figure 7

CSV file type 5 - Pricing/Inventory file

This file is used to specify the information for the Pricing/Inventory tab of each individual entry.
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A B C ¥ E F G H J
Track Inventory
1 |Acticon |Entry Code Price |Tax Category | (TruefFalse) Warehouse Weight Package Min Quantity Max Quar
2 |Update Varl 16.99|General Sales TRUE Default Warehouse 1| box 1
3 |Update Var2 17.9%9|General Sales TRUE Default Warehouse 1| box 1
4 |Update Var3 17.9%9|General Sales TRUE Default Warehouse 1| box 1
5 |Update |Vard 18589 | General Sales TRUE Default Warehouse 1| box 1
& |Update Vars 1859 | General Sales TRUE Default Warehouse 1| box 1
7 |Update Vart 25.59% | General Sales TRUE Default Warehouse 1| box 1
g2 |Update Vary 25.59% | General Sales TRUE Default Warehouse 1| box 1
S |Update Vark 25.9% | General ales TRUE Default Warehouse 1| box 1
0 |Update Varg 445 General Sales TRUE Default Warehouse 1| box 1
11 |Update Varll 15.88 General Sales TRUE Default Warehouse 1 box 1
12 |Update |Varll 2599 | General Sales TRUE Default Warehouse 1| box 1
13
Figure 8

CSV file type 6 - Sale Price file

This file is used to specify the information for the Pricing section of the Pricing/Inventory page.

A B C D E F G H 1

1 |Action Entry Code Sale Type Sale Code Unit Price Currency Start Date End Date

2 |Insert Varl BBW1 16.93/USD 1/1/2009 6:00 10/1/2009 18:00
3 |Insert Var2 BEW2 17.99 UsD 1/1/2009 6:00 10/1/2009 18:00
4 |Insert Var3 BEW3 17.99 UsD 1/1/2009 6:00 10/1/2009 18:00
3 |Insert Vard BEV4 18.93/UsSD 1/1/2009 6:00 10/1/2009 18:00
& |Insert Vars BBWS 18.99/USD 1/1/2009 6:00 10/1/2009 18:00
7 |Insert Varg BEBVE 25.99 UsD 1/2/2009 11:00 6/3/2009 23:00
2 |Insert “ar?7 BEBVT 25.99 UsD 1/2/2009 11:00 6/2/2009 22:00
9 |Insert Vars BEBWS 25.99 UsSD 1/2/2009 11:00 6/1/2009 19:00
10 [ Insert Warg BEWSI 4.49 UsD 1/2/2009 11:00 6/2/2009 22:00
11 |Insert WarlD EEV1O 15.99 UsD 1/2/2009 11:00 6/2/2009 22:00
12 |Insert Varll BBW11 25.99 UsSD 1/2/2009 11:00 6/2/2009 22:00
13

Figure 9

Step 2: Create necessary meta fields for the new catalog entries

For this example, no additional meta fields need to be created because the sample spreadsheet uses
only the default attributes.
To create new meta fields follow these steps here.

e Go to the Administration system in Commerce Manager.

e Selectthe "Catalog System" folder and then "Meta Classes" node located in the left navigation
frame.

e Select Create New, then New Meta Class from its pull-down menu.

e Enterin a Name, Friendly Name (e.g., Baby Catalog), and some description
(optional) for the meta class, and choose "Catalog Entry" for Entry Type.

e Click OK to save the new class.
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e Next Select Create New, then New Meta Field from its pull-down menu.

e Enterin a Name, Friendly Name (e.g., Baby Diaper Size), and some optional
description.

e Also Choose the data type for this meta field and other properties by clicking on the
checkboxes.

o Click OK to save the new field.

e Repeat the steps to create all the necessary fields.
e Associate the new meta fields to the meta class you created.

e Selectto "Meta Classes" node on the left navigation frame again.

e For "Element" choose "Catalog Entry" in the pull-down menu.

e Under "Type" choose your meta class (e.g., Baby Catalog) you created earlier.
e Selectthe desired meta fields from the list displayed at the bottom of the screen.

o Select OK to save the new meta class to fields association.

e You are done with setting up your meta fields.
Step 3: Upload the CSV data files to the CSV Import page

Follow these steps to prepare the CSV files for import:
e Selectthe Catalog Management system.

e In the upper-left detail area, click on Catalogs folder and you will see the Catalog List view in the
main area.

e In the action area above the main view, click the Import/Export drop-down button and select CSV
Import Catalog.

e You will now see the CSV Import Catalog page in the main screen. The screen contains two tabs
1) CSV Import and 2) Mapping File, which we will be talking about next.

CSV Import Tab
e Inthe "CSV Import" tab in the main view, click "Add New File."
e Browse for the CSV file you wish to import, then click "Upload File."
e When you get the "Uploaded File:" confirmation, click "Save the file."
e The CSV file you uploaded will be added to the "Files available for import:" list.

e Repeatthe previous four steps for each CSV file you wish to upload.
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CSV Import Mapping file

It is strongly recommended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one, Then dick the button 'Start Impart’ to start impo

Add Mew File

Files Available For Import:

Actions File Mame Size Creas
Download | Delete BabySalePrice.csv 151 bytes Todan
Download | Delete BabyAssociations.csv 215 bytes Todan
Download | Delete BabyEntryRelations.csv 254 bytes Todan
Download | Delete BabyVariationInventoryPricing.csv 1.52 KB Todan
Download | Delete BabyVariations.csv 1.20 KB Todan
Cownload | Delete BabyPackages 259 bytes Todan
Cownload | Delete BabyProducts.csv 269 bytes Todan
Cownload | Delete BabyStuffCategories.csv 274 bytes Todan
1
Choose mapping file.

Actions File Name Size Creat

Choose catalog for import.

Catalog: | Erands

| Start Import

Figure 10

Step 4: Create a mapping file for each CSV file

Now create a mapping file that will specify the data in the CSV file to its corresponding attributes in the

Commerce Manager.

Mapping file tab

e Click the "Mapping file" tab in the main view. You will now see the "Mapping file" tab view of the
CSV Import Catalog view as shown in Figure 11.
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CSV Import Mapping file

Edit existing mapping file.

g file. [Babyproducts xml v
MetaClass, Language Data File And C5V Adjustment
Mapping Type: Category wf Meta Data v Data File: BabyStuffCategories.csv v
Meta Class: Default Catzlog Node v Delimiter: . -
Language: English {United States) ~ Text Qualifier: " -
Encoding: Default v

Column headers in the data file Custom values
TU/0) | column 1 - Action v

Column 2 - Category Code e

Column 3 - Parent Code v

Column 4 - Category Name A

Column 5 - Available from ha

<Custom value>

Column 1 - Action

Column 2 - Category Code
Column 3 - Parent Code

Column 4 - Category Name
Column 5 - Available from

Column 6 - Expires on
Column 7 - Available (TruefFalse)
Column 8 - Sort Order

Sawve mapping file.

Figure 11
Edit existing mapping file section
e Load mapping file: This section is used to retrieve previously created and saved mapping files.
Since there is no existing mapping file in this example, leave this section blank.
Meta Class, Language section
e Mapping Type*: Select "Category w/ Meta Data"
e Meta Class*: Select "Default Catalog Node"
e Language™: English
Data fle and CSV adjustment section

e Data File*: The drop down values presented here are dependent on the different CSV data files
you uploaded on the "CSV Import" tab in step 2.

e Forthis example, first choose "BabyStuffCategory.csv."Leave the rest of the field as default and
move on to the next section.

Fields and Attributes, Column headers in the data file, and Selected values section
The values presented under the "Fields and Attributes" column are representative of the "Meta Class"
selected in the "MetaClass, Language" section above (which were either previously imported or created
within Commerce Manager).
The values presented in the drop-down menus under the "Column headers in the data file" column are
representative of the "Data file" selected in the "Data file and CSV adjustment" section above (which were
previously imported above).
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e Select the appropriate "Column header" drop-down value to "map" with the MetaClass "Fields and
Attributes" to the left; the value selected will be reflected in the "Selected values" column to the
right.

Save mapping file section

e Enter a file name for the "Enter file name" textbox. For this example, save the mapping files using
the same CSV file names.

e Click the "Save" button. The browser returns to the CSV Import tab, and the mapping file in XML
format will be added to the listin the "Choose mapping file" section.

e Repeat Step 3 to create and save a mapping file for each CSV files you wish to import.

e For CSV Entry files, select the "Entry w/ Meta Data" option under "Mapping Type."

e For CSV Entry Relations file, select "Entry Relation".

e For CSV Associations file, select "Entry Association."

e For CSV Pricing/Inventory file, select "Variation w/ Inventory."

e For CSV Sale Pricing file, select "Sale Price."

e When all the mapping files are saved, your CSV Import tab screen should look something like this.
CSV Import || Mapping fil

Tt is strongly recommended that you back up your ECF database before performing import.

Toimpert catalog, please pick up an existing fle from the grid below or upload @ new one. Then dlck the button 'Start Impart’ te start importing,

Add New File

Files Available For Import:

Actions File Mame Size Created Last Updated
Dovnlozd | Delste EzbySzlefrice. 138 bytez  Yesterday, 4:35 PM Yesterday, 5:14 FM
Delete EzbyAssocistio 215 bytes  Yesterday, 4:33 PM Yesterday, 4:33 PM
Dslsts EzbyEntryRelation: 354 bytes  Yesterday, 4:33 PM Yesterday, 4:33 PM
Delete EzbyVariationlnventoryPricing.csv 1.54 KB Yesterday, 4:23 P Yesterday, 4145 PM
Delete Ezbyvariatio 1.20 KB Yesterday, 4:23 PM Yesterday, 4:21 PM
Dslsts EzbyPackag 255 bytes  Yesterday, 4:21 FM Yesterday, 4:21 FM
Delete BabyProdud 363 bytes  Yesterday, 4:21 PM Yesterday, 4:21 PM
Dovnlozd | Delste EzbyStuffCategorias.cv 274 bytes  Yesterday, 4:21 PM Yesterday, 4:21 PM
1 Page 1 of 1 (& items)
Choose mapping file.
Actions File Marne Size Created Last Updated
Dovnload | EzbySzlePrice.xml 2.82 KB Yesterday, 4:43 PM Yesterday, 4:55 PM
EzbyAssocistions.xml 2.05 KB Yesterday, 4:42 FM Yesterday, 4:42 PM
BabyEntryRelations.xml 1.97 K8 Yesterday, 4:42 P Yesterday, 4:42 PM
EzbyVariationInventeryPricing.xm| 5.22 KB Yesterday, 4:41 FM Yesterday, 4:50 FM
EabyVariations.ml 4.12 KB Yesterday, 4:40 P Yesterday, 4:40 PM
EzbyPackages.xml 4.11 KB Yesterday, 4:38 PM Yesterday, 4:32 PM
EabyProducts.xml 4.14 KB Yesterday, 4:358 FM Yesterday, 4:38 FM
Dovnload | Delete EabyStuffCategory.cml 4.63 KB Yesterday, 4:37 PM Yesterday, 437 PM
1 Page 1 of 1 (& items)

Choose catalog for import.

[Babvswf®

Start Import

Figure 12
Step 5. Import the CSV files and their corresponding mapping files into a specific catalog

Atthe "CSV Import" tab view (Figure 12), do the following:

e Selectand highlightthe CSV file you wish to importin the "Files available for import" section. For
this example, select BabyStuffCategories.csv.

e Selectand highlight the mapping file that corresponds to the selected CSV file in the "Choose
mapping file for import" section. For this example, select BabyStuffCategories.xml.

e Selectthe catalog in the "Catalog" drop-down into which you would like to import your CSV data.
In this example choose "Baby Stuff".
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e Click the "Startimport" button. You will see the "Importing catalog" modal dialog box which will
notify you of the percentage of completion as well as logging messages.

e Click "Close Window" at the bottom of the modal dialog to complete the operation.

e Repeat Step 4 to import all the remaining CSV & Mapping pairs.
Step 6. Verify Your Import

In the Catalog Management system, expand the "Baby Stuff" folder under Catalog and verify that the con-
tents of your CSV file were imported into the appropriate catalog.

Browsing Catalogs

Catalogs and their related products and SKUs can be viewed and explored under Catalog Management.
Click on Catalogs to browse the list of catalogs.

Catalog Management e

-

= — Catalog Management
» Catalog Entry Search
E (Catalog Batch Update

=li—] Catalogs \”_")J
=i Wine 1
# ] Accessories
4[] Imported
# ] Mixed Cases

4 || Wine Region
#_] Templates

The Catalog List page shows the Wine sample node by default, together with associated sub-categories:
e Accessories
e Imported

o Mixed Cases

e Wine Region

Welcome, admin
MERCE Catalog List
@ GetHelp F
L Mew Catalog ﬁ Import/Export ™ i‘j More Actions ¥
|:| Mame Available from Expires Available
D ﬂ‘zl Wine 9/12/2011 11:11:00 AM 9/12/2021 11:11:00 AM True

Clicking on the Edit icon, located between the check box and the folder icon, will display more infor-
mation and settings of the particular catalog in the Catalog Edit page.

Clicking on the Catalog name ("Wine") will take you to the Node List page, which displays the list of sub-
categories under the selected catalog. To browse products, click on a Catalog and drill down in the cat-
egories until you see the products and SKUs.
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Welcome, admin

Catalog List

(7] Cet Help For This Page %

s 2> =
‘_1 MNew Catalog| i} Import/Export ™ '« More Actions ™

|:| Name Available from Expires Available

I:‘ !g Wine 9/12/2011 11:11:00 AM 5/12/2021 11:11:00 AM True

Welcome, admin

Node List

@ Get Help For This Page &

D Create New ™ ﬁ More Actions ™

El Name 1D Available from Exp

=]

= © Decanter Decanter 1/1/2011 1:00:00 AM 1/1
= © waiters Friend WaitersFriend 1/1/2011 1:00:00 AM 1/1
B © Wine Cla WineGlass 1/1/2011 1:00:00 AM 1/1
= (win Enotecagiantermwml FOO146 1/1/2011 1:00:00 AM 1/1
= " Engteca Decanter magnum 35373 1/1/2011 1:00:00 AM 1/1
B " Engteca Waiters' Friend Double Lever Corkscrew Blue 70631 1/1/2011 1:00:00 AM 1/1
B Mi" Enareca Waiters' Friend Double Lever Corkscrew Red 70632 1/1/2011 1:00:00 AM 1/1
= (" Enateca Waiters' Friend Double Lever Carkscrew Yellow 70633 1/1/2011 1:00:00 AM 1/1
= MM Enoteca Wine Glass Large 35368 1/1/2011 1:00:00 AM 1/1
[ = M Encteca Wine Class Small 35367 1/1/2011 1:00:00 AM 1/1

Searching for Catalog Entries
Introduction

The Catalog Search function enables you look for specific sales items stored in EPiServer Commerce.
Click on Catalog Management and then Catalog Entry Search.

Catalog Management e

o= Catalog Management

| -, Catalog Entry Search
B Catalog Batch Update
=113 Ccatalogs
= [ wine
=[] Templates

To do a basic search for catalog entries, enter a one keyword or more into the Search by Keywords(s)
field, such as "white bordeaux". The search will return entries that match either of those keywords.

If you enter keywords inside quotation marks ("white bordeaux"), then search will only fetch entries that
have those exact three keywords.

Entry Search

Search By Keyword(s): hite bordeaux search I:

Additional Filters

Filter By Language: English (United States) -
Filter By Catalog(s): Wine -

Search By Code/Id:
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Catalog Search Filters
To narrow entry search results, there are Additional Filters available. Click search once those filters are
set.

e Filter by language: Pull-down menu will show the available language choices

o Filter by catalog(s): Pull-down menu will show the available catalog choices

e Search by codelid: Instead of text, you can search by code or ID

Search By Keyword(s): | Search [

Additional Filters

Filter By Language: English (United States) ||
Filter By Catalog(s): all catalogs E
Search By Code/Id: 30958

Deleting and Cloning Entries

Users can Delete and Clone entries. To delete or clone an entry:

1. Selectan entry or entries by selecting the box nextto it.
2. Click on More Actions.

3. Click on Delete Selected or Clone Selected .

The entry will either be deleted or a clone (copy) of it appears.

Search By Keyword(s): hite bordeaux search

Additional Filters

Filter By Language: English (United States) v
Filter By Catalog(s): Wine v

Search By Code/ld:

=y
ﬂ More Actions ™

|| P Delete Selected Sz
23 Clone Selected ’{ﬂ 620128
[T M Cchateau u:I'Yquem1 516088
" Chateau d'Yquem 332288
" Chateau d'Yquem 224708
[ M chateau dYquem 63587E
] ™ chateau Suduiraut S57149H

Paging and Sorting Results

Users can sort results by clicking on Name, Code, Available From, Expires, and Status in either ascend-
ing or descending order.
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Zl More Actions ¥

] Name Code 4 Available from Expires Status
D ,ILﬁ"J.LTerriers. C. Collovray Dmnﬂb\ﬁ\scending 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
D .I_”/\HIJ.LTEI’I’iEI’S. C. Collovray 00008H 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
I:‘ .I_”/\HIJ.LTEI’I’iEI’& C. Collovray 00003B 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
[T 1 Bomaine des Deux Roches 00012H 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
D .l_”:"' Seifried 000428 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True

The Page Size (number of items to be displayed on a page) can be set at the bottom of the search result
page, where there is also a paging function for browsing the search result.

[F] W Chateau Lafite Rothschild 228518 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
I:l LN oY xer 229548 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
[ (i cpg lon-Longueville Baron 234168 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True

Page Size: 20 E (1548 items) | Page 412345 ...»

Creating Catalogs

Introduction

The Catalog List page, used to organize and manage catalogs, contains information regarding brands
and sales items. These sets of information will either be displayed on the front-end site, or used for other
purposes such as for pricing and Promotions.

Creating a Catalog

Do the following to create a new catalog:

1. Go to Catalog Management, click Catalogs and then New Catalog in the Catalog List.

MERCE Catalog List

Ll New Catr-.ll_ll_l:ug gﬁ Import/Export ™ ﬁJ Mare Actions ™
|:| U MName

= s Wine

2. Enter the details of the catalog in the Catalog Edit page. The following options are available:

e Catalog Name - this name will appear in the Catalog List Page ("Wine").
e Catalog Owner - designate an existing user as the Catalog owner.

e Available from - enter a date and time you want the catalog to be available
and seen publicly.

e Expires on - enter the date and time you want to catalog to be unavailable
and not be seen publicly.

e Default Currency - this setting will set the Default Currency for the relevant
Catalog contents.

e Default Language - this will set the Default Language for the contents.

© EPiServer AB



70 | User Guide for EPiServer Commerce 1 R3

o Base Weight - this assigns the weight units for the contents of the Catalog
(e.g. pounds or kilograms). More units may be added.

e Other Languages - you can also select other available Languages other
than your default Language.

o Sites - this determines the site/sites that the relevant Products will be dis-
played in, if you have multiple sites.

e Sort Order - the Sort Order determines the order to which the Catalog
appears in the Catalog List page.

e Auvailable - select "Yes" to make the Catalog contents appear on the front
end site; select "No" to hide the Catalog from the front-end site.

3. Once done setting up your catalog attributes, select OK to save the catalog. You will be brought
back to the Catalog List with the new catalog. Select Cancel to cancel out of the Catalog Edit
page and back to the Catalog List.

ERCE Catalog Edit

Overview
Catalog Name: Wine
catalog name description
Catalog owner: @ Mot Set w
Available from: 9/12/2011 1111 AM
Expires on: 9/12/2021 0o am
Default Currency: Pound sterling -

Default Language:  gpgjish (United States)

Base Weight: in kilograms

Other Languagdes: | gpglish (United States)
Cerman (Cermany)
Spanish (Spain)
French (France)

Sites:

Sort Order: 0

Available: @ Yes © No
QK || Cancel

Setting the Availability of a Catalog

Each catalog can be listed as available or unavailable, and you can set an Available from and Expires
on date and time when you want the catalog to be public.

You can set the availability of a catalog for a variety of purposes. For example, if you are a clothing store
and wish to only make your summer catalog available during the summer months, you can set that up. In

this way, future revisions to items and pricing can be prepared easily and reviewed in advance of the
release date to the site.
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Creating Categories

Introduction

Individual catalogs are broken down into categories and subcategories. Categories, also known as
"nodes", allow you to structure and categorize your catalog entries. For example, if you run an online

store selling smartphones, you may want to separate individual brands as different categories, rather than
lump all of your catalog entries into a single category. Categorization is key to organized, manageable cat-
alogs.

Creating a Category

1. To create a new category, click on Create New and then click on New Category/Node.

ERCE Node List

DCreatE Mew ;EIMDrE Actions

Iy MNew Category/MNode ‘\”'_"'J

() MNew Product

il New Variation /Sku
B4 Mew Package
% Mew Bundle

LS
ﬂ% Mew Dynamic Package

2. This page will appear when creating a new category or editing an existing one. The Catalog Node
Edit page will contain information of a Node selected from the Node List page.
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Welcome, admin
DPMMERCE Catalog Node Edit
bout = @ cet Help For This Page 5
J Overview || SEQ || Agsets |
Name: Accessories
catalog node name description
Available .
from: 9/27/201 :ﬁ 12:33 PM
Expires on: 1g,27/2014 H 12:53 M =
Display
Template: lz‘
Code: Accessories
Sort Order: g
Available.  gves  FiNo m
Meta Class: Region Catalog lz‘
Description i -
(en-us): B I =y i Styles - I + 11 O Lo Q [ wm
Our best selling accessories to go with vour wine. ..
[
Path: 4

3. Foravailable options, see below. Once done, click OK to save your changes.

e Name - enter a name for the product.
e Available from - the date to which the product is activated.

o Expires on - the date on which the product expires; once the expiration date
passes, the product will no longer appear on the public site.

o Display Template - if applicable, chose a display template used to show the prod-
ucts in the public site from this drop-down box.

e Code - enter a product code here (e.g. Accessories)

e Sort Order - determines the order to which the productis sorted in the Node List
page

e Available - select Yes to make the product appear on the public site; select No to
hide the product from the public site

e Meta Class - the choice here dictates which of the meta-fields or product attributes
will appear on the site.

e Display Name - enter a name the way you like to use on the public site.
e Primary Image - use the browse button to select and upload an image here.

e Description - enter a description of a product.
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Creating a Subcategory
Creating a subcategory is similar to creating a high-level category.

1. Go to Node List and click through an existing catalog.

2. Click on Create New and click on Category Node. Specify the information under
Catalog Edit (refer to Creating a Category) and click OK to save changes.

Node List

[
D Create New ™ #1 More Actions ™

Name

IE' Accessnri%
IE' Imported

IE' Mixed Cases
IE' Wine Region

ODEOOb

Node List

1 =, i
Create New ™ ¥l More Actions ™

| I Mew Category/MNode ’\”:)J

) Mew Product

Mew Variation [Sku
Mew Package
Mew Bundle

Mew Dynamic Package

MM Enoteca Decanter 1000ml
"M Enoteca Decanter magnum
MM Enoteca Waiters' Friend Double Lever Corkscrew Blue

E':"' Enoteca Waiters' Friend Double Lever Corkscrew Red

el -

M Enoteca Waiters' Friend Double Lever Corkscrew Yellow

M Enoteca Wine Glass Large

i

M Enoteca Wine Glass Small

Al

Cloning, Moving or Linking Categories

Cloning creates a duplicate with a unique ID that you can place in any location/hierarchy
of your choice.

Movel/Link to Folder allows you either to move a category/product to a new loca-
tion/hierarchy or to link one category/product to another category/product. You can for
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example create a category called "Featured Products" and link it to items across various
other categories.

This way, if you make changes to content on the original product page and that same prod-
uctis part of the "Featured Products" category as a linked product, the changes will be dis-

played in both locations. In other words, changes are bi-directional. Links can be broken if
either of the two are deleted.

1. Tolink to a category, go to the Node List and select the category you want to link
back to.

2. Click More Actions and then click on the Move/Link to folder option.

3. Selectlink to folder and select the link destination from the drop-down menu. Click
OK to create the link to that category under that directory.

ERCE Node List

=
D Create New ™ ] More Actions ™

Name X Delete Selected

LD Acc 23 Clone Selected

i Impy| 23 Maove/Link to folder \”__"i
= Mixed Cases

= Wine Region

O@Oo =

Move/Link to Folder 4

) moveor @] Wine/Mixed Cases -

[ ok || close

SEO for Categories

You can work with SEO (Search Engine Optimization) for product categories. Refer to the
section SEO for Catalog Iltems for information on how to work with SEO.

Assets for Categories

You can relate assets to product categories. Refer to the section Assets for Catalog ltems
for information on how to work with SEO.

Creating Products

Introduction

A "product” is a central part of the e-commerce store. A product can have "variations" or SKUs (Store

Keeping Units). For example, a product can be a "red shirt" and a variation/SKU for that shirt would then
be "size".
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Products can be seen as "parents" to their variations/SKUs, although itis not a true parent-child hier-
archical relationship and this view is mainly used internally for organizing and displaying a product struc-
ture. You can configure to have products displayed on the front-end site with a drop-down for the different
variations/SKUs. This type of product/SKU relationship display customization is typical in an imple-
mentation, but does not work directly out-of-the-box.

If your catalog items will have no variations/SKUs, then you can either create all as SKUs and not have
products, or you can use only products. In order to only use products, work with your developers to add
the Pricing/inventory tab to the product details page. Refer to Setting Pricing Data at the Product Level in
the Developer Documentation for EPiServer Commerce.

Creating a Product

To create a product, click through an existing catalog and click on Create New and then select New Prod-

uct.

ERCE Node List

DCrEﬂtE Mew ;EIMDrE Actions ™

) MNew Category/Mode

|(_} Mew Product

il New Variation [Sku
£ Mew Package
% MNew Bundle

ﬂ% New Dynamic Package

The Overview tab is where you enter basic information about a product.

ERCE Product Edit

J Overview || Variations /SKUs || SEC || Associations || Assers || Relations |
Mame:

Available from: S/3/2012 :ﬁ 1022 AM

Expires on: S/3/2022 :ﬁ 10:22 AM

Display Template: Wine Template -

Code:

Sort Order: o

The sort order for the category entry.

Available: - _
wvailable = ves @ Mo

Meta Class: Wine SKU -

Alcohol (en—-us):

Alcofol By volusrre mreasurerrrent
Closure (en—us):

THre cfoswre rmrecHanism of ofre wire
Color (en—us):

The cofor of the sku
Description (en—us):
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Field Description

Name Enter a friendly name, which can include spaces and special characters.

Available from | Enter the date and time the product will be available and active.

Expires On Enter the date and time the product will be unavailable and deactivated.

Display Tem- Chose a display template used to display the productin the public site from this drop-
plate down menu.

Code Enter a value without special characters or spaces, such as "BlueShirtxL."

Sort Order Enter a numerical value to determine the product sort order on the node list page.
Available Set"Yes" to activate the product. Set "No" to keep the productinactive and unsearch-

able on the front-end site.

Meta Class Select a Meta Class from the drop-down menu. Depending on the meta class you
select, additional fields will appear in the Overview tab. The values entered within the
fields of the meta class you selected will be shown on the front-end public site. Note
that meta classes must be created first to become available in the list.

Depending on the meta class selected, more fields may become available. For instance, selecting the
Wine SKU meta class will yield wine related meta fields and attributes.
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Product Edit

Enter description here
Display Name (en-us):
Margin Percentage (en-
us):
) The margin percentage of the SKU
Maturity (en-us):
Maturity

Organic (en-us): ) True @ False

IFthe wine adhieres to organic production principles.

Primary Image (en-us).

Primary Image

Recommendation Boast
(en-us): - o . X X
An integer that can be vsed ro boosr the visibility of products in recormmendation Nsis.
Region (en-us):
Region
Size (en-us):
Size
Style (en-us):
The siyle of the wine
Taste (#n-us):
The taste rating of the wine.
Crape mix (en-us):
The grape varieties in the wine

Wegans (en-us): () True (@) False

Suitable for vegans

Vegetarians (en-us): “ True @ False

Suitable for vegetarians
Vintage (en-us):

Vintage

Ok | | Cancel

Adding Variations/SKUs

Variations/SKUs are subcategories of a product, which represent different "variations" of the particular
product (colors, sizes, different editions for example). Such Variations/SKUs can be grouped together with
a chosen product. Follow these steps to group variations/SKUs.

1. Selectthe Variations/SKUs tab

2. Within the drop-down menu next to Find Item, select from the list variations or SKUs to associate
with the product.

3. Clickon Add Item.

You can add multiple associations to the product and they will appear in a list under the column headers
below.
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ERCE Product Edit

Overview Variations [SKUs H SEQ ” Associations H Azzets H Relations ‘
Find Item: A Add Item

Wil Chateau d"Yquem

Edit Com{ ! Chateau d"Yquem Oty | Group Sort Order
7 1 Chateau d"Yquem 1 default 0
7 1 chateau d'¥guem 1 default 0

] .
1 I Chateau d'vquem Page 1 of 1 (2 items)

1 Chateau Suduiraut
"l chateau Climens

" Bonneau Du Martray L\\)
M Sylvain Leichet

1 Chandon de Briailles -

JERCE Product Edit

Overview Variations [5KUs ” SEO H Associations H Aszets H Relations ‘
Find Item: | |Bonneau Du Martray - Add ltemn

Edit Command | 1D Mame Oty | Croup Sort Order
>< 2762 Enoteca Wine Glass Small 1 default 0
X 2763 Enaoteca Wine Glass Large 1 default 0

1 Fage 1 of 1 (2 items)

| oK || Cancel

SEO for Products

You can work with SEO (Search Engine Optimization) for products. Refer to the section SEO for Catalog
Items for more information.

Associations for Products

You can work with associations for products. Refer to the section Associations for Catalog Items for more
information.

Assets for Products
You can relate assets to products. Refer to the section Assets for Catalog ltems for more information.
Relations for Products

You can work with relations for products. Refer to the section Relations for Catalog ltems more infor-
mation.

Creating Variations (SKUs)

Introduction

A product can have "variations" or SKUs (Store Keeping Units). For example, a product can be a "red
shirt" and a variation/SKU for that shirt would then be "size". Variations/SKUs can be linked to products to
create a product structure that can be used for organizing and displaying products on the website.
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Creating a Variation/SKU

To create a product variation/SKU, click through an existing catalog and click on Create New and then
select New Variation/SKU.

Node List

j‘ .
D Create New ™ _.'i_'] More Actions ™

|| D) New Category/Node

—
!

L MNew Product

] Mew Variation /Sku '\[bj

£} Mew Package

b

&5 New Bundle

4% Mew Dynamic Package 1 000ml

O " Enoteca Decanter magnum

Go to the Overview tab to enter basic information about the variation/SKU.

ERCE Variation/SKU Edit

J Overview Pricing/Inventory SEQ Associations Assets Relations
Narme: Enoteca Wine Class Large
Awailable from: 17172011 HH |01:00 AM
Expires on: 1/1/2020 HH |01:00 AM

Display Template: Wine Template -

Code:

35368
S5ort Order: 0

The sort order for the category entry.
Available: @ Yes © No
Meta Class:

Default Catalog Entry

Display Name (en-us). Enoteca Wine Glass Large

Primary Image (en-us):

Primary Image

Description

Name Enter a friendly name, which can include spaces and special characters.
Available from | Enter the date and time the SKU will be available and active.
Expires On Enter the date and time the SKU will be unavailable and deactivated.

Display Tem- Chose a display template used to display the Variation/SKU in the public site from this
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Field Description

plate drop-down menu.

Code Enter a value without special characters or spaces, such as "BlueShirtXL."

Sort Order Enter a numerical value to determine the SKU's sort order on the node list page.
Available Set"Yes" to activate the SKU. Set "No" to keep the SKU inactive and unsearchable on

the front-end site.

Meta Class Select a Meta Class from the drop-down menu. Depending on the meta class you
select, additional fields will appear in the Overview tab. The values entered within the
fields of the meta class you selected will be shown on the front-end public site. Note
that meta classes must be created first to become available in the list.

Depending on the meta class selected, more fields may become available. For instance, selecting the
Wine SKU meta class will yield wine related meta fields and attributes.

Adding Pricing/Inventory Details

Under this tab, you can set specific pricing and inventory settings for the variation/SKU.

Overview ‘ Pricing/Inventory SEO Associations Assets Relations
Display Price: (gbp) |5 gp In Stock: 1000
Mir. C%antiw: 1.0000 Reserved: 0
Max. Quantity: 200.0000 Rearder Min. Oty 0
Merchant: Allow P der: . _
grehan select merchant « ow Frearaer ) Yes @ |
Weight: 0.75 Preorder Qty: 0
Package: select package ¥ Preorder Avail.: 1/1/2020
Tax Categaory: Allow Backorder: . _
gory select tax category ~ ) Yes @ |
Warehouse: select warehouse ¥ Backarder City: 0
Track Inventory: @ Yes 1 No Backorder Avail.: 111/2020
Inventory Status: Enabled
Pricing
Add Item
Edit Command Sale Type Sale Code Currency Price Min. Quantity Start Date End Da
>< All Custamers 1235555 CEP 0.00 0 Today, 2:55 PM 2r2zjal
1 Pa
| 04 ” Cancel ‘

Clicking on Add item will open the Edit Sale Price Information dialog for adding pricing information.
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Edit Sale Price Information

Sale Type: All Customers -

Sale Code:
Unit Price: 0.00

Currency: Pound sterling -

Min. Quantity: g oo
start Date: 272272012 EH 0255PM

End Date: (272272013 HH 0255 PM

b

system.

Track Inventory

Inventory Status

In Stock

Reserved

Reorder Min Qty

Display Price
Min Quantity

iation/SKUs product page.
Max Quantity

the checkout process).
Merchant

changes.
Weight

total shipping cost .
Package
Tax Category
Warehouse

This sets the minimum quantity the customer is able to purchase the var-

This is the maximum allowable number of items that can be purchased at one
time (this number gets displayed as the upper range in the drop-down during

Optional: if you use many merchants on your site, this provides another way to
add more information for a product; this can only be added/edited directly in
the database so please contact your site administrator/developer to make any

Based on your shipping configuration, the weight you enter here will affect the

This value is based on width/length/height dimensions; the options for this
drop-down are configured in the Administration area.

This separation of taxes by category allows you to charge a different rate of
taxes depending on what is being purchased; for example, you can have one
rate for "General Sales" items and another rate for "Luxury Sales" items.

The details on the available selections are maintained in the Administration

Yes/No. If this is set to "Yes," then the quantity value of In Stock, Preorder, and
Backorder fields will be deducted each time a purchase is made. If this is set to
"No," then those values will not change.

Enable/Disable. If this is Enabled, then the number of units of a product being
purchased cannot exceed the inventory value. In other words, the check out
procedure cannot be completed if you exceed the number in the inventory --
instead the quantity you can purchase will default to the actual number of
remaining units. For instance, if you have Tracking Inventory = Yes, and Inven-
tory Status = Disabled/Ignored, then the available quantity will be monitored,
but it will not limit the number of units that can be checked out. If you only have
a quantity of 5 and you order 6 items, the checkout will still complete and the
inventory number will become -1.

You can enter the quantity of a particular product available for sale.

The quantity you set here allows you to reserve a specified number of inven-
tory "In Stock" and prevent them from being used. So for instance, if you set the
In Stock = 10 and Reserved = 5, then the In Stock count will not go below 5.

If the inventory falls below the value specified here, then this item will appear

Commerce Manager | 81

Field Description

Enter the price that will be displayed on the public site.
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Field Description

in the "Low Stock Report" in the Dashboard or Reporting system.

Allow Pre- Yes or No; you need to set Allow Preorder/Backorder status to Yes to turn
order/Backorder either of these features On.

Preorder/Backorder | When you turn on either of the two and specify a quantity, the count will begin

Avail to decrease after the In Stock count reaches its limit. For example, if you set In
Stock = 10, Reserved =3, and Backorder =10, then the Backorder gty will start
to decrease after In Stock count reaches 3. So if you place an order for 10
units, then the final count will be In Stock = 3, Reserved =3, and Backorder=7.

Backorder Qty The quantity you set here will determine the backorders that can be made by
customers even when the item is out of stock.

Pricing Sale Type - you can select All Customers, a single Customer or a Customer
Price Group (the Customer Price Group gives you the ability to create tiered
pricing).

Sale Code - This is an optional setting. The Sale Code field is used for assign-
ing a price to a specific group of customers. For instance, when you add a new
price and select "Customer Price Group" as the Sale Type, you need to put the
name of the customer group in the Sale Code field. The name of the group that
you putin the Sale Code field needs to match one of the group names found
under Customer Management > Contacts > (Name of Contact). If your entry
into the Sale Code field matches one of the Customer Groups, any member of
that group will receive the specified price.

Unit Price - discounted price per unit *Currency * enter currency using the cor-
rect currency code (i.e. GBP); you can create different prices depending on the
currency thatis selected.

Min. Quantity - minimum number of units you must purchase to get the dis-
counted bulk rate.

O A SKU can only have one warehouse associated to it.

SEO for Variations/SKUs

You can work with SEO (Search Engine Optimization) for variations/SKUs. Refer to the section SEO for
Catalog Items for more information.

Associations for Variations/SKUs

You can work with associations for variations/SKUs. Refer to the section Associations for Catalog Items
for more information.

Assets for Variations/SKUs

You can relate assets to variations/SKUs. Refer to the section Assets for Catalog ltems for more infor-
mation.

Relations for Variations/SKUs

You can work with relations for variations/SKUs. Refer to the section Relations for Catalog Iltems more
information.

Creating Packages

Introduction

A package is an offering of numerous items, butitis comparable to an individual SKU because the pack-
age items must be purchased as a whole. For example, the matching shirt and hat combination is shrink-
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wrapped together and sold as a single unit. The package has its own SKU and itis displayed as a single
line item in the user's shopping basket.

Creating a Package

1.

2
3.
4

Click on Catalogs. The Catalog List appears in the main window.
Click on an existing catalog name highlighted in blue. The Node List window appears.
Click on Create New pull-down menu located in the upper left part of the main window.

On the drop-down menu, select New Product Package. The Product Package Edit page appears.

Enter basic information for the product package:

Name - a name for the Product Package
Available from - the date to which the Product Package is activated

Expires on - the date on which the Product Package expires; once the expiration date passes, the
Product Package will no longer appear on the public site

Display Template - choose a display template used to show the Product Package in the public
site from this drop-down box.

Code - enter a Product Package code here.
Sort Order - determines the order to which the Product Package is sorted in the Node List page.

Available - select Yes to make the Product Package appear on the public site; select No to hide
the product from the public site

Meta Class - the choice made here dictates which the meta-fields or Product Package attributes
will appear on the public site or Commerce Manager site

Adding Pricing/Inventory Details

Display Price - the price that will be displayed in public site

Min Quantity - this forces your customer to purchase a minimum number of items as set here (this
number gets displayed as the lower range in the drop-down during the checkout process)

Max Quantity - this is the maximum allowable number of items that can be purchased at one time
(this number gets displayed as the upper range in the drop-down during the checkout process)

Merchant - (optional) if you use many merchants on your site, this provides another way to add
more information for a product; this can only be added/edited directly in the database so please
contact your site administrator/developer to make any changes

Weight - based on your shipping configuration, the weight you enter here will affect the total ship-
ping cost
Package - this value is based on width/length/height dimensions; the options for this drop-down

are configured in the Administration area

Tax Category - this separation of taxes by category allows you to charge a different rate of taxes
depending on whatis being purchased; for example, you can have one rate for "General Sales"
items and another rate for "Luxury Sales" items

Warehouse - the details on the available selections are maintained in the Administration Sub-
system

Track Inventory - Yes/No. If this is setto "Yes," then the quantity value of In Stock, Preorder, and
Backorder fields will be deducted each time a purchase is made. [fthis is setto "No," then those
values will not change.

Inventory Status - Enable/Disable. If this is Enabled, then the number of units of a product being
purchased cannot exceed the inventory value. In other words, the check out procedure cannot be
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completed if you exceed the number in the inventory -- instead the quantity you can purchase will
default to the actual number of remaining units. For instance, if you have Tracking Inventory = Yes,
and Inventory Status = Disabled/Ignored, then the available quantity will be monitored, but it will
not limit the number of units that can be checked out. If you only have a quantity of 5 and you order
6 items, the checkout will still complete and the inventory number will become -1.

e In Stock - you can enter the quantity of a particular product available for sale

e Reserved - The quantity you set here allows you to reserve a specified number of inventory "In
Stock" and prevent them from being used. So for instance, if you set the In Stock = 10 and
Reserved = 5, then the In Stock count will not go below 5.

e Reorder Min Qty - If the inventory falls below the value specified here, then this item will appear in
the "Low Stock Report" in the Dashboard or Reporting subsystem.

e Allow Preorder/Backorder - Yes or No; you need to set Allow Preorder/Backorder status to Yes to
turn either of these features On.

e Preorder/Backorder Avail - When you turn on either of the two and specify a quantity, the count
will begin to decrease after the In Stock count reaches its limit. For example, if you set In Stock =
10, Reserved =3, and Backorder =10, then the Backorder qty will start to decrease after In Stock
countreaches 3. So if you place an order for 10 units, then the final count will be In Stock = 3,
Reserved =3, and Backorder = 7.

o Backorder Qty - The quantity you set here will determine the backorders that can be made by cus-
tomers even when the item is out of stock.
Pricing .

e Sale Type - you can select All Customers, a single Customer or a Customer Price
Group (the Customer Price Group gives you the ability to create tiered pricing).

e Sale Code - (optional) enter code to give special pricing for a group of Customers
(for instance Dealers).

e Unit Price - discounted price per unit.

e Currency - enter currency using the correct currency code (for instance USD); you
can create different prices depending on the currency thatis selected.

e Min. Quantity - minimum number of units you must purchase to get the discounted
bulk rate.

For more information regarding Sales Type, Sales Code and tiered pricing, please read
Creating a Contact.

Adding Package Items

In the drop-down, you can search through your entire inventory and select items to add to your package
by clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the
Quantity, the Group Name and the Sort Order.

SEO for Packages

You can work with SEO (Search Engine Optimization) for packages. Refer to the section SEO for Catalog
Items for more information.

Associations for Packages

You can work with associations for packages. Refer to the section Associations for Catalog Items for
more information.

Assets for Packages

You can relate assets to packages. Refer to the section Assets for Catalog Items for more information.
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Relations for Packages

You can work with relations for packages. Refer to the section Relations for Catalog ltems more infor-
mation.

Creating Bundles

Introduction

A bundle is a collection of variations/SKUs allowing customers to purchase two or more items at once.
These are presented on the front-end to the customer as a bundle, but added to the shopping basket as
each separate variation/SKU. For example, a matching shirt and hat may be presented together on the
front-end so that the user can buy both items at once. In their shopping basket though they will see each
item listed separately.

Creating a Bundle

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.
3. Click on Create New pull-down menu located in the upper left part of the main window.
4

On the drop-down menu, select New Bundle. The Bundle Edit page appears.

Enter basic information for the bundle:
e Name - a name for the Bundle
e Available from - the date to which the Bundle is activated

o Expires on - the date on which the Bundle expires; once the expiration date passes, the Bundle
will no longer appear on the public site

o Display Template - choose a display template used to show the Bundle in the public site from this
drop-down box.

e Code - enter a Bundle code here.
e Sort Order - determines the order to which the Bundle is sorted in the Node List page.

e Available - select Yes to make the Bundle appear on the public site; select No to hide the product
from the public site

e Meta Class - the choice made here dictates which the meta-fields or Bundle attributes will appear
on the public site or Commerce Manager site

Adding Bundle Items

In the drop-down, you can search through your entire inventory and selectitems to add to your bundle by
clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the
Quantity, the Group Name and the Sort Order.

SEO for Bundles

You can work with SEO (Search Engine Optimization) for bundles. Refer to the section SEO for Catalog
Items for more information.

Associations for Bundles

You can work with associations for bundles. Refer to the section Associations for Catalog Items for more
information.

Assets for Bundles

You can relate assets to bundles. Refer to the section Assets for Catalog Items for more information.
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Relations for Bundles

You can work with relations for bundles. Refer to the section Relations for Catalog ltems more infor-
mation.

Creating Dynamic Packages

Introduction

A dynamic package is similar to the Package definition above (hnumerous items in the package but with a
single defined SKU) with the added ability to configure the package and its contents during checkout. For

example, a clothing company has a "Create your Own Outffit" option on their site. The dynamic package
would be a shirt, a pair of pants, and an accessory that the user chooses from a selected list.

Itis important to note that for your dynamic package to work correctly, you must work with your developer
to configure it correctly so that your users may choose the desired options. In addition, dynamic packages
cannot be ordered and checked out from Commerce Manager but must be configured to work on the
front-end site.

Creating a Dynamic Package

1. Click on Catalogs. The Catalog List appears on the main window.
2. Click on an existing catalog name highlighted in blue. The Node List window appears.
3. Click on Create New pull-down menu located in the upper left part of the main window.
4. On the drop-down menu, select New Dynamic Package. The Product Dynamic Package Edit
page appears.
Enter basic information for the dynamic package.
e Name - a name for the Dynamic Package
e Available from - the date to which the Dynamic Package is activated

e Expires on - the date on which the Dynamic Package expires; once the expiration date passes,
the Product Package will no longer appear on the public site

e Display Template - choose a display template used to show the Dynamic Package in the public
site from this drop-down box.

e Code - enter a Dynamic Package code here.
e Sort Order - determines the order to which the Dynamic Package is sorted in the Node List page.

e Available - select Yes to make the Dynamic Package appear on the public site; select No to hide
the product from the public site

e Meta Class - the choice made here dictates which the meta-fields or Dynamic Package attributes
will appear on the public site or Commerce Manager site

Adding Package Items

In the drop-down, you can search through your entire inventory and select items to add to your dynamic
package by clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to
specify the Quantity, the Group Name and the Sort Order.

SEO for Dynamic Packages

You can work with SEO (Search Engine Optimization) for dynamic packages. Refer to the section SEO
for Catalog Items for more information.

Associations for Dynamic Packages

You can work with associations for dynamic packages. Refer to the section Associations for Catalog
Items for more information.
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Assets for Dynamic Packages

You can relate assets to dynamic packages. Refer to the section Assets for Catalog ltems for more infor-
mation.

Relations for Dynamic Packages

You can work with relations for dynamic packages. Refer to the section Relations for Catalog Iltems more
information.

Managing Catalog Details

In this section you will learn how to add and manage details associated with catalogs and catalog items.
Depending on whether you are working with products, variation/SKUs, packages, bundles or dynamic
packages, you will have different options available for adding product details or linking to other catalog
items.

At every level of your catalog you have Search Engine Optimization (SEO) attributes that you can add, as
well as assets such as videos or product brochures. You may also create product associations which
create relationships between product catalog items. Product associations can be leveraged to create rela-
tionships like "Product Accessories" or "You May Also Like". You can also do updates for multiple items
in large product catalogs.

SEO for Catalog Items

Introduction

Search Engine Optimization (SEOQ) is available on every level of your catalog: categories, products, var-
iations/SKUs, packages, bundles and dynamic packages. You will see this SEO tab within all of your
details pages. By default, if you do not putin any information in this area, the name of your item will be
added as the SEO Title here

Adding SEO Attributes

Open a catalog item for editing, and select the SEO tab. The following attributes are available:

e Title - this is the title that will appear on the title bar of your web browser if you choose to display
this category. It also supports SEO.

e URL - the URL linking the category can be changed. If the field is left empty, it will be automatically
filled in with a generated URL based on the entry name. If the URL field is not empty, it will be
saved as itis, and will not be changed automatically even if you change an entry name. If you
need the URL to change, leave it blank.

e Description - enter a description that search engines will use to represent the page in search
results.

e Keywords - enter various relevant keywords separated by commas, words that will help make
your category page retrievable and relevant to search engines. For example, if the page is related
to "cell phones", you may have a list of keywords such as "cell, phones, accessories, mobile, wire-
less".
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RCE Catalog Node Edit

Chverview ‘ SEO Assets

Title (en-us): Wine Accessories

Url (en-us): Accessories.aspx

Description (2n-us). |acressories for the finest selections o

Keywords (en-us)  |glass cases I
QK || Cancel

Associations for Catalog Items

Introduction

Merchandising involves the promotion of products in various contexts. Promote new, popular, or sale
products by displaying them as featured products in category and search result pages. You can display
your top selling products in your store over a defined interval. They can be displayed on the site home
page, category, or product pages.

Common examples of the usage of associations are the display of "Product Accessories" or up-sell-
ing/cross-selling items with "You May Also Like" type of displays. Associations can be added from the
Associations tab for any of the individual catalog items such as Product Entries, SKUs, Bundles, Pack-
ages, and Dynamic Packages.

Adding a Product Association

Do the following to add a product association:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

Welcome, admin

Product Edit

@ Cet Help For This Page ‘i

| Overview || Variations /SKUs || SEO || Associations || Assets || Relations |

Add an association

Maodify Existing Association: o |EditDetaiI5| |Modif\rA550ciation| |Delete|

2. When the pop-up appears, enter information in the following fields:

¢ Name - name of the association. This name cannot have spaces (ex: Related Items would be
entered as "Related_Items").

e Description - the description to detail what this association is.

e Sort Order - determines in what order this association is displayed in the associations drop-down
list.
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Edit Association Information X

MName: cts
Enter association name.

Description: -~

s

Enter association description.

Sort Order: ]
Enter sort order.

Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

| Overview H Pricing /Inventory || SEO || Associations || Assets || Relations ‘
Modify Existing Association: | cTs - ||EditDe1;aiI5| [Moairy Association] [Delete|

4. Next select the new association that you just created from the drop-down menu and click on Edit
Details. You may also choose to Modify Association or Delete the association.

come, admin

Product Edit

€ Get Help For This |

|O\rer\r|ew H Variations /SKUs || SEQ || Associations || Assets || Relations |

Add an association

Modify Existing Association: | CTS - | ‘ Edit Details | | Maodify Association | I Delete I
CTs
CTs
Pick ltem: | Sylvain Loichet - | Add ltem
Edit Command Name Sort Order Type

Page 1 of O (0 items)

5. Pick an item or items to add to the association. Click Add Item to do so.
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Product Edit

Cherview Variations /5KUs SEQ Associations Assets Relations

Add an association

Modify Existing Association: || CTS -
CTS
CTS
Pick Item: > | | Add Item
1 \ -
Edncqd — Chateau d’Yquem (=1 Sort Qrder
i .
= Chateau d“vquem 0

" Chateau dvquem
1 ;
M chateau d"¥quem

oK " chateau d'Yquem
" chateau Suduiraut
! Chateau Climens I}
M Bonneau Du Martray

M Syhvain Loichet

" chandon de Briailles -

6. Once you click on Add ltem, the item will appear in a list just below. You can have more than one item
tied to an association.

CTs
CTs
Pick Item: | | Chateau Climens - Add ltem
Edit Command Name Sort Order Type
X Sylvain Loichet 0 OPTIONAL
X Chateau Climens 0 OPTIONAL
1 Page 1 of 1 (2 items)
| (o]8 || Cancel |

7. Once you have added all of the items you wish click OK to save the changes.

Assets for Catalog Items

Introduction

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system. The Assets tab
is available on all of the details pages through the levels of your catalog. By default assets are displayed
on the front-end for Variations/SKUs, but any item of your catalog can have assets added to it. A devel-
oper can configure your templates to display assets and other details of any level of your catalog.
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Adding an Asset to a Product

You can associate and link various assets you have previously uploaded to the Asset Management sys-
tem.

Do the following to add an asset to a catalog item such as a product:

1. Under Catalog Management, open a catalog item for editing and go to the Assets tab.

2. Under Find Assets, select an item from the drop-down list and click Add Asset.

JERCE Product Edit

‘Overview H Variations /SKUs H SEQ H Associations ” Assets H Relations ‘

Find Assets: | - Add Asset

-

Croup Mame: D oot/ =

3 Root/videof
Edit Comma ') Root/Presentations/ I} Group Sort Order

i Root/Specifications/

m

Page 1 of 0 (0 items)
) root/Software/

|: = Root/Downloads/

) Root/User Guides/

i Root/Images/

= Root/Images/Package00/

i Root/Images/Package00/726678/

= Root/Images/Package00/726676/Small/
i Root/Images/Package00/726678/Medium/
= Root/Images/Package00/ 726498/

i Root/Images/Package00/726498/Small/
= Root/Images/Package00/726498/Medium/
i Root/Images/Package00/72644B/

= Root/Images/Package00/72644B/Small/
i Root/Images/Package00/72644B/Medium/
= Root/Images/Package00/65990B/

i'Root."Images,fPacI-cageDD,J’ESQQDB,J‘Small,f =

3. Enter a Group Name.

By default EPiServer Commerce offers three options with names that will allow the associated assets to
be correctly displayed on the product details page of the public site.

¢ Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page.
e Downloads - a "Downloads" tab will appear towards the bottom of the details page.

e Specifications - a "Specifications" tab will appear towards the bottom of the details page.

Overview || Pricing/Inventory || SEQ || Associations || Assets || Relations |

Find Assets: Root/Presentations/ T | |Add Asset

Croup Name: | PowerPoint

Edit Command ] Type Mame Croup Sort Order

Page 1 of O (0 items)

Ok || Cancel
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4. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

Overview || Pricing /Inventory || SEOQ || Associations || Assers || Relations

Find Assets: Root/Presentations / Presentation Powerpoint.pptx A

Croup Name: |default

Edit Command 1D Type Name Croup Sort Order

Pt 1 file Root/Presentati.... default 0

1 Page 1 of 1 (1 items)

| CK || Cancel |

5. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes

Relations for Catalog Items

Under the Relations tab the relations for a product will be displayed, and you can manage the categories
a productis linked to. This is useful in order to get an overview of all the different categories (nodes)
where a product will occur. This shows the full catalog path of the variation/SKU. Here the relations for a
product will be displayed, and you can manage the categories a product is linked to. This is useful in
order to get an overview of all the different categories (nodes) where a product will occur. A product can
for instance appear in the "French Market" category, as well as under "Daily Specials" and "Mixed Cases".

Browse to a product and open it for editing. The relations for the product will be displayed under the Rela-

tions tab.
) Welcome, admi
ERCE Product Edit
©ce
| Overview || Variations /SKUs | SEQ H Associations | Assets | Relations
o Name Catalog Full Path
>< Accessories Accessories Wine'\ Accessories
1 Page 1 of 1 {1 items)

Using Meta Classes and Fields
Introduction

The attributes, or the information about a particular product, can be customized using meta fields and
meta classes. Meta fields and meta classes are for adding specific data about an item. For instance, if
you create a meta class called "Wine" you will want to add meta fields that are characteristic for wine, for

instance "color", "taste", "vintage" and "maturity".

Refer also to related information in the sections Catalog Meta Classes and Fields and Order Meta
Classes and Fields.

Adding Meta Fields to a Meta Class

1. Go to Administration > Catalog System > Meta Fields.

2. Click on New Meta Field to create a new meta field.
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Dashboard ~ CMS Add-ons EPISERVER @ ? Ladmn Q

Commerce Manager Settings

EPISERVER COMMERCE Meta Fields

Welcome, admin

‘Welcome v Change Language About v @ CetHelp For This Page =
Administration 2 |[[¥newmera F'Efﬂl
([} Administration D Nirhe Type Multi-Language ~ Compare Search  History  Friendly Name
3 (] System Settings 25 ABY Decimal False True True True Alcohal
9437 Catalog System 26 Clasure ShortString True True True True Closure
@ Warehouses 27 Color ShortString True True True True Color
@ Tax Categories 28 Description LongHtmiString  True False True False Description
@ Meta Classes 239 DisplayName ShortString True True True False Display Name
ST 20 ExtendedDesription LongHtmIString  True False  True False Extended Desription
31 Margin Decimal False True False  True Margin Percentage
@] Order System . -
32 Maturity ShortString True True True True Maturity
23 Qrganic Boolean Falze True False  True Organic
34 Primarylmage ImageFile False False False Falze Primary Image
L| 35 RecommendBoost Intsger False False False  True Recommendation Boost
il 38 Region ShortString Trus Trus Trus True Region
ﬁ Dashboard 37 Size Flost Fals= Trus True True Size
38 Style ShortString Trus Trus Trus True Style
Cust M it
e 33 Taste ShortString Falze Trus Trus True Taste
= catalon Managerment 40 Type ShortString Trus Trus Trus True Type
41 Varieties ShortString Trus Trus Trus True Grape mix
nﬁ Order Management sz Vegans Boolean False Trus  False  Trus  Vagans
43 Vegetarians Boclean False Trus False  True Vegetarizns
IE Marketing a4 Vintage ShortString True True True True Vintage
!ﬂ Asset Management
Reporting < [} | '
. (20 items) | Page 41
Administration Page Size: [20 []

3. The Meta Field Edit page appears. There is a wide variety of parameters you can set for the meta field
depending on the type you select.

Name: Maturity

Friendly Name: Maturity
Maturity

Description:

Type: Short String

[¥] Supports Multiple Languages

[¥] Use in comparing
Allow Null values

[¥] Save History

[l Use Encryption

Search Properties: @ Allow Search

[T] Enable Sorting Search Results
[¥] Include Values in Search Results
[#] Tokenize

[] Include in the Default Search

l OK ” Cancel I

Description

Name Enter a system name without spaces or special characters (e.g. "NumberMegapixels," with-
out the quotes).

Friendly | Enter a user-friendly name seen by end-users on the back and front-end (e.g. "Number of
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Name Megapixels," without the quotes).
Descrip- | Enter any additional information about the meta field.
tion
Type The drop-down menu shows the field types you can use for the meta field. The types avail-

able are:

- datetime

- decimal

- float

- money

- Integer

- Boolean

- Date

- Email

-URL

- Short String

- Long String

- Long Html String

- String Dictionary

- File

- Image File

- Dictionary

Search Depending on the data field type selected, you may have the option to set the search prop-

Prtt?p- erties of the data field. The options are:
erties
- Allow search - allows for searching directly on this metafield.

- Enable Sorting Search Results - search results will be sorted on this metafield.

- Include Values in Search Results - when the search results is returned, the original value
of this metafield will be included with the search results.

- Tokenize - search is prepared for individual words in, for example a long product descrip-
tion property (word breaking).

- Include in the Default Search - feature which tokenizes and combines metafield values
for search from the front end site.

Adding Meta Field to a Catalog Meta Class
1. Go to Administration > Catalog System > Meta Classes or Administration > Order System >
Meta Classes.
2. The meta field you created will appear in the list of meta fields. Select a meta class, checkmark the
meta field you want to add to the meta class, and then click OK.
Catalog Batch Update

Introduction
As a catalog grows larger, you will want to utilize the batch update tool to update multiple catalog entries
atonce. The Catalog Batch Update option gives you the ability to quickly make multiple changes to your

catalog without having to update each catalog entry individually. When searching for catalog entries to
update, you can narrow down you results by using a set of filters.
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Updating Multiple Catalog Entries

Do the following to update multiple catalog entries:

1. Go to Catalog Management > Catalog Batch Update. The Batch Update screen appears.

- Welco

EPISERVER COMMERCE Batch Update

Welcome ¥ Change Language About™

Catalog Management el Main Adjustment it Filters
=
=~ Catalog Management Entry TYDE!  variation/Sku - Language: English {(United States) -
& Catalog Entry Search . .
Meta Class:  pefault Catalog Entry - Catalog/Category’ 4| catalogs -
@ Catalog Batch Update
=3 Catalogs blekis Entry - Name +  Keyword(s): Apply Filter
] wine
= ] Templates %Save All
Name Entry : Name
" Enoteca Wine Glass Small Enoteca Wine Glass Small
" Engteca Wine Glass Large Encteca Wine Glass Large
Wi faiters’ . v
E:IUEEHO[ECE\-NEI[EFS Friend Double Lever Corkscren Enoteca Waiters® Friend Double Lever Corkscrew Elue
(T i . . .
éec‘EnotecaWalterS Friend Double Lever Corkscren Enoteca Waiters’ Friend Double Lever Corkscrew Red
i i . .
\;Eugcluteca\walters Friend Double Lever Corkscren Enoteca Waiters’ Friend Doubls Lever Corkscrew Yellow
" Enoteca Decanter 1000ml Encteca Decanter 1000ml
" Enoteca Decanter magnum Encteca Decanter magnum
il

2. The Main Adjustment filters are divided by Entry Type, Meta Class, and Field. Entry Types in the
drop down menu include Product, Variation/Sku, Bundle, Package, and Dynamic Package. The
Meta Class and Field drop down menus depend on the Meta Class you selected, your selection
will then populate the Field drop down selections.

3. To narrow down your results, you can use the additional filters: Language, Catalog and Key-
words. If your entries are in more than one language and you want to edit a specific entry in
another language, you would want to apply the Language filter. If you want to narrow the results to
a specific catalog, use the Catalog filter to search for entries within that catalog. To narrow your
search even further, enter in Keywords, such as "Wine Glass" (without the quotes).

4. Within your search results, you can click on a specific catalog entry and go directly to its edit page.
Or by adjusting the Field drop-down menu, you can select which field you want to directly edit. For
example, if you have a list of variation/skus, and you want to change the display price for all of
them at once, you can change the Field drop-down menu to "Variation : Display Price." The right
column will then change, allowing you to directly edit the display price for all the catalog entries at
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once.

Welcome, admin |
€EPISERVER COMMERCE Batch Update ’

Welcome v Change Language About = @ Get Help For This Page - |

Catalog Management % || Main Adjustment Additional Filters

=
5™ Catalog Management Entry -
@ c Type: |2 TVPES [=] tanguage: English (United States) I
4 Catalog Entry Search - |
eta -
@ Catalog Batch Update Class. | Default Catalog Entry [=] caralog/cateaory: [y caralogs [=] |
Catalogs .
=] g Field: [ Enery  Name [z] Kewordes) Aoply Filter
] Templates
Iy save An
Name Entry - Name
W1 Enoteca Wine Glass Small Enoteca Wine Glass Small = |
M Enoteca Wine Glass Large Enoteca Wine Class Large

UM Enoteca Waiters' Friend Double Lever CorkscreW [ pngraca waiters' Friend Double Lever Corkserew Blue |

| Blue
il -
i faiters' ’
ﬁ Dashboard qyy oreR Walters' Friend Double Lever Corkseraw | gnoreca waiters' riend Double Lever Corkscraw Red
Q Customer Management U Encteca Waiters' Friend Double Lever Corkscrew | gnaecs waiters' Friend Double Lever Corkscrew Yellow |
s (| elow
~-| Catalog MZnagement W Enoteca Decanter 1000m! Enoteca Decanter 1000ml l

" Enoteca Decanter magnum Engteca Decanter magnum

E Order Management
IE Marketing

zﬂ Asset Management

Wine Glass Wine Class

Waiters Friend Waiters Friend

= Decanter Decanter i
[ remnsten | e (12 items) | Page 41
{Eﬁi Administration Page Size: |20 [v] |

5. When you are satisfied with your changes, click on Save All.

Editing and Deleting Catalogs
Introduction
Catalogs can easily be edited after they have been created, as well as entirely deleted from the site.

O Be aware that deleting a catalog may cause things to stop working on your site. Before delet-
ing your catalog you may also wish to export it to save for future use.

Editing a Catalog

Do the following to edit a product catalog:

1. Click the editicon to the left of the catalog you wish to edit.
2. You will be brought to the Catalog Edit page. Here you will see all of the catalog details.

3. Update the catalog information you want to change, for instance the name, currency or availability
for the catalog.
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Catalog Edit

Catalog Mame: Wine

catalog name descrigtion

Catalog owner: | (@) not Set e

Available from: 9/12/2011 _ﬁ 11:11 AM
Expires an: 9/12/2021 ]m 11:11 AM
Default Currency: Pound sterling -

Default Language:  gpgjish (United States) -

Base Weight: in kilograms

Other Languages: | Epglish (United States)

Cerman (Cermany)
Spanish (Spain)
French (France)

Sites:

Sort Order: 0

Available: @ Yes ® No

oK | | Cancel

4. Click OK to save your changes.

Deleting a Catalog

Do the following to delete a product catalog:

1. Atthe Catalog List page, check the box next to the catalog you wish delete.
2. Select More Actions and then Delete Selected, located in the menu bar.

3. Select OK to confirm the deletion. The chosen catalog will be deleted from the list.

Catalog List

L New Catalog ﬁ Import/Export ™ _21 More Actions ™

] Name X Delete Selected

s Wine

7
|
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-

Message from webpage @

:I Areyou sure you want to delete selected iterns?

Ok ] ’ Cancel

L

Cloning, Moving, Linking and Deleting

Introduction

Within your catalog (node) you may delete, clone, move, or link catalog entries or categories.

e Cloning allows you to replicate an existing entry perhaps as a start off for a second one. A dupli-

cate catalog entry or category folder will be created with a unique ID. Once created you can edit
the item to create a second similar item and/or place it in any location/hierarchy that you choose.

Moving allows you to control the structure of your catalog after items are created. This feature
allows you either to move an entry or category folder to a new location/hierarchy.

Linking allows you to link an item to another location in your catalog hierarchy so that the item
exists in two places and still acts as one item. For example, you can create a category folder
called "Featured Products." You can then link catalog entries to this category folder without having
to clone entries and clutter your catalog with duplicates.

Linked items will have the same ID. Also, if you make changes to content on the original entry
page and that same productis part of the "Featured Products" category as a linked entry, the
changes will be displayed in both locations. In other words, changes are bi-directional. Note that
links can be broken if either of the two are deleted.

All options are available in the Node List under More Actions, when selecting a category (node) under
Catalog Management. The same procedures can also be applied to catalog entries, by expanding a cat-
alog and selecting the desired catalog entries instead of categories.

Node List

=y
D Create New ™ ¥ More Actions ™

Name >( Delete Selected

ODoOo&E

D Acce =% Clone Selected
(= Impq 23 Move/Link to folder
D Mixed Cases

= Wine Region

Cloning a Category/Catalog Entry

Do the following to clone a category/catalog entry:
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—_

Expand the Node List under Catalogs.
Check the box next to the category folder you want to clone.

Select More Actions and then Clone Selected to clone the category.

B ow N

The entry is successfully cloned and added to the Node List. You will notice that all of the details
are exactly the same, with the exception of the ID.

Moving a Category/Catalog Entry
Do the following to move a category/catalog entry:
1. Expand the Node List under Catalogs.

Check the box next to the category you want to move.

Select More Actions and then Movel/Link to folder to move the category.

2
3
4. Selectthe folder you want to move the item to.
5. Click OK to save.

6

The item will no longer be in your current node list. You can verify the move by navigating to your
selected move location.

Linking a Category/Catalog Entry

Do the following to create links between categories/catalog entries:

1. Expand the Node List under Catalogs.
Checkmark an entry or category you want linked back.
Select More Actions and then Movel/Link to folder to create the link.

2
3
4. SelectLink to folder and select the link destination from the drop-down menu.
5. Click OK to create the link to that category under that directory..

6

Your item is now linked. Any changes made to the linked items will be reflected in both instances.
Deleting a Category/Catalog Entry

Do the following to delete a category/catalog entry:

1. Expand the Node List under Catalogs.
2. Check the box next to the category you want to delete.

3. Select More Actions and then Delete Selected to delete the category.

Order Management

Introduction

Order Management is a central part of the e-commerce system. Since the majority of orders will be
created from the front-end site, the ordering process is usually automatic following an order management
workflow, butin some cases orders need to be manually managed. The Order Management system pro-
vides shopping carts (baskets), order capture, order fulfillment, payment functions and item return or
exchange support.

Meta Classes and Fields for Products

You can define your own meta classes and meta fields for both products and orders in Commerce
Manager. For instance, if you create a meta class called "Wine" you will want to add meta fields that are
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characteristic for wine, for instance "color", "taste", "vintage" and "maturity".

When meta fields and classes have been created, they will be available for usage when working with the
product catalog. Meta classes and fields for catalogs are defined in the Catalog System part of System
Administration. For more information, refer to Setting up Meta Classes and Fields.

Working With Order Management
The work with orders includes the following tasks:
e Browsing orders for example to monitor order status and find specific orders
e Creating orders - different ways of creating orders, adding payment plans and split shipments.
e Managing shopping carts and turning them into orders.
e Processing orders - adding payments and preparing the shipment.
e Managing shipments - processing shipments and creating picklists for orders including returns.
e Managing returns and exchanges - processing returns and product exchanges.
e Editing and deleting orders - the cancellation and deletion of orders.

Refer to the Shopping Workflow section for a general description of the shopping procedure in EPiServer
Commerce.

Browsing Orders
Introduction

The majority of your orders will be created on the front-end by customers in the online store, and you will
most likely have a significant amount of orders in your system. In this section we will describe different
ways of finding specific orders whenever you need to manage them manually.

Using Order Search to Find Existing Purchase Orders

Order Search allows you to find existing orders, giving you six different search filters to help refine your
search results. You can click on the ID number of the order to view it.

EPISERVER COMMERCE Order Search

Welcome ¥ Change Language About ™

Order Management 2 || Class Type: | Purchase Order [+] Return
5'f Order Management Status [Any] [=] ID:
(C), Order Search Date Range: | All [=] Customer

23] Purchase Orders
= Today

D D Customer Total Status Last Modified

[[] POU485 Mary Smith £39.98  InProgress  Today, 11:45 AM

@ This Week
@ This Month [[] PO08SD  Mary Smith £59.98 Cancellad Today, 10:43 AM

Filter Description

Name

Class Select "Purchase Orders" on the drop-down list. Otherwise, if you want to
Type search for a specific shopping cart or payment plan, select those.

Status You can filter results by their statuses. For example, if you want to find only

completed purchase orders, select from the drop-down list "Completed".

Available status options are:
e OnHold
e PartiallyShipped
e InProgress

e Completed
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e Cancelled
e AwaitingExchange

Date You can select from date ranges from "today," "last week," or "this month."
Range

Return# | Enter the return number of a purchase order if a return was created for that par-
ticular order.

ID You can specify the order ID. Orders created out of the box with EPiServer
Commerce are typically numbered as PO###.

Customer Enter a customer name and the search results will return only orders filtered
by the specified name.

Click on Search to being your search query. The desired results appear below. The results are broken
down by five column fields:

e ID

e Customer (name)
e Total (cost of order)
e Status

e Modified (date)

You can sortresults by ID, Customer, Total, or Status.
Viewing Purchase Orders by Date or Status

In the left navigation menu, you can click on the nodes below Purchase Orders and Purchase Orders
by Status. For example, clicking on Purchase Orders > Today will show the orders created today only
on the right window.

EPISERVER COMMERCE Order List

Welcome T Change Language About ™

Order Management 2 || [INew Order X Delete Selected
j‘g Order Management B o Customer Total Status Last Modified
| BRI ] Poosss Mary Smith s33.98 In Progress Today, 11:46 AM
D[] Purchase Orders
[F] Po0ss0 Mary Smith $39.98 Cancelled Today, 10:45 AM
Today
[ Po76S7 Hiep Khuc 5499.08 In Progress Today. 10:26 AM

)
= This Week
@ This Month
@

All

Moreover, you can view orders within the Order List by status. For example, click on Purchase Orders
by Status > InProgress to view orders with that status.

EPISERVER COMMERCE Orders by Status

Order Management 2 || [INew Order ¥ Delete Selected
j‘g Order Management F Customer Total Status Last Modified
IRk [ Poo4ss Mary Smith 539,38 In Progress Today, 11:46 AM
@[] Purchase Orders
Purchase Orders By S [[] Po7857 Hiep Khuc $499.98 In Prograss Today, 10:26 AM
= j 'urchase Orders By Status
~ OnHold [ Posss1 Hiep Khuc $967.44 In Prograss 2/18/2011 11148136 AM
(] PartiallyShipped [ Po1s37 Hiep Khuc $451.99 In Progress 2/18/2011 5:58:27 AM

[~]InProgress

(] Completed
(] Cancelled

(] AwaitingExchange

The Catalog Search function enables you look for specific sales items stored in EPiServer Commerce.

Click on Order Management and then Order Search
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Order Management i

:I‘ﬁ Order Management
-'j; Order Search
:lﬂ Purchase Orders
B Today
B This Week
B This Month
oAl
#_] Purchase Orders By 5tatus
H (] Carts
+ ] Payment Plans (recurring)
& |_] Shipping/Receiving

Creating Orders
Introduction

Most orders are created by customers from the front-end part of the website, butin some cases it might be
necessary to create orders manually from within Commerce Manager. You can create orders either from
within Order Management, or directly for a Contact in Customer Management. The order management
option is the most common way to create an order.

Compared to the customer management option, itis faster and has additional alternatives for orders such
as Purchase Order versus Payment Plan. Using the Customer Management system takes a little longer
but allows you to double-check a customer's information before beginning an order.

When an order has been created in this step it appear in the Purchase Orders list with the
order status "In Progress".

Creating an Order from Order List

1. Go to Order Management > Purchase Orders.

2. Click on New Order. A pop-up appears, allowing you to select the site and contact to apply the new
order to. Use the drop-downs to make your selections. For Customer, if your customer is not listed select
More to search for them.
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Commerce Manager

Add-ons

Settings

EPISERVER @ ? L admin

Q

Welcome, admin
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EPISERVER COMMERCE Order List
Welcome v Change Language About + @ Get Help For This Page =
Order Management
New Order X

d'g Order Management
2 Order Search

S [5] Purchase Orders

@ Today

@ This Week

@ This Month

@ All
® ] Purchase Orders By Stat
®] carts
@[] Payment Plans (recurrin,
@[] shipping/Receiving

i ]+

<
ﬁ Dashboard

'g Order Management

Customer Management
- - 000 000 |

=
Catalog Management

E Marketing

rﬂ Asset Management

Reporting

Site:

Customer.

[No sites available]

(@) Mot Set v

m

% Cancel

oy

3. Click OK once your selections are made .

Filling Out the Purchase Order

1. Enter basic order information.

—Basic Order Info

Customer:
Currency:

Coupon Code:

admin

US dollar (|

1234567 |

« Apply

Description

Customer | This is the name of the contact.

Currency | Select from the drop-down list the currency to associate with the Purchase Order.

Coupon

chase Order. Click Apply once code is entered.

Coupon codes created with a promotions can be applied here to associate with the Pur-

2. Click New Item to select the items in the site catalog to associate with the Purchase Order. A pop-up

windows appears allowing you select items from a site catalog.

New Item | # Delete
[ |io MName

Page Size: | 20 |E|
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3. Search for items by entering your search terms into the search field and click Find. You can sort your
search results alphabetically by clicking the Name column. Select an item from the list and click on Con-

figure Selected Entry.
Mew Line ltemn *
bardeaux M ol
Picture Name b Catalog Type Price In Stock
-
Mixed Cases France Variation £8,346.035 1000
Ch. Plantey Canteloup France Variation £6.95 i000 L
Chateau Langoa-Barton France Variation £47.00 1000 =
Chatezu Bellevua France Variation £43.00 1000
Chateau Pichon-Longueville Lalande France Variation £215.00 1000
Page Size: 20 (584 items) | Page4112345 ... F i
Cancel | | Configure Selected Entry

Advanced Search

You can apply three filters to refine your item search results.

MNew Lineltem

Adwvanced Search

Select catalog |E| Select language E Select entry type IE'

Description

Select catalog Select which specific catalog to search
Selectlanguage  Select a specific language (such as German) for items described in German

Select entry type | Select a specific type of entry, such as variation/SKU or bundle

Configuring the Selected Entry

1. Before you add the item to the order, you can configure the actual price, the quantity, and apply a per-
centage or discount based discount.
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New Line lterm *

»

Selected Entry: Chateau Langoa-Barton i

»

Display Price: £47.00

Price: 47.00

Quantity: |1

m

In Stock: 1000, Reserved: 0.

Discount:  enter descr here 0 Percentage Based ~

m

Discount description  amount

Total: £47.00

4 m |

Back I | Add item to the order |

Required Fields

e Price
e Quantity
Display This is the price seen on the public website. This is set at the catalog entry level.
Price
Price This is the actual cost of the item that will be charged when the item is added to the order.

Quantity Set how many of the item to add to the order.
Discount | You can apply a discount to the item, either Value or Percentage based.

Total The total is automatically calculated, factoring in the actual price, quantity, and any dis-
counts applied.

2. Once the item is configured, click Add item to the order. The item will appear on the Purchase Order
form.

= New ltem | ¥ Delete
D [[o] Name Quantity List Price Total Discount
D ELCBOOOSOVTFS6E Nextware iPhone Screen Protector 2-phk. 1 $19.9% $19.99 $0.00
Page Size:| 20 |z| (1 frems) ||

Completing the Rest of the Purchase Order Form

1. Enter a Billing and a Shipping Address.

When entering the Shipping or Billing Address, you can select an existing address associated
with the contact, if any.
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Postal Code
Day Phone
Evening Phone
Email

[7] Add to customer's address book

Postal Code:
Day Phone:
Evening Phone:

Email:

~Billing Addre: /~Shipping Addre:
Address Add new address Address |Add new address hd
[Clsame as Billing Address
Name
Name:
First Name:
First Name:
Last Name:
Last Name:
Line 1:
Line 1
Line 2: .
Line 2:
City:
v City.
Country Name: United States
v [=] Country Name United States [=]
State: Alabama [+] state: Alabama =

D Add to customer's address book

Checkmark Add to customer's address book if you want to save the address to the contact.

If the Shipping Address is the same as the Billing Address, click on Same as Billing Address. The
Shipping Address form is auto-populated with the information entered in the Billing Address form.

Select the kind of shipping to use for the order under Shipment Details. Select from the drop-

down the shipping methods (add link) available.

3. Click on Recalculate to generate the cost summary.

~—Shipment Details:

Shipping method: |Fixed Shipping Rate

|33 Recalgulate

~Summary

Item Subtotal:
Shipping Cost:

Less Shipment Discount;
Total Before Tax:
Itermn Taxes:

Shipment Total:

519.95

310.00

50.00

519.95

50.00

$259.95

4. Click OK to save the order.

Creating an Order Within a Contact

1.

Go to Customer Management > Contacts and create or click on an existing contact. The contact

details appear.
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2. Click on New Order.

Dashboard CMS ey Add-ons EPISERVER @ 7?7 Ladmn Q

Commerce Manager Settings

. ) Welcome, admin
EPISERVER COMMERCE Information
Welcome ¥ Change Language About ~ @ Cet Help For This Page =
Customer o] o
i ¥ Edit Delete Contact Contact: New Orgl E
R it | % Delete Contact | EJ Contacts | |[]New Orge
=4 Customer Management Full Name: admin Parent Organization:
da] Organizations
[g Contacts Information Information
= -
& Roles || - contact
@ Gift Cards Addresses : i
Credit Cards Full Name: admin Customer Group:
Security First Name: admin Preferred Currency:
Roles
Orders Middle Name: Preferred Language:
Order Histary Last Name: Registration Source:
Shopping Lists -
Parent Organization: Last Order Date:
Wish Lists
Shopping Carts Preferred Shipping
Address:
[ Preferred Billing E
Address:
— Account ———— — Edit Account | Change Password | Remove Account —,
ﬁ el User Name: admin Is Locked Out: none
m Customer Management Description: Last Activity: Today, 1:23 PM
El Tolas Uomreme Email: admin@yourcompany.com Last Login: Today, 12:49 PM
Last Password
g Order Management Changed- Today, 6:19 AM
% Marketing
ﬁ Asset Management
=
{ﬁ Administration m

3. The New Order pop-up window appears. Select the site to apply the order to and click OK.

4. The Purchase Order New form appears, allowing users to enter basic information about the
order.

5. Follow the steps under Creating an Order From Order List above to complete order.

Processing Orders
Introduction

The order processing or fulfilling, includes adding a payment and releasing the order for shipping.
These steps are needed in order for the order to be completed and ready for shipping to the customer.
When the payment is cleared the order will be released for packing and shipping. Depending on how
your system is set up, this process may be automatically handled by the system. In these examples we
will describe how the procedure is done manually.

When an order has been processed and relesed for shipping in this step it will have the status
"In Progress" in the order list, and it will appear in the Released for Shipping list under Ship-
ping/Receiving.

Submitting Payment and Releasing to Shipping

Do the following to add a payment and release an order to shipping:

© EPiServer AB



108 | User Guide for EPiServer Commerce 1 R3

1. Go to the Order Management and open the order you wish to add a payment for and process

2. Add a paymentto the order.

[ Add Note §-JSend Notifications = Add Order Address

Order No: POOSS0 Customer: Mary Smith

Order Total: 559.93 Status: InProgress

| Summary | | Details | | Payments | | Returns | | Notes
Create Pa"'m'ﬁ'.:‘j

|:| I'\Jarﬁ‘\-_—-‘| Transaction Type Amount Status
|

Page Size: | 100[x|

Enter the amount of the payment. The Amount field auto-populates the value of the total order,

including shipping costs. However, you can change the value of the payment (useful for splitting
payments between two or more payment methods at the request of the customer).

4. Selectthe Payment Method from the drop-down list.
5. Click OK. The order goes into Edit Mode.

The Order is in Edit Mode. Save changes before exiting. | v Save | | # Cancel
mﬁ\dd Mote & 5end Motifications ﬁﬁ\dd Order Address
Order No: PO2427 Customer: Mary Smith
Order Total: £56.00 Status: InProgress
| Summary | | Details | | Payments | | Returns | | Notes
Create Payment
[ MName Transaction Type Amount Status
[[1 % PayByPhone 86.00 Pending
Page 5ize: oo *

Note: When in Edit Mode, you can add more payments to the order. However, once you click
Save, you finalize the payment. This means that you cannot add or delete any further payments
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Once you have finished adding one or more payments, click Save to exit Edit Mode and save your
changes. The payment gets automatically processed for the amount specified.

RCE Order

[ AAdd Note [ Send Notifications = Add Order Address

Order No: PO0330 Customer: Mary Smith
Order Total: 55598 Status: InProgress

| summary | | Details || Payments || Returns || Notes
|:| Name Transaction Type Amount Status

|:| Pay By Phone Sale 59.9800 Processed
Page 5ize: | 100 El

7. Check the Details tab. You will see that the Shipment Status has changed to "Awaiting Inven-

tory." Once the availability of the item has been determined, click on Release Shipment to release
the order to your shipping department.

| Summary ‘ | Details | | Payments ‘ | Returns | ‘ Notes
Shipment # 1

Naw Line ltem * Delete

= 1D Name Quantity  List Price

Placed Price  Total Discount Discount Description Total

[} Ea' 830178 Chateau Bellevue 2.00 £43.00 £43.00 £0.00 £86.00

Page Size: 1gp -

~— Shipping Information

Shipping Address:

1 First Street, Hometown, Alabama, 81818, United States

Shipping Method:
Free delivery (2-3 days)
~— Shi Si ry Shi

Status

Item Subtotal: £86.00 Status: Awaiting Inventory

Returns/Exchanges
Shipping Cost: £0.00 (

Shipment Total: £86.00

!l

Release Shipment

Cancel Shipment

Promotions

Type Name

Coupon Code

8. By clicking on Release shipment, the status changes to "Released." For further processing of the
order, your shipping department will go to Order Management > Shipment.

O If you click Cancel shipment, you will end up canceling the entire order. (At the moment, there
is no way to undo the cancellation, so you must be careful.)

Refer to Splitting Shipments for more information on how to split shipments. Refer to Setting up Payment
Plans for information on how to work with recurring payment plans for orders.
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Splitting Shipments

Introduction

If there are two or more items within an order, they can be split into separate shipments. This is useful for
expediting items within the order that are immediately ready for shipment, while other items have extra
shipping lead time. It can be useful for shipping multiple heavy items to the same customer, back-ordered
items, or a large volume of items for ease of delivery and pickup. A shipment can be split as many times,
up to the number of items in a single order. Note that the order must have two or more items in order to

be able to split shipments.

Splitting a Shipment for an Order

Do the following to split a shipment for an order:

1. In Order Management, go to an existing purchase order or create a new one.

2. Go to the Details tab in the order form. Look for Shipment # 1.

i:‘Add Note ﬁSend Notifications ?Add Order Address

Order No: PO0GG3 Customer: |ohn Browne

Order Total: 5225];30 Status: InProgress

| Summary ‘ | Details | ‘ Payments || Returns || Notes
Shipment # 1
=/ New Line Item X Delete
D o] Name Quantity List Price Placed Price  Total Discount Discount Description  Total
= E' 745218 Domaine de Montille 2.00 £69.00 £69.00 £0.00 £138.00
£
= [ 748388 Maison Camille Giroud 4.00 £22.00 £22.00 £0.00
B R

£88.00

Page Size: 1pp *

3. Select the item you want to move by clicking on the Move icon.

Shipment # 1

New Line ltem x Delete
|:| [} Name
(] & 745218 Domain

[ =FE

748386 Maison

Page Size: 7o *

4. The pop-up appears, which allows you to choose to move the item(s) to an existing shipment or
create a new shipment. You can also select the quantity of the item to move. Each new shipment
within the order can have its own separate shipping address and shipping method. Select a ship-
ping address and shipping method from their respective drop-down lists. Click OK to save your
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changes.

Mowve Line ltemn

*

EEuantit\.r to move: 4
() Mowe to existing shipment

@ Create new shipment

Address: 123 Sunset Avenue, Suntown, Marshall Islands, 765432, l\:-,
United States

Shipping ]

Method- Free delivery (2-3 days) -

W 0K | | # Cancel

5. After splitting the shipments, the order form goes into Edit Mode. The Details page shows the new

shipment, which can be processed completely separate from one another, but tied to a single pur-
chase order.

The Order is in Edit Mode. Save changes before exiting. ‘ + Save | | A Cancel

mAdd Note @ Send Notifications ETAM Order Address

Order No: PO0BG3 Customer: John Browne
Order Total: £226.00 Status: InProgress
‘ Summary | ‘ Details ‘ | Payments ‘ | Returns | ‘ Notes

Shipment # 1

B New Line ltem | |)( De\em||

D 10 MName Quantity List Price Placed Price  Total Discount Discount Description  Total

=] E@ 74s21e Damaine de Mantille 2.00 £69.00 £69.00 £0.00 £138.00

Page Size: 1pg *

~ Shipping Information

Shipping Address:
123 Sunset Avenue, Suntown, Marshall Islands, 765432, United States
Shipping Method-
Free delivery (2-3 days)
— Shi 5 ' i Status Returns/Exchanges
Item Subtotal- £138.00 Status- Inventory Assigned ( __C EapEr
Shipping Cost:  £0.00

Shipment Total- £138.00

Release Shipment
Cancel Shipment
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Shipment # 2

New Line ltem | ¥ Delete

= (b Name Quantity List Price Placed Price  Total Discount Discount Description Total

=] E 748388 Maison Camille Giroud 4.00 £22.00 £22.00 £0.00 £88.00

PageSize: 10g

-~ Shipping Information

Shipping Address:

123 Sunset Avenue, Suntown, Marshall Islands, 765432, United States
Shipping Method:-
Free delivery (2-3 days)
— Shi 5 y Shij Status Returns/Exchanges
Itern Subtotal: £88.00 Status: Inventory Assigned ( l:l
Shipping Cost-  £0.00 l:l
Shipment Total: £88 00
T —
[ —

6. Click Save to save your changes.

Setting up Payment Plans

Introduction

Payment plans work exactly like orders, except that you use them spread out the payments over time that
a customer has to make. This allows flexibility in how you sell your products, as well as how a customer
pays for them. You can use this for large and complicated orders, orders that need to be shipped in
sequence, or just expensive items.

Payment plans can be setup by the Customer Service Representative (CSR) to generate recurring pay-
ments. An example recurring payment would be for magazine or grocery subscriptions. Payment plans
are handled in the background by a scheduled Quartz job which should be configured by your IT team

based on your business needs.

Creating a Payment Plan
1. Go to Order Management > Payment Plans (recurring). You will open up the Payment Plans
List. To create a new payment plan, click on New Payment Plan.
2. Select a customer contact to attach the payment plan to.

3. The Payment Plan New page appears. Complete the form as you would when creating a new
order.
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4. Under Payment Plan Details, you will set the cycles and parameters of the payment plan.

~—Payment Plan Details o

Plan Cycle (en-Us): Mo cycle -
Cycles mode is used to define period for recurring payments.
Can be day, week, month, Year or Cusiom.

Cycle Length (en-
usy: Cycle lengeh in units of cycle mode.

Max Cycles (en-U5):
Number of maximuim cycles (o process

Completed Cycles

(en-Us): Number of completed cycles

Start Date (en-US):  [2/23/2012 o219 eM
Plan start date

End Date (en-US): 2/23/2012 i o219 PM

Flan end date

) (71 True (@ False
Is Plan Active (en-

Us): Ser to true if plan s active
Last Transaction 272372012 :ﬁ 02:19 PM
Date (en-Us): The date of fast transaction

5. Once the payment plan is configured, click OK.

Fild __[Deseripton |

Plan Cycle You can choose from the following plan cycles, which determine how often the cus-
(Cycle Mode) tomer is charged.
- No Cycle: No recurring payment is created. The customer is charged once when
the initial purchase order is created.

- Daily Cycle: recurring payment happens daily from start date.
- Weekly Cycle: recurring payment happens weekly from start date.
- Monthly Cycle: recurring payment happens monthly from start date.

- Custom1/Custom2: these are placeholders for developers to create custom cycles
within the Mediachase.Commerce.Orders.PaymentPlanCycle class.

Cycle Length Entering a value of 1 or higher determines the unit of time for the Plan Cycle. For
example, if the Plan Cycle is set to "Daily," and the Cycle Length is "3," then a trans-
action occurs every three days. If the Plan Cycle is set to "Monthly" and the Cycle
Length is "1," then a transaction occurs once every month. If "2," every two months,
etc.

Max Cycles Determines the maximum number of cycles to run for this payment plan. For exam-
ple, if the Max Cycles is set to "2," then the maximum number of transactions cycles
is two and then the payment plan stops. Set the Max Cycles to "0" if you wish to run
the payment plan indefinitely.
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Field Description

Completed This tallies the number of completed cycles so far after the payment plan was

Cycles created. When initially creating the payment plan, set this field to "0".

Start Date Set the start date and time to determine when the payment plan should begin (begin-
ning recurring transactions).

End Date Set the end date and time when the payment plan should end (ending recurring

transactions).

Is Plan Active Set "True" to enable the payment plan. Set "False" to create the payment plan but
keep itinactive.

Last Trans- Logs the last transaction date. The date and time already in those two fields when
action Date first creating the payment plan should be keptas is.

Payment Plan Order Detail Page Explained

The payment plan begins once the first purchase order is generated. The purchase order can be created
manually (by clicking on Create First Purchase Order) or automatically by the payment plans quartz job.

After creating a new payment plan, a new Order page appears. This is slightly altered from the original
Order detail page that appears after creating a new order. The changes include:
e Inability to manage shipments (i.e. release shipments for further processing)
e An Orders tab that shows a history of processed purchase orders from this payment plan
e A"Create First Purchase Order" button thata CSR can manually click on to create the first pur-
chase order related to this payment plan. The button disappears after creating the first purchase

order manually or when the payment plan quartz job runs and generates the first purchase order.
Once that first purchase is generated, the payment plan goes into effect.

e The purchase order number that is generated includes the parent ID of the payment plan. For
example, if the payment plan parent ID is 35, the subsequent purchase orders are numbered as
"PO35XXX."

e When a paymentis added to a payment plan, the customer is not charged. The customer is
charged once the purchase order is generated for the first time (and through subsequent pur-
chase orders). The payment plan simply collects the payment information until converted to a pur-
chase order.

Editing and Canceling a Payment Plan

1. To editan existing payment plan, go to Order Management > Payment Plans (Recurring) or
Today/This Week/This Month/All. Click on the payment plan ID number to open the payment
plans order details page and make edits.

2. To cancel a payment plan, when editing a payment plan, click on the Summary tab and then click
on Cancel Payment Plan.

Creating a Recurring Payment Plan Using Authorize.Net

Out of the box, EPiServer Commerce supports Authorize.net as a recurring payment plan gateway.

For more information on how to setup payment methods, refer to the Payment Gateways section.

1. Go to Administration > Order System > Payments > (Language) and create a new payment
method or click on an existing payment method (such as "Pay by Credit Card").
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2. When setting up the parameters of the payment method, select this class name:

Class Mame: Mediachase.Commerce.Plugins. Payment. Authorize AuthorizePaymentGateway -

Select "Yes" for Supports Recurring.
Click OK.

Click on the name of the payment method again and click on the Parameters tab.

o ok~ w

Configure your Authorize.net account for both regular payments and recurring payments.

Ohverview Parameters

Configure Authorize Net Account

Cet an Authorize Net account at www.authorizenet.com.

APl Userld: AySBFUWTjm

Transaction Key. 4camw927n8ulfs)s
Regular Payments

Processing Url: https:  /test.authorize.net/gateway /transact.dll

Payment Options: L
¥ . @ suthorization

1 Zale

Recurring Payments

Processing Url: https:/ /apitest.authorize.net/xml/v1 [request.api

Recurring Method:  |ntarnal -

Cancel Status: OnHold -

a] 4 Cancel

Editing, Canceling and Deleting Orders
Introduction

Orders can be edited after they have been created, which is useful when you need to update for instance
the items for the order or the shipping information. Orders can also be deleted if needed. Both of these
tasks are done from Order Management.

When an order is canceled it will still be visible in the order list but the status will change to
"Canceled". When an order is deleted it will be completely removed from the order list.
Editing an Order
Do the following to edit an order:
1. Go to Order Management.

2. Inthe order list, select the order to edit.

3. Editthe order changing any desired fields under Summary, Details, Payments, Returns and
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Notes.
4. When done, save the order by clicking Save.
Canceling an Order
Do the following to cancel an order:

1. Go to Order Management.

2. Inthe order list, select the order to cancel.

w

Under the Summary tab, click on Cancel Order. This will completely cancel the order. The status
of the order changes to "Canceled" but it will remain in the order list for viewing.

4. The cancellation of the order will be logged under the Notes tab.

Order No: POO0OB50 Customer: Mary Smith
Order Total: 359.93 Status: Cancelled

| summary | | Details | | Payments | | Returns | | Notes
New Item

|:| Originated By Date/Time Mote Text

|:| 5 admin 2/21/2011 :4%:43 AM MNew order placed by admin in ConsoleManager
|:| B admin 2/21/2011 10116 AM MNew Other payment in the amount of $59.98 added to order
|:| 7 admin 2/21/2011 10:08:10 AM Shipment 10 status changes to Released

|:| 8 admin 2/21/2001 1:11:21 AM Order status changed to Cancelled

] I i

Page Size: ]DDE-\F

Deleting an Order
Do the following to completely delete an order:

1. Go to Order Management.
2. Inthe order list, select the order(s) to delete.

3. Click OK to confirm the deletion.

Shipping and Receiving
Introduction

Shipping and Receiving is splitinto two areas: shipments and returns. Shipments control both items
released for shipping and "pick lists", or items that have been packed and are prepared for ship-
ping/ready to be picked up. "Returns" are incoming items that have been return by customers for some
reason, for instance faulty items that need to be replaced by exchanges. Returns are processed in a sim-
ilar way as outgoing shipments.

The final parts in completing the order processing includes these tasks:

e Creating picklists for picking up the physical items in the warehouse.

e Completing the shipment by preparing the physical package to be shipped.
Shipments and returns can be viewed and monitored as described in the following sections.
Viewing Shipments

The Shipments view contains information as described below.
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EPISERVER COMMERCE Released Shipments

Welcome ¥ Change Language About ¥

Order Management i Warehouse: | Default Warehouse Iz‘
j‘ﬁ Order Management

B4 Add Shipment to Picklist

() Order Search

|:| Order Created Last Modified B
) Q Purchase Orders
&[] Purchase Orders By Status [ W 2/18/2011 9:58:27 AM 2/18/2011 9:58:27 AM PO1537-2
[ Carts [C] ) Today. 11:46 AM Today, 11:46 AM PO0485-11

&[] Payment Plans (recurring)
=) Shipping/Receiving
= Shipments {l“"j

| B Released for Shipping

@ Pick Lists

E:'Q Returns

Order Created

This column specifies when an order was created. This is useful, for example, if you want to ship orders
by date and time.

Last Modified
If any changes were made to an order, a date stamp for its last modification will be displayed here.
Number #

This column is for the individual IDs assigned to each order. The first number is the unique tracking
number we described under Purchase Orders. The second number is the unique tracking number
assigned to the order for shipping purposes.

Customer

The full name of the customer as it appears on the package. This is useful, for example, if you want to ship
orders all together to one customer.

Shipping Method

Specifies the shipping method used by each order. Depending on how many methods of shipping you
have specified in the administration area, a different shipping method can show up in this column.

Address
The Address that the package is being shipped to.
Warehouse

A warehouse is (most likely) a physical location where you store your goods before delivery. You can
select from any of the warehouses you have putinto your system. Remember to select the correct one
when attempting to check for shipments. The Default Warehouse can be changed to any name you
desire. This can be changed in the System Administration section of the Commerce Manager. If you have
only digital products, the default warehouse should be more than enough.

Viewing Received Items

ltems that have been returned are managed as incoming packages and can be tracked under Returns
under Shipments in the Shipping/Receiving area of Order Management.

Creating Picklists
Introduction

After you have created an order and processed the order, its status is now "Released for Shipping." Add-
ing an order to an existing picklist or creating a new one is an important part of moving an order in the
workflow. Without this, orders cannot be completed nor shipped and this is one of the last steps to com-
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pleting a purchase order. The shipment will be added to a picklist, and the warehouse will be selected
where the physical item will be packed and shipped from.

When an order has been added to a picklistin this step it will have the status "In Progress" in
the order list. It will disappear from the Release for Shipping list and appear in the Picklist list-

ing under Shipping/Receiving.

Creating Picklists and Adding Shipments

1. Go to Order Management > Shipping/Receiving > Shipments > Released for Shipping. This
shows the Released Shipments screen.

EPISERVER COMMERCE

Released Shipments

Welcome ¥ Change Language About ¥

Order Management Ee"

j‘ﬁ Order Management
[_;‘ Order Search
) @ Purchase Orders
] Purchase Orders By 5tatus
] Carts
&[] Payment Plans (recurring)
== Shipping /Receiving

= Shipments {l“"j

B Released for Shipping

@ Pick Lists

E:'% Returns

Warehouse: | Default Warehouse Iz‘

B4 Add Shipment to Picklist

1 Order Created Last Modified #
I:‘ 0 2/18/2011 9:58:27 AM 2/18/2011 9:58:27 AM PO1537-2
D 0 Today, 11:45 AM Today, 11:45 AM POO485-11

2. Selecta Warehouse from the drop-down list to determine where the item ship be packed and

shipped from.

3. Checkmark which orders you want to add to the Picklist and click Add Shipment to Picklist.

EPISERVER COMMERCE

Welcome ™ Change Language About ¥

Released Shipments

Order Management ,:G‘

= 'g Order Managemant
[_;1‘ Order Search
H @ Purchase Orders
® (] Purchase Orders By Status
# (] Carts
# [ Payment Plans (recurring)
=15 Shipping/Receiving
= Shipments

Warehouse: Default Warehouse lz‘

P’Q,ﬂ\dd Shipment to PickI['Ed

B Released for Shipping

@ Pick Lists

iy Returns

[ Order Created— Last Maodified #
D ﬂ 2/18/2011 9:58:27 AM 2/18/2011 9:58:27 AM PO1537-2
ﬂ Today, 11:45 AM Today, 11:45 AM POO485-11

4. The Add Shipments to Pick List pop-up appears. You can choose to create a New Pick List (by
default, the List Name shows the date and time the Pick List was generated) or add the chosen
shipment(s) to an existing Pick List you can select from the List Name drop-down list.
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Add Shipments to Pick List b4

@ Create New Pick List

List Name: |2011-06-16 16:36
()Add to Pick List

List Name: IE‘

| " OK | | * Cancel

5. Click OK to save your changes.

O Note thatitis currently not possible to change the picklist name, default is date and time.

Completing Shipments

Introduction

This is the final area for an order where you prepare the actual physical shipment by assigning tracking
information, preparing packing slips and "sending the package out of the door". Once this has been done,
the order is completed. This also means that the order becomes available for creating returns if needed,
since returns can only be created for completed orders.

When an order has been completed this step it will have the status "Completed" in the order
list and will disappear from the Picklist listed under Shipping/Receiving. The picklist will still
remain in the list even if there are no packing shipments remaining.

Completing a Shipment

There are two ways to complete a shipment which are described in the following.

Method 1

1. Select the box next to the shipment and then click Complete:

Packing Shipments

;ZICDmpIEtE %Print Picklist EJPrint Packing Slip >( Remove from Picklist

|:| Last Modified - Customer Shipping Method
|:| [ | ;2] 6/16/2011 12:09:53 PM PO4563-4 Carlos Nevada Fixed Shipping Rate
|:| [ | ;2] 6/16/2011 12:14:41 PM POB90B-6 Jennifaer Browne Fixed Shipping Rate
@ | Today, 1:40 PM PO10728-9 Lisa Prescott Ground Shipping

2. The Complete shipment pop-up appears. The default shipment number is based on the number
after the purchase order number. For example, in the image above, the PO number for the
selected order is "PO10728-9". The last number after the dash is the number you want to enter
into the text field, in this case itis "9".
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Packing Shipments

Complete shipment

Shipment #: g

| " | | # Cancel |

3. Click Validate. Once validated, you will see the customer name, shipping address, shipping
method, and a field to enter in the tracking number provided by the shipping provider. Enterin a
tracking number and click OK. The shipment is sent out and completed. The purchase order status
will change to "Completed."

Complete shipment

Shipment £: 9
Customer: Lisa Prescott

Shipping Address: 111 Palm Street, Sun City, Florida, 333445, United States
Shipping Methad: Cround Shipping

Tracking Number: 1234567

Method 2

| " 0K | | » Cancel

Currently, the Complete shipment pop-up is rendered over the purchase order number. So to
reference the shipment number without closing the pop-up, you can move and drag the pop-
up so you can see the PO number by hovering your mouse cursor over the Complete ship-
ment title bar.

1. To complete a shipment, click on the complete shipmenticon highlighted in the image below:

Packing Shipments

;ﬁCumplete =l Print Picklist Print Packing Slip X Remawe from Picklist

|:| Last Madified z Customer Shipping Method
= o ;‘d &6/16/2011 12:09:52 PM PO4563-4 Carlos Nevada Fixed Shipping Rate
= o %5_116_12011 12:14:41 PM POG90E-6 Jennifer Browne Fixed Shipping Rate
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2. The Complete shipment pop-up appears. The shipment# is already validated with the last

number of the PO number.

Complete shipment *
Shipmlnt & B
Custamer: Jennifer Brawne

Shipping Address: 75 Sun Street, Sunshine Valley, South Wales, 333567, Australia
Shipping Method: Fixed Shipping Rate
Tracking Number: 1234566

| " 0K | | A Cancel |

Enter a tracking number provided by the shipping provider and then click OK to complete the ship-
ment and complete the order.

Printing Picklists and Printing Packing Slips

1.

Go to Order Management > Pick Lists. You can see existing Pick lists; you can filter the view by
choosing which warehouse the pick list was generated in.

EPISERVER COMMERCE Pick Lists

Welcome ¥ Change Language About 7

Order Managel ent 2 Warehouse: DefaultWarehouselz‘
j'g Order Manalﬁ\gment
f__j‘ Order Search
x| @ Purchase Orders
=[] Purchase Orders By Status [ 2011-02-21 12:35 1 Default Warehouse admin
H[ ] Carts
# ] Payment Plans (recurring)

X Delete Selected

D Name Packing Shipments Warehouse Created By

=13 Shipping/Receiving
QP Shipments
B Released for Shipping

| & Pick Lists

E’q Returns

You can also sort existing pick lists by Name, Packing Shipments, Warehouse, and Created By.

Click on an existing pick list. The Packing Shipments window appears. You can choose to printa
packing slip and/or a picklist. Checkmark one or more purchase orders. Click on Print Picklist to
generated a printable and exportable (Excel or PDF) pick list.
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K] ;| of1 [ 100% - Select a format v Export = |
Shipment Id: 6
Customer Name  Product Code Product Name Qty
Mary Smith 83017B Chateau Bellevue 2.00
Shipment Id: 9
Customer Name  Product Code Product Name Qty
John Browne 74521B Domaine de Montille 2.00

To generate a packing slip, checkmark one or more purchase orders to include in the packing slip
and then click Print Packing Slip.

Removing Items and Deleting Picklists
Introduction

It may sometimes be necessary to manually remove items from a picklist or delete entire picklists. In this
section we will describe how this can be done.

Removing Items from Picklists

Do the following to remove an item from a picklist:

1. Go to Shipping/Receiving under Order Management and Picklists.
2. Selecta picklistin the list to display the related order shipments.
3. Select the shipment(s) you want to remove and click Remove from Pick List.
4. Click OK to confirm the deletion.
Deleting Picklists

Do the following to delete a picklist:

1. Go to Shipping/Receiving under Order Management and Picklists.
2. Selectthe picklist(s) you want to remove and click Delete Selected.

3. Click OK to confirm the deletion.

O A picklist must be empty of all "packing shipments" (0 shipments remaining) before it can be
deleted.

Shopping Carts

A shopping cart (or basket) is created in the system as soon as a visitor selects the Add to basket
option on any page. The majority of carts are created automatically by shoppers from the front-end of the
e-commerce site. However, if needed shopping carts can also be created and managed manually from
Order Management under Carts. Registered and anonymous customer carts can be viewed in detail
and manually converted into a purchase order.
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In the following sections we will describe how to manage the shopping cart tasks from inside Order Man-
agement. For more information about the overall shopping workflow, refer to Shopping Workflow in this
documentation.

Creating Shopping Carts

Introduction

Shopping carts are the first step in the shopping procedure, created before the purchase order. Each cart
is unique and has its own ID#. When creating a cart manually, you must select a customer, and the sys-
tem will automatically redirect you to an open cart for a customer if that customer already has a cart open.

You can only have one cartopen at a time per customer. When a cartis turned into an order, it will dis-
appear from the carts list, and appear in the purchase order listing.

Functions in the Cart View

The carts view has the following functions and information:

e New Order
Allows you to create a new order from here. Creating a new order means that this will not produce
a cart to view and will not show up in this view screen. It will appear under Purchase Orders. Only
use this button on this screen if you actually wish to create a new order from here.

e New Payment Plan
Allows you to create payment plans which will appear under "Payment Plans (recurring).

e New Shopping Cart
Creates a new cart assigned to a customer.

e Delete Selected
Allows you to delete carts.

e ID
Each cart has an individual ID which can be viewed from here by clicking the numbers.

Creating a Shopping Cart

Do the following to create a shopping cart manually:

1. Go to Order Management and Carts.
2. Select New Shopping Cart.

3. Select a customer to create the cart for. If you do not see your desired customer in the list click
More to search for them.

4. Enter productitems to the cart by selecting New Line Item.

5. Return to the Carts view to verify that the cartis there.

EPISERVER COMMERCE Shopping Carts List ecoms samn

Welcome * Change Language About @ Cet Help For This Page %
Order Management @ || [Imew Order |JNew PaymentPlan [ JNew Shopping Cart X Delete Selected

28 Order Management B o Customer Total Status Last Modified

(1, Order Search (WK admin $56.45 In Progress Today, 1:26 PM
[ Purchase Orders
B Today
B This Week
@ This Month
B Al

1# ] Purchase Orders By Status
447 Carts

B Today

B This Week

B This Month

B Al

© [ Payment Plans (recurring)

=] Shipping/Receiving
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Converting Shopping Carts

Introduction

In most cases shopping carts will be automatically converted into purchase orders when shoppers pro-
ceed to checkout and finalize their purchase there. However, it might sometimes be necessary to man-
ually complete a purchase by converting the shopping cart into an order for further processing.

Converting a Shopping Cart to a Purchase Order

1. Go to Order Management > Carts. You will see the Shopping Carts list. You can also select

"Today," "This Week," or "This Month" to filter by date range.

EPISERVER COMMERCE Shopping Carts List

Welcome * Change Language About ~

Order Management

@ || [INew Order 3 Delete Selected

=] 'g Order Management
() Order Search
= [F] Purchase Orders
@ Today
@ This Week
@ This Month
@ Al
®[] Purchase Orders By Status
=5 Carts
Today
This Week

= (= Customer Last Modified
[RRE Carlos [undefined] Today, 3:27 PM
B e Jennifer Brovme [undefined] 6/16/2011 4:25:13 BM
B 3 Anonymous [undefined] 6/16/2011 12:07:01 PM

I

a
o

@ This Month
a Al

2. Click on the ID number of the shopping cart you want to convert over to a Purchase Order.

3. You will see the Cart View window and details of the customer's shopping cart.

Cart View

ﬂ More Actions =

— Overview

Cart #:
Created Date:
Cart Total:

Currency:

Customer ID: fied5deB-5f95-43f6-abd2-e4348ccadde

14

6/23/2011 1:27:46 PM
418.99

usp

Customer: Carlos

Email Address: carlos®@somemail.com

Open Customer Profile

J Line Items | | Notes
0 i Name Quantity List Price Total
[ EeLceocowmzvals 1.00 51999 51999
D ELCEQOOJNYWEBCE 1.00 3399.00 3399.00

Page Size: | 100 [~

An anonymous user Cart View will look like this:
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;‘AMO{}"f‘ctians'

~— Owverview

Cart#: 3
Created Date: 6/16/2011 10:07:01 AM
Cart Total: 0.00
Currency: USD
Customer: Anonymaous

Email Address:

J Line Items | | Notes
F o Name Quantity List Price Total
I:‘ ELCEOOOTCOHAWE 1.00 59.99 59.99

Page Size: | 100[]

a. Edit Information - You can change the currency to be used for the Purchase Order.

b. Open Customer Profile - You can view the profile of the registered customer (this option is
not available for anonymous shopping carts).

c. Line ltems - This is the list of items currently in the customer's shopping cart, displaying the
Quantity of each item, List Price, and Total.

d. Notes - You can add, edit, or delete notes about the shopping cart.

4. Click on More Actions and click on Convert to Purchase Order.

Cart View
|;21M0re Actions ¥
| Convert to Purchase Ci’r%
Create Payment Plan Edit Information

Cart #: 14

Created Date: 6/23/2011 1:27:46 PM
Cart Total: 415899
Currency: USD

Customer: Carlos

Customer ID: fied5de8-5f35-43f6-abd2-e4348cca%d2e | Open Customer Profile |

Email Address: carlos@somemail.com

The page refreshes and shows the Order view page for further processing of the purchase order.

Returns and Exchanges

Introduction

Once a package has been finalized and shipped out, EPiServer Commerce enables you to process
returns and exchanges directly in the order. A "return” is the actual return of the faulty delivery item. The
customer can either be refunded or be compensated by an "exchange" of either the same product item or
something else.
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Generating an exchange creates a separate Exchange Order (denoted by "EQ", instead of "PQO") tied to
the original purchase order. An exchange order is similar to processing a purchase order, as it involves
payment processing and releasing packages for shipment.

O Returns and exchanges can only be processed once a purchase order status is tagged as
"Completed."

Initiating a Return

Do the following to initiate a return:

1. Go to purchase order that has been finalized and shipped. Go to the Details tab and you will see
that the Create Return is available under Returns/Exchanges. Click on it to begin the return
and/or exchange process.

Shi s ry Shi; Status Returns/Exchanges
Item Subtotal: £86.00 Status: Shipped
| Create Return |
Shipping Cost: £0.00 | |
Shipment Total: £86.00 | |

2. The Create/Edit Return form appears. Click on New ltem to add associate the items to be
returned.

3. The Line ltem drop-down menu defaults to the items that were in the original purchase order. You
can set the Return Quantity and the Return Reason from the drop-down list (Faulty, Unwanted
Gift, Incorrect Item). You can also add additional information to the return. Click OK to save your

changes.
Create[Edit Return ®
‘X Delete‘
D [[»] Name Quantity List Price Total Reason
D 830178 Chateau Bellevue 2.00 £43.00 £86.00 Faulty
Page Size: 20 ¥ (1 itemns) | Page 41 ¥

~—Total Informatio

Infor

Sub Total: §6.00 Comments: |strange taste in batch 12345, 5
Tax Total: 0.00 -
Shipping Total: 0.00
Handling Total: 86.00
Discount Total: 0
Total Return Amount: 8600
[ wvok ][ Xcace |

4. The purchase order will go into Edit Mode. Click Save to continue the return process. Otherwise,
click Cancel to cancel the return.

5. In the Order List, the order will now appear with status Completed/Awaiting Return Completion.
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MERCE Order List

-

D New Order D New Payment Plan >< Delete Selected

E [n] Customer Total Status Last Modified

I:‘ POOBE3 John Browne £226.00 Partially Shipped Today, 11:34 AM

I:‘ PO10564 Carlos Santana £1,250.00 In Progress Today, 11:30 AM

D POO7E1 Carlos Santana $180.85 In Progress Today, 10:27 AM
Complated

D PO2427 Mary Smith £86.00 (Awaiting Return Today, 10:23 AM
Completion)

Return Completing Actions

1. Click on the Returns tab to process the return further. Once you get a notice from the shipping

department, for example, that they have received the returned item, click on Acknowledge
Receipt Items.

MERCE Order Welcome, admin

ry
@ Get Help For This Page ¥

mAdd Note a Send Notifications ?Add Order Address

Order No: PO2427 Customer: Mary Smith
Order Total: £86.00 Status: Completed
Summary ‘ | Details ‘ | Payments ‘ | Returns || Notes

Return # RMAS980

Date/Time Initiated: Today, 12:50 PM Notes: Returns Actions Exchange Actions ——
Created By: admin Strange taste in batch 12345, ‘ R o | | e Exchanne ‘
Status: Awaiting Stock Return
‘ Cancel Return | | Create Exchange ‘
ReturnTotal: £36.00
o] Name Quantity List Price Total Reason
830178 Chateau Bellevue 2.00 43.00 86.0000 Faulty
Page Size. 1gg

You can also choose to edit the return or cancel the return completely.

2. Once you click on Acknowledge Receipt ltems, the Complete Return becomes available.

— Returns actions —— Ex

| Cancel Return |

| Complete Return L\@J

3. Click on Complete Return to open the Create Refund form.
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Create Refund

Amount: B6.0000

Existing Payments

Payment Method:

71 New Credit

@ Pay By Phone (5ale) - £86.00

| " OK | | X Cancel

a. The Amount value defaults to the invoice cost of the item (not including the shipping costs).
For example, if the item cost $49.99 and the shipping cost was $2, then the Amount text

box will show $49.99.

However, you can specify a different amount to refund to the customer, including the full

cost of the order, item(s) + shipping cost. By default, the refund will be deposited based on
the payment method the customer used to make the order.

If the customer wants the refund processed and deposited to a different credit card or pay-
ment method (such as cash, money order, or electronic transfer), click on the New Credit
radio button and you can enter their alternate credit card information or other refund pay-
ment information.

4. Once done, click OK to create and process the refund. The status of the purchase order changes

to Completed.

mAdd Note L‘}Send Motifications ?Add Order Address

Order No: PO2427 Customer: Mary Smith

Order Total: £86.00 Status: Completed

Created By: admin Strange taste in batch 12345,
Status: Complete

ReturnTotal: £86.00

Summary | ‘ Details ‘ | Payments ‘ | Returns | ‘ Notes
Return # RMAZ980
Date/Time Initiated: Today, 12:50 PM Notes: Returns Actions Exchange Actions ——,

\ | \ |
\ | \ |
[T
meedneRecrips o]

D Name

Quantity List Price Total Reason

830178 Chateau Bellevue

2.00 43.00 86.0000 Faulty

Page Size: q1pg0 ~

Initiating an Exchange Order

Do the following to initiate an exchange order:

1. Go to a Purchase Order, click on the Details tab, and then click on Create Return.

2. Add the items for exchange.
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3. Click on the Returns tab and click on Acknowledge Receipt Items. Click Create Exchange to
open the Create Exchange Order form.

4. Click on New Item and then select the item to be exchanged by clicking Configure Selected
Entry. You can adjust the price, quantity, and applicable discounts before you add the item to the
Exchange Order by clicking Add items to the order.

Create Exchange Order
New Line ltem ®
Advanced Search hie
Picture Name Catalog Type Price In Stock
-
Chandon de Briailles France Variation £55.00 1000
Louis Jadot France Variation £125.00 1000
Dujzc Fils & Pere France Variation £36.60 1000 =
Domaine Sylvie Esmonin France Variation £72.00 1000 L4
Maizon Joseph Drouhin France Variation £165.00 1000
Page Size: 20 ~ (2779 items) | Page4112345 ...¥ 4
Cancel | [ configure Setected Entry
Create Exchange Order
MNew Line ltem *
Selected Entry: Domaine Sylvie Esmonin )=
-
Display Price: £72.00 F
Price: |72.00
Quantity: |1
In Stock: 1000, Reserved: 0.
Discount:  enter descr here (] Percentage Based -
Discount description  amount £
Total: £72.00 b
] [ | 3 &
Back | | Add item to the order |

5. Enter a shipping and billing address. Select the shipping method to use for the Exchange Order.
Click on Recalculate to adjust the Summary total.
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6. Click OK once done.

Viewing an Exchange

1. Once an Exchange Order (EO) has been created, click on View Exchange to view the details of
the EO. An EO is similar to how a Purchase Order is set up.

y Exchange actions

| View Exchange H}

]
turn | Create Exchange |
teturn |

2. Click on the Payments tab to add a payment to the Exchange Order. Select a payment method for
processing the EO. You can adjust the amount if needed (the amount default value is based the
item cost + shipping).

MERCE Order

-

The Order is in Edit Mode. Save changes before exiting. |  Save | | A Cancel |

mﬁ\dd Mote ﬂ Send Notifications ﬁ'Add Order Address

| Order No: EO0335 | Customer: Carlos Santana Original Order: PO0731
Order Total: £72.00 Status: AwaitingExchange
| summary | | Details | | Payments | | Returns | | Notes

Create Payment

D Name Transaction Type Amount Status

[[1 %  PayByPhone 72.00 Pending

Page Size: 1gp *

3. The Exchange Order goes into Edit Mode. Click on Save to process the payment and the order.
The payment Transaction Type changes to "Authorization."
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4. In the Order List, the there will be an exchange order with prefix EO instead of PO, and with status
Awaiting Exchange.

MERCE Order List

v

D MNew Order D MNew Payment Plan >< Delete Selected

D Customer Total Status Last Modified

EOO0335 Carlos Santana £72.00 Awaiting Exchange Today, 1:22 PM
POOBE3 John Browne £226.00 Partially Shipped Today, 11:34 AM

PO10564 Carlos Santana £1,250.00 In Progress Today, 11:20 AM

Completed

POO7I Carlos Santana $180.85 (Awaiting Stock Return)

Today, 10:27 AM

oEEao@

PO2427 Mary Smith £26.00 Complatad Today, 10:23 AM

5. Go back to the original Purchase Order and click on the Returns tab. Click on Complete Return
to enable the Customer Service Representative (CSR) to release the EO shipment. Optionally,
you can cancel the shipment to cancel the Exchange Order. Once you release shipment, the CSR
repeats the same process as he would when shipping a Purchase Order.

Marketing

Introduction

The Marketing system is where you will come to create coupons, discounts, and promotions that can be
applied to products, orders, or shipping. Most commonly, these promotions will be created and managed
by marketing and catalog managers, as well as other users or administrators who handle pricing and dis-
counts.

The Marketing system makes it possible to create unique and compelling discounts and promotions. Any
discount that you create can be either percentage or value based. You will also have the ability to create
campaigns and customer segments so that you can target the promotions you have created to specific
customers or time periods.

The Marketing system consists of the following components:

e Promotions - any sort of discount or coupon that can be applied to individual catalog entries,
orders or shipping charges.

o Customer Segments - a subset of customers or users of your website to whom you can target
individual promotions or campaigns.

e Campaigns - a logical grouping of promotions and/or customer segments which will run over a
specified period of time.

e Expressions - conditions expressed in XML which are used to extend or create custom pro-
motions.

e Policies - global rules that are applied to all aspects of the marketing system, and promotions in
particular.

Working With Marketing
The work with the marketing system includes the following tasks:
e Creating different types of promotions with discounts and coupons

e Configuring customer segments used for targeting of promotions to specific groups of users and
customers
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e Creating and managing campaigns, which can be targeted to specific groups of users

e Configuring expressions and policies for defining additional rules and promotion types

Promotions

Promotions provide a way to apply various discounts to products, order totals or shipping. A promotion is
a marketing tool used to increase sales of certain products or product lines. Various incentives such as
lowered pricing and other discounts can be employed as part of a promotion.

Promotions are always tied to Campaigns. In addition, promotions can be classified into two types: 1)
either you can create a promotion that is visible prior to checkout or 2) you can configure the promotion
to be displayed during the checkout.

Through the use of Expressions you can apply conditions to promotions. These conditions vary from the
number of items, the percentage discount, shipping rates and many others.

There are a number of built-in types of promotions that can be created and applied to individual catalog
entries, orders, and shipping:

e Entry level promotions

e Order level promotions

e Shipping level promotions
You can also build your own custom promotions.
Browsing Promotions

To view and browse promotions, click on Promotions on the left navigation bar.

Marketing .,{?
w4 Campaigns

@ Promations

Bl Customer Segments
[ Policies
=[O Expressions

The Promotion List page opens, displaying a list of existing promotions.

MERCE Promotion List

r

= .
D MNew Promaotion ] Mare Actions ™

D Name Croup Priority  Starts

[ Exclusive Glasses 25% entry 1 Today, Z:41 BM

b

You can click on the name of a promotion to view its properties.
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MERCE Promotion Edit

Ovennew

Promotion Type:

Promotion Name: Exclusive Glasses 25%

ENLEr promation naime
Display Name:
English (United States)

Exclusive Glasses

Cerman (Cermany)
Spanish (5pain)
French (France)

Promotion Properties:

Campaign. Craduation Special -

Promotion Group:

Combination with other promaotions: Combine with other promotions ~

select the degree to which multiple pramations can be cambined
Priority: 1
promotions with figher priority will be evalvared firsr

Coupon Code:

will reguire code if entered
Status: Active -

siatus of the promotion

Creating an Entry Level Promotion

Introduction

Out of the box, you can build these Catalog Entry Promotion Types:
e Catalog Entry: Build Your Own Discount
e Catalog Entry: Buy Catalog entry X, get catalog entry Y at a discount
e Catalog Entry: Buy X Get $ Off Discount

The options above are available in the Promotion Type field when creating a new promotion. The fol-
lowing are examples of how to create each type of promotion.

Example: Build Your Own Discount - "40% Off Wine Decanter”

Once you have selected "Build Your Own Discount" from the Promotion Type drop-down menu, enter in
a Promotion Name, such as "40 % Off Wine Decanter"

Under the Display Name section, enter in the display name for each language type.

© EPiServer AB



134 | User Guide for EPiServer Commerce 1 R3

ERCE Promotion Edit

Overview
Promotion Type: Catalog Entry: Build Your Own Discount -
Promotion Name: 40% Off Wine Decanter
enter promotion name
Display Name:
English (United States) 40% OFF Wine Decanter

Cerman (Cermany)

Spanish (Spain)

French (France)

Promotion Properties:

Under the Campaign drop-down, select an existing Campaign created earlier
Promotion Group is grayed out because the Promotion Type is specified
From the Combination with other promotions drop-down, select the degree to which multiple pro-
motions can be combined. There are three options: "Combine with other promotions", "Exclusive
within select groups”, and "Exclusive within all groups."
~— Combine with other Promotions - The selected promotion will be combined with all other
promotion types that may be in use
~ Exclusive within Selected Groups - If the selected promotion is applied, no other pro-
motions within that group will be applied (but other promotions in other groups may be
applied)
~ Exclusive within all Groups - If the selected promotion is applied, no other promotions will
be applied.

Enter a numerical value into the Priority field (promotions with a higher priority will be evaluated
first)

Optionally, enter in a Coupon Code that customers can redeem from the front-end public site to
getreceive the discount. Otherwise, leave the field blank.

Set the Status of the Promotion either as "Active", "Inactive," "Suspended,” or "Deleted" from the
drop-down menu. Select Active to enable the promotion.

Promotion Properties:

Campaign:

Craduation Special -

Promotion Group:

Combination with other promaotions: Combine with other promations ¥

select the degree to which multiple promotions can be combined

Priority: 1

promeotions with higher priority will be evaluated first
Coupon Code: Test

will require code if entered
Status: Active -

status of the promotion
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Purchase Condition and Reward:
Here you can set your own Purchase Condition to receive the discount Rewards. To apply a 40% dis-
count for a wine decanter, use the following settings in the screenshot.

Purchase Condition and Reward:

?}is type of promotion alfows you o create your own custom promotion.

Use the condition below to restrict how the promotion will be applied.
Purchase Condition:

- And

' ’ TargetLineltem.CatalogEntryld Equals (Text) FOO146

[

Use the actions below to assign rewards.

Rewards:
: get % off item  reward  40.00%

.

Redemption Limits:

Under this section, you can specify the redemption limits of this promotion.

o Next to Max. Total Redemption, enter in the maximum number of times the promotion can be
redeemed.

e Nextto Max. Redemptions Per Order, enter in the maximum number of times the promotion can
be redeemed per customer order.

o Nextto Max. Redemptions Per Customer, enter in the number of times a promotion can be by a
single customer.

Redemption Limits:

Max. Total Redemptions: 300 (Redeemed:)

number of times the promoiion can be used by all customers, enter 0 for uniimited

Max. Redemptions Per Order: 1

number of times the promotion can be used in a single order, enter 0 for unlimited

Max. Redemptions Per Customer: 1

nwmber of times the promotion can be used by a single customer, enter O for unlimited

Schedule:
Enter the date and time when the Promotion is Available and when it Expires.

Click OK to save the promotion. The promotion will appear in the Promotion List.
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Welcome, a

Promotion List

D . =5 .
Mew Promotion ﬂ More Actions ™

|:| MName Croup Priority  Starts Ends 51
|:| 4 0% OFf Wine EEEaﬂt% entry 1 Today. Z:02 PM 3/23/2012 3:02:00 PM ac
D Exclusive Glasses 25% entry 1 Today, 2:41 PM 2/23/2012 2:41:00 PM ac

When the promotion is applied, the price on the front-end should change.
Buy catalog entry X, get catalog entry Y at a discount

The steps to create this discount are similar to creating a custom discount. The difference is the Purchase
Condition and Reward.

1. Under the Select catalog entry X drop-down menu, select a specific catalog entry.

2. Under the Select catalog entry Y drop-down menu, select another specific catalog entry.

3. Enter a value for the Quantity of "X" needed to qualify for the promotion. For example, the cus-
tomer must purchase 2 of Catalog Entry X as a prerequisite for the discount.

4. Enter a value for the Quantity of "Y" needed to quality for the promotion. For example, the cus-
tomer must purchase 3 of Catalog Entry Y as a prerequisite for the discount.

5. In the Amountfield, enter in a number and select from the drop-down to indicate that the Pro-
motion is Percentage Based or Value Based. For example, if you enter 40 and select Percentage
Based, the Promotion will take off 40%. If Value based, it will be 40 off the total price.

Purchase Condition and Reward:

This type of pr ion makes iti SKUs / ar a perc discount when an order includes some required
amount of the specified SKU

Select catalog entry X:
g entry Enoteca Wine Glass Large [35368] -

Select catalog entry Y:
Flect catalog entry Enoteca Decanter 1000mI [FOO146] v

Quantity of X' needed to qualify for the promotion: 4
Quantity of " needed to qualify for the promation: 1

Amount: 25 Percentage Based -

Buy X Get $ Off Discount

This type of promotion gives a discount per item by purchasing the minimum quantity specified under
these Purchase Conditions.
1. Enter a Minimum quantity that the customer needs to purchase in order to receive the discount.
2. Enter the Amount of the Promotional discount, whether Percentage Based or Value Based.

3. Selectany number of Variations from the drop-down menu and click on "add variation." Repeat to
add more Variations to this Promotion. Click on the red X button next to the Variation to delete it.
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Purchase Condition and Reward:

This type of promotion gives § off discount per item for the minimum guantity.

Minimum quantity: 2
Amount: 20 Percentage Based ~
Variations: Chateau Haut-Batailley [81725M] (5) more...

Creating an Order Level Promotion
Introduction

Order Level Promotions are discounts applied if the overall order satisfies the conditions specified by
the promotion.
Out of the box, you can build these Order Entry Promotion Types:

e Order: Buy X, get N quantity of Y at a discount

e Order: Sub Total Volume Discount - if the order subtotal minimum is met, then the customer
receives the discount.

e Build Your Own Discount - you can create a custom order level promotion based on a range of
purchase conditions and rewards (similar to creating a custom catalog entry discount).

The options above are available in the Promotion Type field when creating a new promotion. The fol-
lowing are examples of how to create each type of promotion.

Buy X, get N quantity of Y at a discount
This type of promotion allows a customer to be eligible to buy a designated number of items at a reduced
price.

1. Selectan Entry X variation from the drop-down menu and click on "add variation.

2. Select catalog entry Y from the drop-down menu. A certain number of "Y" entries will be dis-
counted based on the Purchase Conditions.

3. Enter a Max quantity Y for the maximum number of Y entries eligible for a discount.

4. Enter the Amount of the promotional discount, whether Percentage or Value based.

Purchase Condition and Reward:

This type of promotion is eligible to buy designated number of item ar a reduced price.

Entry X variation:

Chateau Cuiraud [80758H] (2) more... Exclude
Select catalog entry Y.
g v Domaine Sautereau [F/61518] -
Max quantity Y 1
Amount: an Percentage Based -

Order Sub Total Volume Discount

Enter in the Minimum order amount into the field. For example, if the order amount was set to $200, then
the customer must have $200 or more in his shopping cart to qualify for the discount.

Enter in the Amount of the discount. It can either be "Percentage Based" or "Value Based." If Percentage
Based, then the customer gets a percentage off the price. If Value Based, the customer gets a fixed
amount discounted off.
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Purchase Condition and Reward:

This type of promotion discounts the order subtotal if minimum order amount is met.

Minimum order amount: 0

Amount: 0 Percentage Basedlz‘

Example: Build Your Own Discount - "20% Off for a Shopping Cart Subtotal of $100 or More"

Like a custom Catalog Entry discount (add link here), users can create their own custom Order Level dis-
count based on a list of Purchase Conditions and Rewards. This means that there is a wide range of
Order Level discount possibilities.

The follow Condition and Reward example shows how to create a Promotion that gives 20% off for a
shopping cart subtotal of $100 or more.

Purchase Condition and Reward:

This fype of promotion allows you [0 createé your own cusiom promotion.

Use the condition below to restrict how the promaotion will be applied.
Purchase Condition:

- And
: ShoppingCart.5ubTotal Equals

[

Use the actions below to assign rewards.
Rewards:

- And

o get % off whole order  reward 20.00%

.

The discount should reflect on the shopping cart on front-end public site.

Creating a Shipping Level Promotion

Introduction

Shipping Level Promotions are promotions that give discounts based on the overall shipment. The dis-
count will appear on the order page just before you submit the order.

Out of the box, you can build these Order Entry Promotion Types:

e Shipping: Build Your Own Discount - you can create a custom shipping promotion based on a
range of purchase conditions and rewards (similar to creating a custom catalog or order entry dis-
count).

The option above is available in the Promotion Type field when creating a new promotion. The following
are examples of how to create each type of promotion.

Example: Buy N quantity Get % Off Shipment Discount

This Promotion type applies shipping discount if the specified Variations total the Minimum Quantity set
or more.

1. Enter a Minimum Quantity, for example "5".

2. Enter an Amount of the discount Reward, and select from the drop-down whether itis "Per-
centage Based" or "Value Based, for instance "20%".
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Purchase Condition and Reward:

This type of promotion allows you o create your own custom promotion.

Use the condition below to restrict how the promaotion will be applied.
Purchase Condition:

- And

P Shipment.ShipmentTotal Equals 5.00

Use the actions below to assign rewards.
Rewards:

- And

get % off shipment reward 20.00%

Creating Custom Promotions

Introduction

You can create custom promotions instead of using the built-in ones. Itis possible to create custom pro-
motions on a catalog, order, or shipping level.

How to Use "Or" When Building Your Own Promotions

EPiServer Commerce has a powerful discounting engine and can be used to build all types of promotions
without writing custom code. In most cases these discounts can be built using one of the built in "Build
Your Own Discount" options.

Building the Discount

In this case we want to build a promotion that will give a $10 discount on certain items in our catalog. We
want products with "Bordeaux" OR "Sauternes" in the display name to receive $10 off the item. In this
case we are using a Promotion Type of "Catalog Entry:Build Your Own Discount". Constructing the pur-
chase condition can be a confusing when using the Or operator. The firstitem we must add to the con-
dition is the Or operator since And is the default. The Or will have the effect we desire if added first which
is And (Or (DisplayName = Bordeaux, DisplayName = Sauternes)) which is translated by the rules engine
to And (DisplayName = Bordeaux Or DisplayName = Sauternes). If the Or is not added first the results
will not be as desired as the DisplayName would have to contain Bordeaux And Sauternes.

The Reward is setto $10 Off.
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Purchase Condition and Reward:

This type of promotion allows you o create your own custiom promoiion.

Use the condition below to restrict how the promotion will be applied.

Purchase Condition:

- And

TargetLineltem.DisplayMame Contains Bordeaux

TargetLineltem.DisplayMame Contains Sauternes

Use the actions below to assign rewards.
Rewards:

.

And

10.00
b

get 5 off item reward

Seeing the Discount Applied

We have added three items to our shopping cart. As you can see two of the items (containing "Bordeaux"
and "Sauternes") have been given the $10 off discount and the name of the promotion is shown with the
item. The third item in our cart did not meet the criteria we set so no discount was applied.

Your Basket - you have 5 item(s) in your basket

Barolo, Le Vigne, Az Agr. Luciano Sandrone, Piedmaont Quantity Price Total Remave
5 £117.00 £585.00 o
Do you have a promo code? Enter Code Apply ©
Subtotal £585.00 (exc. Tax)
£0.00 discount awarded in this basket.
Order Discount £0.00 (exc. Tax)
. . . . Company Discount -£0.00 (exc. Tax)
0 loyalty points recieved with this purchase.
Total Order £585.00 (exc. Tax)

Update Basket © [l Go to Checkout ©

Back

Editing, Activating and Deleting Promotions
Editing a Promotion

To edit an existing promotion, go to Marketing and Promotions to expand the list of promotions. Select a
promotion to edit by clicking on the promotion name in the list.
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MERCE Promotion Edit

Ovennew

Promotion Type:

Promotion Name: Exclusive Glasses 25%

ENLEr promation naime
Display Name:
English (United States)

Exclusive Glasses

Cerman (Cermany)
Spanish (5pain)
French (France)

Promotion Properties:

Campaign. Craduation Special -

Promotion Group:

Combination with other promaotions: Combine with other promotions ~
select the degree to which multiple pramations can be cambined
Priority: 1
promotions with figher priority will be evalvared firsr
Coupon Code:
will reguire code if entered
Status: Active -

siatus of the promotion

Update the information and click OK to save your changes.
Activating and Inactivating Promotions
Once a promotion has been created it can be activated and inactivated from the Promotion List view.

This is useful if you want to keep the promotion for reuse on another occasion.

In the Promotion List list, checkmark the box next to the name of the promotion and then click on More
Actions > Flip status (active/inactive) on the menu bar. The selected promotion(s) will be acti-
vated/inactivated depending on their current status.

Promotion List

D . =5 .
Mew Promaotion :d Mare Actions ™

[l Mame X Delete Selected Priority  5tarts

3pring Offer | Flip Status (active/inactive) 1 Today, 11:24 AM

Deleting a Promotion

In the Promotion List list, check the box next to the name of the promotion and then click More Actions >
Delete Selected on the menu bar. Click OK to confirm the deletion.
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Promotion List

D . =5 .
Mew Promotion :d More Actions ™

|:| Name |>< Delete Selected Croup Priority | Starts

Exclusive Glass entry 1 Today, 2:41 PM

Flip Status (activeinactive)

Customer Segments

Customer Segments determine the target audience for Promotions or Campaigns. Within a campaign,
all promotions will be applied to whatever customer segments associated with the same campaign.
Members of the customer segments can be pre-defined in static groups or you can use Expressions to
create dynamic groups whenever promotions are run.

For example you can have a customer segment that targets all users from the Los Angeles area. You can
create an expression that will include all the customers whose home city is Los Angeles. Thus, when a
user registers on the site he or she immediately becomes part of the target customer segment.

You can create a customer segment and manually assign specific contacts to the customer segment, or
you can use conditions to apply rules that automatically make selected customers become part of the cus-
tomer segment.

Browsing Customer Segments

To view and browse customer segments, click on Customer Segments on the left navigation bar.

Marketing Eg‘

=" Marketing
ﬁ Campaigns
@ Promotions
@ Customer Segments
H[7J Policies
=[] Expressions

The Customer Segments List page opens, displaying a list of existing customer segments.

Customer Segment List

a
.éJNEWSEngHt <] More Actions ™

D Name

[[] Los Angeles Area

[] MewYork Customers

You can click on the name of a customer segment to view its properties.
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RCE Segment Edit

Overview

Segment Name: || 5 angeles Area

ENter SEQITIENT NAMTe
Display Name: || 5 angeles Area
Description: Customers in the greater Los Angeles area -
Members:

|:| Exclude member
add member

XK Mary Smith
x Company X

Conditions: —

i The above conditions will be evaluated in runtime and if any are true, the customer will be part of this segment.

QK || Cancel |

Creating Customer Segments

Introduction
Customer Segments defines a specific groups of customers to be targeted by Promotions or Campaigns.
Creating a Customer Segment Assigned to Contacts

Go to Marketing > Customer Segments.

Marketing @

% Campaigns
ﬁ Promations

@ Customer Segments
+ [ ] Policies
# ] Expressions

Click on New Segment on the menu bar to open the Segment Edit page.

Customer Segment List

=
.é] Mew SEgmatH:cp ] More Actions ™

D Mame W,

[ GCraduation

[[] Los Angeles Customers
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1. Enter a Segment Name, such as "Los Angeles Customers."

2. Enterin a Display Name, which will appear to users when associating this customer segment
when Creating a Marketing Campaign.

3. Enter a Description.

4. Selectfrom a list of contacts from the Members drop-down to assign them to this customer seg-
ment. Select the name from the drop-down and then click add member. You can choose to
Exclude member by clicking on the checkbox and then clicking add member.

5. Once done, click OK to save the customer segment.

ERCE Segment Edit P

Overview

Segment Name: Los Angeles Customers

enter SEQMENt name
Display Name: |} oo angeles Customers
Description: Offers targeted to customers in the city of Los Angeles. -
Members:

[ Exclude member
add member

K Mary Smith
x John Browne

Conditions:

The above conditions will be evaluated in runtime and if any are true, the customer will be part of this segrment.

OK || Cancel |

Creating a Customer Segment With Conditions
Instead of assigning members manually to a customer segment, you can use Conditions to apply rules. If
a customer satisfies the conditions, then the customer is part of the customer segment.

To add conditions to the customer segment, click on New Condition on the Segment Edit page. This
example will show how to specify "Company X" or "Winearts" emails as part of this customer segment.

Enter an Expression Name, such as "Company X or Email Addresses."

Setup the conditions based on the image below.

Condition Dialog

Expression Name: \Company X or Winearts Email
enter expression name

Expression Xml: And

Email Equals (Text) Company X

Email Equals (Text) Winearts

H-

Click OK to save the Conditions.
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Conditions: .

x Company X or Winearts Email

The above conditions will be evaluated in runtime and if any are true, the customer will be part of this segment.

oK || Cancel |

Editing and Deleting Customer Segments

Editing a Customer Segment

To edit an existing customer segment, go to Marketing and Customer Segments to expand the list of cus-
tomer segments. Select a customer segment to edit by clicking on the customer segment name in the list.

RCE Segment Edit

Overview

Segment Name: Los Angeles Area

enter SEgIMent name
Display Name: Los Angeles Area
Description: Customers in the greater Los Angeles area -
Members:

|:| Exclude member
add member

XK Mary Smith
x Company X

Conditions: —

The above conditions will be evaluated in runtime and i any are true, the customer will be part of this segment.

Ok || Cancel |

Update the information and click OK to save your changes.
Deleting a Customer Segment

In the Customer Segment list, check the box next to the name of the customer segment(s) and then click
More Actions > Delete Selected on the menu bar. Click OK to confirm the deletion.

RCE Customer Segment List

=y
.é] Mew Segment 1 Mare Actions ™

[ Name |>( Delete Selected
[] Los Angeles Area \

[[] Mew Yaork Customers
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Campaigns

Campaigns provide a way to organize marketing activities. Campaigns must be associated with Pro-
motions in order to provide customer discounts. Optionally, campaigns can also be tied to Customer Seg-
ments for targeted marketing purposes. For example, you can create a seasonal campaign that will
include different promotions targeted for the spring season. Campaigns are the first step to deploying tar-
geted marketing efforts on your e-commerce website.

Browsing Campaigns

To browse existing campaigns, go to Marketing > Campaigns to open the Campaign List.

Marketing ;::3‘

w# Campaigns
@ Promaotions

Sei| Customer Segments
=[] Policies
] Expressions

From the Campaign List, you can view existing campaigns.

Campaign List

=
D New Campaign ¥l Mare Actions ™

0 Name Starts Ends Is Active  Last Modified Created
D Wine campaign 10/7/2008 2:00:00 AM 11/7/2020 1:00:00 AM True 10/8/2008 12:14:13 AM
[] Sering Offer 5/1/2012 1:08:00 PM 6/20/2012 1:08:00 PM True Today, 1:09 PM

You can click on the name of a campaign to view its properties.

© EPiServer AB



Commerce Manager | 147

== Campaign Edit

Overview

Campaign Name: GCraduation Special

enter campaign name

Comments: Spedial offers for the graduation occassion -
Available from: |5 ,33 /20712 HH 02:31 PM
Expires on: 3/23/2012 H 02:31 PM

Target Segments

Active: . .
cHvE @ Yes ) No
Archived: . _
rchive ® Yes @ No
0K Cancel

Creating Campaigns

1. To create a new campaign, click on New Campaign on the Campaign List page.

Campaign List

Ty
D Mew Campaign < More Actions ™
Il

Mame 4 Starts End
O U

|:| Wine campaign 10/7/2008 2:00:00 AM 117

2. This opens up the Campaign Edit page. Enter a Campaign Name, such as "Graduation Special."
3. Enter any Comments as notes about the Campaign.

4. Enter a date directly (or click on the Calendar icon to select a date) and time into the Available
From field. This will indicate when the Campaign is expected to start.

5. Enter a date and time in the Expires On field.

6. Selectthe Target Segments from the list. Target segments are created under the Customer Seg-
ments section
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7. Indicate whether or not the Campaign is Active, "Yes" or "No."

8. Indicate whether or not to Archive the Campaign, "Yes" or "No. NOTE This feature has not been
implemented and switching its status from "No" to "Yes" will not change anything.

9. When done, click OK.

ERCE Campaign Edit

Overview

Campaign Name: | o4y ation Special

enter campaign name

Comments: Spedal offers for the graduation occassion -
Available from:  [5 5350712 H 02:31 PM
Expires on: 3/23/2012 HH 02:31 PM

Target Segments:

Active: _ _
cHve @ Yes ) Mo
Archived: . _
rchive ) Yes @ No
QK Cancel

Editing and Deleting Campaigns
Editing a Campaign

To edit an existing campaign, go to Marketing and Campaigns to expand the list of campaigns. Select a
campaign to edit by clicking on the campaign name in the list.
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Campaign Edit

Campaign Name: GCraduation Special

enter campaign name

Comments: Spedial offers for the graduation occassion -
Available from: |5 ,33 /20712 HH 02:31 PM
Expires on: 3/23/2012 H 02:31 PM

Target Segments

Active: . .
cHvE @ Yes ) No
Archived: . _
rchive ® Yes @ No
0K Cancel

Update the information and click OK to save your changes.

Deleting a Campaign

In the Campaign list, check the box next to the name of the campaign(s) and then click More Actions >
Delete Selected on the menu bar. Click OK to confirm the deletion.

RCE Campaign List

[
D New Campaign #1 More Actions ™

[ [Name |>( Delete Selected Starts
.,tn]:‘

|:| Wine campaign 10/7/2008 2:00:00 AM

[] Spring Offer 5/1/2012 1:08:00 PM

Expressions
Introduction

Expressions are customizable conditions which allow users to extend different aspects of the marketing
system. Expressions are essentially XML statements that enable you to create custom promotions, cus-
tomer segments, and policies. The various parts of the marketing system - Promotions, Customer
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Segments and Policies all rely on expressions. As an example, if you want to set up a promotion like

"40% off ltem X", the expression or condition to enable this promotion would include: "Catalog ID for ltem
X and Reward of 40%".

O Because of the powerful features of this function, creating expressions should only be done
by advanced users of EPiServer Commerce. In order to create an expression, knowledge of
XML is required.

Creating an Expression
Do the following to create an expression:

1. Go to Marketing under and select Expressions .

2. Expand Expressions and Promotions/Segment/Policy to view the Expression List page.

Marketing |

[
s Campaigns

@ Promaotions

@ Customer Segments |
[ Palicies
=9+ 5 Expressions

[ Promation o
] Segment
[~ Palicy

Welcome, admin

ERCE Expression List

@ Get Help For This Pa

D New Expression 21 More Actions ¥

|:| Name Description Madified Created

[C] EntryCustomDiscount {MarketingStrings:Promotion_Custom_Descrip 2/23/2012 2:42:50 PM 2/23/2012 2:42:50 PM
[F] EntryCustomDiscount {MarketingStrings:Promotion_Customn_Descrif 2/23/2012 3:13:48 PM 2/23/2012 3:13:48 PM
[[] BuyXCetYDiscounted {MarketingStrings:Promation_Buy_X_Get_Y_Al 2/23/2012 3:30:24 PM
D BuyXCetNofYatReducedPrice {MarketingStrings:Promotion_Buy_X_Get_N_Al 2/23/2012 3:40:42 PM
[[] BuyXCetOffDiscount {MarketingStrings:Promotion_Buy_X_Get_Dall 3/23/20132 3:47:33 PM
D EntryCustomDiscount {MarketingStrings:Promotion_Custom_Descrif Today, 10:10 AM Today, 10:07 AM

To create a new Expression, click on New Expression. The Expression Edit page appears.
Enter an Expression Name, such as "EntryCustomDiscount."
Enter a Description of the Expression.

Enter the Expression XML.

N o g &~

Under Category, select from the drop-down whether this Expression is for a "Promotion," "Seg-

ment," or "Policy." Depending on your selection, the expression will appear under those respec-
tive folders.
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Expression Edit

Expression Name:

EATer eXpression name

Description:

enter expression description
Expression ¥ml:

enter expression xml

Category: Promotion

Segment

Policy ]

pm caregory
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8. Click OK to save changes.

Welcome, admin

Expression Edit

(7] Cet Help For This Page ‘i

Expression Name: EntryCustomDiscount

Enter expression name

Description {MarketingStrings:Promaotion_Custom_Description} >

1

ENtEr eXpression description

Expression Xml: | zpleSet Name ="PromotionCondition-0-CustomerRuleSet™ Description="{p 1:Mull}" ChainingBehavior ="None™
xming:p1="http: ffschemas. microsoft. comfwinfxf2006 /xaml” xmins="http://schemas.microsoft. comwinfx /2006 fxaml fworkflow™=
<RuleSet.Rules>
<Rule Name="0" Description="{p 1:Null} " ReevaluationBehavior ="Mever" Active ="True" Priority="9999">
<Rule. ThenActions >
<RuleStatementAction >
<Rul ntAction.CodeDo nt
<ns0:CodeAssignStatement LinePragma="{p 1:Mull}" xmins:ns0="clr-
namespace:System.CodeDom; Assembly=System, Version=2.0.0.0, Culture=neutral, PublickeyToken=b77a5¢56 1934e089™>
<ns0:CodeAssignStatement.Right =
<ns0:CodePrimitiveExpression >

| »

<ns0:CodePrimitiveExpression. Value >
«nsL:Boolean
xminsins1="dr-namespace:System;Assembly=mscorlib, Version=2.0.0.0, Culture=neutral, PublickeyToken=b77a5c56 1934089 >true</ns1:Boolean >

<fns0:CodePrimitiveExpression. Value >
«/ns0:CodePrimitiveExpression >
< In=N:CodeAssionStatement Rinht =
enter expression xmi

Policies
Introduction

Policies are business rules on how to eliminate similar promotions for the same order or same product.
Policies are always executed when Promotions are applied and can be pre-configured for each store. Pol-
icies can be optionally associated with one or more promotion groups.

If a policy is associated with a promotion group, itis considered a local policy, and applies only to those
promotions in the group to which this policy is associated. If a policy is not associated with a promotion
group, itis considered a global policy which applies to all promotions. This allows a marketing manager
to declare rules just once for the whole site. An example of a rule can be for instance "Do not allow neg-
ative orders".

O Because of the powerful features of this function, creating policies should only be done
by advanced users of EPiServer Commerce.

Creating a Policy

Do the following toe create a policy:

1. Go to Marketing and Policies to open the Policy List.
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Policy List

DNEW Policy _\ﬂhﬂnrehctinnsv

[ mMame

Click on New Policy to open the Policy Edit page.
Enter a Policy Name.

Enter the Status of the policy.

o & N

Select"Yes" or "No" to set the policy Is Local.

a. Policy Is Local is No - this is the default behavior. This means that this policy is not part of
a promotion group and is available for all promotions.

b. Policy Is Local is Yes - this means this policy is part of a promotion group and is appli-
cable only for that promotion group.

6. Selectan existing Policy Expression from the drop-down menu.
7. Selectfrom the Groups list to place the policy under.

8. Click OK when done.

ERCE Policy Edit

Owverview
Policy Name:

enter Policy narme
Status:

enter PFolicy status
Is Local: ™ Yes @ Mo

Expression: IE'

select policy expression

Croups: Order
Catalog Entry
Shipping

seflect policy group, alfows you to logically group policies

| 8]4 | | Cancel

O Policy Status and Policy Is Local has not been fully implemented. Therefore, all policies will
be global (meaning it cannot be limited to a promotion group) until this feature becomes avail-
able in a future release.
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Assets

Introduction

Files or "assets" as they are also referred to, are used for a variety of purposes including within the site's
design, as details for products sold, or even as products themselves available for download. Typically
assets are images or videos for product and content display, or PDF documents which can be associated
with specific products or content.

In EPiServer Commerce, assets can be managed both from the Assets subsystem in Commerce Man-
ager, as well as from the File Manager inside EPiServer CMS. These parts are fully integrated and syn-
chronized, so any assets you add from either side will be visible from the other.

Working With Assets
File and asset management includes the following tasks:
e Searching for files
e Creating folders
e Uploading files
e Setting access rights for folders
e Renaming files and folders
e Deleting files and folders
o Editing files

Find out more about how to work wit assets from either the File Manager from CMS, or the Assets Man-
agement subsystem inside Commerce Manager.

File Manager
Introduction

This section describes how to work with files (assets) from EPiServer CMS. The File Manager in the EPiS-
erver Commerce sample site is available in the right-hand area when in Edit view. You will see the start-
ing points that have been configured for the website. The sample site will have the Global Files,
Documents and Commerce Assets starting points, with a set of sub-folders. You can define your own
folder structure and configure additional starting points for your website.
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o

Blocks Catalogs
ol

Fath: Commerce Assets

Falders
|] Page Files

Starting Points

|| Global Files
|| Documents

Commerce
Assets

My Favarites

Add favorite
folders using the
right-click menu
for any of the
folders on the
right

upload

Drop files here to

=

L1

1

1

Commerce Assets

Images

Presentations
Software
Specifications

IUser Guides

Video

T Integrating with EPiServer EN.pdf

In the following we will provide an overview of the features of the file manager. For a more detailed
description of file management in EPiServer, refer to the user documentation for EPiServer CMS.

Searching for Files

Click the Search button in the file manager menu to search for files in the file manager. The search can
be limited to specific folders in the structure.

Creating Folders

Click the Folder button in the file manager menu to create a new folder. To create a sub-folder, double-
click the folder under which you want to add a sub-folder.

Uploading Files

Click the Add button in the file manager menu to add files to a folder, or use the quick upload option
under Drop files here to upload in the lower left part. Multiple files can be uploaded with both options.

Setting Access Rights for Folders

Click the Access rights button in the file manager menu to change access rights for a folder. Double-
click the folder to which you want to apply access rights, and then select users and groups as desired.
Folders that users do not have access to will not be visible in the structure.
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O Note that the Everyone group must have read access to any images that you want to be pub-
licly visible on the website.

Renaming Files and Folders

Click the Rename button in the file manager menu to rename a selected file or folder. When renaming a
file, any pages linking to the file will be listed, and the link will be updated.

Deleting Files and Folders

Click the Delete button in the file manager menu to delete a selected file or folder. When deleting a file or
a folder, any pages linking to the file will be listed.

Editing Files

Select the file you want to edit, right-click and select the desired option in the right-click menu. You can
open the file for editing, or you can view and edit the file summary. You can also check out the file for
editing, if this has been activated in the file manager. Refer to the user documentation for EPiServer CMS
for more information.

o
Blocks Catalogs
Folders & Images

[ Page Files Path: Clobal Files/Images

Starting Points t] [g] lij liJ w ﬁ] li]

[ Global Files
[ Show thumbnails
] Documents
= Name Size

- [] Commerce [ Carousel

Assets r

My Favorites 56 adv-right-small1.gf 15 KE

Add favorite [SEGM Show File Summary

folders using the ——— _

right-click menu 13 Toal Open File

for any of the & logo.d

olders one | [Fbe
right SReul Edit File Summary

Check Out

EEE

% Rename

Cut

Drop files here to
upload

Asset Management

This section describes how to work with files (assets) from Asset Management in Commerce Manager.
The Asset Management system allows for assets including images, MP3s, PDFs, software packages and
other downloadable files to be centrally stored and displayed on the website.

You can also work with assets from the File Manager in EPiServer CMS.
Browsing Assets

Introduction

The Asset List page categorizes and manages downloadable Asset files. The default list of Asset folders
are: Video, Presentations, Specifications, Software, Downloads, User Guides, and Images. These fold-
ers can be edited or deleted and are simply placeholders for typical asset folders.
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Browsing for Assets
Do the following to access existing assets in the system:

1. Go to Asset Management.

2. Click on Asset Management > Root and expand any of the folders below Root.

Asset Management Q—“‘

| =] Root —ﬂ"‘n |
[ Video A=

I:I Presentations

[ Specifications

[ Software

[ Downloads

[ User Cuides
ﬂl:llmages

3. The Asset List shows folders and assets. The Asset List shows the total Size of the assets and
the Created date. Expand the folders to view the content of each folder.

ERCE Asset List

D Create New ™ :2] More Actions ™

|:| Mame Size Created

[ J video 2/22/2012 4:03:05 AM
[ 3 presentations 2/22/2012 4:03:05 AM
[ (O specifications 2/22/2012 4:03:05 AM
O J software 2/22/2012 4:03:05 AM
o () bownloads 2/22/2012 4:03:05 AM
[l & User Guides 2/22/2012 4:02:05 AM
o = Images 2/22/2012 4:03:05 AM

Creating Folders

Creating an Asset Folder

Do the following to create a folder for storing assets:

1. Go to the Asset List by clicking Asset Management > Root (or any folder underneath Root).
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2. Click on Create New > New Folder.

ERCE Asset List

DCreate Mew ;}]Mureﬁ.ctiunsv

New Folder ’\{h_")—

MNew File

Upload Multiple Files

= IE' Specifications
= = Software
=

=k IE' Downloads

= = User Guides

E Images

O 000 0|D K

3. Enter a name for the folder and click Create.

New Folder *

Mame Audio Create|

4. The folder will be created in whichever folder you are currently in. In this example, the folder
"Audio" was created underneath Root.

DCraate New~ | | More Actions ¥

|:| Marre Size Created

D = E\-"idel} 5/11/2010 2:34:57 PM |
D B E Presentations 5/11/2010 3:34:57 PM

0 ] Specifications 5/11/2010 3:34:57 PM

D = h Software 5/11/2010 2:34:57 PM
0= o @-muaus 5/11/2010 3:34:57 PM

D =5 E User Guides 5/11/2010 3:34:57 PM
0D Images 5/11/2010 3:34:57 PM

0 & O audio Today, 2:15 BM

5. To see the folder in the left navigation frame, click on the Refresh icon and the new folder"Audio”
will appear. You can create additional sub-folders underneath Audio (or any other existing folder).
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Root

[ Video

[ 7] Presentations
[ Specifications
7] Software

7] Downloads
[ User Cuides
[ Images

[ Audio

Uploading Asset Files

Uploading Individual Files

Do the following to upload a single file to the system:

Commerce Manager | 159

1. Navigate to the folder you want to upload the file to and then click on Create New > New File.

ERCE

Asset List

D Create New ™

2] More Actions ™

| [

Mew Faolder

B

Mew File

[J upload Muttiple Files

EO0O0OOO

] Packagel]

- Packagel2
- Packagel3
- Package(4

- Package(5

LargeWineClassCrystal.jpg
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2. Click Browse or enter the file path into the field. Once done, click on Upload.

Welcome, admin

File ltem

e
(7] Cet Help For This Page

Click Browse and select file, or type file path:
C:\Transfer\SmallWineGlass.jpg

e ]
A

3. Aprogress bar appears below. Once the upload is complete, the Folder Element form appears,
allowing you to edit the name of the file, if you wish. Once done, click OK.

File ltem

ImageFolderElement

Name: SmallwineGlass.jpg

Ok | | Cancel
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4. The File is now visible on the Asset List of the destination folder.

ERCE

Asset List

D Create New ™

= )
_\d More Actions ™

|:| Marme

E.l’ [..]

OOo0OoOoOoOoOoOo

= - Package00
= - Package(1
= - Packagel2
= - Packagel3
= - Packagel4
= - Packagels
= @LargeWineCIasststal.jpg

@ SmallWineClass. jpg

Uploading Multiple Files at One Time

Do the following to upload multiple files to the system:

1. Click on Create New > Upload Multiple Files.

ERCE

Asset List

D Create Mew

fé] Maore Actions ™

[y Mew Folder

] NewFile

] Upload Multiple Files

,.‘
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2. The Add Files pop-up window appears. Click on Browse to add files. An additional field will
appear below, allowing you to add more. You can upload up to five files at one time. One done
adding files, click Upload.
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Add Files ¥
C:\ Transfer\ SmallWineClass. jpg Browse...
C:\ Transfer\ MediumWineGlass.jpg Browse...
Browse...

3. A progress bar window will pop-up, showing you the progress of the uploads. Once complete, the
files will appear in the Asset List.

. Welcome, ady
EPISERVER COMMERCE Asset List
Welcome ™ Change Language About ™ (710
Asset Management !%‘ D Create New ™ 2] More Actions ™
I Root ] Name Size Created
Jvideo I

[_J Presentations

[ specifications | @Mediumwmeclass.jpg 12.04 KB Today, 2:51 PM
[CJsoftware = @Smal\WineCIass.jpg 14.22 KB Today, 2:51 PM
[_] Downloads
[_JUser Guides

:Ialmagas
] Package00

] Package01

] Package02

= ] Package03

e | Package04

# ] Package0s
| [ Glasses

Editing and Deleting Folders and Assets
Editing Folder and Assets Names
Folder and asset names can be edited by clicking on the Edit icon next to the Name.

D Create Mew ™ i] Mare Actions ™

Name
video

- Presentations

& Specifications
[ Software

- Downloads
- User Guides

%l’_‘l Images

This brings you to the Folder Item page, allowing you to editthe Name.

[ R
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Folder ltem

J Folder ltem

Mame | Images

OK Cancel

If you are editing an asset such as an image, the File ltem page appears, allowing you to edit the name
as well.

ERCE File Item
File ltem

ImageFolderElement

Name: LargewineGClassCrystal jpg

014 | | Cancel

Copying/Moving Folders and Assets

To copy or move an Asset or Folder to another location, place a check mark in the box next to the Folder
or Asset name and then click on More Actions > Move/Copy.

ERCE Asset List

r=
D Create Mew ™ <] More Actions ™

[ Name )( Delete Selected

[-] 3 Move/Copy ®J
- PackageQ0

- Packagel1
- Package02
- Package(3
= Package(4

= Package05s

EO0O0DDODOOO

@ LargeWineGlassCrystal.jpg
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The Move/Copy to Folder pop-up appears. You can select to "move" or "copy to folder." From the drop-
down menu, select the destination. Click on OK to confirm.

Move/Copy to Folder b4

i@ move or ") copy to folder: Ru:u:ut_."Presentaticun5| v|

| 0K | | cClose |

Deleting a Folder or an Asset

To delete a Folder or Asset, place a check mark in the box and click on More Actions > Delete Selected.

ERCE Asset List

D Create Mew ™ 21 Mare Actions ¥
[l Name ¥ Delete Selected '{bj—
= [ 5 Move/Copy

0 = - Package00

O = - PackageO1

O = - Package02

O = - Package03

O = - Package04

O = - Package0s

=Y @LargEWinECIasststal.jpg
Reporting
Introduction

Reporting offers some common type reports out-of-the-box, intended to be used as a support tool for e-
commerce managers.

The default reports include:
e Sales Report - an overview of the website sales performance over a period of time.

e Shipping Report - the shipping method, number of orders and total shipping cost over a period of
time.

o Best Sellers Report - shows which products are sold the most in terms of quantity and total reve-
nue over a period of time.

e Low Stock Report - shows which products are running low in inventory. If a product's inventory is
less than its reorder minimum quantity, it will be included in this report.
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The display of these reports can be filtered by date and time, and the reports can be exported to Excel
or PDF format, or printed.

You can also develop your own customized reports, refer to the EPiServer Commerce Developer Guide
for more information on how to work with reports to extend the functionality.

Working With Reporting
The work with reports includes the following tasks:

e Generating various reports based on e-commerce data such as sales quantities, order numbers,
shipping costs and inventory stock status.

e Filtering the view for displaying data for the desired time intervals.

e Exporting reports to various outputs such as Excel, PDF or print.

About SQL Reporting Services

Since EPiServer Commerce utilizes SQL databases, custom reports can also be created using Microsoft
SQL Server Reporting Services. Reporting Services provides a complete, server-based platform
designed to support a wide variety of reporting needs enabling organizations to deliver relevant infor-
mation where needed across the entire enterprise.

Refer to the technical documentation for SQL Reporting Services for more information on how to work
with this together with EPiServer Commerce.

Generating and Exporting Reports
Introduction

Reports for Sales, Shipping, Best Sellers, and Low Stock information can be generated by default. Data
can be customized and filtered and the final report can be exported to different formats. Reports are man-
aged under the Reporting option in the left menu.

Reporting .:}'
:IE;H Reporting
:l Sdles

J 5ales Report

J Shipping Report
:l Products

J Best Sellers Report

J Low 5tock Report

Generating a Report

To generate a report, click on Reporting and select one of the default reports available under Sales and
Products: Sales Report, Shipping Report, Best Sellers Report or Low Stock Report. The report display
will be generated.
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Sales Report

4 <
m
=
0O
m

Start Date: [5/7/2010 #1248 pm | End Date:5/7/2010 f#[1z48Pm | GroupBy: Day [=|[_Apply Filter |
4 4 I of1 b Pl 100% [=] Select a format [ Export [ =
Sales Report (05/08/2010 - 06/07/2010)
Period Num. Of Items Ordered Sub Total Tax Shipping Discounts Total Invoiced
Orders

05/08/2010 0 0 0 0 0 0 0 0
05/09/2010 0 0 0 0 0 0 0 0
05/10/2010 0 0 0 0 0 0 0 0
05/11/2010 0 0 0 0 0 0 0 0
05/12/2010 0 0 0 0 0 0 0 0
05/13/2010 0 0 0 0 0 0 0 0
[os/1472010 0 0 0 0 0 0 0 0

Filtering Report Data

To filter the data displayed, select the Start Date and End Date ranges and time. You can also group the
report data by "Day," "Month" or "Year." Once done, click Apply Filter. To regenerate the report after
changing the filtering, click the reload icon.

Below is an example of a Sales Report with a date range from 5/1/2010 at 6am to 6/7/2010 at 12pm
Grouped By Month.

MERCE Sales Report
ut T
Start Date: 5/1/2010 [ |06:00 AM | End Date: 57,2010 i 12:00PM | Croup By: | Month[+ ]
4 4 1 of1 P Pl 100% [+] Select a format  [w] Export k| =
Sales Report (May, 2010 - June, 2010)
Period HNum. Of Items Ordered Sub Total Tax Shipping Discounts Total Invoiced
Orders
May, 2010 0 0 0 0 0 0 0 0
une, 2010 5 10 41,316.61 0.00 52.00 0.00 41,370.61 41,370.61
5 10 41,318.61 0.00 52.00 0.00 41,370.61 41,370.61

Exporting a Report

When the report has been generated it can be exported as a file for further processing.To export a report
to a file, click on the Select a format option. By default reports can be exported either as Excel or PDF
files. Select a formatin the drop-down, click Export and Open or Save the file once the prompt appears.
Reports can also be printed by clicking the print icon.

Administration

Introduction

In the Administration part you will configure and administer many of the system settings used in EPiS-
erver Commerce. The settings configured here are both general settings used by the entire system, as
well as settings used by specific parts of the system such as Catalog and Order management.

The various configuration options are available from the Administration part of Commerce Manager.

Working With Administration

The work with system administration includes the following tasks:
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e Adding new languages, countries, currencies and return reasons to the e-commerce system,
which is done through so called Dictionaries.

e Tracking changes and monitoring system activities through the log features.

e Configuring common settings such as default language, currency, and length and weight units to
be used by the system.

e Customizing, creating and publishing business objects in order to extend the attributes of the Cus-
tomer and Asset Management systems, providing more flexibility for fields and attributes displayed
and collected.

e Define and activate new customized workflows after they have been set up in code.
e Updating the search index for the website to reflect changes to the product catalog.
e Customizing the left menu by adding your own menu items.

o Defining warehouses and tax categories, as well as meta classes and meta fields to be used by
the Catalog Management system.

e Defining payment gateways and shipping methods and providers, as well as configuring taxes
used by the Order Management system.

Refer to the EPiServer Commerce Developer Guide for more detailed technical information about con-
figuration settings.

System Settings

System Settings includes functionality for adding default system settings for language, currency, units
and meta data fields and classes, as well as many other general configuration possibilities.

The features can be accessed by selecting System Settings under Administration.

=

e

Administration

:IE Administration
=] Systemn Settings
=] Dictionaries

B Languages

B Countries
B Return Reasaons
=d Currencies
=i Logs
B Systermn Log
B Application Log
Commaon Settings
Business Foundation
Waorkflow
S5earch Index
Left Menu
# ] Catalog System
H_] Order System

E B B B =

In this section we will describe how to work with the options under System Settings.
Dictionaries

In EPiServer Commerce, dictionary values are used for defining languages, countries and currencies
used in the e-commerce process, as well as your own defined return reasons used in order management.
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This section explains how to add Languages, Countries,Currencies and Return Reasons to EPiServer
Commerce.

Adding Languages

By default English, German, Spanish, and French are available.

To add a new language, login to Commerce Manager and go to Administration --> System Settings -->
Dictionaries --> Languages.

Administration .,—E’

:IE Administration
=1"-] System Settings
=] Dictionaries
B Languages _n.m
B Countries R

B Return Reasons
ZH Currencies

Click New Language and fill in the following:

e Language Code - to obtain the correct language code, go to the MSDN site Table of Language
Culture Name, Codes, and ISO Values Method [C++].

e Friendly Name - this name is displayed in the front-end site language drop-down and various
Commerce Manager admin pages.

o Is Default - Yes/No.

MERCE Language Edit

r

Overview
Code: en-Us
Language code (for example, en-LU5%)

Friendly Name: English

Is Default: ) Yes @ No

| Ok || Cancel

Click OK to save the language.

Verify in the Default Language field under Common Settings that the new language is selectable from the
menu.

Adding Countries

To add a new country, login to Commerce Manager and go to Administration > System Settings > Dic-
tionaries > Countries.

Administration EE’

:l_-a_t- Administration
=i System Settings
=‘=] Dictionaries

B Languages

B Countries

B Return Reasons
< Currencies

Click on New Country and fill in the following displayed in the Overview tab:
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e Country Name - this is the friendly name that is displayed in the public site during the checkout
process

e Code - to obtain the correct country code, go to the MSDN site Table of Country/Region and
State/Province Names and Codes [C++] (use the ISO Short Code or ISO Long Code as long as
you remain consistent).

e Sort Order - enter a number starting from 0 (the lower number is listed on the top of the drop-
down)

e Visible - Yes/No.

ERCE Country Edit

-

Owverview Regions

Country Name:

Code:

sort Order: 0

Visible: 1 Yes i@ Na
014 || Cancel |

Regions refer to states, provinces or prefectures. In the Region tab, fill in the following:

e Type a Friendly Name (e.g. CA - this will be displayed in the public site during the checkout proc-
ess) and click Add. You can checkmark it either as Visible or not on the public site

Owverview Regions

New Region Name CA
Regions:
Edit Command Mame Ordering Visible
| X CA o
| QK || Cancel |

When you click the Edit icon, you can change the Ordering of the region. Click Update to save those
changes.

Regions:
Edit Command  Mame Ordering Wisible
Update | Cancel CA o

Adding Currencies

To add a new Currency, login to Commerce Manager and go to Administration > System Settings >
Dictionaries > Currencies.
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Administration =

dﬁ Administration
=15 System Settings
=¢=3 Dictionaries
B languages
B Countries

B Return Reasans

Zd Currencies
H[J Logs

Click on New Currency. Fill in the following displayed in the Overview tab:

e Currency Name - this name is displayed in the front-end public site currency drop-down and var-
ious Commerce Manager administration pages.

e Code - currency codes can be obtained from htfp./en.wikipedia.org/wiki/ISO_4217#Active_codes.

MERCE Currency Edit

L

Overview Rates

Currency Name:
Code:

Modified:

Ok || Cancel

In the Rates tab, you can Add Rates which are the foreign exchange rate when you want to convert from
one currency to another.

Owerview Rates

Add Ra%

Edit Command  Currency  Rate Rate Date Modified

| (o] || Cancel |

In the Edit Currency Rate Information dialog enter the following:
e To Currency - select from the drop-down the currency to convert to from the current currency.
e End of Date Rate - enter the End of Day rate.
e Average Rate - enter the Average rate.
e Currency Rate Date - enter a Currency Rate Date.

Click Save Changes.

Edit Currency Rate Information v
From Currency: Australian dollar (AUD)

To Currency: Canadian dollar IZ|

End Of Day Rate:  |0.0000

Average Rate: 0.0000

Currency Rate Date:5/25/2010 ﬁ 11:25 AM

Modified: 5/25/2010 11:25:12 AM
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Managing Return Reasons
Introduction
Out of the box, the three return reasons in EPiServer Commerce are "Faulty," "Incorrect ltem," and

"Unwanted Gift." More return reasons can be added or customized so that when a Customer Sales Rep-
resentative (CSR) processes a return, more return reasons are available via the drop-down menu.

Administration =

:IE Administration
=] System Settings
=‘=] Dictionaries
E Languages

B Countries

E Return Reasons

Zd Currencies

Creating a New Return Reason
1. To add a new return reason, go to Administration > System Settings > Dictionaries > Return
Reasons. The Return Reasons screen appears.
2. Click New Return Reason. The Return Reason Edit screen appears.

3. Once done, click OK. The new return reason appears on the list.

LT

Return Reason Enter a friendly name, such as "Changed Mind".
Sort Order The lower the value, the higher the position the return reason is on the list screen.

Visible Select Yes (to enable to return reason) or No (to disable it).
Editing and Deleting a Return Reason

e On the Return Reasons list, click on the Edit icon. Make any edits to the Return Reason name,
Sort Order, and its Visibility and then click OK to save your changes.

e To delete an individual Return Reason, click on the Delete icon. To delete multiple return reasons
at one time, check-mark the box next to the Return Reason and then click More Actions > Delete
Selected. Confirm your selection by clicking OK.

Logging

Introduction

Logs contains the system log and application log. These logs track the activities of made within the EPiS-
erver Commerce system. This is useful for troubleshooting purposes and if you want to track events and
changes in the system during a specific time period.

In the database, the logs are recorded in the dbo.ApplicationLog table. For details on how to set up and
configure the logging features, refer to the Developer Guide for EPiServer Commerce.

The log features are available under Administration, System Settings and Logs, in the left column.
System Log

The System Log keeps a detailed track of system-related activities within EPiServer Commerce. Here is
where you would be able to view any errors that occur in the system as well to find out more details about
it.
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You may filter these logs to show more detail by filtering by Operation, Object Type, or the Created
Before date and time and clicking Apply Filter. You may also use Export Log for your records after you
have filtered for the desired data. The More Actions drop-down includes options to Delete Selected or
Delete All to remove log items.

EPISERVER COMMERCE System Log

Welcome ™ Change Language About ™

Administration ]

5 Filter Settings
S Administration Operation
=3 System Settings Object Created 5/22,2012 ]
# (] Dictionaries Type Before: 1145 AM Apply Filter
3G Loos B export Log [ More Actions ™
[ B System Log
[7] |Operation | Object Key Object Type User Name Created Notes
@ Application Log
® Common Sertings [ oG login.aspx Commerce Manager admin Today, 11:14 AM
B Business Foundation [ oG login.aspx Commerce Manager admin Today, 10:18 AM
B Workflow Yesterday, 4115 Front &n
B Sernins [[] erroR HandleException Mediachase.Cms.CmsHttpModule D;’ erday. 4: Mediach
earch Index b ocp
B Left Menu Yesterday, 3:34 Backenc
] ERROR HandleAdminExceptior Mediachase.Cms.CmsHttpModule admin esterday. 3: Mediach
® [ Catalog System PM Koy s
@ (] Order System :
| — =k [ oen login.aspx Commerce Manager admin :;“E""V' 2:04

Application Log

The Application Log by default tracks changes made in the Catalog Management system. For example,
when you add a SKU to a catalog, it gets logged here. This is the default behavior of the application log
and can be configured and extended to track and log other sources as well.

You may filter these logs to show more detail by filtering by Source Type, Operation, Object Type, or the
Created Before date and time and clicking Apply Filter. You may also use Export Log for your records
after you have filtered for the desired data. The More Actions drop-down includes options to Delete
Selected or Delete All to remove log items.

EPISERVER COMMERCE Application Log

Welcome ™ Change Language About ™

Administration 2 || Filter settings

=T Administration Source Type: Object Type
=) System Settings Operation Created Before: [5/22/2012 B i4saM Apply Filter
] Dictionaries
=3 Logs
@ System Log

2 ExportLog (@ More Actions ™

] Source Operation  Object Key Object Type User Name Created
= Application Log
B Common Settings [[] catalog Modified 2763 entry sdmin Ry
o Buei
S ass e s [[] catslog Modified 2763 entry admin 2{;1{531
B Search Index [F] catalog Modified 2769 entry =dmin Sizinn
B Left Menu [[] ecatalog Modified 2781 entry sdmin 428201
@[] Catalog System
[[] catalog Modified 2781 entry admin 4/26/201
#H [ Order System 2:54:52

Configuring Common Settings

Introduction

Under Common Settings you are able to select your default language, currency, length unit, and weight
unit. When the defaults are set and saved, parts of Commerce Manager where you select the language,
currency, length unit, and weight unit default to those settings.

Defining Languages, Currencies and Length/Weight Units

To set your default language, currency or unit, login to Commerce Manager and go to the Administration
--> System Settings --> Common Settings and make the appropriate selections.
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&

Administration

:I_-ﬂj Administration
=l System Settings
=] Dictionaries
=] Logs
B Common Settings

Business Foundatian
Warkflow

Search Index

Left Menu

=] Catalog System

=[] Order System

B B B &

Out of the box, you have the following options:
e Language - English, German, Spanish, French.
e Currency - US dollars, Canadian dollars, Euros, Yen, Pound sterling and many others.
e Length units - meters, feet.

¢ Weight units - kilograms, pounds.

Commeon Settings

Owverview

Default Language: | English (United 5tates)E|
Language that will be selected by default in drowdowns, etc.
Default Currency: us dollar
Currency that will be used is cases where currency is needed but not specified

Default Length Unit: | Faat E‘
Default unit of length

Default Weight Unit: | paunds IE‘
Default unit of weight

OK || Cancel

Click OK to save your changes.

Business Foundation

Business Foundation allows you to extend the attributes of the Customer and Asset Management Sys-
tems to give you move flexibility on the fields and attributes displayed and collected. Business Foundation
works with the meta data engine to allow no-code customization of the data model. Using this you can
define new objects and relations between them within the Customer Management and Asset Man-
agement systems.
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Configuration

Welcome, admin

Welcome ¥ Change Language About ¥

1@ Get Help For This Page

inistrati £
Qdminisization || [QcreateNew~ | [ZExportmport~
=S Administratian
Show:  All -
3 system Settings
50 Dictionaries System Name Friendly Name Plural Name Type
907 Logs &3 Address Address Addresses Info
0 @IS &4 Contact Contact Contact Info
® Eusiness Foundation &4 CreditCard Credit Card Credit Cards Info
© Warkflow 3 Customizationitem Customization Item Customization Item Info
B Search Index frde temArgument Ci Item Argument Customization [tem Arguments Info
B LeftMenu &3 CustomPage Custom Page Custom Pages Info
B Catalog System &5 Folder Folder Folder Info
H(] Order Syst
o se &4 FolderElement Folder Element Folder Element Info
3 GiftCard Gift Card Gift Cards Info @ X
mageFolderElement mageFolderElement mageFolderElement are
5 ImageFolderEl ImageFolderg! ImageFolderl card
& Organization Organization Organization Info
3 PafFolgerElement PdfFolderElement PdfFoldzrElement carg
%5 RecentReferencetiistory User Recent Reference User Recent References Info

The form is fully customizable so you can define layout and specify which fields you want to display. You
can also work with system fields. Common examples of how users leverage Business Foundation are set-
ting a standard height and width for an image file uploaded to the Asset Management system, or creating
a "Gift Card" field within the Customer Management system used to track how much a customer has left
on their gift card.

@

In the following we will describe how to work with the features in Business Foundation.

The currentimplementation of Business Foundation only supports the Customer and Asset
Management subsystems.

Creating Business Objects
Introduction
Creating business objects allows users to extend customer and asset forms for tracking and relating dif-

ferent types of data. New business objects can be created to suits a multitude of business purposes. In
this example we will describe how to create a "Contract” business object.

Creating a Contract Object

Do the following to add a contract business object:

1. Go to Administration, expand System Settings, and click on Business Foundation to access the Busi-
ness Foundation Configuration page.

2. Click Create New and select New Business Object. The New Business Object dialog appears.

Welcome, admin

Configuration

wt T @ Get Help For This Page ¥

EJ Back To L\st|

New Business Object

Base Info Field Info

System Name: Contract System Name: Contract

Friendly Name: Contract Name @ Friendly Name: Contract Name &
Plural Name: Contract ) Maximum Length- |100

D Supports Extensions

® Cancel

+" Save | ‘

Enter information as described below.
Base Info

e System Name: name of the Business Object (once you input a name, the Friendly Name and Plu-
ral Name fields are auto-populated).

e Friendly Name: alternative to the System Name.
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e Plural Name: plural version of the system/friendly name for example inventories.

e Supports Extensions: this allows you to extend an existing meta class with extra properties. For
example, you can have a download class and you can extend it with "imagedownload" which con-
tains width and height as extra parameters.

Field Info
o System Name: enter a system name.
e Friendly Name: enter a friendly, front-end name.
e Maximum Length: maximum number of characters allowed in this field.

3. Click Save to save the changes. You will now see the details of your newly created business object.

Busi Object C 5 New Field Edit | 23 Publish | [£J Back To List
System Name: “I% Contract Friendly Name: Contract Name
Type: Business Object (Public) Plural Name: Contract
| Fields || 1:N Relations || MN:1 Relations || M:N Relations || Forms || System Views
System Name Friendly Name Type
4" Contract Contract Name Text
2¥ Contractld Id Cuid

Next Steps

Add fields to the contract business object as needed, refer to Adding Fields to Business Objects. To fur-

ther customize a business object, refer to Customizing Business Objects.
Customizing Business Objects
Introduction

A standard installation of EPiServer Commerce includes a number of business objects that can be edited
and customized. Customizing existing business objects is a good starting point to model business objects
for your needs.

Editing and Deleting Business Objects

Many of the default business objects and related fields can be both edited and deleted but not all of them.
For example, pre-existing business objects such as "Address" and "Organization" cannot be deleted, only
edited. Business objects that can be edited and deleted will have an Edit and Delete icon next to them.

ERCE

Configuration

(7] Cet Help For This Page :‘

DCreabe Mew - gExporthmportv
Show: Business Object -

System Name Friendly Name Flural Name Type
4% Address Address Addresses Info
4% Contact Contact Contact Info
4% CreditCard Credit Card Credit Cards Info
&% Customizationitem Customization Item Customization Item Info
-JgCustnmlzatmn\temArgument Custamization [tem Argument Customization Item Arguments Info
-33 CustomPage Custom Page Custom Pages Info
4 Folder Folder Folder Info
4% FolderElement Folder Element Folder Element Info
“3 GiftCard Gift Card Cift Cards Info = ¥
@4 MyCard MyCard MyCard Infa ®
“% NewCard MNewCard NewCards Info &= ¥
;@Organization Organization Organization Info
ﬁRecentReferenceHistory User Recent Reference User Recent References Info
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Editing and Deleting Fields of Business Objects

Fields that can be edited and deleted will have an Edit and Delete icon next to them.

& CreditCardNumber Card Number Text

W CustomerServicePhoneNumber Customer Service Phone Number Text Y X
av ExpirationMonth Expiration Month Integer
av ExpirationYear Expiration Year Integer

Fields that are locked cannot be edited, for instance Field Name and Field Type in the image below.

Edit Field

EJ Back

Business Object:
Field Name: Format: Text
Friendly Name:

Description:

Credit Card Field Type: String

Customer Service Phone Number @ Maximum Length:
Phone # found on back of card =~

+ Save RA | * Cancel

Update the fields that are unlocked and click Save to save the changes to the business object.

Adding Fields to Business Objects

Introduction

Existing Business Foundation objects can be customized to have additional data entry fields. For exam-
ple, you can add fields to the New Credit Card form builtinto Commerce Manager.

Adding Fields to a Business Object

Do the following to add fields to an existing business object:

1.

Click on Administration, expand System Settings, and click on Business Foundation to access
the list of Business Foundation objects. In this example, the CreditCard Business Object is used.

Welcome, admin

Configuration

(7] Get Help For This Page A?

D Create New ﬁ Export/Import

Show: Al -

System Name Friendly Name Flural Name Type
4% Address Address Address Info
4% Contact Contact Contact Info
4% CreditCard Credit Card CreditCard Info
3% Customizationitem Customization ltem Customization ltems Info
33 CustomizationltemArgument Customization [tem Argument Customization Item Arguments Info

-33 CustomPage Custom Page Custom Pages Info
% Folder Folder Folder Info
3 FolderElement alderElement olderElement nfo
4% FolderEl FolderEl FolderEl Inf
“§ CiftCard Cift Card Cift Cards Info =
mageFolderElement mageFolderElement mageFalderElement ar
& FolderEl I FolderEl | FolderEl Card
33 Organization Organization Organization Info
olderElement olderElement olderElement ar
4l PdfFolderEl PdfFolderEl PdfFalderEl Card
User Recent Reference User Recent References Info

33 RecentReferenceHistory
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2. Click on the business objectin the list to open it for editing. To add a new field to the CreditCard
Business Object (or any other Business Object), click on New Field.

Busi Object C izati = New Field Edit | 23 Publish | £ Back To List
Systemn Name: 33 CreditCard Friendly Name: U Credit Card
Type: Business Object Plural Name: CreditCard
| Fields || 1:M Relations || MN:1 Relations || MN:N Relations || Forms H System Views |
System Name Friendly Name Type
jv Address Address Text (ReferencedField)
£ Addressid Address Reference
&% CardType Type CreditCardType
jv Contact Contact Text (ReferencedField)
3 Contactld Contact Reference
av Created Created DateTime
av Creatorld Creator Guid
av CreditCardld Id Guid
4 CreditCardNumber Card Number Text
aY ExpirationMonth Expiration Month Integer
aY Expirationear Expiration Year Integer
aY LastFourDigits Last Four Digits Text
4 Modified Modified DateTime
&% Modifierld Maodifier Cuid
jv Organization Organization Text (ReferencedField)
=] Organizationld Organization Reference
av SecurityCode Security Code Text

3. The New Field form allows you to specify the type of data field you want created for the business
object.

New Field EJ Back
Business Object: Credit Card Field Type: String E|
Field Name: CustomerServicePhoneNumber Formar- Text [=]
Friendly Name: CustomerServicePhoneNumber @ Maximum Length: 100
Description: e

D Unique value

[¥] attow Nults [ save | [ % cancel

Add Field To: Edit Form
View Form
Short Info Form

Enter a Field Name, which is the system ID or name of the field. The Field Name that is entered
auto-populates the Friendly Name field.

Since the Friendly Name is auto-populated based on the Field Name, you can either keep the
name the same or change it. The Friendly Name is what appears on a form (such as the Credit
Card form).

You can optionally enter in a Description that appears below the data entry field to explain the
field to the user.

Checkmark on or off to Allow Nulls for this field.

You can choose to Add Field To an existing Form. Checkmark all that apply.

Enter a Field Type. For further explanation of each Field Type, refer to the Reference Section on
the bottom of this page. In this example, a String field type is used.

The Format drop down menu and options depend on your Field Type selection. In this example,
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Text is selected as the field format, with a Maximum Length of 100. Unique value is left
unchecked.

4. Once done, click Save. The new field appears on the list of fields.

& CreditCardld Id Cuid
¥ CreditCardNumber Card Number Text

W CustomerServicePhoneNumber Customer Service Phone Number Text .
av ExpirationMonth % Expiration Month Integer

5. To verify if the new field appears, check the form associated with that new field. Since this exam-
ple customized the New Credit Card form, you will see that the new field appears.

MNew Credit Card *

— Overview

Type: Visa =] &
Last Four Digits: Expiration Month: [Novalue]l [+]
Card Number: Expiration Year: [Novalue] [+]

Security Code:

Customer Service
Phone Number:

+ 0K || A Cancel

Customizing Forms

Introduction

Forms dictate how fields are presented to the EPiServer Commerce user when viewing and editing infor-
mation in the system. Every field is associated with a form, and each business object is associated with
one or more types of forms. Some common types of forms found are the Edit Forms, Short Info Forms,
and View Forms. For example, the New Credit Card form looks like this:

New Credit Card *

— Owverview
Type: Visa E| B
Last Four Digits: Expiration Month: [ No value ] [=]
Card Number: Expiration Year: [ No value ] [=]

Security Code:

Customer Service
Phone Number:

| n Ok | | Cancel |

In this section we will describe how you can customize forms and adapt them to the specific needs of your
EPiServer Commerce users.
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Editing Forms

By editing the form, you can change the layout, add new fields and sections, and more.

To edit an existing form, click on a Business Object and click on the Forms tab to see the list of asso-
ciated forms.

Busi Object C izati = New Field | =/ Edit | 23 Publish | [E Back To List
System Name: 33 CreditCard Friendly Name: Credit Card
Type: Business Object Plural Name: CreditCard

Fields || 1:M Relations H MN:1 Relations H N:N Relations H Forms || System Views

Name

Edit Form

Short Info Form

View Form

Click on the Edit icon next to the form you want to make changes to. The form customization window pops
up.
Common Tasks foReaeate Form | &€t Form | [Esave +

Table: Credit Card Form: Edit Form

Add™ | f 4 4= = | ZfEdit | X Remove ‘

Overview
Type
Last Four Digits Expiration Month
Card Number: Expiration Year:
Security Code

Customer Service
Phone Number:

There are various functions available to edit and customize a form.
Editing the Layout

You can change the layout and the fields that appear on the form.

1. Click on Edit Form.
a. Select a View Type (or the layout of the form). You have a choice between a Two Column (1:1,
1:2,2:1), or Three Column (1:1:1) layout.
b. Enter in a pixel value for the Cell Padding, or spaces between each cell.

2. Click Save to confirm your changes.

This example uses a Two Column (1:1) layout.
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Common Tasks ‘5 Recreate Form pEdit Form Hsave -
7
'_r,é eCommerceFramework - Windows Intern... L= —iS—

Table: Credit Card

Add + 4 & =» | =E |§. ht'tp:-'-'Ecf.episer\.rer.(0m-'.-;-ppz-'l'detaDataBazE:l'»'1etaUI-'Pagez-| |
[=H

Edit F:
~— Owverview it Form

You can edit form.
Type:
Last Four Digits: Table: Credit Card
Card Number:

Form: Edit Form
Security Code:
Customer Service View Type:
Phone Number:

'@' Two Columns (1:1)

©) Two Columns (1:2)

©) Two Columns (2:1)

(©) Three Columns (1:1:1)

Cell Padding: 5

Save Cancel

0 Internet | Protected Mode: On v H100% v

Adding Sections and Fields
Once your layout is set, you can add additional sections and/or additional fields.
1. Click on Add --> Add Section to add a new section. Adding sections allows you to separate and
divide groups of fields on a form with their own header and border.
2. Enterin a Title for the section.

3. Checkmark the box next to "Show border line for this section" if you want to show the border
around section. Otherwise, uncheck the box to hide the border.

4. Checkmark "Show the name of this section on the form" if you want to show the title of the section
on the form. Otherwise, uncheck the box to hide the title.

5. Selecta View Type or layout of the section: One Column, Two Columns (1:1), Two Columns (1:2),
Two Columns (2:1)

6. Enter a numeric pixel value for Cell Padding or amount of space between each cell in the section.

7. Click Save to save your changes.
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7 -
& eCommerceFramework - Windows Intern... L= E

€] http://ecf.episerver.com/Apps/MetaDataBase/Metalll/Pages;

Commen Tasks

Table: Credit Card

Addv|| f¢ P 4= = | Edit | ¥ Rem
Add section |
% AddField

Last Four Digits:
Card Number:

Security Code:

Customer Service
Phone Number:

Add Section
Add a new section to the form.

Title: Credit Card 2|

Show border line for this section.

Show the name of this section on the form.

View Type:
@ One Column '
) Two Columns (1:1) |

©) Two Columns (1:2) _'

) Two Columns (2:1

Cell Padding: o

Save Cancel
0 Internet | Protected Mode: On v H100% v

You can edit a section by clicking on a section and click on Edit.

Common Tasks 5 Recreate Form [ZpEdit Form Hsave -
Table: Credit Card Form: Edit Form
adv | ¢ 3 & |

Last Four Digits:
Card Number:
Security Code:

Customer Service
Phone Number:

Expiration Month:

Expiration Year:

( Credit Card 2
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Within each section are fields. You can add new fields to a specific section by highlighting the section and

then by clickin

g Add --> Edit.
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Commeon Tasks E Recreate Form gﬁdit Form u Save -

Table: Credit Card Form: Edit Form

4+ ¥ 4« = | =fedt | X Remove |

E2| Add Section

| @ Add Field &l

Last Four Digits Expiration Month:

Card Number: Expiration Year:
Security Code:

Customer Service
Phone Number:

Credit Card 2

(Last Four Digits

Select an existing associated field in the dropdown menu.
a. Checkmark the "Field is Read Only" box if you want the field to be unavailable for edit. When you see
the rendered form, the field will be grayed out.
1. Selectthe "ltem label showing on the form."
2. e Hide Label: No label appears next to the text box
e System Label: Shows the system name next text box
e Custom Label: Enter in a custom label
3. Enterin a Label Width numerical value. Defaultis 120px.
4. Tab Index: enter an index for the tab.

5. Selecta View Type, either a One Column or Two Column. In the dropdown, enter in the number of
text box rows, up to 3.

6. Click Save to add the field to the section.
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Common Tasks
Table: Credit Card
add~ | ¢ & ¢ = | @Edit | X Rem

.
& eCommerceFramework - Windows Intern... Elilg

| €| http://ecf.episerver.com/Apps/MetaDataBase/Metall/Pages/

Last Four Digits:
Card Number:
Security Code:

Customer Service
Phone Number:

Add Field
Add a new form item to the form.

Field: Organization -

[T Field Is Read Only

( Credit Card 2

Eem label showing on the form.
() Hide Label
@ System Label

(Z) Custom Label

Label width: 120 px
Tab Index: ]
View Type:
. —T—]
@ One Column | —
| — —
. | — —
) Two Column |
| — —
Rows: 1 -
Save | Cancel

v ®100% v

€ Internet | Protected Mode: On
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[FéfEdit Form Hsave

To edit a field, click and highlight the field and click on Edit to change your previous settings.

Common Tasks

Table: Credit Card

E Recreate Form

Form: Edit Form

[#pEdit Form EHsave ~

Last Four Digits:
Card Number:
Security Code:

Customer Service
Phone Number:

Expiration Month:

Expiration Year

Credit Card 2
(Drgan ization:

You can re-arrange fields on a form but using the arrow controls on menu bar.

click on the directional arrow you want the field to move to.
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Common Tasks ’E Recreate Form @dit Form n Save v
Table: Credit Card Form: Edit Form
Add ~ 4+ ¥ <= = | =5'edt | X Remove |
Overview
Type:

Last Four Digits:
Card Number:
Security Codp:

Customer Service
Phone Number:

Expiration Month:

Expiration Year:

|~ Credit Card 2
i (Organizat\on:

In this example, the "Security Code" field is moved to the right where the "Customer Service Phone
Number" field is placed by clicking on the right directional arrow. Fields are moved from cell to cell within

a section.

Common Tasks

Table: Credit Card

Form:

Edit Form

’i?_§| Recreate Form

[ZEdit Form

n Save v

Add

Type:
Last Four Digits:

Card Number:

Customer Service
Phone Number:

Expiration Month:
Expiration Year:

Security Code:

|~ Credit Card 2
i (Organizat\on:

Deleting Sections and Fields

To delete a section or field, highlight either one and click on Remove. A popup will appear. Click OK to

confirm deletion. Otherwise, click Cancel.

Common Tasks ‘5 Recreate Form [#fEdit Form Esave ~
Table:- Credit Card Form:- Edit Form
Adv | ¢ § & = | FHEdit | (X Remﬂve
Overview
Type:

Last Four Digits:
Card Number:
Security Code:

Customer 5ervice
Phone Number:

Expiration Month:

Expiration Year:

' |~ Credit Card 2
i (Drganiza:ion:
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' B
Message from webpage M

| Do you really want to delete selected section?

[ ok || Concel

Recreating a Form

Recreating a form allows a user to create a form from scratch with a single field rather than customize a
form with all fields already in place. Click on Recreate Form on the upper right corner of the window.

Common Tasks t! Recreate Form| | &Edit Form Hsave +

Table: Credit Card Form: Edit Form

add~ | 4 4 & = | SEdt | ¥ Remove ‘

Overview
Type
Last Four Digits: Expiration Month
Card Number: Expiration Year:
Security Code

Customer Service
Phone Number:

A popup will appear. Click on OK to recreate the form. Otherwise, click Cancel. Once you confirm, the
fields will clear from the form except for the required field.

Common Tasks ‘EIRecreate Form [#¥pEdit Form Hsave ~
Table: Credit Card Form: Edit Form

Adv | ¢ § & = | Fedt X Remove ‘

Saving a Customized Form

Once you are done with your changes, click on Save on the upper right corner of the window. To save
and close the window at the same time, click the down-arrow next on the Save button and on the drop-
down click Save and close.
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Common Tasks “f5 Recreate Form [FEdit Form H save I -
Table: Credit Card Form: Edit Form
Add~ | § § <= = | @Edt | ¥ Remove 2 saveand cloze

Overview
Type:
Last Four Digits: Expiration Month:
Card Number: Expiration Year:

Security Code:

Customer 5ervice
Phone Number:

Once those changes are saved, the form you edited will render based on your configuration. For exam-
ple, here is the customized Credit Card edit form an end user sees.

New Credit Card it

— Owerview

Type: Wisa [=] ff'l
Last Four Digits: Expiration Month: [ No walue ] [=]
Card Number: Expiration Year: [ No wvalue ] [=]

Customer Service

Phone Number: Security Code:

~— Credit Card 2

Organization:
{Customer.CreditCard_mf Qrganization_Description)

Relating Business Objects

Business objects must be related to other business objects to be able to connect, track and record rel-
evantdata. This is where the concept of Relations is used in Business Foundation.

Relations can be of these types:

e 1 to Many Relationship - 1 object can be associated or related with multiple object-related data.
For example, one organization can be associated with multiple contracts.

e Many to 1 Relationship - Multiple object-related data can be associated or related with a single
object. For example, multiple contacts can be related to a single organization.

e Many to Many Relationship - Multiple object-related data can be associated or related with mul-
tiple objects. For example, different SKUs can be associated with one or more warehouses for
tracking and storage.

In the following we will describe how to create the various types of relationships between business
objects.

Adding a 1 to Many Relation

Business Foundation objects allows you to specify 1 to Many Relationships. For example, if you have
one organization, you can relate many types of data to that organization, such as multiple contacts,
addresses, or organizational units or divisions within an organization. Within a 1:N relationship, the busi-
ness object you selected will be "1."

In the example below, 1 = Organization and N = related objects such as Address, Contact, CreditCard etc.
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To add a 1 to many relationship to a business object, you will need to create a new business object or
use an existing one. On the Business Object Customization page, click on 1:N Relations.

) . Welcome, Manager
ERCE Configuration

) Get Help For This Page -

Busi; Object C izati = New Field Edit | 23 Publish EJ Back To List
System Name: 33 CreditCard Friendly Name: Credit Card
Type: Business Object Plural Name: CreditCard
| Fields || 1M Relatlorwg.L || N:1 Relations || MN:M Relations H Forms H System Views
System Name p Friendly Name Type
:,v Address Address Text (ReferencedField)
g Addressid Address Reference
2" CardType Type CreditCardType
3\4 Contact Contact Text (ReferencedField)
g4 Contactld Contact Reference
8" Created Created DateTime

Click on New Relation "one to many" to create a new relation.

Object C izati =] New Field Edit | 2 Publish | [£ Back To List
System Name: 33 Organization Friendly Name: Organization
Type: Business Object Plural Name: Organization
‘ Fields || 1:N Relations H N:1 Relations || N:N Relations || Forms || System Views

yE New R@tmn “one to many”|

MName Primary Object Related Object
G Address Organization Address
g Contact Organization Contact
G CreditCard Organization Credit Card =
= Organization Organization Organization =

Under General Info, the Primary Object Organization is automatically set to Organization.

1. Select a Related Object to relate an the Organization object in the dropdown.

2. The Object section below General Info will have a different title based on Related Object you
selected. For example, if you selected "Address," the title would be "Object 'Address™.

3. Enterin a Field Name and Friendly Name. They are auto-populated already using the system
name of the business object.
Both names must be unique and not be the same as an existing field. The Field Name cannot con-
tact spaces or special characters, only letters, numbers, and underscores.

4. Checkmark the box Allow Nulls if you do not want this to be a required field the user fill in while
editing a form. Otherwise, uncheck the box to make it a required field.

5. Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).

6. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box.
Additional options such as Display Text and Display Order will appear based on your dropdown
menu selection.

7. Once all the relevant information is entered, click on Save.

© EPiServer AB



188 | User Guide for EPiServer Commerce 1 R3

Relation 1:N

— General Info

Primary Object: Organization

Related Object: Address El

~— Object "Address”

Field Name: Organization
Friendly Name: Organization

Allow Nulls
Add Field To: Edit Form

View Form
Short Info Form

~— Object "Orgamnization™

Display Region: [ Not Set ] El

| + Save | | ¥ Cancel

O The Related Object will have the Primary Object appear under the opposite relationship (N:1)
on its configuration form. For instance, if organization is the Primary Object and the Related
Object is Address, the relationship is automatically generated under the N:1 tab in Address.

Welcome, admin

Configuration

@ Get Help For This Page %

Business Object Customization 43 New Field | &= Edit | 23 Publish | £ Back To List|
System Name: 4z Address Friendly Name: Address

Type: Business Object Plural Name: Address

[ Fietds ][ 1:NRelations || n:l Relations || N-NRefations |[ Forms || system Views

"5 New Relation "ane to many’

Name Primary Object Related Object

. Contact Address Contact =
@ e
i Contact Address Contact =
i@ CreditCard Address Credit Card E

Adding a Many to 1 Relation

You can relate business objects via a Many to 1 Relationship. For example, you can relate multiple con-
tacts to a single organization or unit.
In the example below, N = Organization and 1 = related objects such as Parentld, PrimaryContactld etc.

To create Many to 1 relationships, click on a business object and click on the N:1 Relations tab.

e, Manager

ERCE Configuration

@ Get Help For This Page %

Busi Object C izatis ’E’_E| Mew Field | Edit | éﬂJJ Publish | Back To List
System Name: jg Organization Friendly Name: Organization
Type: Business Object Plural Name: Organization
| Fields || 1:M Relations H N:1 Relations || N:N Relations || Forms || System Views
System Name Friendly Name Type
.:;v BusinessCategory Business Category BusinessCategory
¥ Created Created DateTime
.Li‘V Creatorld Creator Guid
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Click on New Relation "Many to one" to create a new relationship.

Busi Object C izati = New Field Edit | 22 Publish | [ Back To List
System Name: ;3 Organization Friendly Name: Organization

Type: Business Object Plural Name: Organization
| Fields H 1:M Relations || N:1 i || N:N Relations || Forms || System Views

;El Mew Relation “many to one”
System Name Name Primary Object Related Object @
P Parentld Parent Organization Organization =
e PrimaryContactld Primary Contact Contact Organization

The Relation N:1 form is very similar to the Relation 1:N form, except you can select the Primary Object
from the dropdown, whereas the Related Object defaults to the name of the Business Object.

Under General Info, the Primary Object Organization is automatically set to Organization.

1. Selecta Primary Object to relate an the Organization object in the dropdown.The Object section
below General Info will have a different title based on the Related Object name.

2. Enterin a Field Name and Friendly Name. They are auto-populated already using the system
name of the business object.

Both names must be unique and not be the same as an existing field. The Field Name cannot con-
tact spaces or special characters, only letters, numbers, and underscores.

3. Checkmark the box Allow Nulls if you do not want this to be a required field the user fill in while
editing a form. Otherwise, uncheck the box to make it a required field.

4. Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).

5. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box.
Additional options such as Display Text and Display Order will appear based on your dropdown
menu selection.

6. Once all the relevantinformation is entered, click on Save.

Relation MN:1

~— General Info

Primary Object: Address El

Related Object: Organization

— Object "Organization”

Field Name: Address

Friendly Name: Address
Allaw Nulls

Add Field To: Edit Form

View Form
Short Info Farm
System View (All organizations)

~— Object "Address”

Display Region: [ Mot Set ] E|

| + Save | | *# Cancel
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O Like an 1:N relationship, if you create a N:1 relationship with a Primary and Related Object, a
1:N relationship is automatically generated for the Primary Object under the 1:N tab.

Adding a Many to Many Relation

You can also create Many to Many Relationships with business objects. For example, many to many rela-
tionships help to track different SKUs and their inventory levels with different warehouse locations.
Another example is multiple contacts a part of multiple organizations. A Many to Many relationship
between two objects is also referred to as a Bridge.

In the example both Organization and Organization_Contact = N.

To create a Many to Many relationship, click on a business object and then click on the N:N Relations
tab.

Welcome, Manager

Configuration

0 Get Help For This Page A;

Busi Object C izati = New Field Edit | £ Publish | [£] Back To List
System Name: ;3 Organization Friendly Name: Organization
Type: Business Object Plural Name: Organization
‘ Fields H 1:N Relations || N:1 Relations || MN:N Relatiunsnh” Forms H System Views
System Name :'\eﬂ\trri!' Name Type
57 BusinessCategory Business Category BusinessCategory
5" Created Created DateTime
a¥ Creatorld Creator Cuid
5* Description Description LongText
5% Modified Modified DateTime

Click on New Relation "many to many" to create a new N:N relationship.

Object C izati =) New Field Edit | 23 Publish | [ Back To List
System Name: _{3 Organization Friendly Name: Organization
Type: Business Object Plural Name:- Organization
Fields H 1:N Relations || N:1 Relations H N:N {{ || Forms || System Views
E New Relation “many to many”|
L

The Relation N:N is much different compared to the Relation 1:N/N:1 forms.

1. The Current Object defaults to the name of the Business Object you are editing
2. Select a Related Object from the dropdown menu

3. The Relation Name is auto-populated by (Current Object Name_Related Object Name). Change
this name if you wish, but you cannot have spaces or special characters, only letters, numbers,
and underscores.

4. Enterin a Friendly Name, which can have special characters and spaces. Make sure both Rela-
tion and Friendly Names are unique do not already exist.

5. Under Current Object, select a Display Region where the field will appear.

6. Under Related Object, select a Display Region where the field will appear.

Once all the relevant information is entered, click on Save.
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Relation N:M

Ceneral Info

Current Object: SKUs

Related Object: SKU_Warehouse El
Relation Name: SKUs_Warehouse

Friendly Name: SkKUsS5KU= Warehouses

Current Object (SKUs)

Display Region: Information El
Display Text: SkUs Warehouses
Display Order: 10000

Related Object (SKU_Warehouse)

Display Region: Information El
Display Text: SKU=s
Display Order: 10000

| " Save | | ¥ Cancel |

O A many to many relationship is automatically generated for the related object when you click
on its N:N tab under its configuration form.

Publishing Business Objects

Introduction

Another feature of Business Foundation is the ability to publish objects within the left navigation as a
node. You can essentially add more functionality to a specific system without modifying code. Before pub-
lishing you can set proper access permissions for the business object, controlling which user groups will
have access to use the business object

For related information refer also to the section Customizing the Left Menu.
Setting Permissions and Publishing
Click on Publish on the Business Object Customization page.

Welcome, Store Manager

Configuration

B & Get Help For This Page %
Busi Object C izati 2 New Field | = Edit | 23 Publish | (£ Back To List
System Name: J[g Contract Friendly Name: Contract N}rﬁle
Type: Business Object (Public) Plural Name: Contract

| Fields || 1:M Relations || MN:1 Relations || MN:M Relations || Forms || Systemn Views
System Name Friendly Name Type
2" Contract Contract Name Text
2¥ Contractld Id Cuid
:gv Organization Organization Text (ReferencedField)
<3 Organizationld Organization Reference = )(

You can set permissions by customizing Access Permissions. This string is auto-generated. To
change, you can copy and paste string values from other objects.
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@a} Dashboard 0 Display Region: < nothing is selected =
ﬂﬁ Customer Management 40
@™ Catalog Management 50 Display Text: Contract
i‘E Order Management 30 Display Order: 10000
= ™™ Marketing 100
__1 Asset Management 120 Client Script: CSManagementClient.ChangeBafView('Contract’, 'Lis|
w3l Reporting 130 Access - i fo
— . . e businessfoundation:contractlistpermission
@ Administration 200 Permissions:

Item Icon: l}

+" Publish

Click Publish to publish the selected business object.

O You must refresh your browser after a business object has been published in order to make it
appear in the left hand navigation.

Deleting Business Objects

Once a business object has been published, you can delete all customized business object by going to
Administration > System Settings > Business Foundation.

To remove from the left menu, you have to perform an additional step of going to Administration > Sys-
tem Settings > Left Menu and clicking the Delete icon.

€EPISERVER COMMERCE Left Menu e

-
(7] Cet Help For This Page +

Welcome ™ Change Language About™

Administration @ || add
21 Administration Title Order
=243 System Settings = Dashboard o
# ] Dictionaries ; y 10
= ome
. Logs
T T = Customer Manzgement 40
© Business Foundation = Organizations 30
@ Workflow Contacts 40
© Search Index = Roles 50
© Left Menu
| = Gift Cards 10000
. Catalog System
= Catal M it 80
E Order System =stelog Managemen
Catalog Entry Search 10
= Catalog Batch Updats 20
4 = Catalogs 30
Templates 40
=
ﬁ T = Order Management a0
= Order Search 10
Customer Management
m ? Purchase Orders 20
=
E Catalog Management = Today 10
‘g Order Management = This Wesk 20
This Month 30
% Marketing
= All 40
;% Asset Management = Purchase Orders By Status 30
al Reporting
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Updating the Search Index

Introduction

When you have done changes to an existing product catalog, such as adding or deleting products, you
will need to index the catalog for those changes to be reflected in the search results.

There are two types of indexing: Build and Rebuild. Use the Build option to make a quick re-indexing of
an existing catalog where you made changes to existing products. Build is faster than a rebuild because it
performs a reindexing of only the items that were changed since the last build.

If you are using a brand new catalog or you made structural changes to your existing catalog (i.e. moving
categories around, changing a product name, etc.), then you will need to perform a Rebuild. Rebuild
takes longer because it does a complete indexing.

Building and Rebuilding the Catalog

To build or rebuild your catalog, go to Administration > System Settings > Search Index.

EPISERVER COMMERCE Search Manager Heceme sdmn

Welcome ™ Change Language About ™ (7] Cet Help For This Page

Administration o
Index

j_-i Administration
. Search Configuration
=3 system Settings

] Dictionaries
M ] Logs
B Common Settings

Default Search Provider: LuceneSearchProvider
Installed Search Providers: SolrSearchProvider; LuceneSearchProvider;
Indexers: catalog (built 2/22/2012 4.08:01 AM);

Index Operations
Business Foundation P

o
B Workflow Rebuild Index Rebuild the Search Index. This operation will cause complete index rebuild.
o]

search.index Build Index Build the Search Index. This operation will build the index for items updated since last build.
O Left Menu

H[ ] Catalog System
# (] Order System

Select Rebuild Index or Build index. Once you perform either of these two operations, you will see the
changes or additions reflected in your search results.

If you have the Quartz service installed, then your catalog is reindexed every five minutes or whatever
time interval you decide upon. Refer to the EPiServer Commerce Developer Guide for more information
about the Quartz service.

Customizing the Left Menu

Introduction

Prior to customizing your left menu, we advise you to read the section Publishing Business Objects
describing how to configure Business Objects and adding them as individual nodes in the left navigation
frame.

Adding a Left Menu Item from the Left Menu Page

To add a Left Menu item, you have two choices. You can either configure the entire menu item first within
Business Foundation or you can add an empty container by clicking the Add button and then go back to
Business Foundation to fill in the page contents (objects).
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€EPISERVER COMMERCE

Welcome, admin

Left Menu

Welcome ¥ Change Language About™ @ cet Help For This Page =]
Administration = ‘D A"rEJ
=2 -i Administration S Tivle Order

o]

el System Settings
# (] Dictionaries
=] Logs

Dashboard a

Home 10

Customer Management 40

Commaon Settings

Organizations 30

Business Foundation

Workflow Contacts 40

Search Index Roles s0

Bl @ 3 &

Left Menu

Gift Cards 10000

e Catalog System
E | Order System

Catalog Management 50

Catalog Entry Search 10
Catalog Batch Update 20
Catalogs 30

Templates 40

ﬁ Dashboard

Order Management 20

m Customer Management

Order Search 10

Purchase Orders 20

et R e e -
-

= Catalog Management Today 10
‘g Order Management This Week 20
This Month 30

IE Marketing
= All 40
ﬂ Asset Management g, Purchase Ordars By Status 20

ii Reporting

m Administration

20 - (83 items) | Page412345¥

Page Size:

A new window will pop up for publication settings.

Select a Display Region from the navigation three on the left. Click on the node you want Contract
to be placed under. For example, Contract will be placed on the root level of Customer Man-
agement.

The Display Text defaults to the system name of the Business Object. You can choose to keep the
name or change it.

Enter in an Item Link, an URL to a page. When the object is clicked, a new window will appear on
the right based on the given link.

The Display Order defaults to 10000. You can keep it at that number or change the value to deter-
mine the position of the node.

Access Permissions is auto-populated only when a menu is created through the Business Foun-
dation. When creating a new left menu from scratch, you may leave this field blank or otherwise
copy in permissions from other existing menus. If you want to change Access Permissions, refer to
the Permissions section.

An Item Icon can be uploaded to represent the node. Click Browse to upload an icon.

Once all relevant information is entered, click on Publish.
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@5} Dashboard

= Customer Management

40

H“" Catalog Management
= ¥ Order Management
= ™™ Marketing

4] Asset Management
w3l Reporting
@ Administration

60
80
100
120
130
200

Display Region:

Display Text:
Item Link:
Display Order:

Access
Permissions:

Item Icon:

Customer Management

Contracts

10000

+ Add

Browse...
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To verify if the object was published, go to the Display Region where you specified the object to be pub-
lished to. Click on the Refresh icon on the left navigation frame if at first you do not see the new node.

Customer Management %
@ Organizations
F-E Contacts

33 Roles

B Contracts

Editing, Ordering, or Deleting a Left Menu Item

To Edit a user-generated node in the left menu, click on the Notepad icon.

[jada
Title
= Dashboard
Home
= Customer Management
=) Organizations
Contacts
= Raolas
Contracts
Catalog Management
i Catalog Entry Search
i

Crder

10
40
30
40
s0
10000
&0

i0

If the left menu item was created via the Left Menu page, this popup window will appear.

© EPiServer AB



196 | User Guide for EPiServer Commerce 1 R3

Editing ><
Display Text: Contracts

Item Link: http:/ /'world episerver.com/cantracts

Display Order: 100

Access Permissions:

Item Icon:

OK | | Cancel |

If the left menu item node was created using Business Foundation, this popup appears.

To change the sort order of the left menu item, adjust the numerical value in Display Order. The lower the
value, the higher the position of the item within the navigation tree relative to items with a higher Display

Order value.
Editing 4
Display Text: Contract
Client Script: CS5ManagementClient.ChangeBafView('Contract’, 'Lis
Display Order: 10000
Access Permissions: businessfoundation.contractlist.permission
Item Icon:

oK | | Cancel |

To save changes, click OK.

To delete a left menu item, click on X icon.
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o Welcome, admin
EPISERVER COMMERCE Left Menu
- - -
Welcome Change Language About 7} Cet Help For This Page +
Administration @ || add
21 Administration Title Order
=243 System Settings = Dashboard o
H Dictionaries
3 = Home 10
. Logs
T T = Customer Manzgement 40
© Business Foundation = Organizations 30
= Workflow = Contacts 40
© Search Index = Roles 50
| @ Left Menu .
= Gift Cards 10000
. Catalog System
= Catal M it 80
E Order System =stelog Managemen
= Catalog Entry S=arch 10
= Catalog Batch Updats 20
N Catalogs 30
= Templates 40
=
ﬁ — Order Management 80
= Order Search 10
m Customer Management
Purchase Orders 20
——| Catalog Management = Today 10
‘g Order Management This Week 20
= This Month 30
% Marketing
= All 40
;% Asset Management = Purchase Orders By Status 30

Reporting

Catalog System Administration

Under Catalog System you can set up warehouses and tax categories, as well as work with catalog spe-
cific meta fields and meta classes.

The features can be accessed by selecting Catalog System under Administration

Administration e

:IE Administration
H ] System Settings
=13 Catalog System

Warehouses

o]

B Tax Categories
B Meta Classes
o]

Meta Fields
+ ] Order System

In this section we will describe how to work with the options under Catalog System.

Woarehouses

Introduction

A Warehouse is the physical place with an address from which product items are shipped. EPiServer
Commerce includes the option to add and track a list of warehouses within the system. When creating a
new SKU, you will specify the warehouse where the item is being stored under the Pricing/Inventory tab.

O A SKU can only have one warehouse associated to it.

Adding a Warehouse

To access warehouses, navigate to Administration > Expand Catalog System > Warehouses.
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Administration r@

=[] System Settings
=li—] Catalog System
= Warehouses .-ﬂ'l'n |
A\

m Tax Categories

= Meta Classes
= Meta Fields

The Warehouse List page appears. The sample site has a default example warehouse called "Default
Warehouse". To create a new warehouse, click on New Warehouse on the menu bar.

Welcome, admin

ERCE Warehouse List

@ Get Help For This Pi

DNewWarehnur?'E & More Actions v

D Marne A= Istctive  Created Modified Sort Order

|:| Default Warehouse True 5/11/2010 1:25:45 PM 5/11/2010 1:26:31 PM [}

The Warehouse Edit page has two tabs: Overview and Address.
1. Under the Overview tab enter in a Name and Code. The Name and Code name can have spaces
in between characters.
2. Enterin a value for the Sort Order to determine the Warehouse's position on the Warehouse List.
3. Under Available select "Yes" or "No."

4. UnderIs Primary select whether or not this Warehouse is the primary one. You can only have
one primary Warehouse.

ERCE Warehouse Edit

Owverview Address
Mame: Mew Warehouse

Code: new warehouse

Sort Order: |1

The sort order for the category entry.

Available: @ Yes ™1 No
Is Primary. 7 Yes @ Mo
oK H Cancel
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5. Under the Address tab, enter all relevant information regarding this Warehouse.

Overview Address

First Name:
Last Name:
Organization:
Line 1:

Line 2:

City:

State:

Country Code:
Country Name:
Pastal Code:
Region Code:
Region Name:
Day Phone:
Evening Phone:
Fax Number:

Email:

| QK || Cancel |

6. Once you are satisfied with your entries, click on OK to save the Warehouse. Otherwise, click Can-

cel to go back to the Warehouse List page. The new Warehouse will appear on the list.

DNEwWarehnusE & More Actions v

|:| Marme Ishctive  Created Modified Sort Order
[[] Default Warehouse True 5/11/2010 1:25:45 PM 5/11/2010 1:26:31 PM 0

[ Mew WEI’EHDI@ True Today, 1:17 PM Today, 1:17 PM 10

Deleting a Warehouse

To delete a warehouse, place a check mark on the box next to the name of the Warehouse and the click

on More Actions on the menu bar.

D MNew Warehouse ii Mare Actions =

[ Mame ¥ Delete Select
[C] Default warehouse
Mew Warehouse

Confirm deletion by clicking OK on the pop-up window.

Tax Categories

Introduction

Tax categories for catalogs will work in coordination with your tax configuration setup for orders. The tax

configurations includes specific taxes for example state, local and federal taxes. Refer to the Tax
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Configuration section for more detailed information.

Adding a Tax Category

Go to Administration, Catalog System and click Tax Categories to see a list of existing tax categories.

Administration e

e

:IE Administration
H ] Systemn Settings
=" Catalog System

B Warehouses

B Tax Categories .
B Meta Classes S
B Meta Fields

H ] Order 5ystem

To create a new category, click on New. A pop-up window appears. In the Tax Category Name field,
enter a name and click OK to save the tax category.

Deleting a Tax Category

To delete a tax category, click the Delete icon next to the item in the Tax Categories List. To delete mul-
tiple items, select the check boxes next to items, select More Actions and then Delete Selected.

Catalog Meta Classes and Fields

Introduction

Using meta classes and meta classes, itis possible to extend the meta data of catalog items and order
forms. Meta fields are for adding specific data about an item. For instance, if you create a meta class
called "Wine" you will want to add meta fields that are characteristic for wine, for instance "color", "taste",
"vintage" and "maturity".

When meta fields and classes have been created in the System Administration part of Commerce Man-
ager, they will be available for usage when working with product entries in the product catalog.

Refer also to the section Using Meta Classes and Meta Fields for catalog attributes.

Creating a Meta Class

Do the following to create a meta class:

1. Navigate to Administration, Catalog System and select Meta Classes. This will open the Meta
Classes page.
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2. Click Create New and select New Meta Class.

- Welcome, admin
EPISERVER COMMERCE Meta Classes
Welcome ¥ Change Language About™ @ cert
Administration r::" |D Create New ™ -__}1 Import/Export™

:l_-i Administration “1% New Meta Class
@[] System Settings
=3 Catalog System

B Warehouses

B Tax Categories Name:

W New Meta Field
TR Brands A

B Meta Classes
B Meta Fields
=3 Order System Description: i

B Meta Classes
B Meta Fields

= Payments

] Shipping

©] Tax Configuration

Friendly Name: |grands

Select Sort MName
Return form number

PO Number

Expiration Date

Parent Order |d

Card type

Expiration Month

OoooomOoO

Expiration Year

3. Enter the meta class details.
Name - name of the meta class used in your code, this cannot have any spaces.
Friendly Name - name of the meta class displayed for practical use in Catalog Management.
Description - description of the meta class.
Object Type - select Catalog Node or Catalog Entry.
4. Click OK to save your changes.

5. You will now see that your newly created meta class is available in the drop-down for Type.

If you select the meta class you will see all of the available meta fields listed below, but with none
selected. Next steps will be to create and apply desired meta fields.

Creating a Meta Field

Do the following to create meta fields and customize the attributes of a catalog meta class:

1. Navigate to Administration, Catalog System and select Meta Fields. This will open the Meta Fields
page.

2. Click Create New and select New Meta Field. Click on New Meta Field and the meta field edit page
will appear.
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Welcame, admin

EPISERVER COMMERCE

Meta Fields

Welcome ¥ Change Language About™

(7] Get Help For This Page

Administration E&“‘ | ¥ New Meta Field|
n
:‘-'E Administration (o] Name Type Multi-Language Compare Search
] System Settings 167 ABV Decimal False True True
=) Catalog System 168 Closure ShortString True True Trus
B Warehouses 163 Color ShortString True True True
B Tax Categories 170 Description LongHtmlString True False True
B Meta Classes 171 DisplayMame Shortstring True True True
B Meta Fields 172 ExtendedDesription LongHtmlString True False True
=<3 Order System 173 Margin Decimal False True False
B Meta Classes 174 Maturity ShortString True True True
B Meta Fields 175 Organic Boolean False True False
176 Primarylmage ImageFile False False False
=] Payments il g B
. 177 RecommendBoost Integer Falsa Falsa Falsa
=] Shipping
. 178 Region ShortString True True True
© ] Tax Configuration .
179 Size Float False True True

Alternatively, select New Meta Field from the Create New drop-down within the Meta Classes page.
3. Enter Meta Fields details.

Welcome, admin

Meta Field Edit

7] Cet
Mame: Wooden
Friendly Name: ‘Wooden
Wooden -
Description:
Type: Short String -

Suppor‘ts Multiple Languages

Use in comparing
[T] Allow Null Values
I:‘Sa\.re History

D Use Encryption

Search Properties:
Allow Search

Enable Sorting Search Results
Include Walues in Search Results
[¥] Tokenize

Include in the Default Search

|| Cancel |

Description

Name Enter a system name without spaces or special characters (e.g. "NumberMegapixels," with-
out the quotes).

Friendly @ Enter a user-friendly name seen by end-users on the back and front-end (e.g. "Number of

Name Megapixels," without the quotes).
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Descrip- | Enter any additional information about the meta field.
tion
Type The drop-down menu shows the field types you can use for the meta field. The types avail-
able are:
- datetime
- decimal
- float
- money
- Integer
- Boolean
- Date
- Email
-URL
- Short String
- Long String
- Long Html String
- String Dictionary
- File
- Image File
- Dictionary

Search Depending on the data field type selected, you may have the option to set the search prop-
Prop- erties of the data field. The options are:
erties - Allow search - allows for searching directly on this metafield.
- Enable Sorting Search Results - search results will be sorted on this metafield.
- Include Values in Search Results - when the search results is returned, the original value
of this metafield will be included with the search results.
- Tokenize - search is prepared for individual words in, for example a long product descrip-
tion property (word breaking).
- Include in the Default Search - feature which tokenizes and combines metafield values
for search from the front end site.

4. Click OK to save your changes. The newly added meta fields will be listed in the meta fields list.

If newly created meta fields are notimmediately visible, go to the next page or set the Page
Size to display more entries.

Applying Meta Fields to a Meta Class
Do the following to apply meta fields to a particular meta class:

1. Navigate to Administration, Catalog System and select Meta Classes.

2. Select Catalog Entry from the Element drop-down menu, then select the desired meta class from
the Type drop-down.

3. To apply a meta field to a meta class, check mark the box next to the meta field. If you wish to sort
the order that the meta fields appear in the catalog entry, enter a number into the Sort field.
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ERCE Meta Classes

="
D Create New ™ i Impart/Export™
Element: Catalog Entry -
Type: Barrel -
Name:
Friendly Name: garra|
Description:  |Barrel ,
Select Sort Name
1 Return form number
2 PO Number
|:| Expiration Date
3 Parent Order Id
D Card type
|:| Expiration Maonth

4. Click OK to save your changes.

Order System Administration

Under Order System you can set up payment methods, shipping methods and providers, configure spe-
cific taxes, as well as work with order specific meta fields and meta classes.

The features can be accessed by selecting Order System under Administration.
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Administration o )

= ﬁ Administration
H ] Systemn Settings
+ ] Catalog System
=l Order System
B Meta Classes
B Meta Fields
=‘l Payments
|_1English (United States)
|1 Cerman (Cermany)
|_15panish (Spain)
|_1French (France)
=I'=J Shipping

B Shipping Jurisdiction Croups
B Shipping Jurisdictions
E Shipping Providers
B Shipping Packages
H[_] Shipping Methods
="l Tax Configuration
B Tax Jurisdiction Groups
B Tax Jurisdictions

B Taxes

In this section we will describe how to work with the options under Order System.

Payments

Introduction

Payments is an essential part of an e-commerce system. When shopping online customers will be pre-
sented with a number of different payment options. When creating and configuring payments in EPiServer
Commerce, there are three components that need to be created or re-used as well as configured: Pay-
ment Types, Payment Gateways and Payment Methods.

Payment Types — these are meta classes which contain the properties of a particular payment type. For
example, a credit card payment type contains credit card number, card expiration date and card type. The
most common payment types are already built-in to EPiServer Commerce:

e Credit card
e Cash Card
e Gift Card
e Invoice

In addition, a generic "OtherPayment" class type is included in EPiServer Commerce.

Payment Gateways — these provide an interface to the system which provides payment processing. A
payment type is passed to the payment gateway and the gateway executes the payment transaction with
the payment system (e.g. PayPal). One payment type is associated with each payment gateway.
Payment Methods — these contain information about the way the customer views a payment option and
has a payment gateway associated with it.
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Using Built-ln Payment Gateways

To setup payments using a built-in payment gateway, go to Administration, Order System and Pay-
ments. Select a language in the list.

Administration =

:IE Administration
] System Settings
=[] Catalog System
== Order System
B Meta Classes
B Meta Fields
= Payments
[ English (United States)
[ German (Cermany)
[ Spanish (Spain)
[ French (France)
=[] Shipping
= ] Tax Configuration

The Payment Methods window appears.

Welcome, admin

Payment Methods

(7] et Help For This Page %

D MNew ﬁ More Actions ™

D Name IsActive  IsDefault Ordering  Created Last Modified

I:‘ >( Cift Card True False i} 2/22/2012 5:08:21 AM 2/22/2012 5:08:21 AM
I:‘ = )( Pay By Credit Card True False 2 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 AM
[} X ExchangePayment False False 2 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 AM
0 X Pay By Phone True True 2 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 AM
I:‘ = >( Credit on Account True False 100 2/22/2012 5:08:21 AM 2/22/2012 5:08:21 AM

If selecting English (US) on the EPiServer Commerce sample site the following payment methods will be
available by default:

e Gift Card

e Pay By Credit Card
e Exchange Payment
e Pay By Phone

e Crediton Account

To create a new Payment Method, click on New to open the Payment Method Edit screen.
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MERCE Payment Method Edit

L4

Overview Parameters
o

Name:

Description: -

System Keyword:

Language: select language El

Class Name: (none) IE'
Sort Order: 0

IsActive: 71 Yes i@ No

IsDefault: ) Yes @ No

Supports Recurring: 1 Yes i@ No

Restricted Shipping Methods

Available Shipping Methods Chaosen Shipping Methods

Default Shipping
Online Download

Add ->
Add All ===

(0] || Cancel |

Here is an explanation of some of the gateway properties:
¢ ID - the system-assigned unique identifier for the payment gateway
¢ Name - the name to be displayed to the user
e Description — a description that can be displayed to the user

o System Keyword — the unique name for each instance of the gateway; new non-unique key-
words will not save to the database. This is not be editable after a gateway is initially created

e Language — allows a specific language to be specified for the payment gateway

e Class Name — name of the gateway class to be associated with the payment

e Sort Order — specifies the order of the payment method on the list of payment methods page
e IsActive — specify whether or not the payment method is active\

e IsDefault — specific whether or not the payment method is the default one

e Supports Recurring — specify whether this payment methods supports recurring payments, such
as for subscriptions

e Restricted Shipping Methods — Restricted shipping methods is not fully imple-
mented out of the box and requires a developer to complete the functionality.
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Restricted Shipping Methods

Awailable Shipping Methods Chosen Shipping Methods

Default Shipping

Cinline Download

Add -
Add All -=>

Restricted Shipping Methods

Awvailable Shipping Methods Chosen Shipping Methods

Online Download Default Shipping

Add ->
Add All -=>

< - Remove
< - Remmreﬁ.| E

Click OK to save the Payment Method. The payment method will appear in the list of Payment Methods.

Welcome, admin

Payment Methods

e Cet Help For This Page %

D New | 2] More Actions =

@

ElElEl=E
%R

il

b ah ab b ¢

Marne Ishctive  IsDefault Crdering  Created Last Modified

Maoney Orger False False [} Today. 10:45 AM Today. 10:45 AM
Payment by card (DIES) Trua Trua o 5/12/2010 6:10:05 AM 5/12/2010 6:10:05 AM
Fay By Fhone True True 1 1/1/2006 1:00:00 AM S/LZ/2010 6:10:34 AM
Pay By Credit Card True False 2 1/1/2006 1:00:00 AM 1/1/2007 1:00:00 AM

Using nSoftware Provided Payment Gateways

EPiServer Commerce supports multiple payment gateways out of the box using nSoftware where new
payment methods can easily be set up by end-users.

-

© ©® N o o &~ w D

To enable nSoftware supported gateways, create a new payment method.

Enter in a Name, such as nSoftware or anything else.

Enter in a Description.

Enter in the System Keyword as "ICharge”.

Select a Language from the drop-down menu.

Select the Class Name "Mediachase.Commerce.Plugins.Payment.ICharge.IChargeGateway".
Select "Yes" for IsActive.

Change the Sort Order, IsDefault, Supports Recurring as needed.

Click OK to save changes.
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Payment Method Edit

Owverview Parameters

10

Marme: nSoftware

Description: nSoftware -

System Keyword: ICharge

Language: select language IZ‘

Class Name: Mediachase.Commerce.Plugins.PaymentICharge. lChargeGateway E‘
Sort Crder: 0

IsActive: 71Yes @ No

IsDefault: 71 Yes i@ No

Supports Recurring: () Yes @ No

Restricted Shipping Methods

Available Shipping Methods Chosen Shipping Methods

Default Shipping
Online Download

Add -
Add All ->>

OK || Cancel

Once created, click on the payment gateway again to go back to the Payment Method Edit page. Click on
the Parameters tab.

The Configure IBiz E-Payment Integrator Component appears and you can select from the Gateway
drop-down menu several dozen of the most popular payment gateways will appear. Depending on the
gateway you select, such as Authorize.Net, the Configuration Parameters will change. Enter in your cre-
dentials and other relevant information to activate the gateway and click OK.
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Overview Parameters

Configure IBiz E-Payment Integrator Component

Cateway: Authorize Net IE'

Cet [Biz E-Payment Integrator from weaw.nsoftware.com. You will find more documentation on how to configure it there also.

Configuration Parameters
Payment Options: Sale E

“Merchant Login:
Merchant Password:
Transaction Key:
5ecret Hash:

Payment Gateway URL {used for testing):

Ok || Cancel

Editing Payment Methods

To edit an existing payment method, click on the Notepad icon next to the Delete icon.

DNEW _.EIMureActians'

Marme

nSoftware

Money Order

Payment by card (DIES)
Pay By Phone

Pay By Credit Card

The ID is auto-generated. Every field can be changed except System Keyword. After you are satisfied with
your changes, click on OK.
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MERCE Payment Method Edit

L

Overview FParameters
1D elfbbeld-053f-4adc-b15c-669374639502
Mame: Maney Order

Description: -

System Keyword: %

Language: English (United States) E

Class Name: EPiServer.Business.Commerce.Payment.DIBS.DIBESPaymentCateway Iz‘
sort Order: 0

IsActive: i) Yes (@ No

IsDefault: 1 Yes i@ Mo

Supports Recurring: () Yes i@ No

Restricted Shipping Methods

Available Shipping Methods Chaosen Shipping Methods
Online Download Default Shipping
Add ->
Add All ==
<- Remawve
<< - Remove All

Ok || Cancel

Deleting Payment Methods

To delete Payment Methods, click on the X icon next to the payment method name and click OK when
the popup appears. To delete multiple payment methods at once, check mark each payment method you
want to delete, then click on More Actions --> Delete on the drop-down menu. Click OK when the popup
appears.

Shipping

Introduction

Shipping involves everything related to the actual physical delivery of products to e-commerce customers.
Just as for payments, you can set up shipping methods, gateways and providers. In the following the ter-
minology is described as well as the different configuration possibilities for shipping.

There are two options out of the box for shipping gateways:
e Generic Gateway (flat shipping rate)

e Weight/Jurisdiction Gateway (base price + additional fee depending on weight and shipping loca-
tion)
These are starting points to create customized shipping gateways. For more information refer to the Devel-
oper Guide for EPiServer Commerce.

The shipping administration is available under Administration, Order System and Shipping.
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Administration o 1}

:IE Administration
] System Settings
+ ] Catalog System
=] Order System
B Meta Classes
B Meta Fields
+ ] Payments
=" Shipping
B Shipping Jurisdiction Groups
B Shipping Jurisdictions
B Shipping Providers
B Shipping Packages
=] Shipping Methods
[_1English (United States)
|1 Cerman (Cermany)
|__1Spanish (Spain)
|_1French (France)
#l ] Tax Configuratian

1

Shipping Methods

A shipping method manages a set of information and rules that determines the shipping cost and dis-
plays it on the front-end site while a customer checks out an item from his/her shopping basket. The ship-
ping fee is added to the total price of the purchase. A shipping method is mapped to a shipping provider
visible to a back-end administrator in Commerce Manager. This allows the public site to display friendly
names such as "Ground Shipping" to the customer and this is mapped to a provider such as UPS. There-
fore, when a customer picks "Ground Shipping", UPS will be used by default.

Shipping Providers

A shipping provider is the class(es) that interacts directly with one or more actual shipping services such
as USPS, UPS, or FedEX. It retrieves shipping price information from the shipping service(s) its asso-
ciated with. One typical scenario would be to have a provider that represents a particular service (e.g.
USPS). A provider can also represent a particular type of shipping situation. One example is that you
could have a provider for overnight delivery. The provider could retrieve pricing for that service to deter-
mine the lowest price given the location of the customer. A provider could also represent other specific
scenarios with one or more services such as price by weight or ground shipping.

Shipping Gateways

A shipping gateway is the specific class that you select (Generic Gateway or Weight/Jurisdiction Gate-
way). You select the shipping gateway in the Shipping Provider screen and then configure the actual
values for that gateway/provider in the Shipping Methods area.

Shipping Jurisdictions

An option which allows you to define values for region-specific shipping rates; this is only used when you
select the Weight/Jurisdiction Gateway, for instance for a "county".
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Shipping Jurisdiction Groups

Group of jurisdictions; this is required because this is a required field when configuring the Shipping
Method parameters, for instance for a "region".

Shipping Methods

Introduction

A Shipping Method manages a set of information and rules that determines the shipping cost and dis-
plays it on the front-end site while a customer checks out an item from his/her shopping basket. The ship-
ping fee is added to the total price of the purchase.

Customizing Shipping Methods

There are two Shipping Methods available out of the box for you to customize: Ground Shipping and
Fixed Shipping.

To customize the Shipping Methods, first go to Administration > Order System > Shipping > Shipping
Methods > English (United States) or any other languages.

At the Shipping Methods List screen, select the editicon for either of the available methods. The Over-
view tab screen for Shipping Method Edit will load with the below fields:

Qverview Settings Parameters

1D: alcal bca-6fbf-4bef-b01f-bbf3df23a02a
Name:
Friendly Name: Cround Shipping
Description: Calculates shipping based on weight and zone, -
Prowvider: Weight/Jurisdiction Catewa',rE
Language: English (United StatesJE
Base Price: 2.00
Currency: US dollar [=]
IsActive: @ Yes Mo
IsDefault: @ Yes Na
Sart Order: 0
0K || Cancel |

e ID - this is auto-generated after saving the new shipping method

¢ Name - enterin a name without spaces or special character; this name will not be displayed in the
public site, but is only for end users to manage and organize the shipping methods

e Friendly Name - enter a friendly name which can have spaces and special character; the friendly
name is the name seen by customers who are purchasing items

e Description - enter a description (optional)

e Provider - select an available provider from the drop-down menu; the options displayed here are
created in the Shipping Providers screen (Generic Gateway is for a fixed shipping fee specified
below under base price, while Weight/Jurisdiction Gateway is used for a shipping fee depended
on the weight and shipping location)

e Language - select a language of your choice from the drop-down menu
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e Base Price - the base price you specify here will become the fixed shipping fee for the Generic
Gateway option, and part of the Weight/Jurisdiction Gateway option.

e IsActive - select Yes or No under IsActive to enable is disable it, respectively
o IsDefault - select Yes or No if this shipping method is the default one

e Sort Order - enter a number for the sort order to determine its position on the list of shipping meth-
ods
The Settings tab is used to exclude any Countries, Regions, and Payments from a particular shipping
method.
To exclude a selection, highlight the items on the Available boxes on the left and move them to the
Chosen Countries boxes by clicking Add.

Cverview Settings Parameters

Restricted Countries

Available Countries Chosen Countries

Afghanistan
Albania
Algeria Add -=

m »

American Samoa Add All ->>
Andorra

Angola

Anguilla

Antarctica

Antigua and Barbuda
Argentina

Restricted Regions

Available Regions Chosen Regions

Alabama
Alaska
American Samoa Add ->
Arizona Add All -> >
Arkansas

Armed Forces Africa

Armed Forces Americas (except(
Armed Forces Canada

Armed Forces Europe

Armed Forces Middle East

Restricted Payments

m| »

Available Payments Chosen Payments
Payment by card (DIBS)
nSoftware
Pay By Phone Add -
Pay By Credit Card Add All -=>

Ok || Cancel

The Parameters tab is use to set conditions to determine the shipping fee. This screen become available
only when the Weight/Jurisdiction Gateway is selectin the Provider field in the Overview tab (it will be
empty with the Generic Gateway option).
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Overview Settings Parameters

Configure Price Per Weight for Jurisdiction Croup
Jurisdiction

Croup: United States lz‘

Weight: or more

Price:

Start Date: 5/25/z000 :ﬁ 12:00 AM

End Date: 5/25/2011 jﬁ 10:55 AM

Croup Name Weight Price Start Date End Date Edit

United States 0 or more 10 10/8/200812:00:00 AM  10/8/202012:00:00 AM Modify Delete

e Jurisdiction Group - select a jurisdiction group to apply the current Shipping Method using the
drop-down menu; the options listed here are set up in the Shipping Jurisdictions and Shipping
Jurisdiction Groups screen.

o Weight - enter a numerical value for the weight; units for the weightis setin the Common Settings
screen

e Price - enter a price to be added to the base price (Overview tab) when the weight and juris-
diction group conditions are met.

e Start Date - enter a start date and time for the shipping method to take effect
e End Date - enter a end date and time for the shipping method to expire

When finish entering the values above, select Add to save the condition. The condition will appear on
table below. In the above example, if the customer checks out an item that weights anywhere between 0
to 10 weight units (Ibs for example), and the customer's shipping address is in the United States, then the
total shipping fee will equal $10 + the base price you enter in the overview screen.

Click OK to save changes.

Deleting Shipping Methods

1. Check off the box that corresponds to the shipping methods you want to delete.

2. Click on the More Actions button on the upper left corner of the main window menu bar, and
choose Delete from the pull down menu.

3. Click OK when prompted. The selected methods will be deleted from the list.

ERCE Shipping Methods

DNEW iiMDrE Actions~

|:| Marne Display Marne
O X Default Shipping Ground Shipping
I:‘ -h Cnline Download Fixed Shipping Rate

Shipping Providers

Introduction

A Shipping Provider is the actual shipping service such as USPS, UPS, or FedEX. However, a provider
can also be a type of shipping in order to determine shipping price. The Shipping Providers page man-
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ages the list of these providers/types. There are two shipping methods available out of the box for you to
customize: 1) Generic Gateway and 2) Weight/Jurisdiction Gateway.

A Generic Gateway is used for a fixed shipping fee while Weight/Jurisdiction Gateway is used for a ship-
ping fee that is calculated based on the weight and shipping location.

Customizing Shipping Providers

Go to Administration > Order System > Shipping > Shipping Providers. Edit one of the two providers
listed.

1. EditName, and Description.

2. System Keyword (no spaces) and Classes are something that your developers need to code
and provide.

3. Click OK to save changes.
The revised shipping provider will appear in the Shipping Providers page.

O The Parameters and Packages tabs are not fully implemented; they serve as a starting point
for developers for full implementation of those features.

Deleting Shipping Providers

1. Go to the Shipping Providers page.

2. Check off the box that corresponds to the shipping providers you want to delete.

3. Click on the More Actions button on the upper left corner of the main window menu bar, and choose
Delete from the pull down menu.

4. Click OK when prompted. The selected providers will be deleted from the list.

ERCE Shipping Providers

DNEW iil’\-mre Actions ¥
|:| Mame
I:‘ X Ceneric Gateway

[ h Weight /Jurisdiction Gateway

Tax Configuration

Introduction

Taxes can be configured so that specified rates are calculated and added to the total price during the
checkout process. Depending on your configuration, itis also possible to combine and apply multiple
taxes (such as federal, state and local tax) to a purchase.

Taxes can be set up and maintained using two methods:
e Creating/editing each tax control manually
e Importing all data using a CSV file.

In the following we will provide a few examples to demonstrate how this works.

Taxes are configured
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Configuring Taxes Manually

To set up your taxes manually, you will need to work with the following areas in the Administration tab of
the Admin Site — Tax Categories, Tax Jurisdiction Groups, Tax Jurisdictions, and Taxes — as well as
the configuration pages for each of the catalog items.

The steps below summarize the process you need to follow to configure taxes.

1. Create and configure Countries and Regions (Go to Administration > System Settings > Dic-
tionaries > Countries): In Countries section create the countries you plan to sell your products in
and set the appropriate country codes. For the country codes, itis important that you use the
ISO Short code provided at MSDN site Table of Language Culture Name, Codes, and ISO Values
Method [C++]. Using the ISO Long code or anything else will not correctly calculate taxes during
checkout.

2. Create new Tax Categories (Go to Administration > Catalog System): In this step you will
create tax categories that will be used later to associate your catalog items with the tax rates you
define. For example you may create categories such as "General Sales," "Food," and "Luxury
ltems" depending on the tax regulations for your item types. The categories you create here will
become selectable on the Page Details of your items (i.e., Variations/SKU Edit page) and on the
Tax Edit page.

3. Create and configure Tax Jurisdictions (Go to Administration > Order system > Tax Con-
figuration): In this step you will specify particular Tax Jurisdictions. You can create different Tax
Jurisdictions for a particular region by specifying zip codes, country codes, etc. Tax rates will be
applied to whatever level of information you specify for each Jurisdiction. For example, if you spec-
ify only the country code as US, all shoppers with a US address (regardless of state, county etc.)
will be included in this jurisdiction. Note: Country Code and Region Code you enter in the Juris-
dictions Edit page must match the codes you used in step 1.

4. Create and configure new Tax Jurisdiction Groups (Go to Administration > Order system >
Tax Configuration): New Tax Jurisdiction Groups created here can include multiple Tax Juris-
dictions.

5. Create and configure Taxes (Go to Administration > Order System > Tax Configuration): Here
you will specify tax rates and also associate the Tax Categories and Jurisdiction groups created in
Steps 2 and 4.

6. Associate Catalogs to the Tax Categories created in Step 2 (Go to Order Management > Cat-
alogs): Now you will switch over to the Catalog Management subsystem and link specific catalog
items to the appropriate Tax Categories. This can be done on the Pricing/Inventory page within
each Variation/SKU Edit page.

Configuring Taxes Using CSV Import

Using the CSV Tax Import functionality is a convenient way to quickly setup and update tax data in bulk.
Creating a CSV tax file with a specified format (see "Example Scenarios" below) will allow you to com-
plete steps 2 through 5 in one shot (above in Method 1). Step 6 of Method 1 can be done manually, but
you can also use the CSV import functionality in the Catalog Management subsystem to associate cat-
alogs to tax categories. Click here to see how CSV Catalog Import works.

Import your CSV tax file into your Commerce Manager by following the steps:

1. Selectthe Administration tab in the Commerce Manager.
2. In the navigation tree drill down to Taxes: Order System > Taxes Configuration > Taxes.

3. Click Import Taxes on the menu bar.
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4. Choose Add New File and then Browse to select and upload your CSV tax file. The path of your
chosen file will appear in the field.

5. Click Upload File and then Save The File icon. The CSV tax file will appear under the Files Avail-
able for Import section.

6. Selectand highlightthe CSV file and click the "Start Import" button.

7. Yourimport should begin and complete successfully in a pop-up dialog box.

8. You will now be able to view your tax setup in the Commerce Manager.

If you want to edit the existing setup, simply repeat steps 1 through 8 with your modified file.

Caution: Re-importing CSV files only edits existing information or adds new data, but nothing gets
deleted. If you delete an entire row of data in the CSV file, you must manually delete those entries in the
Commerce Manager. If in doubt, you can always delete all the tax data and perform the CSV tax import
from scratch.

Sample CSV Files and Scenarios

Example 1: Single Tax Per Catalog ltem Based on a Single Jurisdiction

For example, if your variable is State, then you can specify the tax rate on a state-level. So let's say CA is
9% and MA is 6%. If you placed an order from California, then 9% sales tax would be applied during
checkout.

Jurisdiction Jurisdiction Group | Tax Rate | Tax Category

California CA Tax Group 9% General Sales

Massachusetts | MA Tax Group 6% General Sales

A sample tax CSV file called test.csv is available in this directory — [taxcsvsample1.zip ].

Example 2: Two or More Taxes Per Catalog Item Based on More Than One Juridiction

For example, if you have a luxury item that requires State and Federal tax to be applied, then you can
specify tax rates on a state and federal level. So let's say a luxury item purchased in CA has a 9% state
tax rate and a federal tax rate of 3%. Both taxes would be applied during checkout.

Jurisdiction Jurisdiction Group | Tax Rate | Tax Category

California General CA GS Tax Group | 9% General Sales
Massachusetts General | MA GS Tax Group | 6% General Sales
California Luxury CA LX Tax Group 9% Luxury Sales
Massachusetts Luxury | MALX Tax Group |6% Luxury Sales
US Federal Luxury US LX Tax Group 3% Luxury Sales

Order Meta Classes and Fields

Introduction

Using meta classes and meta classes, it is possible to extend the meta data of catalog items and order
forms. Meta fields are for adding specific data about an item. For instance, if you create a meta class
called "Wine" you will want to add meta fields that are characteristic for wine, for instance "color", "taste",
"vintage" and "maturity".

When meta fields and classes have been created in the System Administration part of Commerce man-
ager, they will be available for usage when working with catalog items and orders.

© EPiServer AB



Commerce Manager | 219

O Default order meta fields used by the ordering process are built into the system and are not
available. However, you can add your own meta fields to extend the attributes of your orders.

Creating a Meta Class

Do the following to create a meta class:

1. Navigate to Administration, Order System and select Meta Classes. This will open the Meta
Classes page.

2. Click Create New and select New Meta Class.

EPISERVER COMMERCE Meta Classes

Welcome ¥ Change Language About ™

P - =
Administration e |D Create New ™ ] Import/Export ™

:‘.-i Administration “[4 Mew Meta Class
# ] System Settings
# ] Catalog System
=43 Order System

B Meta Classes

w Mew Meta Field
TR PUrchase Urder -

Name:

= ;
Meta Fields Friendly Name: pyrchase Order

H [ Payments

H ] Shipping Description:  |Contains orders that has been submitted into the system -

# ] Tax Configuration

Select Sort Name
Return form number
o PO Number

Expiration Date

EEEO
(=]

0 Parent Order Id

3. Enter the meta class details.
Name - name of the meta class used in your code, this cannot have any spaces.
Friendly Name - name of the meta class displayed for practical use in Order Management.
Description - description of the meta class.
Object Type - select Order Group, Order Form, Shipment, Lineltem, Order Group Address or
Order Form Payment.

4. Click OK to save your changes.
5. You will now see that your newly created meta class is available in the drop-down for Type.

If you select the meta class you will see all of the available meta fields listed below, but with none
selected. Next steps will be to create and apply desired meta fields.

Creating a Meta Field

Do the following to create meta fields and customize the attributes of an order meta class:

1. Navigate to Administration, Order System and select Meta Fields. This will open the Meta Fields
page.

2. Click Create New and select New Meta Field. Click on New Meta Field and the meta field edit page
will appear.
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EPISERVER COMMERCE Meta Fields

Welcome ™ Change Language About”

Administration ] | ¥ New Meta Fiem|
=2 -E Administration 1D @ame Type Multi-Language Compare Search
e | System Settings There are no items available

(] Caralog System
=2 a Order System
B Meta Classes
B Meta Fields
| Payments
® ] Shipping
i [:l Tax Configuration

Alternatively, select New Meta Field from the Create New drop-down within the Meta Classes page.
3. Enter Meta Fields details.

ERCE Meta Field Edit

Mame: WVIP
Friendly Mame: WIP
VIP Customer s
Description:
Type: Shart String -

Supports Multiple Languages

Use in comparing
[¥] Allow Null Values
|:|Save History

|:| Use Encryption

Search Properties:
[¥] Allow Search

Enable Sorting Search Results
Include Values in Search Results
[l Tokenize

|:| Include in the Default Search

| (o]'4 || Cancel |
Field Description
Name Enter a system name without spaces or special characters for example "Num-

berMegapixels".

Friendly Enter a user-friendly name seen by end-users on the back and front-end.
Name

Description Enter any additional information about the meta field.

Type The drop-down menu shows the field types you can use for the meta field. The types
available are:

- datetime
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- decimal

- float

- money

- Integer

- Boolean

- Date

- Email

-URL

- Short String

- Long String

- Long Html String
- String Dictionary
- File

- Image File

- Dictionary

Properties

Search Depending on the data field type selected, you may have the option to set the search
properties of the data field. The options are:

- Allow search - allows for searching directly on this meta field.

- Enable Sorting Search Results - search results will be sorted on this meta field.

- Include Values in Search Results - when the search results is returned, the original
value of this meta field will be included with the search results.

- Tokenize - search is prepared for individual words in, for example a long product
description property (word breaking).
- Include in the Default Search - feature which tokenizes and combines meta field
values for search from the front end site.

4. Click OK to save your changes. The newly added meta fields will be listed in the meta fields list.

If newly created meta fields are notimmediately visible, go to the next page or set the Page

Size to display more entries.

Applying Meta Fields to a Meta Class

Do the following to apply meta fields to a particular meta class:

1. Navigate to Administration, Order System and select Meta Classes.

2. Select Catalog Entry from the Element drop-down menu, then select the desired meta class from

the Type drop-down.
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3. To apply a meta field to a meta class, check mark the box next to the meta field. If you wish to sort
the order that the meta fields appear in, enter a number into the Sort field.

ERCE Meta Classes

=
D Create Mew ™ ] Import/Export ™

Element: Order Form -

Order Croup

Type:

Shipment
Name: Lineltem

Order Croup Address
Friendly Name:|Order Form Payment

Description:  \order Form Extended Class -
Select Sort Name
) Return form number
1 PO Number
] D Expiration Date
£ 2 Parent Order Id
D Card type

4. Click OK to save your changes.
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Access Rights

Introduction

The user administration in EPiServer Commerce is based on contacts. A "contact" can be a (registered)
customer shopping on the website, as well as a user working with the system, editing website content or
managing online store tasks.

Managing users involves both customer contact administration, as well as defining access rights for sys-
tem users working with online store administration in Commerce Manager, and users working with
editorial content. These may or may not be the same individuals, depending how your organization is set
up.

EPiServer Commerce has full support for the standard EPiServer Membership and Role Providers, includ-
ing Multiplex and Active Directory. This means that users and their access rights are managed in the
same way in the system. Refer to the technical documentation for EPiServer CMS for more information on
role and membership providers.

Contacts and Accounts

A contact can have an account associated with it, which is needed if you want to assign access rights to
that contact. Only contacts with associated accounts will appear in the CMS administration interface.

O A contact must have an account associated with it to in order to be able to apply roles and set
access rights in Commerce Manager and the CMS system respectively.

When an online shopper decides to register with the website, a contact with an account is created. How-
ever, anonymous shopping is allowed, which means that shoppers are not required to create an account
in order to purchase. Contacts can belong to organizations. The relationship between organizations, con-
tacts, accounts, roles and user groups, is illustrated below.

|. Organization ‘

Contact 1 | | Contact 2 ‘ | Contact..n

| Account |

In Commerce Customer Management: In CMS Admin interface:
Add Role(s) with Commerce Add Account to User Group(s)
permissions to Account with CMS Edit/Admin access rights
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Contacts, accounts and organizations are administered from the Customers system. This includes man-
aging user accounts and adding roles to users (contacts). Setting access rights for editorial content man-
agementin the page tree of the website is done from the CMS administration interface.

The EPiServer Commerce sample site has a number of predefined users, roles and groups both for
administering e-commerce tasks as well as managing editorial content. Remember that these users and
groups are only examples of how you can set up access rights for your website.

Defining User Access

Introduction

Users can be created either from the CMS Admin mode, or from the Contacts section under Customer
Management in Commerce Manager. When a user is created in CMS, the user will appear as a contact
with an accountin Commerce Manager. However, when a user is created in Commerce Manager, it will
appear in CMS only when an account has been created for the user in Commerce Manager.

When a user has been created in the system, you can define the desired access rights, depending on
whether the user is going to work with content in the editorial interface of CMS, or with store admin-
istration in Commerce Manager.

Store Administrators

The Customers system allows for creating users and groups with either pre-configured roles or custom
roles which control access to different systems or individual elements within a system.

When you install EPiServer Commerce, you are provided with an administration account with the fol-
lowing credentials:

¢ Username - "admin"

e Password - "store"

O The predefined administration accountis given full privileges, meaning it has full access to all
systems and all elements within each system. Therefore it is highly recommended that you
change this password after installation.

Additional accounts used by your internal team to access EPiServer Commerce must have one or more
Roles assigned to them. A role can be for instance "Catalog Viewers", "Marketing Admins" or "Asset Man-
agers".

O EPiServer Commerce users are internal to your organization and should not be confused
with customers. By default, customers who register from your public site are given the "Every-
one" and "Registered" Roles, but these roles do not allow access to the administration inter-
face of EPiServer Commerce.

Predefined Roles

A standard installation of the EPiServer Commerce sample site has a number of predefined roles. These
roles are based on common e-commerce working procedures and provides a suggestion to how you can
work with the system.
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G ) Welcome, admin
EPISERVER COMMERCE Role List
Welcome v Change Language About v @ Cet Help For This Page =
Customer Management 2 || [Anew | [2More Actions -
2@ customer Management 1 Role Name
oF| Organizations [=] Adminz
[ Contacts [[] g X Order Manzgers
23 Roles =) # Order Supervis
= pervisor
@ Gift Cards & X
[} X Shipping Manager
0 = " Recaiving Manager
[} X Everyens
=) " Registered
O = X Mansgement Users
= Administrators
@ Dashboard { O x
[0 g X webadmins
Ig Customer Management B % WebEditars
=| Catalog Management [} & )( Expert
g Order Management
IE Marketing
«ﬂ Asset Managemeant
Sl] rerorans
- - (12 items) | Page 41>
Iﬁ Administration Page Size: |20 [v]

Each role is associated with a range of permissions on different levels, related to the various parts of EPiS-
erver Commerce.

The following roles are available by default, with a set of permissions for each role:
e Admins - default role allowing to fully administer most areas.

e Order Managers - this role can create returns and exchanges, view and edit orders, send noti-
fications, process payments and split shipments. You can also allow order managers to manage
discounts and/or change the line item price.

e Order Supervisors - this role has full permissions for the entire order management procedure,
including the entire Order Managers permissions.

e Shipping Manager - this role allows for viewing, packing and completing shipments.

e Receiving Manager - this role can view shipments and receive returns.

e Everyone - assigned when a customer registers an account from the front-end public site.
e Registered - assigned when you register from an account from the front-end public site.

e Management Users - this role allows users access to EPiServer Commerce.

e Administrators - this role has extensive administration rights in areas such as assets, catalogs,
core functions, marketing and customer and order management.

o WebAdmins - this role is EPiServer CMS specific and provides access to the EPiServer CMS
administration interface, needed when administering the content management parts of EPiServer
Commerce.

e WebEditors - this role is EPiServer CMS specific and provides access to the EPiServer CMS edit-
ing interface, needed when working with content on the EPiServer Commerce website.

e Expert - this role is used in the EPiServer Commerce sample site for external users that are
reviewing products.

You can change the detailed permissions for each of these roles, as well as define your own roles and
set permissions, all in order to match the specific working procedures in your organization.

Content Editors

Access rights for content editors are managed from the Admin interface in EPiServer CMS. Here you can
view all users and user groups under Search User/Groups. Setting access rights for editorial content and
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the page tree structure is done from the Set access rights section, just as you normally do in EPiServer
CMS.

There are the following default roles:

e Everyone - an anonymous visitor browsing to your website. Can only access the View mode of
the website.

e WebAdmins - membership in this group provides access to the EPiServer CMS administration
interface.

o WebEditors - membership in this group provides access to the EPiServer CMS editing interface.

Refer to the EPiServer CMS user documentation for more information on how to work with access rights
for editorial content.

Dashboard [ ®lEY Commerce Add-ons €EPISERVER @ ? Ladmin Q
Edit Admin Reports  Visitor Groups

Admin || Config || Page Type || Block Type

w Access Rights
Set Access Rights
Administer Groups Type Groups [~
Search User/Group

Search Users/Groups @

Name |
Create User

Number of hits per page 20

w Scheduled Jobs
i Searcl
Subscription L
Publish Delayed Page Versions MName Provider
Remoye Autosaved Page Drafts m Administrators CMSRoleProvider
Change Log Auto Truncate
Automatic Emptying of Recycle Bin & Expert CWSRoleProvider
Clear Commerce Cache m dmins CMSRaleProvider
I EEES m WebEditors CMSRoleProvider
Archive Function
1

Link Validation

Remaove Expired Carts

Rotate Encryption Keys

Full Search Index Job
Subscriptien Payment Plans Job
Incremental Search Index Job
Remove invalid comments
Remove Permanent Editing
Serialize Catalog Meta Data Job
Shipment Release Job

v Tools
Export Data
Import Data
File Management 5

As with any EPiServer CMS website, you can work with role and membership providers from Windows or
SQL, or both using the multiplexing setting. You can also build your own user and membership provider.

Find out more about membership and role provide managementin the technical documentation for EPiS-
erver CMS on world.episerver.com.
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Globalization

With "globalization" we mean the possibility to display content in different languages to website visitor
groups with different language preferences. When a visitor to the website selects a language option, the
content for that language will be displayed. If content does not exist in a selected language, a fallback pro-
cedure may be applied if this has been configured. Another dimension of globalization is the possibility
for users to select different language options for the user interface inside EPiServer Commerce.

Find out more about globalization and language managementin general on a website in the doc-
umentation for EPiServer CMS on world.episerver.com. In this section we will describe in more detail how
you work with the different language settings in EPiServer Commerce.

Language Settings

Specific Language Settings

In EPiServer CMS there are three different language concepts, two which are defined by ASP.NET (Cul-
ture and Ul Culture), and one which is the contentlanguage. The ASP.NET Culture is referred to as "Sys-
tem Language", and Ul Culture as "User Interface Language". A typical culture is "en-US" which defines
the language as English (en) with the culturally defined specifics for United States (US).

O In EPiServer Commerce, "Ul Culture" is used and "English (United States)" is the default lan-
guage used by the system. This is due to the EPiServer Commerce database which uses "Ul
culture" in the matching.

Make sure this is set up right from the start to avoid problems later on. Itis recommended that only
"Ul Culture" languages, i.e. "en-US", "en-GB", "nl-BE" efc., are enabled on the website.

Content Language

To display contentin the desired language on your website, you may apply the language management
options available in EPiServer CMS edit mode, to create pages in different languages. Available content
languages are enabled from the EPiServer CMS Admin mode under Config and Manage Website Lan-
guages. For more detailed information on how the language settings work, please refer to the user doc-
umentation for EPiServer CMS.
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Dashboard W®MEl Commerce Add-ons EPISERVER @ ? Ladmn Q
Edit Admin Repotts Visitor Groups
admin || Config || Page Type || Block Type .
Manage Website Languages @
w System Configuration
EEETEEIES Define the languages that should be available to visitors on your website.
Site Information
Edit Categories o Add Language
Edit Frames
Edit Tabs Move Up  WMove Down | Name Language Code Enabled | SystemlIcon |Template Icon
Manage Website Languages hd English en v = =
Remote Websites 4@ 3 English (United Kingdam) en-GB ¥4 iz B
w Property Configuration & 3 English (New Zealand) en-NZ =] =]
Edit Custom Property Types & 3 English (South Africa) en-ZA = =
Dynamic Properties & 5 Deutsch de = =
v Security & ;8 francais ir [ | i |
Permissions for Functions & I sspafiol os = =
v Tool Settings & 3 svenska sV v = =
Plug-in Manager P - -
norsk no i= =
Change Log #* i
Rebuild Name for Web Addresses @ o dansk ga = =
Mirraring & 3 suomi fi += +=
Register Web Parts & 5 Mederlands nl = =
Search Configuration
4 5 Mederlands (Belgié) nl-BE [} [N
& n Partugués (Brasil ptBR = =
& 3 English (United States) en-Us "4 = =
& 3 Deutsch (Deutschland) de-DE v ]
4 & Espafiol (Espafia, alfabetizacidn internacienal) es-ES ¥4 =
& frangais (France. --FR .1 [iF ]

User Interface Language

To setthe user interface language for EPiServer CMS, click your user profile name in the upper right
corner. Select My Settings and then the Display Options tab. Select the language of your choice in the
list, and click Save. Note that you may need to refresh the browser window for the changes to apply.

Dashboard CMS Commerce  Add-ons EPISERVER @ 7 Q

w EPiServer CMS

Wy Settings IVIy Settings (’D

User Information || Display Options

Language Settings

Personal Language Use system language =

Use system language
Dansk
English (United States)

English E
e
Norsk g

Swvenska

Deutsch

Espafiol

Francais

H#E5 (Japanese)

Portugués

ez (g A R4ANE) (Chinese (Simplified, PRC))

To set the user interface language for EPiServer Commerce, select Change Language in the upper
menu of the administrative interface. Choose the language of your choice in the list and click OK to save
you changes.
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Dashboard Home

Welcome, admin

1@ Cet Help For This Page
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-

Customer Management U ,@

News & Announcements

:lm Customer Management
] Organizations
[ Contacts
s Rales
@ Gift Cards

Summary - X

Start

Editing EPiServer 7 content on a maobile device
Tue, 06 Nov 2012 20:59:49 CMT

Creating a component that searches for content
Mon, 05 Nov 2012 15:53:02 CMT

EPiServer MVC content rendering - Part 2
Maon, 05 Nov 2012 10:50:37 GMT

Partial Routing

Mon, 05 Nov 2012 09:12:21 GMT

New in EPiServer Find - Unified Search

Mon, 05 Nov 2012 11:58:17 GMT

New in EPiServer Find - Unified Search

Maon, 05 Nov 2012 045817 GMT

New in EPiServer Find - Unified Search

i| | Mon, 05 Mov 2012 13:58:43 GMT

& Products: 2779 ©3 Categories: 19
] orders: 0 &] Customers: 6
D Promotions: 0

ﬁ Dashboard

Help

Performance - X
&
Sales Graph ks

Monthly Sales (thi

no sales data avail

Customer Management
&

=
Catalog Management

? Qrder Management

E Marketing

vﬂ Asset Management

Help will appear in a separate window.

Find answers to questions about Commerce Manager

containing the terms...

Examples: Campaigns and Promotions
How da | Create a Discount Promation?
How da | Create a New Product?

Where is the release history?

Reporting

m Administration

m

| »

Languages for Catalogs

Globalization | 229

For products in the product catalog, the language information is set in the product database. EPiServer

Commerce will display the product information in the language selected by the website visitor. Lan-

guages for the content of a product catalog, are set when you create the product catalog. Find out more
about this under Catalogs.
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Searching

Introduction

The EPiServer platform has a sophisticated search functionality which allows you to search through dif-
ferent types of content on your entire website. You can search for content pages and blocks, document
files, community objects and products. The same search function is used in the global search, as well as
for sample search page templates and the file manager in EPiServer CMS. The search can be extended
to include results from external systems integrated with your website.

The search results will automatically be filtered based on access rights so that users will only see content
they have access to. The search service in EPiServer is based on the open source search engine
Lucene. The service is plug-able which means that Lucene can be replaced by another search indexing
provider.

Accessing Search

The underlying search functionality is used by the different EPiServer products, and the description here
applies to standard installations of EPiServer products with their respective sample templates. Visitors to
the site will usually access the search through a website search page with a search field. The search
field is also available in the top menu of the website.

From the top global menu, editors and administrators can access the global search option in the upper
right corner of the page when logged on to the website.

EPISERVER @ ? L epidemo Q

s

Blocks B Alloy Meet teaser - Alloy Meet
B Alloy Meet jumbotron - Some happy
B Customer testimonial wide teaser - Sl
HE alloy Track video
B Download Alloy Track form - Start do.
E Alloy Track teaser - Alloy Track

m

E Alloy Plan teaser - Alloy Plan
HE alloy Track jumbotron - Alloy Track -
B About Alloy Track - Alloy Track Projec

Bl Customer testimonial wide teaser - Si

Pages |:I Alloy Meet - Alloy meetings are easy
O Alloy Meet Campaign =
[ DDWH:\&Id Alloy Meet
El Start - Alloy - collaboration, communi
O Alloy EU
O Alloy US il
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When hovering over a link in the search hit list, information about the page will be displayed, helping you
identifying the correct item. Clicking on a link will take you to the item, for instance an web page or a doc-
ument file.

How to Search

You can search for web pages with a certain name, and you can also search for pages that contain a cer-
tain text string. This means that if you cannot remember what the page is called but remember the first
lines of the text, then the page can easily be retrieved. It is also possible to search for a page using its ID
number, if you know this.

Search Tips

e Enter a sufficient number of search keywords, usually around 6-8 carefully selected words, sep-
arated with a space. Start with fewer keywords and if needed narrow your search by extending the
number of words. Example: episerver product project.

e When searching for specific phrases, you can combine keywords using quotation marks. Exam-
ple: "episerver search tips".

e The search function is case insensitive, meaning that you can use both upper and lowercase
letters. Example: New York and new york will both return the same result.

e You can restrict the search by placing a plus sign (+) in front of the words that must be found to
consider the page a match. Example: +episerver +search +tips.

e Similarly you can restrict the search by placing a minus sign (-) in front of the words that must not
occur to consider the page a match, for example -episerver -search -tips.

e To match part of a word, place an asterisk(*) at the end of the word. Example: word1* word2 will
return content with the words word123 and word2, but not word123 and word234.

e The boolean operators AND and OR can be used. AND means "l only want documents that con-
tain both/all words", OR means "l want documents that contain either word, regardless of which
one". Example: episerver AND search returns documents with both words, episerver OR search
returns documents with either episerver or search.

Displaying Search Results

The items in the search result listing will appear based on the ranking they received from the search algo-
rithm.The display of the search results depends on how this is set up on your website, since this can be
customized in many ways. Often some kind of filtering is applied which can be based for instance on cat-
egorization of content.

Administering and Configuring Search

The search feature has some administration and configuration options which are managed from the
administration interface in EPiServer CMS. Refer to the administration part of the EPiServer CMS user
documentation for more information.

Refer to the EPiServer Framework SDK for a technical description of the search functionality, con-
figuration possibilities and the integration interface.

When installing the sample site, Lucene will be the default search provider installed. To find out more
about Lucene, refer to the official Lucene website.
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Search in EPiServer Commerce

Introduction

The search in EPiServer Commerce is based on the search functionality in the EPiServer platform. In an
implementation of the EPiServer Commerce sample site, you will notice that, in addition to content pages,
blocks and files, products will be included when a search is performed.

Dashboard |88} Commerce Add-ons EPISERVER @ ? Ladmin [Q
Edit Admin Reports  Visitor Groups Search | wine
Q ) == Products [ madsira Wine Company-1920 - Bual, Bl:

Root [ madeira wine Company-NV - Enoteca's
[imadsira wine Company-NV - Enoteca's
[ Heitz Wine Cellars-2001 - Heitz Bella O:
[ madeira Wine Company-1908 - Bual, Cc
' 1 Par| EIRamey Wine Cellars-2007 - Ramey Ritcl

Rickn EIMadelra Wine Company-NV - Enoteca's
Hertfl

=4 Home

m
<

& [Menu] en-Us
[Functional P..en-Us
[Footer Conta.en-UsS

[imadsira wine Company-NV - Enoteca's

EIRldgewew Wine Estate-2008 - Grosven

EIRldgewew Wine Estate-2008 - Knightsk

enoteca

=
=
& [My Profile]  en-US
& [Content Pag..en-US
=]

[Company Pro.en-US
Jump to Enoteca Wine store - To Site [http://fn...

: Y A4
Discover our new Spring'collection

View our new arrivals ©

—— " > ™ Refreshing Rose for Js
Recent B .t special occasions .-

The sample site also features faceted navigation , a features allowing for advanced filtering of products
in the product catalog.

It is possible to replace the Lucene search engine with other search providers. Refer to the technical doc-
umentation for EPiServer Commerce for more information on how to set up search providers.

Related Information

Refer to the sections listed below for more information on related topics.
e Searching for product catalog entries
e Indexing product catalogs

e Faceted navigation
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Sample Site

Introduction

The "Enoteca winestore" sample site is a fully functional B2C and B2B e-commerce solution for a mid-
size retailer. The templates make use of the built in functionality of the EPiServer platform, and illustrates
the many possibilities when creating dynamic e-commerce websites.

Tris is & demo store. Any orders placed through this store wil not be honored or fulfled. EPISERVER
Welcome, admin  Log Out My Profile

Your Local Store

' 1 Park Road

Rickmanswoth

Hertfordshire

WD3 1RE W Your Basket

enoteca g (D) E23852600 Oiem(s)  Totak S0.00

Mixed Cases

. 1 3’._
Discover our new Spring'collection

View our new arrivals ©

Recent Reviews

No Recent Reviews

3 for the price of 2
" on all mixed cases

See our most popular mixed cases ©

E)) Get RSS Feed O

Y 'u:‘:‘?f':"‘k_

. i
r'y OCCas1ion :
tion @

L ELLEE I LR D 20% off select Reds Our newest arrivals  Bring out the bubbly

Multiple Deliveries Our Favorites

Our delivery services are
managed localy Pulenta, La Flor,
Sauvignon Blanc,

Find Out Mere © Mendoza (Stelvin) 2010

2005

fn-gray:17002

Site Structure

When installing the EPiServer Commerce package with a sample site, a number of pages will be created
and displayed in a specific structure in the page tree. Some of them will show editorial content. Some
pages are used as containers for other pages These will not display any content of their own and will be
hidden in navigation menus.

e The home page is built using the Home page type. The Home page contains numerous settings
affecting the entire website, for instance top menus, search and login. This is also where you
define pages to be used for shopping carts, payments and checkout.

e The main menu navigation is built up by the page structure under [Menu]. The products listing is
retrieved from the [Resources] section where the Product Listing page type which is used for dis-
playing the products, fetching product information from the product catalog.

e The [Functional Pages] section of the site structure holds the display templates for a number of
general functions such as Checkout, Login and Create Account. These have their own specific
page types linking to functions in the Commerce Manager module.

o Editorial content pages are most often based on the page type Standard Page. These are pages
where editors can create and edit content the usual way in EPiServer CMS. Examples of editorial
content are the pages under the [Content Pages] and [Footer Container].
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e The [My Profile] section contains display templates for personal settings for online shoppers.
Page types used here are for instance My Orders, My Page and Wishlist.

e The [Company Profile] section of the site structure holds display templates related to the B2B part
of the sample site. This includes page types such as Company Order Detail, Create Member and
Company Page.

Sites Tasks

Q

Foot

11l
L]

= # Home
= [Menu] en-Us
= [Functional Pages] en-US
& [Footer Container] en-US
= [My Profile] en-Us
& [Content Pages] en-Us

B [Company Profile] en-Ls

O Note that some pages will not have a display template for preview, since they are only used as
container pages. Container pages have a special symbol in the page tree structure. You can-
not link to a container page.

Sample Pages

In the following the page templates included in the package are described in more detail, explaining the
setup and the possibilities with EPiServer Commerce to both developers and end-users. If you are a
developer, you can install Enoteca templates project in your development environment, to explore in
more detail how the templates are built.

Page Types

Introduction

Page types contain the properties or fields, where editors enter information in a page. Page types will
have content areas where editors can either type information directly in the area, drag-and-drop pages
into the area, or add content blocks. When hovering over a content area with existing content, you can
see if the contentis a block.

O Note that this version of the sample site offers only limited possibilities for drag-and-drop of
contentinto content areas. Furthermore, the sample site does not contain any sample block
types.
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o f

L~
lel@| e
Sites Tasks Catalogs [EEIRIIS) Files

Home ) [Content Pages] Changes to be published AR IF ¥ =
Q Multiple Deliveries Q
Root [l commeree Content R... -
#t Home This is a demo store. Any orders placed through his store will il (2 wine
& [Menu] [ Accessories
Your Local Store
& [Functional Pa... o [ Mixed Cases
& [Footer Contai... z‘c::ﬂ:iwﬂ"‘ (2 wine Region
& [My Profile] eriotdshire . =l
WD3 1RE __| Argentina = =
i [Content Pages] enoteca © =44 (01923 432605
L Australia
Multiple Del...
em— Mixed Cases - Austriz
I chile
Terms And...
’ Ty [ France
& [Company Pro... Multiple Deliveries = L4
[ Germany
oy O Enoteca takes pride in customer service,
Create Me. Our locally managed delivery service is fast, convenient and very refiable. And because its managed with a human [ Great Britain
change your delivery requirements. Best of all, you won't have to wait iw day for a courier.
Edit Member Most of the time, your loal store team will be able to get your wine to ydwwithin a day or twe of placing your order. | !
=niless G [you within an absoluts maximum of 7 days. [ Hungary
Company P... [ raly -
El Bodegas Mauricio Lorca-2009 [... =- *
Popular Products Bodegas Mauricio Lorca-2010 [F... E
9
B Finca Flichman-2007 [Finca Flich... ||
| B Finca Flichman-2008 [Finca Flich...
Finca Flichman-2009 [Finca Flich...
+ =
Bl Finca Flichman-2009 [Finca Flich... -
Recent =

Page properties can be edited both through direct on-page editing or forms editing. However, some
properties will only be available for editing through forms editing. Hover over the content area to find out
which properties you can edit directly in the page.

The right-hand side pane of the sample site displays the Product Catalogs. With this feature it is possible
to expand a catalog node to display products, and drag-and-drop a product into the content area of a
page.

O Note that in this version of the sample site, you can only drag-and-drop products into content
areas of the Home page (start page) of the site.

Content Editing

The editorial contentis mostly added under the Content tab in Forms Editing. The specific properties
available under the Content tab, will differ depending on the page type. For instance you can have a Main
body property providing all the functionality of the EPiServer CMS editor. The Category field, used for cat-
egorizing the content, is available for all page types.
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L~ |
' (=l
Sites Tasks :
_ | Home > [Content Pages] Changes to be published _JITN 1 1 SRV I
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= Root Autosaved 11:26 AM Undo?
# Home =
& [Menu] Name Multiple Deliveries Visible to Everyone Manage
& [Functional Pa... . . L Languages en-Us
Name in URL Multiple-Deliveries Chanqe
1D, Type 57, Standard Page

& [Footer Contai...
Simple address Change

& [My Profile]

@ [Content Pages] Display in navigation

[ Multiple Del... 2 =
[ Corporate m =2

[ Terms And...

Category Add one or more categories -+
B [Company Pro... ‘ ° |
C Q0. i

[ company Heading ‘ Multiple Deliveries |

D Create Me... L

[ Edit Member Description ‘ Our delivery services are mz E
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[ Company P...
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Sample Page Types

The sample site has a set of page types for specific purposes, with built-in functionality. Available page
types on a site can be categorized to make selection easier for editors. Note that not all page types exist-
ing on a site may be available for selection in edit mode, and not all page types may be available under a
specific node in the page tree. The availability of page types in edit mode can be controlled from the EPiS-

erver CMS administration interface
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‘Suggested Page Types

Container Page
This page type will be ussd
33 3 contziner and will not
containz any data.

g

Home Page
The start page is the main
entry point to the wab site
centaining a main and
secondary body as well a5
differant listings for news
and svents.

Shopping Basket Page
List added products.

Address Book Page
Page displays address
book.

Container Page

This page typs will be used
25 = contziner and will not
contsins any data,

Standard Page
An Enotaca Standard Page

Checkout Page

A Page which is usad for
customer to check out
goods

Standard Page
An Enotsca Standard Page

Create Account Page
Used to create 2 new user
account

Login Page
This page will be used for
user to login.

My Orders Page
Page displays order
history.

My Settings Page

Page displays profile
settings for users.

Company Order Detail
Page
Company order datail
page.

Members List Page
Page displays the list of
=mbers.

Compare Page

This page type displays a
list of preducts to be
comparsd,

Search Result Page
Used to show search
result,

Product Listing Page

This pags type displays 2
list of products.

Wish List Page
Page displays wish list for

Edit Member Page

Page used to adit an
existing company member.

Company Page
Page displays company.
profilz overvizw.
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Wine Detail Page
This pags type contains
the data for 2 wine.

Company Checkout
Page

Checkout page for
company usar.

My Page

Page contzins information
for standard users,

Order Detail Page
Detail informstion of =

Create Member Page

Page used to create 3 naw
compzny member.

In the following sections of this documentation we will describe the features and specific properties of the
page types included with the sample site. Use these sample pages as inspiration when creating your own

pages.

O The templates, tabs, fields and functions described in this documentation refers to a "standard
installation" of an EPiServer Commerce sample site. The standard functions and fields of EPiS-
erver CMS are not described here. Please refer to the EPiServer CMS documentation for
editors and administrators available on world.episerver.com.

Home Page

Introduction

The home page is based on the Home Page page type and is normally defined when the website is
installed. The page type has no editorial areas, instead most of the content is fetched from other parts of
the website. The page type holds a number of settings with references to other pages on the website. The
main settings of the home page will most likely not be touched very often after setup of the site. Other
parts like special offer advertises and product campaign content may be updated more frequently.

The Home page also has a "carousel" feature where you define a set of images with associated texts and
referral links. The images are selected from the File Manager, and will replace each other in a continuous

slideshow.

Adding Content

Content can be added both through direct on-page editing or forms editing. However, some properties
will only be available for editing through forms editing. When you hover over a content area you can see if
itis available for direct editing, and what type of content it is.

Expanding Catalogs in the right-hand pane, allows you to drag-and drop specific products into the Our
Favorites content areas. These can also be edited through forms editing.
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- ——

Home No changes to publish = a z
; SO0 ey

Discover our new Spring'collection

[ commerce Content R...
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View our new arrivals © L Accessories
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Recent Reviews
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No Recent Reviews
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Our deiivery services are

Pulenta, La Flor, H i 3 Craiglee Vineyard-2009 [Craigle...
managed locally ' e 2 o 5 : | B Craig ¥ l
P () . Kz GENRI2LT ] Dean Hewitson-2007 [Hewitson... =~

Australia 2007] PO1-2008 [Hewitson..

Corporate
Bl Dean Hewitson-2009 [Hewitson...

Constantly striving to exceed
your expectations
Find Cut Mere. ©

[l Dean Hewitson-2009 [Hewitson...

E] Elderton-2006 [Elderton Comma,
Tokaji Betsck, 6 1 H Rosso Conero DOC, H

Puttonyos, The Royal | “Sassi Nert, Fattoria Le | E] Elderton-2008 [Elderton, Botryti...
Tokaii Wine Company Terrazze, Marche 2005

2005 [l Elderton-2009 [E Series, Shiraz/...

[E] Elderton-2010 [Enoteca's Austra.

[ Elderton-NV [Enoteca's Australia..
Add to Basket © ‘Add 1o Basket ©

[l Frankland Estate-2005 [Frankla.

In the following sections the properties on the various tabs in forms editing will be further described.
Content Tab

Introduction

Below are the properties that can be changed under the Content tab for the Home page in forms editing.
Carousel Feature Properties

The Carousel feature allows you to define a set of four images with associated information.

o 0 -
ARCA 2L
Mix and match deals 207 off select Reds Our newest arrivals Bring out the bubbly

First/Second/Third/Fourth Carousel Image URL

The link to the carousel image, select an image from the File Manager.

First/Second/Third/Fourth Carousel Tab Name

The text on the tab that will be displayed with each image.
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First/Second/Third/Fourth Carousel Caption

The text that will be displayed with each image.

First/Second/Third/Fourth Carousel Promotion Link

The target link when clicking on a carousel image, select a page in the page tree.

First/Second/Third/Fourth Carousel Promotion Link Title

The text for the link to the selected target page.

Home

Name

Name in URL

Simple address

Display in navigation

Settings

Category
First Carousel Image
url

First Carousel Tab
Mame

First Carousel
Caption

First Carousel
Promotion Link

First Carousel
Promotion Link Title

Second Carousel
Image Url

Second Carousel Tab
Mame

Second Carousel
Caption

Second Carousel
Promotion Link

Second Carousel
Promotion Link Title

Other Properties

Home
Home Change
Change

Favourite Products

Visible to
Languages

ID, Type

External Links

Add one or more categories

/Global/Images/Carousel/ho E

Mix and match deals

3 for the price of 2 on all mi:

Mixed Cases 26

®|[.]

See our most popular mixed

/Global/Images/Carousel/iSt E

20% off select Reds

Save on Reds from Merlot tc

Red Wines 27

Sample every shade

o[-

Maximum items in you may also like tab

Everyone Manage
en-GB, en-US, de-DE, fr-FR

5, Home Page

Tools

Site Configuration

Set the maximum number of items allowed for the display of "you may also like" items.

About Us age

Provides linking to display content from the About Us page section stored in [Footer Container].
Deliveries Page
Provides linking to display content from the Multiple Deliveries page stored in [Content Pages].

Corporate Page

Provides linking to display content from the Corporate page stored in [Content Pages].

Main Advertise

No changes to publish ]

n
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Provides an editor area for adding editorial content to the main advertisement area at the top of the home

page.
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Bottom Advertise
Provides an editor area for adding editorial content to the advertisement area at the bottom of the home
page

About Us Image

Provides linking to an image to be displayed with the "About Us" section on the home page.

[ ~ |
e@ (=
Home No changes to publish H

Maximum items in 3 - -
You may also like s
tab

About us Page

About Us 38 [x] E

Multiple Deliveries 57 @ E

Corporate 58 [x] E

Deliveries Page

Corporate Page

Main Advertise B % [0 O i)
B I 2 S sules - Q =

m|»

< 0 r

Path 4

Bottom Advertise = i [ % [0 O L

m_|»

« i v
Path

A
About Us Image

m

m

N

Favorite Products Tab

Introduction

Below are the properties that can be changed under the Favorite Products tab for the Home page in
forms editing.

Properties

On this tab you define links to the (four) selected favorite products displayed under "Our Favorites" on the
home page. The products are defined using the product link dialog which allows you to chose products

from the product catalog. Find out more about this feature in the Product Picker Property section of the
EPiServer Commerce SDK.
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@ @ =
Home No changes to publish H

Name Home Visible to Everyone Manage
. Languages en-GB, en-US, de-DE, fr-FR
Mame in URL Home Change
1D, Type 5, Home Page
Simple address Change
Display in navigation

Content Settings Favourite Products External Links Site Configuration

First Favourite
Product

Second Favourite
Product

Third Favourite
Product

BB E

Forth Favourite
Product

External Links Tab

Introduction

Below are the properties that can be changed under the External Links tab for the Home page in forms
editing.

Properties

On this tab you define external links to the link selection displayed under "Follow Us" in the footer section
at the very bottom of the home page. The links are defined using the ordinary link dialog tool in EPiServer
CMS.

e |@| a
Home No changes to publish H

Name Home Visible to Everyone Manage
) Languages en-GB, en-US, de-DE, fr-FR
Mame in URL Home Change
ID, Type 5, Home Page
Simple address Change
Display in navigation
Content Settings Favourite Products External Links Site Configuration
Facebook Link http://facebook.com/ I:I
RSS Link http://world.episerver.com/! III
Twitter Link http://twitter.com/ |:|
YouTube Link http://youtube.com/ I:I

Site Configuration Tab

Introduction
Below are the properties that can be changed under the Site Configuration tab for the Home page in
forms editing. The settings here are common website configuration items that are defined as properties

on the start page and will be inherited to the sub-pages. Most often these settings are defined when the
website is installed but it may be necessary to update them at some point.
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Here you define settings for both a B2C (consumer) and a B2B (company) scenario. Note that the related
function pages must be created first before you can define them on the home page.

Open the home page for editing to change the settings for the different properties. For the page links,
select the appropriate page in the page tree structure and save and publish the page to update the set-
tings.

Properties

Login Advertise Image

Here you define the image to be displayed to the rightin the login page for the site, intended as an adver-
tising space. Select an image in the File Manager.

Link to Login Page

Defines the login page to be used when visitors log in to the website.

Create Account Page Link

This defines the display page for creating an account when a shopper registers to the website.
Product Compare Page

This setting defines the display page to be used when comparing products.
Search Result Page Link

This setting defines the display page for presenting search results on the website.
Shopping Basket Page

This is the page to be used when displaying a shopping basket.

Max. Quantity Of Display Entry

Here you define the maximum number of products to be displayed in a product listing. If you have a large
amount of products in specific categories, it might be wise to limit the display number.

My Page Link

This page type displays a snapshot of recent account activities for a customer.

My Wish List Page Link

This setting defines the wish list page to be used when displaying a customers wish list.
Checkout Page

The page to be used when displaying the check out page for a customer.

Order Detail Page

Used for displaying the details for a specific order, when selected from the My Order page.
My Order Page

This page type displays the order history for a specific customer

My Settings Page Link

Here you define the page type to be used for displaying account details for a customer.
Checkout Page for Company User

Used for displaying a checkout page for a company user in the B2B scenario of the sample site.
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Company Page

This page type displays a snapshot of recent account activities for a company.
Members List Page

This page type is used for listing company members.

Create Members Page

Here you set the display page for creating a company member.

Edit Member Page

This page type is used for editing the settings of a company member.
Company Order Detail Page

This page type displays the details of a company order.

= (=
Home No changes to publish =

Name Home Visible to Everyone Manage
. Languages en-GB, en-US, de-DE, fr-FR
Name in URL Home Change
ID, Type 5, Home Page
Simple address Change

Display in navigation
Content Settings Favourite Products External Links Site Configuration

Login Advertise .
Global/T ductsRi

Image ‘f lobal/Images/productsRig | III

Link to Login page ‘ Login 17 o | III

m

Create Account Page
Link

Create Account 20 [x] | III

Product Compare
Page

Product Compariso... [x] | I:I

Search Result 22 [x] | lzl

Shopping Basket 21 a | I:I

Search Result Page
Link

Shopping Basket
Page

Max Quantity Of ‘ 9g - |
Display Entry =
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|~
= JERIE] (=]
Home No changes to publish =
My Page Link My Page 52 o E
My Wish List Page : iat =
Line Wish List 54 <] E
Checkout Page Checkout 16 o E
Order detail page Order Detail 55 o E
My Order Page My Orders 51 o E
My Settings Page My Settings ==
s 0]

Checkout page for
company user

Company Checkout.. & E

Company Page Company Page 65 [x] E

Members List Page Members List 64 o E
Create Member Page

Create Member 62 [x] E
Edit Member Page Edit Member 63 ) E
Company Order Company Order De.
Detail Page =) b E

Each of the page types mentioned here are described in more detail in the following sections of this doc-
umentation.

Product Listing
Introduction

The page type Product Listing is used for listing product information from the product catalog in Com-
merce Manager. The listing will be fetched from the selected product category (node) in the product cat-
alog and will display an image of the product together with information about ratings, reviews and social
plug-in features.

In the left column of the page itis possible to filter the product display according to a preset product cat-
egories. To the right on the page, information related to selected products will be shown. Under the prod-
uct listing, the recently viewed products are displayed.

The page functionality also includes a product compare option as well as the Add to basket button for
each productin the list. You can define the number of items to be listed per page, and a pager feature
allows for browsing between the listed pages.
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Welcome, admin Log OQut My Profile
Your Local Store

' 1 Park Road
Rickmanswoth
Hertfordshire
WD3 1RE wr Your Basket

enOteca § +44 (0)1323 432608 Ditem(s)  Tolal: 50.00
Mixed Cases Popular searches 5 °:

Home = Wine

Currently Shopping By
There are 12 product{s) found

Region® Stellenbasch - Recent Reviews

Remove Cabernet Franc, Oldenburg Vineyards Stellenbosch, SA 2008 o Recent Reviews
Clear All 0 Review(s)
) Get RSS Feed O
Browse Wines Eaila 0
Price Cabernet Franc in Europe tends fo be used as a minor ingredient in e h
blend, such as in Bord tin the Loire, where it is th o ~ff c :
. a blend, such as in Bordeaux, except in the mre. where i !s. e 20% Ott Ch_an-lpagn
sole grape used to produce Chinon and Bourgueil. Unless itis ... h

Style $22.45 View Che

Closure

0 Compare @ Quentity: 1 E| Add to Wish List @

Grape mix

Alcohol Add fo Basket ©

Taste
Syrah, Oldenburg Vineyards Stellenbosch, SA 2008
L 0 Review(s)

H Eaila o

= Deep. dark-hued wine redolent of blackberries and cherries on the
nose with hints of pepper. Wonderful purity of fruit expression on
both nose and palate, very fine tannins and great persistence on

Properties

To define a product listing, create a page based on the page type Product Listing and select the desired
product category (node) in the Catalog Node name field. The categories (nodes) available here are
retrieved from the [Resources] section in the page tree structure which is set up atinstallation. This in turn
reflects what is defined in the product catalog in Commerce Manager.

In the ltem Per Page field you can define the number of items to be displayed on each page. The content
of the Bottom Advertise editor field is displayed at the very left-hand bottom of the product listing page.
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|~ |
a

omapiitenl Mo changes to publish i=
Wine
Name Wine Visible to Everyone Manage

. - Languages en-Us
Name in URL Wine Change

1D, Type 7, Product Listing Page

Simple address Change
Display in navigation

Category

Add one or more categories
Catalog Node I:I

Node Name

m

Item Per Page

Bottom Advertise ] -~ g [ < [0 O i
B 7= i=| styles - Q =

Fath

Functional Pages

The pages under the [Functional Pages] section in the page tree structure of the sample site holds a
number of page types with general e-commerce functionality such as login, checkout and search result
presentation. These page types are described more in the following sections of this documentation.

Check Out

Introduction

The purpose of the Check Out page type is to display the steps of the check out procedure when a cus-
tomer wants to finalize a purchase.The check out procedure is initiated when the customer selects the
Checkout option. The checkout procedure may look differently depending on the payment and shipping
options defined in the system. On this sample site the checkout procedure has four steps: Welcome,
Address, Payment and Confirmation.
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Step |: Welcome

Register Login My profile
Your Local Store

' 789 Tincidunt

Riiquam erat
Yuisque varius
Sollicitudin @ Your basket

enoteca +44 (0)00000789 Sitem(s)  Total: £535.95

Mixed Casos T3

2. Address 3. Payment 4. Confirmation

Hello,

Have you already got an account with us? Login to use your details. If you haven't got an account, why not
register?

Yes, | would like fo login or register @ No thanks, proceed to check-out @

In this first step the customer has the option to either log in or register to the site, or to proceed directly to
the next step without registering.
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Step 2: Address

1. Welcome 2. Address 3. Payment 4. Confirmation

Deliver and Billing Address

|. Choose delivery address

Address Title
First Name
Last Name

Company (Optional)
Email Address
Phone Number
Country
Postcode
Address Line 1

Address Line 2 {Optional)
Town

County (Optional)

Choose a delivery option

Free delivery (2-3 days) @ £0.00
First class delivery (1-2 days) ) £10.00
Express delivery (1 day) ) £20.00

2. Choose billing address

Here the customer enters name, address and contact details, if these are not already registered in the sys-
tem. If they are, there will be an option to update the existing information. The available shipping options
are selected in this step. It is also possible to chose a different billing address.
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Step 3: Payment

1. Welcome 2. Address

Payment

Amarona della Valpolicella Classlco &. Quintaralll, Venato

Bardoling Chlaretho DOC, Monte Del Fra

Payment Method

O cm can

@ pay By Phone

¥ Pay By Crem Card

e visa B

Card number

Expiry date 1 [w]/ 2010 ]

o
g
5

Guantity Prica
z £255.35
@uantity Price
3 £675
Subtotal
Shipping cost

‘Order discount

Total

£510.70

Total

£26.25

ES3E.55 (2uc. VAT)
£0.00 (=xc. VAT)

£0.00 ez, VAT)

TOTAL to pay

Payment by Girt Card

E530.55 (=xc. VAT)

(2. VAT)

Remain to pay
Sy ane payment method below

Name on tha card

v

(3. VAT

Update remain to pay ©

Sample Site | 249

Here the total order sum is calculated, and the desired payment method is selected. The sample site also
has a gift card option where the gift card details are entered and the total sum is recalculated based on

this.
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Step 4: Confirmation

1. Welcome 2. Address 3. Payment

THANK YOU FOR YOUR ORDER!

Your order number is PO73397

A receipt has been sent to your email address: mary@somemail.com

The Team

N

5;* .
20% off Champagne @ For every occasion

View our fine wine collection @

View Champagne 0*'

Register with us and you will eam loyalty points!

Legin and Register

The final step contains the order confirmation and displays the order number the customer. Also in this
step an order confirmation email is sent to the customer.

Properties

The Check Out page is created in edit mode and then defined in the site configuration setting of the start
page. Apart from categories, the page does not have any editable properties.

For more information on different payment providers in EPiServer Commerce, please refer to the Payment
Providers section.

Login

Introduction

The Login page provides a login possibility for both website editors and administrators, as well as reg-

istered customers. A user name and password is required. The page has functionality for password recov-
ery. Itis also possible to log in to the site using Facebook account credentials.

The Login page is also the entrance for registration of new customers to the site. Clicking on the Register
option will take the user to the Create Account page. To register, a name and email address is needed,
together with a user name and a password.
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Your Local Store

' 1 Park Road

Rickmanswoth
Hertfordshire

Mixed Cases

Log in or create an account

Registered Customer * Required Fields

If you have an account with us, log in using your username.

Username *  admin

Password = seeer

Use your Facebook account to log in.

New Customers
Register on our site and create your personal profile.

New to Enoteca?

Take advantage of Enoteca's fine wine collections, education resources and special events by

registering. Register ©

Properties

Most of the functionality of the Login page is defined in code. However, in edit mode you will find and
editor field where itis possible to design a welcome message to new users registering on the site.

No changes to publish =
Login

[~ |

Home » [Functional Pages]

WD3 1RE @ Your Basket

enoteca (I ISIR08 0 item(s)

Total: 50.00

Name Login Visible to Everyone Manage
) X Languages en-us
Mame in URL Login Change
1D, Type 17, Login Page
Simple address Chanae

Display in navigation

Category Add one or more categories |
Invite New Customer E i
el = W 4 (5 01 5 (i
B J | i= i=||Styles = Q [

Hew to Enoteca?
Take advantage of Enoteca's fine wine collections, education resources and special events by registering.

Fath:

When created, the Login page must be defined in the site configuration setting of the start page.
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Wine Detail

Introduction

The Wine Detail page is a "product page", and as such plays a central role on this type of site, since itis
used for displaying product details and related information. The page is displayed when a customer
selects a specific product, and will display product information from the product catalog of Commerce
Manager.

The productinformation is displayed in the center area, with options for comparing, adding to wish list
and buying. Below the product information, any related review or ratings information will be displayed.
The rest of the page is built up displaying other information related to the product. The information is
selected based on type of product and meta data available in the product catalog.

Home = Wine = Haly » Luciano Sandrone Italy

Barolo, Le Vigne, Az. Agr. Luciano
Sandrone, Piedmont
o de oA 100 %

ElLke The wines of kaly offer breathtaking variety. From bright,
fresh Pinot Grigio to the deep reds of Barolo, ftaly has

something for everyone, especially given our great range
Sandrone's dark ruby-colored 2001 Barolo Le Vigne of wines.
presents a fantastic nose of flowers, minerals and Find Out More €
crushed raspberries followed by generous amounts
of very ripe red fruits, mint and eucalyptus notes

with well-integrated oak and fine tannins. it is This wine has a fatastic boguet, you should try it
noticeably more structured than the 2000, with more out . »

balance, freshness and a longer finish. Traditienal in
- admin

design, but modern in execution, the 2001 Barclo Le
Remove 3

Vigne presents tremendous harmeny and elegance.
ldeally a few years of cellaring are warranted
although the wine is already drinking well today.
Wine Country: faly

Color: Red

Style: Haly

Closure: Cork

20% off Champagne
\ Cha

Grape mix: Nebbiclo

Alcohol: 14

Taste: Dry

Vegetarians: False

Vegans: False

£117.00

[[] compare @  Quantity 1 T Addtowish List ©

Add to Basket ©

Reviews

Fantastic!
admin, February 2012

This wine has a fatastic boguet, you should fry it out.

***** Remove €

Properties

The Wine Detail page type is linked to the information stored about the productin the product database.
For instance, information such as name, code, catalog image, and display price is collected from the Com-
merce Manager product catalog. Apart from categories, the page does not have any editable properties.
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Compare

Introduction

The Compare page type holds functionality for displaying selected products for comparison. For each
product you want to compare, you can select the Compare option, which will add the product to the Com-
pare page. This page can then be accessed by clicking the Compare link/button.

£11.45

Add to basket ©

Add to Wish list ﬂ

Compare Cuantity 1 IEI

The selected products are listed next to each other together with related product features, for easy over-
view and comparison. You can compare up to four products at the same time. A product can be removed
from the comparison list, or added to the shopping cart or the wish list. The selected products will remain
for display on the compared products page until they are removed or a new product selection is done by
the user.

Compare products

Wine KU
REmava Ramove
Barolo, La Wigns, Az Agr. ‘¥arra Yering Dry Red No.2
Luclano 3androns, Pledmaont Shiraz, Yarra Valley, Victorla
Lt 8 8.8 1 ok
£117.00 £51.00
Sanonone's dark ruby-colared Pragaminantly Siraz but wiin
2001 Barglo La \figne presents 3 | matiarings of Both Viogrier and
faniastic noe= of flawers, minerals | Marsanne # which Imbue a
and cnushad raspbamies folowed t2 and 3 tauch
by GenErous amounts of very ripe aly, spicy
rad frults, mint and eucalyplus . | power of the Shiraz. The Inclusion
Quantiy: 1 |E| Quaniy: 1 |E|
Add to basket © Add to basket O
Add o wish List At B Viksh List oy
Baroio, L2 Vigne, Az Agr. Yama Yaring Dry Red No.2
LEEETD Lucizna Sandrone, Aledmont Shiraz, ara Valley, Vicloria
tyle Italy Australla
Graps mix Nedbialy Syranishiraz
Eack FRamave all products from companean £
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Properties

The (Product) Compare page holds no information of its own so it has no editor field. When the product
compare page has been created, it must be defined in the site configuration setting of the start page.

Create Account

Introduction

The Create Account page type provides the possibility to create new customer accounts on the website.
Personal and login information such as name, e-mail and password is entered by the user, and there is
also an option to sign up for a newsletter.

When the user has agreed to and selected the Terms and Conditions option and clicked on Continue, a
confirmation message will be displayed. The account will be created and the account details are saved in
the customer database of Commerce Manager. Later on account details can be updated from the My Pro-
file option.

Register an account

Personal details

Title  Mr E|

First name Carlos
Last name Santana

Email address  carloz@somemail.com

Your login details

Usemame Carlos
Password sssssss {min & characters)

Confirm password esesssss

MNewsletter (optional)

I would like to recieve enoteca emails.

Terms and Conditions

| agree to the enoteca Terms and Conditions
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Properties

The Create Account page holds no information of its own so it has no editor field. When the page has
been created, it must be defined in the site configuration setting of the start page.

Shopping Basket

Introduction

The purpose of the Shopping Basket page type is to display product items that a customer has added to
the personal shopping basket. The page can be accessed from several instances, and the Your basket
view option is always available in the tope menu of the site. The total value is instantly updated when
something is added to the basket.

wWF Your basket

2item{s) Totak £19.45 Checkout ©

The Shopping Basket page provides functionality for changing the quantity of items as well as removing
items from the basket. The promotion code option will apply any discount from a selection of related dis-
count options from the system.

Your basket - you have 2 item(s) in your basket

Fantasia Torrontes, Bodegas Mauricio Lorca Quantity Price Total Remove

1 £10.00 £10.00 L]

Pulenta, La Flor, Sauvignon Blanc, Mendoza (Stelvin) Quantity Price Total Remove

1 £9.45 £9.45 (<]

bkt

Do you have a promo code?

Enter code Apply O
N _ Subtotal £19.45 (exc. VAT)
£0.00 digcount awarded in this basket
Order discount -£0.00 (exc. VAT)
[x] loyalty points recieved with this purchase. Company discount 000 (exc. VAT)
{Log in to use your points)
Total Order £19.45 (exc VAT)
Update basket © [l Go fo checkout ©
Back

O The "Total" value in the shopping basket display does notinclude promotions.

When the shopping basket information has been changed, clicking Update basket will cause the pricing
information to be recalculated based on the new information. Information about loyalty points will also be
calculated and displayed on the page. Clicking Go to checkout takes the customer to the first step of the
shopping completion procedure.

Properties

The Shopping Basket page holds no information of its own so it has no editor field. When the page has
been created, it must be defined in the site configuration setting of the start page.
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Search Result

Introduction

The Search Result page page type is used for displaying the results of a product search performed on
the website. The matching search hits are shown in a listing with product details displayed. From here
you have the possibility to add items to the shopping basket, or add items to the wish list. Clicking on an
item will display the full product information page.

With the Refine your search option in the left column, the search results can be filtered based on cat-
egories.

Mixed Cases Popular searches. [E3 °

Search Result

All results: Your results (83) - You searched for "riesling”
Refine your search

Category Heggies Vineyard Botrytis Riesling, Eden Valley, South Australia £1 2 95
Al resufts (83) .
Products (32) s Grown in vineyards planted high up in the Eden Valley, this fabulous sweet Add to Wish fist @
Reviews (0) E | Riesling is now beginning to show the first stages of maturity as it ages. The Add 1o basket ©
Pages (1) exotic aromas of apricot and peach are
1 White wines
First things first, why is “white” wine, not white at all , but yellow, golden or straw-like in color? It's color can be derived from an
assortment
i Ostler Blue House Riesling, Waitaki River, Otago [Stelvin)
£16.95
Add to Wish fist @
= Add fo basket ©
! Riesling Hochrain Smaragd, Franz Hirtzberger
£40.80
L From the top of the hill above the village of Spitz an incredibly rich and complex Add to Wish list @
e | Riesling; lime, bacon rind, flamboyant acidity and a fulsome palate which is both Add fo basket
flirtatious and yet somehow quite ..
O 12 3 4558678439 O
Properties

The Search Result page page holds no information of its own. When the page has been created, it must
be defined in the site configuration setting of the start page.

For more information on how to search in EPiServer Commerce, refer to the Search section of this doc-
umentation.

Company Checkout

Introduction

The Company Checkout page is used in the B2B scenario, and is similar to the B2C check out page.
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1. Welcome 2. Address 3. Payment 4. Confirmation

Deliver and Billing Address

|. Choose delivery address

Add ©
@ Home Dispatch to this address
Line 1
PostCode Town
United States
Work Dispatch to this address @
2. Choose billing address

Properties

The Company Checkout page page holds no information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.

Standard Page
Introduction

The page type Standard Page in EPiServer Commerce is used for creating an ordinary information page.
On the sample site you will find it for example under the [Content Pages] and [Footer Container] sections
of the page tree structure.

Properties

The page type is quite simple and contains a Heading and a Description field together with an editorial
body. The editor toolbar contains the Product Link tool for creating links to products.

© EPiServer AB



258 | User Guide for EPiServer Commerce 1 R3

L~
(=
Home » [Footer Container] No changes to publish
Popular Products

Name Popular Products Visible to Everyone Manage
. Languages en-USs
Name in URL Popular-Products Change
1D, Type 25, Standard Page
Simple address Change

Display in navigation

Category ‘.Add one or more categories |

Heading ‘ Popular Products |

Description

mn

‘ Donec semper neque quis Ell

MainBody =l i [ (5 O & Ga
B 7 iS i= Styles - Q @

Suspendisse uliricies risus eget sem iaculis uliricies. Nam imperdiel, nibh ac fermentum ulirices, sapien ipsum cursus
velit, vitae hendrerit est elit quis mauris. Efiam adipiscing aliquam nulla vilae pellentesque. Mauris al placerat augue.
Suspendisse polenti. Vivamus a odio dui. Denec uliricies eral eu neque viverra et feugial ante mollis. In egestas
laarest orci, eget iaculis ligula pretium ac. Donec faucibus aliquam lectus eu viverra Nulla facilisi. Pelientesque viverra
massa lorem, vel euismod sem. Vivamus feugiat, velit vitae tempus consequat, gquam turpis accumsan erat, in
adipiscing dolor eros sed nulla. Vivamus iaculis gravida suscipit. Aiquam id purus justo, eu aliquet metus. Donec
semper neque quis eral auctor fempus.

Path

Y L4

For more information on how to work with the editor field, refer to the user documentation for EPiServer
CMS.

My Profile Pages
Introduction

In the sample site, the personal user account related information is available from the My profile option at
the very top of the page when the user is logged in.

Welcome, Carlos  Log Out My Profile

wWF Your Basket

Ditem(s) Total: $0.00 Checkout @

The information is contained in a set of pages organized under the My Profile view.

My Profile

Address Book
My Orders
My Page

My Settings
Wish List

The personal account related pages are stored under the [My Profile] container page in the page tree.
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Sites Tasks

Q

F.oot

= # Home

1]
4

B [Menu]
& [Functional Pages]
& [Footer Container]
B [My Profile]
Address Book
My Orders
My Page
My Settings
Wish List
Order Detail
i [Content Pages]

& [Company Profile]

Properties

These pages are based on specific page types with functionality for extracting personal customer infor-
mation from the customer management part of Commerce Manager. The page types hold no editorial
information of their own. After they have been created, all the pages except Address Book must be
defined in the site configuration setting of the start page.

Address Book

Introduction
The Address Book page holds functionality for adding, displaying and deleting address information for a
user account. Multiple addresses can be added, and different shipping and billing addresses can be

used. Specific addresses for billing and shipping can be set as default, and will be used in the checkout
process.
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New Address

Address Title
Firsi Mame
Last Name

Company
Email Address
Phone Number
Country
Postcode
Address Line 1
Address Line 2
Town

County

The address information is displayed as part of the information under My Profile for the user account.

My Profile

Address Book
My Orders

My Page

My Settings
Wish List

Properties

The Address Book page holds no editable information of its own.

My Orders

Introduction

The purpose of the My Orders page is to display the order history for a user account. The order infor-
mation is collected from the customer management part of Commerce Manager, and is displayed as part

Home
Carlos

Santana

carlos@somemail com

123456789

United States [~]
123888

1 Main Street

Sun City

Use as my Default Billing Address
Use as my Default Shipping Address

Address Book

Add new Address ©

Default Billing Address

Carlos Santana
1 Main Street
123888 Sun City
United Stafes
123456789

Edit @

My Addresses

G Carlos Santana, 1 Main Street, Sun Gity

(Optional)

(Cptional)

(Cptional)

Default Shipping Address

Carlos Santana
1 Main Street
123888 Sun City
United States
123456789

Edit @

0 Carlos Santana, 1445 Sun Beach Lane, Harbour City

of the information under My Profile for the user account.

The Order History overview displays the order ID number, creation date, receiver, and total order amount

and status.

Clicking View Order will display further order details for the selected order. The options here are
described in the Order Detail section. Clicking Reorder in the Order history view will initiate the creation

of the exact same order.
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My Profile

Address Book Order History
My Orders
My Page ‘Order ID Created Ship to Total Status

My Setfings

I P0O389491 February 15, 2012 Carlos Santana £1,439.45 InProgress View Order @ Reorder €3
ish Lis

Properties

The My Orders page holds no editable information of its own. When the page has been created, it must
be defined in the site configuration setting of the start page.

My Page
Introduction

The My Page page provides an overview of the personal account information, with user data and product
reviews added by tthe user. The My Page information is displayed as part of the information under My Pro-
file for the user account.

My Profile

Address Book

My Orders Carlos Santana
My Page Full Name: Carlos Santana
My Settings Email: carlos@somemail.com
Wish List

Edit setfings

Reviews

Avoid this!
Wednesday 15 February 2012

This should be avoided, particularly this bafch, something went wrong here.
Posted in: France

Wonderful!

Wednesday 15 February 2012

This is a greaf wine, strongly recommended.

Posted in: France

View all reviews G

Clicking Edit settings allows for editing of the account information. The settings here are described fur-
ther in the My Settings section of this documentation.
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Edit Account Information

Account details

Title Mr E

First Name Carlos
Last Name Santana
Email Address carlos@somemail.com

Change Password |:|

Profile details

I would like to receive newsletter and offers from Enoteca com

D Please e-mail me offers from third parly companies

(sovo o Jll Corol ©

Properties

The My Page page holds no information of its own. When the page has been created, it must be defined
in the site configuration setting of the start page.

My Settings
Introduction

From the My Settings page a customer can update the user name, e-mail address and password for the
account. From here itis also possible to sign up for newsletters and third-party information.

Edit Account Information

Account details

Title Mr E

First Name Carlos
Last Name Santana
Email Address carlos@somemail. com

Change Password |:|

Profile details

I would like to receive newsletter and offers from Enoteca com

D Please e-mail me offers from third party companies

[sove 0 [l Corco ©)
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Properties

The My Settings page holds no information of its own. After creation the My Settings page must be
defined in the site configuration setting of the start page.

Wish List

Introduction

The Wish List page functionality displays productitems in a personal wish list for a customer. The items
are added to the list when the customer clicks on the Wish List option for a product.

£11.45

Compare CQuantity 1 IEI Add to Wish list I Add to basket ©

The wish listitselfis accessed when from the My Profile option at the very top of the page.

My Profile
Address Baok Wish List
My Orders
My Page
Masseto, Tenuta di Ornellaia Marchese Ludovico £394.00 Remaove @3
My Settings Antinori
Wish List
The eslate’s 2007 Masseto is fabulous. Loads of black
cherry, blackberry and cassis are intermingled with minerals,
violets and French oak. This is an especially sensual
Masseto that impresses ... Quantity: 1 |z| Add to basket @
L'Ermita, Alvaro Palacios £427.90 Remave @
100% Gamnacha in 2006, L'Ermita is made from 60-100 year
old vines, farmed at 15 hi/hectare and then aged for 18-19
months in new French barrels. 2006 is the first time that the
wine is made R B T B /.4 to basket ©
Properties

The Wish List page holds no information of its own. When the page has been created, it must be defined
in the site configuration setting of the start page.

Order Detail

Introduction

The Order Detail page displays order details for a selected order. The page is displayed when clicking
View Order from the order history overview on the My Orders page under My Profile.
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Order details - pogs491

Order numder: PO89491

Order Date: 2/115/2012 4:26:53 PM
Order Email: carlosi@somemail.com
Status: InProgress

Billing Address Payment Information
Carlos Santana Method(s):

1 Main Street Pay By Phone (Processed)
123888 Sun City

United States

Split Shipment - Part |

Name Total
Qty Price Discount Total
Pulenta, La Flor, Sauvignon Blanc, Mendoza (Stelvin) 1 £9.45 £0.00 £9.45
Ch. d"Yquem, Sauternes 3 £410.00 £0.00 £1,230.00
Vieux Chateau Certan, Pomerol 1 £200.00 £0.00 £200.00
Subtotal

Shipping Address Shipping Method(s) EEERD (ERVED
Carlos Santana 1 package via: Shipping & Handling £0.00 (exc. VAT)
1 Main Street Free delivery (2-3 days)

123888 Sun City Taxes (VAT)

£0.00
United States

Order discount £0.00 (exc. VAT)

e/ WishoListr ) Total Order £1.439.45

Properties

The information displayed includes contact details, address and payment information, shipping address
and methods, product quantity and price, as well as the total order sum including taxes and any dis-
counts. All of this is retrieved from Commerce Manager, and can only be viewed.

Company Profile
Introduction

In the B2B scenario of the sample site, the Company Profile pages are used for displaying account infor-
mation for a company with associated users. Through a company account, companies can add their
employees as users, and deliveries can be shipped to multiple addresses.

As for users in a B2C scenario, the company account related information is available from the My profile
option at the very top of the page for the company account administrator when this user is logged in.

© EPiServer AB



Sample Site | 265

Welcome, Carlog  Log Out My Profile

w7 Your Basket

Ditem(s)  Total: 50.00 Checkout ©

The company information is displayed using the Company Page page type. Refer to the Managing Com-
pany Accounts section for more information on how to set up company accounts.

The company account related pages are stored under the [Company Profile] container page in the page
tree.

Sites Tasks

Q

Foot

A Home
E [Menu]
i [Functional Pages]
& [Footer Container]
E [My Profile]
& [Content Pages]

B [Company Profile]

1]
4

Company Order Detail
Create Member

Edit Member
Members List

Company Page

Properties

These pages are based on specific page types with functionality for extracting company account infor-
mation from the customer management part of Commerce Manager. The page types are only used for dis-
play and hold no editorial information of their own. After they have been created, all pages must be
defined in the site configuration setting of the start page.

Company Order Detail

Introduction

The Company Order Detail page displays order details for a selected order. The page is accessed when
selecting an order in the Orders list of the Company Profile overview page.
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Company Profile

Order Details - roissia

Order Number: PO15532
Ordet te: J19/2012 9:59:50 AM

Order Email: mary@somemail_com
Status: InProgress

Billing Address Payment Information
Mary Smith Method(s):

Company XYZ Pay By Phone (Processad)
1 First Strest

81818 Hometown

United States

Split Shipment - Part |

Name Total
aty Price Discount Total

Ch. Suduiraut, Sauternes

O The information here is read-only, itis not possible to update any order information from here.

Properties

The Company Order Detail page holds no information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.

Create Member

Introduction

The Create Member page provides a possibility for the company account administrator to add members
to be associated with the company account. The Create Member page can be accessed by the company
account administrator by selecting the Create a Member option in the Members List page.

Company Profile
Create Members

Title Ms -
First Mame  Lisa
Last Hame  Jones
Email Address  |isa@scmemail.com

Username  Lisa

ssssaee (min & charscters)

Password

Confirm Password T
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Enter information in all fields and click Save when done. The member will be added to the company
account, and will be able to log in with the credentials provided.

Properties

The Create Member page holds no editorial information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.

Edit Member
Introduction

The Edit Member page provides a possibility for the company account administrator to edit the settings
for an individual member of the company account. The Edit Member page can be accessed by selecting
the Edit option in the Members List page.

Company Profile

Edit Members Al fields are required

Address Book
Tile  Ms -

Add New Address ©
FirstName  Lisa
Default Billing Address Default Shipping Address
LastName  Jones
Lisa Jones Lisa Jones
Email Address  lisa jones@mail com
= = - 45 Main Street 45 Main Street
R 581234 Shiptown 681234 Shiptown
United States United States
123456786 123456786
Edit @ Edit @
My Addresses
© LisaJones, 45 Main Street, Shiptown Edit Address ) Delete Address €3

The following information can be edited from here:

e Personal information for the company account member - name, e-mail address and resetting of
the password. Click Save to update the changes.

o Default billing and shipping addresses used by the account member. Addresses can be edited
and deleted, and the same information can also be updated by the individual member from the
User Profile pages.

Properties

The Edit Member page holds no information of its own. When the page has been created, it must be
defined in the site configuration setting of the start page.

Members List

Introduction

The Members List page provides an overview of members associated with the company account. The
listis displayed when the company account administrator selects the Manage Members option in the left
column of the Company Profile overview page.
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Company Profile

Members

Mary Smith
Member Since: 23 Feb 2012

Carlos Santana
Member Since: 23 Feb 2012

Lisa Jones
Member Since: 19 Mar 20412

Manege I-.Ien'tr-I';

From the Members List, the company account administrator can create new members associated with
the account, edit information for existing members, and delete existing members from the account.

Member List
Create a Member
First Name Last Name
Carlos Santana Carlos. Santana Edit @ Delete €
Lisa Jones Lisa Jones Edit & Delete €
Mary Smith Mary Smith Edit @

O The company account administrator cannot be deleted from here, this information must be
changed by an administrator in Commerce Manager.

Properties

The Members List page holds no editorial information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.

Company Page
Introduction

The Company Page provides an overview of information related to a specific company. The page can be
accessed by the company account administrator when logging in and selecting the My Profile option at
the top of the page. If the user is a company account administrator, the Company Page will be displayed

by default.
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Members

Mary Smith

Member Since: 23 Feb 2012

Carlos Santana

Member Since: 23 Feb 2012

Lisa Jones

Member Since: 19 Mar 2012

Mansge Members &

Members Latest Comments

& & Although is should be taken a little cooler
than it actually says on teh bottle, be

aware!

Carlos Posted in: Italy
Mondzay 19 March 2012

&G ..trythis out!

Carlos Posted In: Argentina
Wednesday 29 February 2012

View All Reviews ©
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Company XYZ

Business Category: Food & Dining
Members: 3

Mondzy 19 March 2012
PO2867E

Monday 19 March 2012
PO26407

Mondzay 19 March 2012
PO18533

Monday 27 February 2012
PO17865

£378.00

£122.25

£233.38

£338.89

The page is built up of several sections. On the upper left side, a list of all members associated with the

company account will be displayed. Selecting Manage Members here will display the Member List page,
from where members and member information can be managed. In the lower left part, product comments
and reviews added by members are listed.

The top main section displays company account information. Here, the Edit Settings option provides a
possibility for the company account administrator to edit the account settings.

Edit Company Details

Company Name

Business Category

Monday 19 March 2012
PO23678

Monday 19 March 2012
PO26407

Company XYZ

Food & Dining

[ Mo Value ]

Arts & Entertainment

Automotive

Business & Professional Services
Clothing & Accessories
Community & Government
Computers & Electronics
Construction & Contractors
Education

Health & Medicine

Home & Garden

Industry & Agricutture
Legal & Financial

WMedia & Communications
Personal Care & Services
Real Estate

Shopping

Sports & Recreation
Travel & Transportation

Settings that can be edited are the Company Name and the Business Category that it belongs to. Select
Save to save the changes.
The middle part of the page displays a listing of recent orders for the company account. The order date,
number, and total order sum is shown. Clicking an order number will display further order details using

the Company Order Detail page.
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Properties

The Company Page page holds no information of its own. When the page has been created, it must be
defined in the site configuration setting of the start page.

Payment Providers

Introduction

EPiServer Commerce is a flexible platform allowing you to use many of the most popular payment pro-
viders within e-commerce. There are a number of payment solutions for different markets available "out-
of-the-box" for EPiServer Commerce. Some are installed automatically with the EPiServer Commerce
sample site, and some are available as separate modules.

Payment Method

Gift Card

Payment by Gift Card (exc. Tax)

Remains to Pay (exc. Tax)
by payment method below

Update "Remains to Pay” ©

'@ Pay By Credit Card

S visa B

Card Number Name on Card

ExpiryDate 1 =+ ; 2010 - vV

Pay By Phone

Credit on Account

Payment Providers Available with the Sample Site

When you install the EPiServer Commerce sample site, the payment provider options listed below will be
included by default:

e Pay with Gift Card- payment using gift card of certain values and types.
e Pay by Credit Card - payment using the most common credit cards.

e Pay by Phone - payment method where paymentis done by phone.

e Credit on Account - credit payment option for a company account.

The following sections of this documentation briefly describes the user functionality for the various pay-
ment methods available. Refer to the EPiServer Commerce SDK for more information on how to configure
and customize the different payment methods.

Gift Card

The Gift Card payment provider is available by defaultin a standard installation of the EPiServer Com-
merce sample site. This option allows for purchases using gift cards with certain values. When the Gift
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Card option is checked, the customer can enter the card number and security code for the gift card to be
used.

Payment Method

| Gift Card

Card number 123444555
Security code 159

Payment by Gift Card (exc. VAT)

Remain to pay (exc. VAT)
By one payment method below

Update remain to pay ©

The associated gift card value will be calculated, and when clicking Update remain to pay, the total
remaining order sum will be calculated.

Gift cards are defined in Commerce Manager under Customer Management. Refer to the Gift Card Admin-
istration section for more information. Refer to the EPiServer Commerce developer documentation for
more information on how to configure the different payment providers available.

Pay by Credit Card

The Pay by Credit Card payment provider is available by default in a standard installation of the EPiS-
erver Commerce sample site.

This widely used payment option is used for managing payments for the major credit card providers. The
customer enters credit card details such as card number, expiration date, card name and CVV (Card Ver-
ification Value) number. The system verifies the card information, and the payment transaction is carried
out.

Refer to the EPiServer Commerce developer documentation for more information on how to configure the
different payment providers available.

Pay by Phone

The Pay by Phone payment provider is available by defaultin a standard installation of the EPiServer
Commerce sample site. This payment method makes it possible to manage payments over telephone.
Refer to the EPiServer Commerce SDK for more information on how to configure the different payment
providers available.

Credit on Account

The EPiServer Commerce sample site has functionality for adding company accounts in a B2B scenario.
The checkout procedure for company accounts includes by default the Credit on Account payment
method, where businesses can pay using company account credit. Refer to the EPiServer Commerce
SDK for more information on how to configure the different payment providers available.

Faceted Navigation

Faceted navigation is a feature allowing user to quickly navigate through many kinds of filters in product
listing, for instance color, price range or taste. The faceted navigation feature is available on the EPiS-
erver Commerce sample site when selecting "Wine" or "Mixed cases" in the main menu.
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Home Wine Mixed Cases

Home = Wine = IKaly

Currently Shopping By

Price: £10-£20 - Remove There are 30 product|s) found
Clear All
Derthona, Colli Tortonesi, La Colombera, Piedmont
Browse Wines ; 0 Review(s)
Coy Elaila
=
diiz The wines from Colombera are an exciting find. Made using the
Closure indigencus local grape Timoragso, arguably the region's finest white
warietal, this is a bone dry, refreshing alternative to the ...
[ Grape mix
o £15.35
Nebbiolo (2)
Barbera (3}
Sangiovese (5)
Timorasso (2} Compare @ a . Add to Wish @
[ compare Quantity: | 1 - Add to Wish
Muscat (1) List

Corvina (1) Add to Basket ©

Primitivo (1}
Pelaverga (1)
Nerello (1}

Verdicchio (1) Barbera d'Alba, Cru Serraboella, Az. Agr. Cigliuti, Piedmont

Dolcetto (3) 0 Review (s}

Garganega (1) Haiz

Cortese (1)

Armeis (1} For those who love thick, unctuous Barbera made in a fruit forward,

Fiano (1) mind-blowing style, egged on by a hot vintage then here's your

wine.
Alcohol
£19.25

Taste

The product listing in the main area will be filtered based on the selections done by the user in the left
menu. This offers a powerful way of guiding the user to the desired products in the product catalog. The
faceted navigation can be easily customized through configuration, refer to the EPiServer Commerce
Developer Guide for more information.

Personalization

Introduction

The personalization feature in EPiServer CMS allows you to create adapted content that will be displayed
to targeted Visitor Groups. Based on user information collected when visitors access your website, dif-
ferent content will be shown to different visitor groups of your choice. You can for instance display dif-
ferent content to first time visitors and returning visitors on your website. The personalization feature is
described in detail in the user documentation for EPiServer CMS.

Personalization Criteria for EPiServer Commerce

The EPiServer Commerce sample site features a number of predefined visitor group criteria customized
for an e-commerce site where you want to adapt content based on products and order information. Visitor
groups can be applied to the various content on your EPiServer Commerce site, thus creating a per-
sonalized website visitor experience.
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The visitor groups and their associated personalization criteria can be accessed by clicking CMS in the
global menu, and then selecting Visitor Groups in the submenu displayed. Or, you can right-click in View
mode and select Visitor Groups in the EPiServer CMS right-click menu.

The personalization criteria for EPiServer Commerce are available under Commerce Criteria when you
click Add to define visitor groups for your site. The various criteria can then be dropped into the con-
figuration area.

Dashboard J®YEl Commerce Add-ons EPISERVER @ ? Ladmin Q

Edit Admin Reports  Visitor Groups

Create Visitor Group @

Adapt content on your website by first creating visitor groups and then using the groups to target the content on pages.

Criteria

Commerce Criteria

Match Al
Customer Properties
g Drop new criterion here : Order Frequency
Total Spent 2 Product in Cart or Wish List
Recent Orders

Other Information

Name

Notes

Security role [7] Make this visitor group available when setting access rights for pages and files Community Criteria

Statistics Enable statistics for this visitor group Site Criteria

Time and Place Criteria

= URL Criteria

Visitor Groups

The predefined personalization criteria for EPiServer Commerce are described in more detail in the fol-
lowing.

Customer Properties Criteria

With the Customer Properties criteria you can personalize content based on for instance age and geo-
graphic location.

Personalize content based on the following information (select from drop-down list):

e Date of Birth - define an age range by entering a from/to date. Select a date in the calendar or
enter a date directly in the field (default format mm/dd/yyyy).

e Customer group - select one of the existing groups Customer, Partner or Distributor.
e Registration source - enter the source of registration in free text format.

e Country - select a country from the list.

e Region code - select a region code based on the address region in addresses.

e Address postal code - based on state selected, select a postal code from the list.

o State - select a state from the list.

O Only one property type with a related value can be selected for a criterion, but several Cus-
tomer Properties criteria can be defined for a Visitor Group.

Order Frequency Criteria

With the Recent Orders criteria you can identify customers that have placed an order in the store" X"
times in the last "Y" days.
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Personalize content based on the following information:
e Order times - select the number of times an order has been placed.

e Number of days - select the number of days.

Product in Cart or Wish List Criteria

With the Products in Cart or Wish List criteria you can identify shoppers that have placed a product of a
certain type or brand in their cart or on their wish list.

Personalize content based on the following information:
o Specified product code - enter the desired product code in free text format.
e Product from a specified category - select the desired product category from the list.

e Product has a specified property and value - enter the desired product property and value, for
instance "brand" and "Sony".

O Only one property type with a related value can be selected for a criterion. However, you can
add several criteria of the type "Products in Cart or Wish List" to a Visitor group.

Recent Orders Criteria

With the Recent Orders criteria you can personalize content for visitors that have placed an order on the
site in the last "X" days.

Personalize content based on the following information:

e Number of days - select the number of days.

Total Spent Criteria

With the Total Spent criteria you can personalize content for visitors that have spent "X" amount of money
(in a specified currency) on the site in the last "Y" days.

Personalize content based on the following information:
e Spent at least - select amount and currency.

e Select number of days.

Social Features

Facebook Integration

The EPiServer Commerce sample site has a built-in Facebook integration, allowing users to share "lik-
ings" of any product in the product catalog. This is a powerful way to promote the marketing of products in
one of the largest social community networks.
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Reviewing and Commenting
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Customers that are logged on to the EPiServer Commerce sample site have the possibility to add prod-

uct reviews by providing comments and rate the products. The resulting reviews are displayed for

instance in the right-hand section of the page, as well as for each product.

Recent Reviews

Chablis, Bougros 'Cote Bouguerots' Grand
Cru, Domaine William Fevre

This should be avoided, particularly this batch,
something went wrong here.

*

Ch. d"Yquem, Sauternes
This is a great wine, strongly recommended.

*ohddok  LEEERD)

Barolo, Le Vigne, Az. Agr. Luciano
Sandrone, Piedmont
Fantastic taste, very versafile. It's AWESCME!

2.2 8¢ ¢ " SN <==dmor= O

© EPiServer AB



276 | User Guide for EPiServer Commerce 1 R3

The reviews will be displayed to all visitors to the site regardless of whether they are logged on or not.
Only the three latest reviews will be displayed at the same time, with the possibility to see all reviews if
desired.

Adding Comments

When selecting a product, there will be an Add a review option available where a comment can be
added as well as a rating (1-5). A user can rate a product, but only once. The average score of the ratings
will be displayed as the rating for that product.

Add a review I

Write your review
Bon
Try this out!

This was a great suprise, bought this as a gift to a friend and it turned out to havab

Vil wondearful boquet

Wine rating (Click on the star o rale the wine)

Rating - A W ‘@

z0w |3

L

| B Done © Cancel €

Logged on users can remove their own comments using the Remove option.

Reviews

Totally agree!
Mary, February 2012

Found the same thing, a very strange taste or is i

st becavse of the dry summer this

year?

ok Remove ©

Avoid this!

Carlos, February 2012
This should be avoided, particularly this batch, something went wrong here.

* Report as Inappropriate @)

View il rmiizus ©

Approving comments

The sample site is configured so that comments added will receive status "pending" and must be
approved by the site administrator before they are made visible to others on the site. The approval is
done from the dashboard using the Approval Gadget. Commerce Manager administrators can see the
status for each comment, and remove all comments, from the display for each product.

Abuse reporting of comments

When logged on to the website, you can abuse report comments that others have posted for a product.
This is done using the Report as Inappropriate option on the review section for a product. Site admin-
istrators can then monitor inappropriate content using the Abuse Gadget on the dashboard. When a com-
mentis reported as inappropriate, it will generate an item in the list of abuse reports for the site
administrator to manage.
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Experts

The EPiServer Commerce sample site includes functionality for assigning experts to be involved in rat-

ing and reviewing of products. An expert is someone with thorough product knowledge and trusted by the
community. From the Admin mode in EPiServer CMS, website administrators can assign the "Expert" role
to registered users on the site. Expert’s reviews will be highlighted and will appear in the top of review list.

Dashboard @ISR Commerce Add-ons EPISERVER @ 7?7 Ladmin Q

Edit Admin Reports  Visitor Groups

J Admin || config || Page Type |[ Block Type |

Edit User @

w Access Rights

Set Access Rights
Administer Groups
Search UseriGroup

J User Information H Display Options

Create User Username
v Scheduled Jobs Password
Subscription Confirm password

Publish Delayed Page Versions
Remove Autosaved Page Drafts
e E-mail address carlos.santana@somemail.com

[F] Change Password

Automatic Emptying of Recycle Bin Active £
Clear Commerce Cache E Account locked (too many failed logon attempts)
Mirroring Service
HEEEFIEET Provider ChSMembershipProvider
SISEEEE Created date 11812012 Z:10:39 PM
Remove Bxpired Carts Last login date 11/8/2012 2:16:08 PM
Rotate Ency
TR Description
Full Search Index Job
Subscription Payment Plans Job
Incremental Search Index.Job
& Not member of & Member of
Remaove invalid comments ad
ministrators |W
Remove Permanent Editing WebAdmins
Serialize Catalog Meta Data Job WebEditors
Shipment Release Job
¥ Tools
Export Data
Import Data

Produdi licensed to Dung Le EFiServer AB il

Gadgets

A gadget is a small application available from the Dashboard in EPiServer OnlineCenter and the Assets
Pane and Navigation Pane in EPiServer CMS. A number of gadgets are shipped out-of-the-box with each
EPiServer product, see the product-specific user documentation.

You can use some of the gadgets with other devices, such as iPhone and iPad.

You can also develop and customize your own gadgets to suit your needs, see EPiServer Framework
SDK.

Gadgets that are specific for EPiServer Commerce are described in the following.

Commerce Orders Gadget

The Commerce Orders gadget displays orders statistics in the form of a sales graph and a list of pur-
chase orders in a time interval of your choice.

Do the following to add and configure the Commerce Orders gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.
2. Selectthe Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Orders
gadget by clicking on itin the list. The gadget will be displayed on the dashboard. By default, it will
be updated to display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new
time interval. Click OK to save you changes.
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When the Commerce Orders gadget has been added to your dashboard, you will be able to easily mon-
itor sales activities for your EPiServer Commerce website.

Commerce Overview Gadget

The Commerce Overview gadget shows sales data from the e-commerce system. The data is grouped
by products, categories, orders, customers and promotions.

Do the following to add and configure the Commerce Overview gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.
2. Selectthe Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Overview
gadget by clicking on itin the list. The gadget will be displayed on the dashboard. By default, it will
be updated to display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new
time interval. Click OK to save you changes.

When the Commerce Overview gadget has been added to your dashboard, you will be able to easily mon-
itor sales data from your EPiServer Commerce website.

Comment Approval Gadget

Users logged on to the sample site can add comments (reviews) to products on the site. The Comment
Approval gadget makes it possible for EPiServer Commerce administrators and editors to manage com-
ments that are left by website visitors. This gadget provides an overview of the commenting status, and
you can view, approve or delete comments from here.

Do the following to add and configure the Comment Approval gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.

N

Select the Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Comment Approval
gadget by clicking on itin the list. The gadget will be displayed on the dashboard.

&

By selecting Edit in the drop-down menu of the gadget, you can set the number of approval items
to display, as well as the length of the description.

5. Click OK to save you changes. The gadget will be displayed on your dashboard.
Do the following to use the Comment Approval gadget:
1. Log on to EPiServer Commerce and select Dashboard in the right-click menu and select the Dash-

board tab under which the Approval gadget is located.

2. You can chose to view all comments, or filter them according to their status - Approved, Pending
or Deleted. Click Refresh to update the listif needed.

3. Selectone or more comments for which you want to update the status, by clicking the checkbox to
the left of each comment. Click the top left checkbox to select all comments displayed in the list.

4. Select the status you want to apply - Approve, Mark Pending or Delete. For instance, select
Approve to approve the selected comments.

Comment Abuse Report Gadget

The Comment Abuse Report gadget makes it possible for EPiServer Commerce administrators and
editors to manage comment abuse reports that have been created by website visitors. This gadget pro-
vides an overview of abuse reports, and you can remove selected comments from here.
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Do the following to add and configure the Comment Abuse Report gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.

N

Select the Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Comment Abuse
Report gadget by clicking on itin the list. The gadget will be displayed on the dashboard.

4. By selecting Edit in the drop-down menu of the gadget, you can set the number of items to display,

as well as the number of abuse reports to be displayed for each comment.

5. Click OK to save you changes. The gadget will be displayed on your dashboard.
Do the following to use the Comment Abuse Report gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu and select the Dash-
board tab under which the Comment Abuse Report gadgetis located.

2. Selectthe comments you want to manage by clicking the checkbox to the left of each comment.
Click the top left checkbox to select all comments displayed in the list.

3. Click Remove Comment to remove the comment. Select Ignore to leave the comment without any
actions.

Commerce Settings for CMO Gadget

Introduction

With EPiServer Campaign Monitor and Optimization (CMO) you can measure and monitor campaigns
on your website and optimize your landing pages. EPiServer CMO provides a simple way to analyze cam-
paigns and landing pages, rather than whole sites. Find out more about EPiServer CMO in the user doc-
umentation on world.episerver.com.

EPiServer CMO can also be used for monitoring activities on an EPiServer Commerce site. You can for
instance monitor the number of views or orders for a specific product or product category. The logging of
Commerce KPI data is supported using the Generic KPI function in CMO. The number of orders is an
example of a generic KPI. This allows for external applications such as Commerce to send notifications
using a specific application key. The application names and keys are defined in EPiServer CMO, which
will then listen for incoming notifications with these specific key values, and collect and store the data.

The following procedure applies when setting up the integration between CMO and Commerce:
e Setup the web services to be used by EPiServer CMO and the corresponding URL to be used.
o Define the external applications, their application names and keys, in EPiServer CMO.

e Define the product views and/or product orders you want to monitor, using the EPiServer Com-
merce Settings for CMO gadget. Here you will need the application keys and the URL for the
CMO Web Services.

e In EPiServer CMO, create a campaign and add the generic KPI for EPiServer Commerce.
e EPiServer Commerce will update the KPI value using web services.

e The monitoring result will be displayed on the campaign report page in CMO, or by using the
CMO KPI Summary gadget for EPiServer Commerce on the site that has the EPiServer CMO serv-
ice installed.
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The collected data for EPiServer Commerce is defined in the EPiServer OnlineCenter using the Com-
merce settings for CMO gadget, as described in the following.

@

To use this gadget you need to have both EPiServer CMO and EPiServer Commerce installed
on your website.

Adding the Commerce Settings for CMO Gadget

When you add and configure this gadget, you can choose to monitor activities for a selection of product(s)
or order(s).

Do the following to add and configure the CMO gadget forEPiServer Commerce:

1.

2
3.
4

Open the EPiServer OnlineCenter for your website(s) and select Add Gadgets.
Click on the Commerce setting for CMO gadget to add it to your dashboard.
Click Add to define the monitoring parameters.

Select Type, choose either Product View or Product Order. The Product View will define views of
a product or all products under a specific category (node). The Product Order will define orders for
one selected product or all orders of products under a specific category (node).

In the Product/Category field, choose a product or a category by selecting an option in the tree
structure on the left hand, and click Search in the area to the right. Select a product in the search
listand click Select. Or, you can select an entire category (node). You can also search directly for
a product name or ID. Click Select to add your selection.

In the Application Key field, enter the application ID (defined in EPiServer CMO).

In the URL for CMO Web Service field, enter the URL to be used by CMO for the web service
(defined in EPiServer CMO).

Editing Commerce Settings for the CMO Gadget

Do the following to edit a set of settings for the CMO Gadget:

1.

Open the EPiServer OnlineCenter Dashboard, and navigate to the Commerce settings for CMO
gadget.

Click the Edit icon for the settings you want to edit.

Update the settings information, please refer to the section about adding the Commerce settings
for CMO gadget.

Click OK to save your changes.
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Deleting Commerce Settings for the CMO Gadget
Do the following to delete the settings for the CMO Gadget:
1. Open the EPiServer OnlineCenter Dashboard, and navigate to the Commerce settings for CMO
gadget.
2. Inthe check box to the left, select the set of settings you want to delete.

3. Click the Delete button and click OK to confirm.

Tools and Plug-ins

In this section we describe a number of tools and plug-ins for EPiServer Commerce. These are for exam-
ple a plug-in for the EPiServer CMS editor making it possible to select product details directly from the
product catalog. The plug-ins described here are all included by defaultin the EPiServer Commerce sam-
ple site.

Product Link Tool

Introduction

The Product Link Tool is a plug-in to the EPiServer TinyMCE editor. The tool adds a new function to the
toolbar allowing an editor to link content to products in the product catalog in Commerce Manager. When
the link is clicked on, the visitor will be transferred to the product page "view mode" for that product.

Adding a Product Link

You can add product links to text, files orimages in an EPiServer CMS page or a block.

1. In the editor, select the text, files or images where you want to add a link to a product page in the
product catalog.

2. Selectthe Insert/edit Product Link tool in the toolbar of the editor.

3. When clicking the button in the Select Product field, the product picker dialog will open. When
you expand the catalog tree on the left, related products will be displayed. You can browse the
structure and select products. The product display can be sorted by clicking on product ID or
Name. You can also search for a product by entering free text or product ID. Select a productin
the listand click Select.

4. In the Language field you can choose to select the desired language version for the product page,
or let the system decide by selecting Automatically.

5. Enter the details for the link such as title and target frame, just as you would for any link in EPiS-
erver CMS. Click OK.

6. The productlink will be displayed in the editor.
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EPiServer Commerce supports permanent links, meaning that when a product is renamed the
URL will be remembered and will not be broken.

Editing a Product Link
1. Selectthe link and choose the Insert/edit Product Link tool in the toolbar. This will open the Prod-
uct Link dialog.

2. Editthe link options as desired and click OK to save your changes.

Removing a Product Link

Select the link and click the Unlink tool in the editor toolbar. This will remove the link from the selected
text.

The tool buttons in the editor toolbar can be customized, for instance you can change the
grouping and orders of the buttons. This is done from the EPiServer CMS administration inter-
face and is described in the Configuring the HTML Editor section of the EPiServer CMS user
documentation.

Product Dynamic Content
Introduction

The Product Picker Dynamic Content function is used for displaying products as dynamic content. In
editview in EPiServer CMS , the editor can use the function to display product information from the prod-
uct catalog. This adds to the many possibilities with dynamic content, where you can reuse and display
contentin multiple places on the website, but will only need to update the information in one location.

Adding Product Information as Dynamic Content

Do the following to add product information as dynamic content to a page:
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1. Open the page for editing in edit view and place the cursor in the editor where you want to add the
information.

2. Selectthe Dynamic Content tool in the toolbar.

3. Select Product picker in the Select plug-in field. The product picker fields will appear in the Set-
tings section.

4. In the Select product field, click the button to select a product from the Commerce Manager prod-
uct catalog.
The product picker dialog will appear, and you can select a product or a product category by
expanding the product category tree, or searching in the search field. Select the desired product
and click Select.

5. The product display template is defined in the Select display path (can be changed here if
needed).

6. Click OK. A dynamic content box will appear in the editor. Save your changes and view the result
in preview or view mode.
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You can also personalize dynamic content, and display customized information to different vis-
itor groups. Find out more under the Personalization section.

@

Editing Dynamic Content for a Product

Do the following to edit dynamic content for a product:

1. Open the page for editing in edit view and place the cursor in the editor where you want to add the
information.

2. In the dynamic content box, select the Edit option. The product picker dialog will appear, and you
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can selected another product or product category. Click OK when done.

3. Save your changes and view the resultin preview or view mode.

Removing Dynamic Content for a Product

Do the following to remove dynamic content for a product:

1. Open the page for editing in edit view.
2. Selectthe dynamic content box and press Delete on your keyboard.

3. Save your changes to the page.

Scheduled Jobs

Introduction

A scheduled job is a service performing a specific task that can be executed repeatedly at a given time
interval or when an administrator manually executes it. When installing EPiServer Commerce there will
be a few scheduled jobs added to your website, that are specifically needed for Commerce functions.
These scheduled jobs are administered from the EPiServer CMS administration interface. For more infor-
mation on how to use the EPiServer CMS administration interface, refer to the user documentation for
EPiServer CMS.

Administering Scheduled Jobs

Do the following to manage a scheduled job:

1. Login as an administrator and navigate to the EPiServer CMS Admin mode.

2. Selectthe desired schedule job under the Scheduled Jobs section of the Admin tab

3. Check the Activate check box to activate the scheduled job.

4. If you wantto run the scheduled job manually, click Start Manually and the job will be executed.
5

If you want the scheduled job to be run automatically, set the desired time interval in the Sched-
uled job interval field.

6. The time when the scheduled job will be run the next time will be displayed in the Next scheduled
date field.

7. Click Save to save your changes.
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Under the History tab, you can monitor the status and results when the scheduled job has been
executed.

Clear Commerce Cache
A scheduled job for clearing EPiServer Commece cache data.

Settings | Histnr',rl

Date Status Message
Q/10/2012 12:56:21 FM QK Cleared Commerce cache data successfully.

Refer to the section Default Scheduled Jobs for more information about scheduled jobs included with
EPiServer Commerce.

Default Scheduled Jobs

Introduction

In a sample installation of EPiServer Commerce, a number of scheduled jobs will be added to the admin-
istration interface of EPiServer CMS. In this section we describe the jobs that are included by default with
EPiServer Commerce. Refer to the Scheduled Jobs section for more information on how to administer
scheduled jobs.

Available Scheduled Jobs
Clear Commerce Cache

When importing or deleting a product catalog, it will be necessary to clean the runtime cache in order to
make the website up to date. This is done using the Clear Commerce Cache scheduled job. This job can
be executed repeatedly at given time intervals, or manually. After the job has been executed, in order to
verify that the cache has been cleared, you need to refresh the catalog display pages.
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Remove Invalid Comments

In EPiServer Commerce it is possible for customers to review a product and add comments about it.
When a product is deleted and no longer available in the system, itis also recommended to remove com-
ments associated with the deleted product in order to maintain system accuracy. This is done by the
Remove Invalid Comments scheduled job. The scheduled job can be executed repeatedly at given time
intervals, or manually.

Remove Expired Carts

Shopping carts are created by shoppers from the front-end site, and then converted to a purchase order
during the checkout process. Carts that are "abandoned" and not converted into an order, will be stored in
the system for a certain time before they expire. The Remove Expired Carts job will remove expired carts
when executed.

Rotate Encryption Keys

Encryption keys are used for securing sensitive customer data and is set on meta fields. The Rotate
Encryption Keys job will rotate the encryption keys used by the system. Refer to the EPiServer Com-
merce SDK for more information on encryption.

Full Search Index

The Full Search Index job will perform a full search indexing.
Subscription Payment Plans

Payment plans are used for generate recurring payments, for example for magazine or grocery sub-
scriptions. The Subscription Payment Plan job will ensure that these recurring payments are regularly
generated as a background process.

Incremental Search Index
The Incremental Search Index job will perform an incremental search indexing.
Serialize Catalog Metadata

The Serialize Catalog Metadata job is used for serializing catalog data to speed up the meta data
retrieval when searching catalogs.

Shipment Release

The Shipment Release job searches for releasable shipments in active orders. If the difference between
current time and shipment creation time is greater than the configured time span, the shipment status for
the order will be changed to "released".

Defining Display Templates

Introduction

To be able to display different products on the e-commerce site you need to define the display templates
to be used. These can be different for different language groups on the site. On the EPiServer Commerce
sample site, the display templates will automatically be imported and configured during the installation
procedure. However, when new templates have been created you may want to define their use in the sys-
tem, or modify the use of existing ones. This is done in Commerce Manager in the Catalog Management
sub-system under Templates.
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Adding a display template
1. Under Catalog Management, select Templates and click New.
In the Name field, enter the name of the display template, for instance "WineTemplate".
In the Friendly Name field, enter the display name for the template, for instance "Wine Template".

In the Type field, enter the type of display template, for instance "entry".

o &~ w DN

In the Path field, add the path to the display template, for instance:
~/Templates/WineStore/DisplayTemplates/WineDetailTemplate.ascx.

6. Click OK to save your changes.

Updating an existing display template
1. Under Catalog Management, select Templates and the language version and template that you
want to update.
In the Name field, enter the name of the display template.
In the Friendly Name field, enter the display name of the display template.
In the Type field, enter the type of display template.
In the Path field, add the path to the display template.

o o kv D

Click OK to save your changes.

Sample Catalog Import

Introduction

The product catalog contains information regarding brands and sales items. This information will either
be displayed in the public site, or used for pricing and promotions. Product catalogs needs to be imported
into EPiServer Commerce. This will normally be done automatically during the installation procedure for
the EPiServer Commerce sample site.
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However, there may be occasions where you need to import a product catalog, and the procedure is
therefore described in the following. There are different ways of doing this, and in this example we
describe how you manually import the sample catalog for the sample site, using the import/export function
in Commerce Manager. When product catalogs have been imported, they also need to be indexed, in
order for the product search function to incorporate any changes.

Additional information on how to import product catalogs can be found in the Catalog Management sec-

tion.
- ~ Welcome, admin
EPISERVER COMMERCE Catalog List
Welcome » Change Language About v @ Get Help For This Page %
Catalog Management 2 | |New catalog | & Import/Exparty | (& More Actions *
:la'_ Catalog Management Fl Name Available from Expires
4 Catalog Entry Search D 5@ Wine S/12/2011 11:11:00 AM 9/12/2021 11:
@ Catalog Batch Update
=3 Catalogs
H=[_JWine

4[] Templates

ﬁ Dashboard
m Customer Management

fl_: Catalog Management

ng QOrder Management
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vﬂ Asset Management

Reporting 4 0] ¢
m Administration Page Size: 20 [+] B rm=) ) e 9 dn

Importing the Sample Catalog

The sample site includes two product catalogs providing the "everything" and the "brand" view.

1. In Commerce Manager, select Catalog Management and then Catalogs.
2. Click on Import/Export and then Import Catalog, this takes you to the Import Catalog screen.

3. Selectthe catalog zip file, in this case "CatalogExport_Catalog_Wine_Sample.zip" and click Start
Import.

4. When the import has completed, click Close Window.
5. Select "CatalogExport_Catalog_Wine_Sample.zip" and click Start Import.

6. When the import has completed, click Close Window.

It is strongly recommmended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one. Then click the button "Start Import' to start importing.

Add New File

Files Awvailable For Import:

Actions File Name Size Created Last Updated
Download | Delete CatalogExport_Catalog_Wine_Sample.zip 74290 KB Today, 2:35 PM Today, 2:34 PM

1 Page 1 of 1 (1 items)
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Indexing the Sample Catalog

After importing a product catalog, this also needs to be indexed.

1. In Commerce Manager, select Administration, System Settings and then Search Index.

2. Click Rebuild Index to index the catalog for the first time. The Build Index option is used for future
updates when you import the same catalog again and only want to index the changes.
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Managing Content

Introduction

Content on a website can originate from different sources, depending on where on the site and by whom
it has been created. Content can be created and updated by internal or external editors and marketers, by
e-commerce administrators, or by the "shopping community" on the website. On the EPiServer Commerce
sample site for instance, shoppers can rate and add comments to products.

Editorial Content

On the EPiServer Commerce sample site, certain parts of the content is editorial, meaning that it will be
created and updated by editors or marketers from inside EPiServer CMS. Typically this type of content
builds the basic structure of the website and describes the products, the e-commerce company and the
services delivered, support and contact information. There can also be newsletters and articles related to
products and services delivered.

From the edit view you can work with content, create campaigns and add product information using the
Product Link Tool, or you can add product information as Dynamic Content.
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Community Content

The EPiServer Commerce sample site offers some interactivity allowing shoppers to review, comment
and rate productitems. This content which will also be displayed as part of the entire website content, and
as a website owner you may like to monitor and approve information created from this source. In EPiS-
erver Commerce this can be done through the Comment Approval and Comment Abuse Report gadgets.
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